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Chapter 149

Using the 
Fairlight Page

This chapter covers the basic user interface controls found on the 
Fairlight page, where they are and what they do, in order to give you an 
overall orientation of how to work with this integrated audio environment.

Chapter – 149 Using the Fairlight Page 3116



The Fairlight Page User Interface 3119

The Interface Toolbar 3119

Showing Which Panel Has Focus 3120

The Audio Timeline 3120

Controls in the Audio Timeline 3121

Zooming Audio Waveform Height 3123

Track Layering 3124

Switching Among Multiple Timelines 3124

Toolbar 3125

Customizing Clip Display in the Timeline 3126

Customizing the Timeline’s Display 3127

Fixed Playhead Mode 3127

Visible Video Tracks 3127

Video and Audio Scrollers 3127

Mixer 3129

The Monitoring Panel 3132

Viewer 3132

The Media Pool 3133

Importing Media Into the Media Pool on the Fairlight Page 3134

Media Pool Preview Player 3134

Bins, Power Bins, and Smart Bins 3135

Showing Bins in Separate Windows 3136

Filtering Bins Using Color Tags 3136

Sorting the Bin List 3137

Filtering Clips With Audio in the Fairlight Page 3137

Searching for Content in the Media Pool 3138

Taking Advantage of the Media Pool’s Usage Column 3138

Effects Library 3139

Effects Library Favorites 3139

ADR 3140

The Setup Panel 3140

The List Panel 3140

The Record Panel 3141

Contents

Chapter – 149 Using the Fairlight Page 3117



Sound Library Browser 3142

Library Controls 3143

Display Controls and the Search Field 3143

Preview and Audition Controls 3145

Sound Effect List 3146

Index 3147

Edit Index 3147

Tracks 3147

Markers: 3150

Inspector 3150

Metadata Editor 3151

Test Tone Settings for Generating Tone, Noise, and Beeps 3151

Pro Tools AAF Import 3152

Dual Monitor Layout 3152

Customizing the Fairlight Page 3153

Undo and Redo in DaVinci Resolve 3154

Chapter – 149 Using the Fairlight Page 3118



The Fairlight Page User Interface
In single monitor mode, the Fairlight page is an optimized look at the audio tracks of your 
project, with an expanded mixer and custom monitoring controls that make it easy to evaluate 
and adjust the levels of your program in order to create a smooth and harmonious mix.

Audio page

The Interface Toolbar
At the very top of the Fairlight page is a toolbar with buttons that let you show and hide different 
parts of the user interface. These buttons are as follows, from left to right:

The Interface toolbar

 � Media Pool: Shows and hides the Media Pool, from which you can edit audio clips into 
the Fairlight page Timeline.

 � Effects Library: Opens the Audio FX panel of the Effects Library, from which you can 
apply VST and other audio effects to clips in the Timeline.

 � Index: Shows and hides the Index and its Tracks and Markers panels. The Tracks panel 
lets you manage the tracks of the Timeline, showing and hiding which ones you want 
to work with. The Markers panel lets you see every marker in the Timeline, along with 
associated data, so that it’s easy to browse through your markers all at once to quickly 
find the information you need.

 � Mixer: Shows and hides the Mixer, to the right of the Timeline, that lets you adjust 
various effects and levels associated with each track of the Timeline in order to create 
a harmonious mix.

 � Monitoring: Shows and hides the Monitoring audio meters and viewer at the top of the 
Fairlight page.

 � Inspector: Show and hides the Inspector, from which you can edit different clip attributes.

 � Metadata: Shows and hides the clip metadata inspector.  
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Showing Which Panel Has Focus
Whenever you click somewhere on the DaVinci Resolve interface using the pointer, or use a 
keyboard shortcut to “select” a particular panel (such as in the Edit page), you give that panel of 
the user interface “focus.” A panel with focus will capture specific keyboard shortcuts to do 
something within that panel, as opposed to doing something elsewhere in the interface. 
A highlight appears at the top edge to show you which panel has focus so that you can keep 
track of which part of the current page is taking precedence, and you can switch focus as 
necessary to do what you need to do.

The focus indicator shown at the top edge of the Media Pool, 
shown next to a Viewer that doesn’t have focus

The Audio Timeline
The heart of the Fairlight page, the Audio Timeline presents the audio channels and tracks of 
the currently selected Timeline differently than the Edit page does, in a one-channel-per-track 
format that’s optimized for audio mixing and sweetening. The Audio page Timeline cannot 
be closed.

The Audio page timeline
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Controls in the Audio Timeline
The Audio Timeline has the following controls.

 � Timecode fields and Range buttons: Four timecode fields show the current timecode 
value corresponding to the position of the playhead (at the very top), the Range In 
point, the Range Out point, and the Range duration. Clicking the Range In and Range 
Out buttons (to the left of the timecode fields) set these points and their corresponding 
timecode value.

Timecode fields and Range 
buttons in the Fairlight page

 � Transport controls: The bar defining the top of the Timeline contains the Fairlight 
page’s audio-specific transport controls, which differ from those found on the 
Media, Edit, Color, and Deliver pages due to its inclusion of recording capabilities. 
These include Fast Reverse, Fast Forward, Play Forward, Stop, Record, and Loop.

Fairlight page transport controls

 � Automation toolbar: Clicking this button opens a secondary toolbar with all the 
controls you need to configure the recording of mixer automation.

Fairlight page automation toolbar

 �  Monitoring controls: At the far right of the transport controls, a set of three monitoring 
controls let you quickly control the output volume of your mix. An audio Enable/Disable 
button lets you mute audio playback, while a slider lets you change the volume, and 
a DIM button lets you temporarily duck the monitored volume being output in order 
to have a quick chat with your client about sports or the state of the world while 
keeping half an ear on the mix. Dim and Mute commands are also available from the 
Fairlight menu.

The monitoring controls

 � Timeline Ruler: The Timeline Ruler shows the program’s timecode. The playhead 
indicates the current frame and sample where you’re working in the Timeline, and the 
playhead has a handle that appears within the Timeline Ruler. Dragging within the 
Timeline Ruler moves the playhead. When you add markers to the Timeline, these 
markers appear within the Timeline Ruler, as well.

 � Playhead: Shows the current frame and sample of playback, and provides a visual 
representation of where you are while playing, shuttling, and jogging through the 
Timeline. Also used as a reference point for editing operations. The largest timecode 
display at the upper left-hand display shows the position of the playhead.
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 � Audio tracks: The Fairlight page of DaVinci Resolve supports multiple audio tracks, 
and each audio track may contain multiple lanes with which to accommodate the audio 
channels that are contained within multi-channel audio clips using track mappings such 
as stereo, 5.1, 7.1, or Adaptive (1–24 channels). All audio clips that have been edited 
into the Timeline appear within each track, with the recorded channels within each clip 
occupying as many lanes as that clip has available. At the left of each track is a header 
area that contains a number of controls.

The Fairlight timeline is divided into tracks and lanes; track A1 has a single lane for the 
mono audio within it, and track A2 has two lanes to accommodate stereo audio

 � Track header: The track header contains different controls for selecting, 
locking/unlocking, and soloing/muting tracks. Each track header also lists how 
many clips appear on that track. The track header contains the following five 
controls, from left to right:

The track header controls of the 
Fairlight page timeline

 – Track color: Each track can be color-coded with one of 16 different colors. These 
color codes correspond to the Edit page Mixer, and to the Fairlight page Mixer and 
Audio Meters. You can choose a new color for any track by right-clicking the track 
header and choosing from the Change Track Color submenu. You can set multiple 
tracks to the same color by Command-clicking in the track header of multiple 
tracks to select them, and then right-clicking one of the selected track headers and 
choosing from the Change Track Color submenu.

 – Track number: Indicates the number of each track.

 – Track name: Each track has a name that defaults to the track number, such as Track 
1, Track 2. However, you can click any track’s name and edit it to be whatever you 
like. For example, you can rename each track with the type of audio you’re editing 
onto it, such as Production, Ambience, SFX, or Music. These track names are also 
used to identify each track’s channel in the Mixer, in the middle of each channel strip 
(each channel strip’s track number is simultaneously displayed at the top).

 – Audio channel type indicator: Audio tracks also show which channel configuration 
that track uses, listing the number of channels for mono, stereo, 5.1, 7.1, and adaptive.

 – Fader value: A field displays the current fader setting at the position of the playhead, 
in dB.

 – Lock Track button: Light gray when turned on, dark gray when turned off. When a 
track is locked, clips can’t be replaced, moved, or otherwise edited, although clips 
on locked tracks can be graded.
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 – Arm button: This button arms recording onto that track.

 – Solo button: Disables all other tracks but the current one, enabling you to quickly 
hear a single track in isolation. This affects rendering, so if one or more tracks are 
soloed, the muted tracks won’t be output or rendered.

 – Mute button: Temporarily disables audio on that track so it’s neither monitored nor 
output. This affects rendering, so if one or more tracks are muted, they won’t be 
output or rendered.

 – Audio meters: Each track has audio meters in the track header that let you see 
levels during playback.

 � Toolbar editing tools: The toolbar contains both modal and command buttons to let 
you work on your projects. More detail on these appears in the following section.

 � Vertical and horizontal scroll bars: If your project is longer than the current width of the 
Timeline, or the number of audio tracks is taller than the current height of the Timeline, 
these scroll bars let you drag to navigate around your program. When you scroll 
horizontally, you also move the playhead. You may also scroll vertically using the scroll 
wheel (or other scroll control) of your mouse or other pointing device. You may scroll 
horizontally by holding the Command key down while using your scroll control.

 � Individual Timeline track resizing: Any track in the Timeline can be individually resized 
by right-clicking anywhere within that track’s header control area and choosing a track 
height from the Lock Track Height To submenu of the contextual menu. You can choose 
a fixed size including Micro, Mini, Medium, Large, and Extra Large. When you choose 
a fixed track height, vertical zooming no longer affects that track until you change that 
track’s Lock Track Height to option back to None.

Resizing an individual audio timeline track using contextual menu options

Zooming Audio Waveform Height
You can zoom into or out of the audio waveforms shown in each clip of one or more tracks, to 
make them taller or shorter, or you can reset them to unity. This doesn’t change the audio levels 
of clips in affected tracks, it just lets you make the audio waveforms easier to see. 

To zoom audio waveform height using your scroll wheel:
Hold down Command-Option, and roll the scroll wheel or control up or down to resize 
all waveforms in all tracks.
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You can also use commands that are accessed by right-clicking any track on the Timeline and 
choosing a command from the Track Waveform Zoom submenu of the contextual menu. You 
can also select multiple tracks and resize their waveforms all at once. There are three sets 
of commands:

 – Reset Zoom All/Selected Tracks

 – Zoom In All/Selected Tracks

 – Zoom Out All/Selected Tracks

Track Layering
Audio layering is a special audio editing mode that lets you superimpose multiple audio clips in 
the same track, with audio clips edited into the top layers muting overlapping sections of audio 
clips appearing on lower layers. With audio layering enabled, superimposed audio clips are 
treated similarly to superimposed video clips that have opacity set to 100%, with clips on top 
obscuring (or muting) clips underneath. 

Turning on track layers opens up space to edit more audio into each track

Audio layering is incredibly useful for any situation where you’re combining segments of 
multiple takes together to create a single voiceover, audio vocal track, or dramatic performance, 
as you can choose which segments to use via their superimposed position in the stack of clips 
appearing in that track, while at the same time you’re preserving the other takes underneath in 
case you might want them later.

TIP: Track layering can be enabled for audio tracks on the Edit page as well.

Switching Among Multiple Timelines
Timelines can be organized like any other clip in the Media Pool. To open or switch among 
timelines, use the following procedures.

To switch timelines, do one of the following:
 – In the Edit page Media Pool, double-click a timeline.

 – In the Edit page Timeline Viewer, choose a timeline from the Timelines 
drop-down menu at the top of the viewer.

 – In the Color page, choose a timeline from the Timelines drop-down menu at 
the top of the viewer.

 – In the Fairlight page, choose a timeline from the Timelines drop-down 
menu to the left of the transport controls.
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Toolbar
The Toolbar has buttons that let you choose modes of functionality and other buttons that let 
you execute commands such as placing markers and flags.

Buttons in the Fairlight Page toolbar

 � Normal Edit mode: The default mode in which you can move and resize clips in the 
Timeline, roll edits, and do other basic editing tasks. While this mode can be used 
with the pointer, it’s designed for letting you make automatic selections of clips at the 
position of the playhead in selected tracks, using keyboard shortcuts or the Fairlight 
Editing console.

 � Region Selection mode: An editing mode in which you can select partial regions of 
one or more clips for partial editing. While this mode can be used with the pointer, it’s 
designed for letting you make automatic selections using In and Out points to define 
regions of selected tracks, using keyboard shortcuts or the Fairlight Editing console.

 � Edit Selection mode: An editing mode that’s optimized for pointer-based editing in the 
GUI. Multiple selection and editing functions may be accessed by clicking or dragging 
on different regions of audio clips in the Timeline. Additionally, an important aspect 
of working in Edit Selection mode is that this is the only mode that lets you edit the 
Timeline during playback, which you can’t do in Selection and Range modes.

 � Add Cut: Click to add a cut to every clip on an unlocked track that intersects the 
position of the playhead.

 � Snapping: Enables or disables clip snapping. When turned on, clip In and Out points, 
markers, and the playhead all snap to one another for reference while you’re editing. 
A drop-down menu lets you choose how to use snapping to quantize clip position, to 
Bars, Beats, Divisions, Tics, or via Smart snapping. 

 � Flag Clip/Flag Colors drop-down menu: Flags identify clips, and indicate all clips that 
correspond to the same item of media in the Media Pool. Clips can have multiple flags. 
Clicking the Flag button automatically adds a flag to whichever clip is currently selected 
in the Timeline. A drop-down menu to the right lets you choose differently colored 
flags, and clear all flags from the currently selected clip.

 � Add Marker/Marker Colors drop-down menu: Markers identify specific frames 
of individual clips. Clicking the Add Marker button adds a marker of the currently 
displayed color to the clip at the position of the playhead in the Timeline. A drop-down 
menu to the right lets you choose differently colored markers, and clear all markers 
from the currently selected clip.

 � Timeline View Options drop-down menu: Contains a variety of controls with which to 
customize the display of clips in the Timeline:

 – Timeline View Options: The left button lets you display or hide the video tracks 
in the current timeline, for use as a reference while you work. The right button lets 
you set the playhead to be fixed, so that during playback the tracks scroll past the 
playhead as it remains in place, which is useful when working with the Fairlight 
control surface.

 – Scroller: Three buttons let you turn on one video and two audio scrollers, which 
act as scroll bars and zoomed-in visual references for the video and audio media 
immediately surrounding the playhead.
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 – Audio View Options: The left button lets you toggle full waveforms on and off, 
optionally hiding the divider bar that keeps the waveform separate from the file 
name area of each audio clip, so the waveform occupies the full space of each 
audio bar in the Timeline. The right button lets you toggle waveform outlines on 
and off, drawing a dark border around the edges of each waveform to make them 
easier to see.

 – Zoom Presets: These buttons let you choose from one of 7 zoom levels.

Selecting the Audio Timeline View options

 � Zoom Height slider: Lets you change the height of all tracks and clips in the Timeline 
at once. You can also zoom the height of timeline tracks by pressing the Command key 
while using the scroll control of your pointer, if it has such a control. The scroll wheel of 
a mouse is most common.

 � Zoom Width slider: Lets you shrink or expand the width of the contents of the Timeline. 
You can also control the width of the contents of the Timeline using the scroll control of 
your pointer, if it has such a control. The scroll wheel of a mouse is most common.

Customizing Clip Display in the Timeline
Choose Fairlight > View Clip Info Display to open a dialog with which you can customize what 
information is shown at the bottom of each clip in the Timeline. This dialog has options for 
viewing the clip name versus the display name, and for choosing from among a variety of 
metadata that you might want available as you work.

Selecting the audio clip view options

Chapter – 149 Using the Fairlight Page 3126



Customizing the Timeline’s Display
There are a variety of ways you can customize the Timeline to better see what you’re 
working on.

Fixed Playhead Mode
Turning on the Fixed Playhead mode in the Timeline View Options drop-down menu, or 
choosing View > Show Fixed Playhead, puts the Fairlight timeline into an audio-centric mode 
where the playhead remains fixed in place, and the Timeline scrolls underneath it as you use 
the transport controls or JKL to play, shuttle, or scrub forward or back.

Visible Video Tracks
A checkbox in the Timeline View Options drop-down menu of the toolbar lets you display small 
versions of the video tracks in the Fairlight timeline, for reference. These video tracks are 
uneditable; they’re simply there so you can see which audio clips correspond to which video 
items, and so they can be used as snapping targets for positioning audio.

Showing video tracks on the Fairlight page

Video and Audio Scrollers
Checkboxes in the Timeline View Options let you optionally show one Video Scroller and up to 
two Audio Scrollers at the bottom of the Fairlight timeline. 

Video and Audio Scrollers at the bottom of the Fairlight timeline

At the default Low zoom level, the Video Scroller provides a scrollable frame-by-frame filmstrip 
view of the video of your program, where one frame of the scroller equals one frame of your 
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video. Each of the two Audio Scrollers, on the other hand, let you focus on a continuous 
waveform view of a particular audio track. You choose which track populates an Audio Scroller 
via a drop-down menu in the Timeline header. 

Audio Scrollers showing the drop-down 
menu that selects which track they display

What Are They Used For?
The Audio Scrollers always provide a zoomed-in view of specific audio tracks that you’re 
focused on, regardless of the zoom level of the Timeline tracks above. This means you can 
focus on subtle details of the audio of one or two tracks that you’re working on, while the rest of 
the Timeline shows you the overall stack of tracks with clips that are playing together at 
that moment.

Meanwhile, the Video Scroller always shows the exact frame of video that corresponds to the 
current moment in time, so it’s an aid to precision editing involving frame-specific adjustments.

Additionally, both the Filmstrip and Waveform viewers scroll continuously during playback, 
giving you a preview of what visual actions and audio cues are coming a few moments forward 
in time that you can refer to while performing automation or recording foley.

Repositioning the Scroller Playhead
While the scrollers are visible, the Scroller playhead can be dragged to the left or right in the 
Timeline to give you more or less preview room to the right.

Zooming the Video Scroller
Right clicking on the Video scroller lets you choose a Low, Medium, or High zoom level. At Low, 
you get a frame-by-frame view of the program that feels like scrolling a strip of film on a 
Steenbeck. At Medium and High, you get a progressively abbreviated film strip that lets you 
zoom more quickly.

Scrolling the Fairlight Timeline Using the Scroller Tracks
Dragging the scroller tracks to the left or right smoothly scrubs through the Timeline in greater 
detail, regardless of the zoom level of the Timeline tracks above.
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Mixer
The Audio Mixer provides a set of graphical controls you can use to assign track channels to 
output channels, adjust EQ and Dynamics, set levels and record automation, pan stereo and 
surround audio, and mute and solo tracks.

The Audio Mixer exposes two sets of channel strips with controls that correspond to the tracks 
in the Timeline. The leftmost set of channel strips expose one set of controls for each track in 
the Timeline, while the rightmost set of channel strips expose another set of controls for each 
Main and Sub (submix) you’ve created to bus the mixed audio tracks to whatever set of output 
tracks you want to expose.

The Audio Mixer, with channel strips 
corresponding to the tracks in the Timeline

 � Track color: Each track can be differently color-coded, to help you keep organized.

 � Track number: The number of the Timeline track corresponding to each channel strip 
appears here.

 � Input: A drop-down menu that lets you patch inputs, patch buses, and configure the 
input settings of audio signals routed through Blackmagic hardware interfaces.

 � Effects: VST and Audio Unit effects that you apply to tracks from the Effects Library 
appear here, with controls for enabling/disabling each effect, opening an effect’s 
custom controls, and deleting that effect.

 � Insert: Enables the routing of effects from Blackmagic audio interface hardware to 
outboard effects boxes and back again. This button can be toggled to enable/disable 
such routing.

 � EQ: Double-clicking exposes a four-band parametric equalizer with additional Hi and 
Lo Pass filters, that has both graphical and numeric controls for boosting or attenuating 
different ranges of frequencies of audio on each track. You can select from among 
four types of EQ filtering from the Equalizer Type drop-down menu, with options 
for Earth (the default), Air, Ice, and Fire. Each band has controls for the filter type 
(Bell, Lo-Shelf, Hi-Shelf, Notch), Frequency, Gain, and Q-factor (sharpness of the band), 
with the available controls for each band of EQ change depending on the filter type.
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The channel strip EQ window

 � Dynamics: Double-clicking exposes a set of dynamics controls with three sets of 
controls corresponding to an Expander or Gate, a Compressor, and a Limiter that can 
be used separately or in concert to manage the dynamics of the audio on that track.

The channel strip Dynamics control window

 � Aux: Lets you route that track’s channels through an Aux send bus. Each Aux bar 
corresponds to a specific Aux bus that you created. Double-clicking any of these bars 
opens up the Auxiliaries window, with which you can enable or disable auxiliaries, set 
each one to be routed Pre the channel strip or Post the channel strip (the default), and 
set the Send level and Pan value.

The Auxiliaries control window

Chapter – 149 Using the Fairlight Page 3130



Whatever level you set an Aux bus will be shown in the bar that represents that Aux bus 
in the Mixer’s channel strip.

The Auxiliaries levels shown in the 
channel strip of the Mixer

 � Pan: A pan control compatible with stereo and surround panning. You can drag within 
this control to adjust pan, or you can double-click to expose a pan window. What 
controls are available in the pan window depend on the mapping of the audio track, 
but both stereo and surround panning controls are available, with corresponding 
numeric controls.

The Pan control window

Option-double-clicking on the Pan control of the Mixer opens an alternate 3D Audio 
Pan window. Whereas the regular Pan window lets you do stereo and conventional 
5.1 and 7.1 surround panning, the 3D Audio Pan window lets you do the kind of spatial 
audio positioning enabled by advanced surround formats such as Auro 3D and NHK 
22.2 (more information about specific support for these and other formats will 
come later). 

The 3D Pan window
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 � Main: These buttons let you assign a track or Sub’s channels to one or more 
of the main buses.

 � Submix: These buttons let you assign that track’s channels to one or more submix 
buses.

 � Track name: This mirrors the track name found in the header controls of the Timeline. If 
you customize a track’s name in the Timeline, that name appears here.

 � dB: Shows you the volume, in decibels, that track is currently set to.

 � Arm, Solo, and Mute buttons: Identical to the controls found in the track header 
controls of each timeline audio track. Arm lets you enable a track to be recorded onto. 
Solo lets you mute all other tracks in order to play that track in isolation (along with any 
other Soloed tracks). Mute disables audio playback from that track.

 � Fader: Each track’s vertical faders let you adjust the volume of that track, and perform 
automation recording.

The Monitoring Panel
The Monitoring panel that runs along the top of the Fairlight page shows all of the audio meters 
corresponding to the tracks in the Timeline, as well as the Master Output meter, control room 
meters, and a video viewer.

The Monitoring panel

At left, a row of audio meters corresponds to the channel strips of the Mixer, one meter for 
every audio track in the Timeline. Each track displays the number of meters that corresponds to 
that track’s audio mapping, with mono tracks having a single audio meter, stereo tracks having 
two, 5.1 tracks having six, and so on. All of these track and bus meters (with the exception of the 
Loudness meters) display both peak and RMS (root mean square) levels against a dB scale.

To the right of the Track meters are the Bus meters, in which all Mains, Subs, and Aux buses 
appear, separated by type, and each displaying the number of meters that corresponds to that 
track’s audio mapping. This way you can see the sum of all tracks that have been routed to a 
particular bus.

The last set of meters, to the right of all others, are the Loudness meters, which consist of two 
sets of meters and a numerical readout. These meters let you keep track of the integrated 
loudness of the overall mix, which is the standard to which all contemporary mixing 
specifications refer when describing the deliverables you’re expected to provide to the client.

Viewer
A small viewer to the left of the Monitoring panel shows the frame of video at the position of the 
playhead. The only available control is a button in the lower right-hand corner that lets you 
expand the Viewer into its own floating window.
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The Monitoring panel

The Media Pool
In the Fairlight page, the Media Pool serves as the repository of all audio clips in your project, 
both clips that appear within the Timeline, and clips that you’ve added to your project but have 
not yet used. When you record audio into the Timeline, the resulting clips are stored in the 
Media Pool as well, for future use. The Media Pool is also mirrored on the Media and Edit pages, 
and contains all of the video clips and timelines within that project. 

The Bin list at the left shows a hierarchical list of bins used for organizing your media, which is 
also used to organize your timelines. By default, the Media Pool consists of a single bin, named 
“Master,” but you can add more bins as necessary to organize timelines and clips by right-
clicking anywhere in the empty area of the Media Pool and choosing Add Bin. You can rename 
any bin by double-clicking on its name and typing a new one, or by right-clicking a bin’s name 
and choosing Rename Bin. The Bin list can be hidden or shown via the button at the upper 
left-hand corner of the Fairlight page toolbar.

The Media Pool in Thumbnail mode showing audio clips
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The browser area to the right shows the contents of the currently selected bin in the bin list. 
Every clip you import, every timeline you create, and every AAF, XML, or EDL file you import 
appears here. You can create or import as many timelines as you need within a single project.

As elsewhere, the Media Pool can be displayed in either Icon or List view. In List view, you can 
sort the contents by any one of a subset of the total metadata that’s available in the Metadata 
Editor of the Media page. Of particular interest to audio editors are columns for Name, Reel 
Name, different timecode streams, Description, Comments, Keyword, Shot, Scene, Take, Angle, 
Circled, Start KeyKode, Flags, and Usage.

For more information on using the myriad features of the Media Pool, see Chapter 11, “Adding 
and Organizing Media with the Media Pool.” In the sections that follow, some key features of the 
Media Pool are summarized for your convenience.

Importing Media Into the Media Pool on the Fairlight Page
While adding clips to the Media Pool in the Media page provides the most organizational 
flexibility and features, if you find yourself in the Edit or Fairlight pages and you need to quickly 
import a few clips for immediate use, you can do so in a couple of different ways.

To add media by dragging one or more clips from the Finder to the Fairlight page Media 
Pool (macOS only):

1 Select one or more clips in the Finder.

2 Drag those clips into the Media Pool of DaVinci Resolve, or to a bin in the Bin list.

Those clips are added to the Media Pool of your project.

To use the Import Media command in the Fairlight page Media Pool:
1 With the Fairlight page open, right-click anywhere in the Media Pool, and choose 

Import Media.

2 Use the Import dialog to select one or more clips to import, and click Open.

Those clips are added to the Media Pool of your project.

For more information on importing media using the myriad features of the Media page, see 
Chapter 11, “Adding and Organizing Media with the Media Pool.”

Media Pool Preview Player
The Media Pool has a preview player at the top that provides a place to open selected source 
clips in the Media Pool, play them, add marks to log them, and set In and Out points in 
preparation for editing them into the Timeline via drag and drop. The Media Pool Preview Player 
effectively acts as a Source monitor for editing in the Fairlight page.
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The preview player in the Media Pool

 � Various viewing controls populate the title bar at the top. A drop-down menu at the 
upper left lets you choose a zoom level for the audio waveform that’s displayed. To 
the right of that, a Timecode window shows you the duration of the clip or the duration 
that’s marked with In and Out points. Next to the right, a real-time performance 
indicator shows you playback performance. In the center, the title of the currently 
selected clip is shown, with a drop-down menu to the right that shows you the most 
recent 10 clips you’ve browsed. To the far left, a Timecode field shows you the current 
position of the playhead (right-clicking this opens a contextual menu with options to 
change the timecode that’s displayed, and to copy and paste timecode).

 � The center of the Media Pool Preview Player shows you the waveforms in all channels 
of the currently selected clip, at whatever zoom level is currently selected.

 � Transport controls at the bottom consist of a jog bar for scrubbing, Stop, Play, and Loop 
buttons, and In and Out buttons.

Bins, Power Bins, and Smart Bins
There are actually three kinds of bins in the Media Pool, and each appears in its own section of 
the Bin list. The Power Bin and Smart Bin areas of the Bin list can be shown or hidden using 
commands in the View menu (View > Show Smart Bins, View > Show Power Bins). Here are the 
differences between the different kinds of bins:

 � Bins: Simple, manually populated bins. Drag and drop anything you like into a bin, 
and that’s where it lives, until you decide to move it to another bin. Bins may be 
hierarchically organized, so you can create a Russian dolls nest of bins if you like. 
Creating new bins is as easy as right-clicking within the bin list and choosing Add Bin 
from the contextual menu.

 � Power Bins: Hidden by default. These are also manually populated bins, but these 
bins are shared among all of the projects in your current database, making them ideal 
for shared title generators, graphics movies and stills, sound effects library files, music 
files, and other media that you want to be able to quickly and easily access from any 
project. To create a new Power Bin, show the Power Bins area of the Bin list, then right-
click within it and choose Add Bin.
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 � Smart Bins: These are procedurally populated bins, meaning that custom rules 
employing metadata are used to dynamically filter the contents of the Media Pool 
whenever you select a Smart Bin. This makes Smart Bins fast ways of organizing the 
contents of projects for which you (or an assistant) has taken the time to add metadata 
to your clips using the Metadata Editor, adding Scene, Shot, and Take information, 
keywords, comments and description text, and myriad other pieces of information to 
make it faster to find what you’re looking for when you need it. To create a new Smart 
Bin, show the Smart Bin area of the Bin list (if necessary), then right-click within it and 
choose Add Smart Bin. A dialog appears in which you can edit the name of that bin and 
the rules it uses to filter clips, and click Create Smart Bin.

Showing Bins in Separate Windows
If you right-click a bin in the Bin list, you can choose “Open As New Window” to open that bin 
into its own window. Each window is its own Media Pool, complete with its own Bin list, Power 
Bins and Smart Bins lists, and display controls. 

This is most useful when you have two displays connected to your workstation, as you can drag 
these separate bins to the second display while DaVinci Resolve is in single screen mode. If you 
hide the Bin list, not only do you get more room for clips, but you also prevent accidentally 
switching bins if you really want to only view a particular bin’s contents in that window. You can 
have as many additional Bin windows open as you care to, in addition to the main Media Pool 
that’s docked in the primary window interface.

Filtering Bins Using Color Tags
If you’re working on a project that has a lot of bins, you can apply color tags to identify particular 
bins with one of eight colors. Tagging bins is as easy as right-clicking any bin and choosing the 
color you want from the Color Tag submenu.

For example, you can identify the bins that have clips you’re using most frequently with a red 
tag. A bin’s color tag then appears as a colored background behind that bin’s name.

Using color tags to identify bins

Once you’ve tagged one or more Media Pool bins, you can use the Color Tag Filter drop-down 
menu (the drop-down control to the right of the Bin List button) to filter out all but a single 
color of bin.
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Using Color Tag filtering to isolate the red bins

To go back to seeing all available bins, choose Show All from the Color Tag Filter drop-down.

Sorting the Bin List
The Bin list (and Smart Bin list) of the Media Pool can be sorted by bin Name, Date Created, or 
Date Modified, in either ascending or descending order. Simply right-click anywhere within the 
Bin list and choose the options you want from the Sort by submenu of the contextual menu.

You can also choose User Sort from the same contextual menu, which lets you manually drag all 
bins in the Bin list to be in whatever order you like. As you drag bins in this mode, an orange line 
indicates the new position that bin will occupy when dropped.

Dragging a bin to a new position 
in the Bin list in User Sort mode

If you use User Sort in the Bin list to rearrange your bins manually, you can switch back and 
forth between any of the other sorting methods (Name, Date Created, Date Modified) and 
User Sort and your manual User Sort order will be remembered, making it easy to use whatever 
method of bin sorting is most useful at the time, without losing your customized 
bin organization.

Filtering Clips With Audio in the Fairlight Page
The Media Pool in the Fairlight page has one additional feature: the ability to filter out audio-
only clips, or clips with audio, in the currently selected bin. This makes it easy for you to find 
audio clips that you’re looking for, which are hidden along with lots of video clips in the same 
bin. To use this feature, click the Option menu of the Media Pool and choose Show All Clips, 
Show Audio Only Clips, or Show Clips With Audio. 
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The Media Pool filter options in the option menu

Searching for Content in the Media Pool
An optional Search field can be opened at the top of the Media Pool that lets you quickly find 
clips by name, partial name, or any of a wide variety of Media Pool metadata. 

To search for a clip by name:
1 Select which bin or bins you want to search.

2 Click the magnifying glass button at the upper right-hand corner of the Media Pool.

3 Choose the particular column of information you want to search (or All Fields to search 
all columns) using the Filter by pop-up menu. Only selected bins will be searched.

4 Type your search string into the Search field that appears. A few letters should be 
enough to isolate only those clips that have that character string within their name. 
To show all clips again, click the cancel button at the right of the search field.

TIP: Smart Bins are essentially multi-criteria search operations that scope the entire 
project at once and are saved for future use.

Taking Advantage of the Media Pool’s Usage Column
In List view, the Usage column does not automatically update to show how many times a 
particular clip has been used. However, you can manually update this metadata by right-clicking 
within the Media Pool and choosing Update Usage Data from the contextual menu that 
appears. Afterwards, each clip will display how many times it’s been used in this column. Clips 
that have not been used yet display an x.
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Effects Library
The Effects Library on the Fairlight page displays both the built-in FairlightFX audio plug-ins that 
accompany DaVinci Resolve on macOS, Windows, and Linux, as well as whatever Audio FX are 
available on your workstation. 

 � FairlightFX are built-in audio processing effects that are fully cross-platform on all 
platforms DaVinci Resolve supports. 

 � On macOS and Windows, DaVinci Resolve supports the use of third-party VST audio 
plug-ins. 

 � On macOS, DaVinci Resolve supports Audio Unit (AU) audio plug-ins. 

Once you install third-party effects on your workstation, they appear in this panel of the Effects 
Library alongside the FairlightFX that are always available. Audio plug-ins let you apply effects 
to audio clips or entire tracks worth of audio, to add creative qualities such as echo or reverb, or 
to take care of mastering issues using noise reduction, compression, or EQ.

The Effects Library

Similar to the Media Pool, the Effects Library’s Bin list can be opened or closed using a button 
at the top left.

Effects Library Favorites
You can click on the far right of any transition, title, or generator to flag that effect with a star as 
a favorite effect. When you do so, the favorited effects appear in a separate Favorites area at 
the bottom of the Effects Library Bin list.

Stars indicate a flagged favorite effect, all favorites are currently filtered
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ADR
The Fairlight page of DaVinci Resolve has a sophisticated interface for doing ADR, or 
automated dialog replacement, in a structured and straightforward manner. Simple yet powerful 
cue list management, industry-standard audio beeps and visual cues, and sophisticated take 
management with star ratings and layered take organization help you manage the resulting 
recordings to use the best parts of each take in your program.

When open, the ADR interface consists of three panels to the left of the Timeline: a Record 
panel, a List panel, and a Setup panel. The controls of these panels are described in the order 
in which they’re used.

The Setup Panel
As its name implies, the Setup panel is where you configure your ADR session. It presents the 
controls letting you set up which audio input you want to use and what tracks to listen and 
record to, as well as preferences governing what the actors will see on the display you output 
video to, to help them keep their performance in sync.

The Setup panel of the ADR interface

The List Panel
This is where you create a list of cues you need to re-record, either from within the Fairlight 
page, or imported from a .csv file that someone provides you. It presents controls for adding, 
editing, importing, and exporting cues that you want to record.
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The List panel of the ADR interface

The Record Panel
This is where you actually run the ADR recording session you’ve set up, using the dialog cues 
you’ve put into the Cue list. It presents controls for displaying and selecting which cues to 
record, previewing and initiating recording, and adding metadata to rate the different takes 
you’ve recorded and to keep track of which cues have been completed.

The Record panel of the ADR Interface

For more information on using the VO panel, see Chapter 153, “ADR (Automated Dialog 
Replacement).”
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Sound Library Browser
A Sound Library panel is available from the Interface toolbar for browsing sound effects libraries 
that you have available to you, on your system or on a SAN you’re connected to. It includes the 
capability of scanning specified file paths to catalog available sound files and their metadata, 
storing this data within the currently selected project database (or another database that you 
select) to use when searching for the perfect sound effect within your library. Once you’ve 
cataloged your sound effects collection, it’s easy to search for sounds, preview what’s been 
found in the list, and edit the one you like best into the Timeline.

The Sound Library panel

TIP: You can download the Fairlight sound library, a royalty-free collection of over 500 
professionally recorded foley sounds that you can use in your own projects, from 
https://www.blackmagicdesign.com/support/family/davinci-resolve-and-fusion. The 
Fairlight sound library features everything from atmospheric ambient sounds to foley 
sounds such as foot steps, explosions, hits, effects, and more. This free sound library is 
designed to work with the Fairlight foley sampler, which lets you use a MIDI keyboard 
to trigger sounds so they can be recorded at precisely the right time in your program.
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Library Controls
Clicking the Library button (to the right of the Search field) reveals a menu that lets you choose 
which database to use for searching (and cataloging) sound effects collections. Each 
PostgreSQL database can have a different catalog.

Choosing a library to search

NOTE: The Sound Library is now capable of using the Mapped Mount option in the 
Media Storage panel of the Preferences, in order to access sound effects located on 
remote volumes using other operating systems.

To catalog all audio files within a given file path for searching using the Sound Library:

1 Using the Project Manager, create an empty PostGres database in which to store the 
sound effects catalog.

2 Open a project, open the Edit or Fairlight pages, and open the Sound Library.

3 (Optional) Click the Library button (to the right of the Search field), and select the 
PostgreSQL-based project database you created to save the resulting metadata 
analysis to, using the Library drop-down menu that appears. The current database is 
selected by default. If you’re working within a disk database instead, the top compatible 
PostgreSQL database in the list will be the default.

4 Do one of the following:

a.  If you’ve not yet connected a library of sound effects, an Add Library button 
appears in the center of the Sound Library. Click this button, and from the file dialog 
that appears, select the top-most directory of a file path that contains sound effects; 
if you’ve selected a directory with subdirectories inside, each subdirectory will be 
examined for content.

b.  If you’re adding more sound effects to an existing library, then click the Option 
menu and choose Add Library. From the file dialog that appears, select the top-
most directory of a file path that contains sound effects; if you’ve selected a 
directory with subdirectories inside, each subdirectory will be examined for content.

5 Click Open.

A progress bar will show you how long the operation will take. When you’re finished, a dialog 
will appear letting you know how many clips were added to the current library.

Display Controls and the Search Field
The Sound Library title bar has controls for sorting the sound effects list, showing it in List or 
Icon view, and an Option menu with various other settings and commands.

Display controls let you choose how the 
contents of the Sound Effects list are viewed
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Underneath, a text field lets you enter search terms, while a drop-down menu to the right lets 
you choose whether to search the current database for sound effects by name, description 
metadata, or all.

The Search field and Filter By menu

To search for a specific sound effect and edit it into the Timeline:
 � Type a search term into the Search field. The case of search terms is ignored, except 

for boolean operators.

To help you to eliminate false positives, the search field supports different kinds of searches, 
such as literal searches, and/or/not boolean searches, wildcard searches, and ranges of 
characters. 

NOTE: If you want to perform boolean searches, the boolean operators must be typed 
in all upper caps, such as AND, OR, and NOT. In lower caps, and, or, and not will be 
treated as search terms.

Or/And/Not Searches
Simply typing words separated by a space is treated as a series of OR searches for each word 
independently of one another, either literally or as part of another word. For example, if you 
type either of the following:

car door  
car OR door

both yield the same results. Every sound effect in your library containing either the 
letters “car” or “door” (or both) will appear, whether these letters appear independently, 
or within other words. Results will include files such as “CarExDoorClose,” 
“Doormouse_Squeak,” “Carburetor dropped on cement,” and “Carpet Shake.”

Using AND (it must be upper caps) lets you specify multiple criteria for a search, when 
each file that’s returned should contain every word you type somewhere within, in any 
order. For example, if you type:

car AND door

every sound effect in your library containing both the strings “car” and “door” will 
appear, even if these words appear either singly, in combination, or within other words, 
such as “NewCarDoorSlam” and “Carpet_Footsteps_Indoors,” and 
“GarageDoorHitsCar.”

Using NOT lets you omit sound effects that have a particular word. For example, 
if you type:

car NOT door

only sound effects with “car” will appear, and all sound effects with “door” will 
be omitted.
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Literal Searches
Using quotations specifies a literal search for only the specified term, separated from other text 
by a space. For example, if you type:

“cat”

every sound effect in your library with the standalone word “cat” appears. Sound 
effects with “cats” and “caterpillar” will be omitted. Results will include “Space cat 
drone” or “Cat meowing.”

Wildcard and Range Searches
The * (asterisk) specifies a wildcard search of any number of characters. Adding an * between 
two search terms identifies any sound effect with the two search terms connected by any 
number or combination of characters with no spaces (even no characters). For example, 
if you type:

close*door

results include “Door-Wood Cheap-Wooden-Closet-Door-Kick-In-Flimsy-Rattle,” 
“ElevatorCabinCloseDoor,” and “LatchSwingCloseSqueakDoorSecur.” If you 
instead type:

door*close

results include “DoorHvyMetalCloseSlam,” “DoorLidWoodenChestCloseAntique,” and 
“ElevatorDoorCloseSlam.” If instead you type:

c*r

results include “lectrohummin,” “KiaShumaEXTBootCloseTrunkaka,” and “Ambience 
with Piana, Louder.”

The ? (question mark) specifies wildcard search specifying only a single character. The 
number of question marks you type specifies how many characters of wildcard 
searching you want to perform. For example, if you type:

door?close

you may get no results at all, unless you have a sound effect named “door-close.” 
However, if you type:

door????close

results include “DoorWoodClose” since the word wood is four letters, matching the 
number of wildcard letters you’ve specified.

Preview and Audition Controls
Selecting an item in the Sound Effect list loads it into the preview player where you can play it 
or audition it in your timeline using the controls underneath the search field.

 � Clip name: The name of the current clip you’ve selected.

 � Next/Previous buttons: Two buttons let you select the next or previous sound effect 
clip in the Sound Effect list.

 � Zoom control: Controls the zoom level of the Playthrough waveform.

 � Duration field: Shows the duration of the current clip, or of the section of the clip 
marked with In and Out points.

 � Playhead timecode field: The timecode of the playhead’s position.
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 � Navigation waveform: The waveform of the entire sound effect appears here, making it 
easy to jump to different parts of the selected clip. All channels are summed together in 
this display.

 � Playthrough waveform: A zoomed-in section of the selected clip that lets you see 
more waveform detail for setting In, Out, and Sync points.

 � Jog bar: Lets you scrub around the clip.

 � Transport controls: Stop, play, and Loop buttons let you control playback, although you 
can also use the space bar and JKL controls. Right-click the Stop button to switch it into 
“Stop and Go to Last Position” mode.

 � Marking controls: The Sync Point button lets you mark which frame of the sound effect 
you want to use to sync to a frame of the Timeline when you audition. In and Out points 
let you mark how much of the sound effect clip you want to edit into the Timeline.

 � Audition controls: The Audition button puts you into Audition mode where the currently 
selected sound effect clip appears at the position of the playhead in the currently 
selected Timeline track. Cancel and Confirm buttons let you choose whether you want 
to remove the clip from the Timeline and try again with another clip, or leave the sound 
effect clip in.

Auditioning clips you’ve found in the Timeline:
1 Select a sound effect clip you’ve found from the list that you want to audition in 

the Timeline.

2 In the Sound Library, use the scrubber bar to move the playhead to the part of the 
sound effect that you want to sync to, and click the Sync Point button to place a sync 
mark on that clip. For example, if you’re syncing the sound effect of a car door closing, 
you might sync the first frame of the door fully closed to the peak of the “slam” sound 
effect, rather than any door squeaking earlier in the sound effect.

3 Set In and Out points to define the range of the sound effect you want to 
potentially use.

4 Select a track you want to preview the sound effect in by clicking its track header or 
Mixer channel strip.

5 Position the playhead at the place in the Timeline you want to align the sync mark you 
set in Step 2.

6 Click the Audition button in the Sound Library. That clip now appears, temporarily, in the 
Timeline, and you can play through that section of the Timeline to see how you like the 
sound effect in context with the rest of the mix.

7 If you like the sound effect, click Confirm to keep it in the Timeline. If you don’t, click 
Cancel, and it will disappear from the Timeline.

Sound Effect List
All sound effect clips that match the current search criteria appear in this scrollable list. Double-
clicking anywhere on an item of this list plays that sound effect in its entirety.

 � File Name: The name of that sound effect file in the storage system.

 � Duration: The duration of that sound effect file.

 � Channel Mapping: The number of channels in that sound effect file.
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 � Star rating: A clickable control you can use to rate sound effects within 
DaVinci Resolve. Star rating information is not saved outside of DaVinci Resolve.

 � Embedded Metadata: Any metadata that’s embedded within the files of professionally 
created sound effect libraries appears here.

 � Waveform: The overall waveform of the entire sound effect library is stretched or 
compressed within the available width of the Sound Library, regardless of the actual 
duration of each clip.

Index
The Index provides a handy interface for listing all of the clips in the current edit, all the tracks in 
the current Timeline, and all the markers in the current Timeline. Using these lists, multiple items 
can be selected, tracks can be managed, and marker notes can be consulted with ease. Each 
of these three categories of information is displayed in separate panels:

Edit Index
Displays the Edit Index as seen in the Edit page. Each audio clip in the currently open Timeline 
corresponds to a row in the Edit Index, with columns for video track, Source In and Out, Record 
In and Out, Name, and other descriptive metadata. All selected clips (including clips that are 
automatically selected because they intersect the playhead) are selected in the Edit Index. The 
Option menu lets you filter the Edit Index by various criteria, for example showing only clips with 
a particular color of flag, marker, or color, only clips with speed effects, only clips with audio 
filters, or compound audio clips.

The Tracks panel shows a row of information for each of the tracks in the Timeline

Tracks
Every track in the currently open Timeline corresponds to a row of controls and information in 
this panel. From left to right, each track has a color control, a visibility control, a number, a name, 
track controls, a format, and a numbered VCA group that it belongs to. These controls can be 
used to hide or show tracks, color code them, rename them, turn track controls on singly or by 
dragging over several at a time, change their format, and rearrange them (by dragging one or 
more rows up and down this list).
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The Tracks panel shows a row of information for 
each of the tracks in the Timeline

If you have MPEG-H enabled for immersive audio authoring, additional columns appear 
in this panel.

When MPEG-H is enabled in the Project Settings, the Tracks panel shows additional columns of 
information for defining each track in the Timeline

These columns include:

 � Track Type: Allows definition of either a static component or a dynamic object. When 
dynamic is selected, the dynamic track-level pan automation from that track is also 
exported. Only a track can be set to dynamic. 

 � Kind: A content type label, such as mixed content, music, dialogue, effect, etc. When 
Kind is defined for a bus (rather than the default state of Undefined), that bus is 
automatically bounced during the export process. 

 � Language: The content-specific language for that track. 

 � SW Group: Allows the track to be assigned to a user-defined switch group. A switch 
group allows the track to be grouped together with other tracks in the final content, 
forming an selectable item when rendered. For eample, a switch group of dialogue, 
containing an English and a Chinese language track, could allow the user to select 
between these languages on playback. In order to define a switch group, click that 
track’s cell in the SW Group column, and choose “Sw Groups…” to open the Switch 
Groups Manager window, which lets you create new switch groups.

Chapter – 149 Using the Fairlight Page 3148



The Switch Group Manager

Once one or more groups has been created, they’re available for selection in the 
drop-down menu of any cell in the SW Groups column. This lets you quickly make a 
variety of custom assignments.

The drop-down in the SW Group column

 �  • Presets: Allows a track to be assigned to a user-defined preset. For example, 
a Bed Mix and Language switch group could form one preset, while the same tracks 
and a spoken subtitle could form another. In order to define a Preset, click that track’s 
cell in the Presets column, and choose “Presets…” to open the Preset Manager window, 
which lets you create new Presets. 

The Preset Group Manager

Once one or more presets has been created, they’re available for enabling in the 
drop-down menu of any cell in the SW Groups column. Any track can be added to 
multiple presets, so the Presets drop-down contains one checkbox per preset so you 
can make multiple assignments.

Chapter – 149 Using the Fairlight Page 3149



The drop-down in the Presets column

Once configured, the metadata from these presets form how the content is exported in 
the final deliverable, so there will be a set of presets that contain all configured 
components and switch groups.

Markers:
The markers panel can be displayed in either thumbnail or list mode. In thumbnails mode, each 
marker in your timeline corresponds to a thumbnail displaying the timecode of its location 
underneath it, and the color of the marker to the left of the timecode location. In list view, each 
marker displays a row with the following information; marker number, frame (showing a 
thumbnail), marker name, start timecode, end timecode, duration, marker color, and notes.

The Markers panel shows a row of information for 
each of the markers in the Timeline

Inspector
When you add an audio effect to a clip or a track, those effects appear in the Inspector when 
that clip or track is selected.
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Metadata Editor
Lets you view and edit the metadata of selected clips in the Fairlight page.

Test Tone Settings for Generating 
Tone, Noise, and Beeps
The Fairlight page has a general purpose oscillator, the settings of which you can customize by 
choosing Fairlight > Test Tone Settings. This opens the Test Tone Settings window that you can 
configure to generate tones, noise, or beeps using five sets of controls:

 � Enable/Disable Test Tones toggle: Lets you turn the Oscillator on or off system-wide.

 � Frequency dial: Sets a custom frequency of oscillating tone, from 20 Hz to 10kHz. 
Defaults to 1kHz.

 � Frequency buttons: Lets you quickly select 100, 440, 1K, or 2K preset tones, 
or a continuous rising sweep of frequencies from 1 Hz to 15kHz.

 � Level dial: Sets the output level for the tone or noise, from –50dB to +10dB. 
Defaults to –15 dB.

 � Frequency presets: Four buttons let you choose from four commonly used tones: 100 
Hz, 440 Hz, 1 kHz, and 2 kHz.

 � Noise type buttons: Two buttons let you choose from White noise or Pink noise.

You can set up the Oscillator to output whatever kind of tone or noise you require, and then 
patch it to tracks for recording tones, or patch it to audio outputs for calibrating speakers. If you 
use the beep options of the ADR panel, those are performed via the Oscillator.

To play the Test Tone out of your speakers:
1 Choose Fairlight > Patch Input/Output to open the Patch Input/Output window.

2 Choose System Generator from the Source drop-down menu, and choose 
Audio Outputs from the Destination drop-down menu.

3 At the left, click the button of what you want to output, Osc (Oscillator) or Noise.

4 At the right, click the connected audio outputs that you want to patch to, and click 
Patch. Tone or noise should immediately start playing out of your configured speakers.

5 To stop, select one of the patched buttons, and click Un-Patch.
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To record a tone or noise from the Oscillator to an audio track:
1 Choose Fairlight > Patch Input/Output to open the Patch Input/Output window.

2 Choose System Generator from the Source drop-down menu, and choose Track Input 
from the Destination drop-down menu.

3 At the left, click the button of what you want to output, Osc (Oscillator) or Noise.

4 At the right, click the connected audio outputs that you want to patch to, and click 
Patch. Close the Patch Input/Output window.

5 Click the Arm Record (R) button in the track header of the track you patched the 
Oscillator to. If your Main is properly patched to your outputs, you should hear the tone 
or noise, and that track’s audio meter should immediately rise to the level being output 
by the Oscillator.

6 Click the Record button of the transport controls to initiate recording of that tone to 
the patched track. Click the Stop button or press the Spacebar to halt recording when 
you’re done.

Pro Tools AAF Import
As of DaVinci Resolve 16, you can import AAF projects and media from Pro Tools, enabling you 
to move an audio project from a Pro Tools workstation to a Fairlight workstation. AAF import 
supports the import of embedded audio and track automation. To do so choose File > Import 
Timeline > Import AAF/EDL/XML.

Dual Monitor Layout
The Audio page has a dual monitor layout that provides maximum space for the mixer and 
audio meters on one screen and a full-screen timeline on the other.

To enter dual screen mode:
Choose Workspace > Dual Screen > On.
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The Fairlight page in dual screen mode

To switch which UI elements appear on which monitors:
Choose Workspace > Primary Display > (Monitor Name), which reverses the 
contents of both monitors in dual screen mode.

Customizing the Fairlight Page
The default layout is quite efficient for a number of tasks on most displays. You can always 
return to the default layout by choosing Workspace > Reset UI Layout. However, the Fairlight 
page can be customized to create more room for specific areas of the interface to 
accommodate different tasks.

To resize any area of the Fairlight page:
Drag the vertical or horizontal border between any two panels to enlarge one and 
shrink the other.

To resize the height of individual audio tracks:
Move the pointer to the bottom border of any audio track header, and when it becomes 
a resize cursor, drag that border up or down to resize that track. Each track can have an 
independent size when you do this.

To resize any column of the Index: 
Move your pointer over the divider between any two columns and drag when the 
horizontal resize cursor appears.

To rearrange Index columns: 
Drag the header of any column to the left and right to move that column.

Chapter – 149 Using the Fairlight Page 3153



Undo and Redo in DaVinci Resolve
No matter where you are in DaVinci Resolve, Undo and Redo commands let you back out of 
steps you’ve taken or commands you’ve executed, and reapply them if you change your mind. 
DaVinci Resolve is capable of undoing the entire history of things you’ve done since creating or 
opening a particular project. When you close a project, its entire undo history is purged. The 
next time you begin work on a project, its undo history starts anew.

Because DaVinci Resolve integrates so much functionality in one application, there are three 
separate sets of undo “stacks” to help you manage your work.

 � The Media, Edit and Fairlight pages share the same multiple-undo stack, which lets you 
backtrack out of changes made in the Media Pool, the Timeline, the Metadata Editor, 
and the Viewers.

 � Each clip in the Fusion page has its own undo stack so that you can undo changes you 
make to the composition of each clip, independently.

 � Each clip in the Color page has its own undo stack so that you can undo changes you 
make to grades in each clip, independently.

In all cases, there is no practical limit to the number of steps that are undoable (although there 
may be a limit to what you can remember). To take advantage of this, there are three ways you 
can undo work to go to a previous state of your project, no matter what page you’re in.

To simply undo or redo changes you’ve made one at a time:
 � Choose Edit > Undo (Command-Z) to undo the previous change.

 � Choose Edit > Redo (Shift-Command-Z) to redo to the next change.

 � On the DaVinci control panel, press the UNDO and REDO buttons on the T-bar panel.

TIP: If you have the DaVinci control panel, there is one other control that lets you 
control the undo stack more directly when using the trackballs, rings, and pots. 
Pressing RESTORE POINT manually adds a memory of the current state of the grade to 
the undo stack. Since discrete undo states are difficult to predict when you’re making 
ongoing adjustments with the trackball and ring controls, pressing RESTORE POINT 
lets you set predictable states of the grade that you can fall back on.

You can also undo several steps at a time using the History submenu and window. 
At the time of this writing, this only works for multiple undo steps in the Media, Cut, Edit, 
and Fairlight pages.

To undo and redo using the History submenu:
1 Open the Edit > History submenu, which shows (up to) the last twenty things 

you’ve done.

2 Choose an item on the list to undo back to that point. The most recent thing you’ve 
done appears at the top of this list, and the change you’ve just made appears with a 
check next to it. Steps that have been undone but that can still be redone remain in this 
menu, so you can see what’s possible. However, if you’ve undone several changes at 
once and then you make a new change, you cannot undo any more and those steps 
disappear from the menu.
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The History submenu, which lets you undo several steps at once

Once you’ve selected a step to undo to, the menu closes and the project updates to show you 
its current state.

To undo and redo using the Undo window:
1 Choose Edit > History > Open History Window.

2 When the History dialog appears, click an item on the list to undo back to that point. 
Unlike the menu, in this window the most recent thing you’ve done appears at the 
bottom of this list. Selecting a change here grays out changes that can still be redone, 
as the project updates to show you its current state.

 The Undo history window that lets you browse 
the entire available undo stack of the current page

3 When you’re done, close the History window.
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Chapter 150

Setting Up 
Tracks, Buses, 
and Patching

One of the first things you need to do when you’re setting up a new 
project for mixing in the Fairlight page is to define all of the audio tracks 
and buses you’re going to need, including submixes and mains that route 
and combine the audio being output. This chapter covers how to create 
audio tracks, and how to use buses to manage your mixes in the most 
efficient possible way.
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Audio Tracks
Each audio track in a Resolve timeline corresponds to a single channel strip on the Mixer’s left 
side. Depending on how an audio track has been configured, each audio track is assigned a 
specific audio format such as mono, stereo, LCRS, 5.1 surround, or 7.1 surround, so that multiple 
audio channels within the clips on that track can be correctly routed to the proper audio output 
for monitoring and rendering via the lanes that can be seen within each track on the 
Fairlight timeline.

Audio tracks in DaVinci Resolve have been designed to contain multiple channels of clip audio 
within a single track, but how those individual audio channels are displayed depends on the 
page. The Edit page hides these individual audio channels, displaying only a single clip in the 
timeline to make it easier to edit multi-channel sources without needing to manage a huge 
number of tracks. However, the Fairlight page has a unique track and lane system for 
displaying audio. 

The Fairlight page displays the same number of tracks as the Edit page, but each track on the 
Fairlight page is divided into lanes, which expose each individual channel of clip audio for 
editing and mixing.

(Top) Stereo audio in the Edit page represented by a single track; (Bottom) The same stereo audio in the Fairlight 
page shows the two lanes that correspond to each of the stereo audio tracks
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Now that you understand how tracks work on the Fairlight page, the next important concept 
you need to understand in order to unlock the power of the Fairlight page is the audio bus, 
which lets you combine multiple audio tracks in different ways.

What Is a Bus?
In audio postproduction, a bus is essentially a destination channel to which you can route 
multiple audio feeds (typically the audio tracks of the Timeline) so they are mixed together into 
a single signal that can be controlled via a single channel strip. For example, by default a single 
bus called a Main (named Main 1) combines the levels of every clip edited onto every track of a 
timeline into the signal that’s output to your speakers.

Mains are one kind of bus, but there are other kinds of buses with which you can organize the 
output of tracks in a timeline. For example, if you have five audio tracks into which have been 
edited all of the dialog audio clips for a particular program, you can route the output of all five 
dialog tracks to a Submix bus, which combines them so that the combined levels from all dialog 
tracks can be adjusted (or mixed) using a single set of controls.

Ultimately, you’ll use multiple levels of buses to mix programs in an organized fashion. For 
example, individual tracks can be routed to Submix buses, as described above. Then, multiple 
Submixes can be routed to one or more Mains. For example, you could have four submix buses, 
one for German dialog, one for English dialog, one for Music, and one for Effects. You could 
route the German, Music, and Effects submix buses to Main 1 to output the German version of 
the program, and route the English, Music, and Effects submix buses to Main 2 to output the 
English language version of the program.

Audio tracks from the Timeline are routed to buses via each channel strip’s multiformat surround 
panner, so buses are configured to accommodate specific audio formats such as mono, stereo, 
LCRS, 5.1 surround, or 7.1 surround. 

Types of Buses
There are four types of buses in DaVinci Resolve.

Mains
Main buses are typically the primary output of a program; each new project you create starts 
out with a single Main called M1, to which all tracks are routed by default. You can add 
additional Mains, and you can use them however you like, as either full or partial mixes of the 
program you’re working on. Mains can be directly output in the deliver page.

Sub (Submix)
Sub buses are often the means by which multiple tracks of audio that belong to the same 
category (dialog, music, effects, ambience, and so on) are combined together so that 
everything in that category can be mixed as a single audio signal. Multiple Sub buses can be 
themselves routed to Main buses, or they can be directly output in the deliver page.

Aux (Auxillary)
Each channel strip includes the ability to expose up to 12 auxiliary bus sends, which are 
typically used to route audio to software or hardware effects of some kind. Typically, an audio 
signal is sent to the effect (or hardware) applied to that bus and then is routed back to the 
channel it came from. Auxiliary send signals can be connected either immediately before or 
after a channel strip’s fader, based on a Pre setting. Each auxiliary bus can also be configured 
to accommodate specific audio formats such as stereo, LCRS, 5.1 surround, or 7.1 surround.
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Multi Track
Multitrack buses provide bus paths for combining feeds that you want to re-record to disk, or 
route to other I/O.

Buses in Nested Timelines
When you nest a timeline inside of another timeline that has buses set up for mixing in the 
Fairlight page, all Sub and Aux routings work as intended within the nested timeline, which 
exposes all channels of Main 1 in the enclosing timeline. In this sense, the audio of the nested 
timeline can be considered to be a submix that outputs its resulting audio to the audio track it’s 
edited onto.

Exposing Bus Tracks in the Timeline
You can expose any bus, including Mains, Subs, and Aux buses, as a track in the Timeline. 
This makes it possible to view and edit automation that’s applied to parameters on that bus.

To show a bus in the Timeline:

1 Open the Automation controls by clicking the automation button on the Fairlight toolbar.

2 Open the Index, and click the eye button for the Main you want to see in the Timeline.

3 You can choose any automation curve you want to view by choosing it from the 
drop-down menu in the track header controls.

Controlling Signal Flow
The process of setting yourself up for editing and mixing in the Fairlight page involves: 

 – First, customizing the tracks of the timeline to be organized and 
configured as required.

 – Second, creating the buses you need in order to organize your signal flow.

 – Third, patching the tracks to Subs, and the Subs to Mains, in order to create the 
signal flow you need.

Managing Audio Tracks
When you’re getting ready to record or edit audio clips into the Fairlight Timeline, you need to 
make sure you’ve got enough tracks to do the job. The following procedures cover the different 
methods available for adding, removing, and rearranging tracks as you work. These commands 
are all available via the contextual menu that appears when you right-click anywhere in the 
Timeline header area (the header of the Timeline is the area to the left where each track’s 
various buttons and controls are located).
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Defining Timeline Audio Track Channels at Creation
If you decide to create a new audio track, you have to choose what kind of audio track it will be. 
Right-clicking in the bottom audio portion of the Timeline track header reveals a contextual 
sub-menu that lets you create different kinds of audio tracks.

 � Mono: Holds a single channel with only one lane.

 � Stereo: Holds stereo left and right channels, with two lanes.

 � 5.1: Holds the six channels corresponding to a 5.1 surround mix, for a total of six lanes. 
For broadcast, SMPTE specifies Left, Center, Right, Left Surround, Right Surround, and 
LFE. For cinema distribution these tracks are ordered Left, Right, Center, LFE, Surround 
Left, and Surround Right.

 � 7.1: Holds the eight channels corresponding to a 7.1 surround mix, for a total of eight 
lanes. For broadcast, SMPTE specifies Left, Center, Right, Left Surround, Right 
Surround, LFE, Back Surround Left, and Back Surround Right. For cinema distribution 
these tracks are ordered Left, Right, Center, LFE, Left Surround, Right Surround, Back 
Left Surround, and Back Right Surround.

 � Adaptive: Capable of holding up to 24 audio channels, which would display up 
to 24 lanes within the track. An adaptive audio track can hold clips with different 
combinations of channels, up to the maximum number of channels allowed within 
that track. The number of channels allowable on a particular Adaptive track is user-
definable (1–24) at the time that track is created. If you edit a clip with more channels 
into an Adaptive track that was created to hold fewer channels, the extra clip channels 
are muted.

Creating Tracks
There are two commands with which to create new audio tracks, and both are in the contextual 
menu found by right-clicking within any audio track’s header controls. Add Track adds a single 
audio track of the type you choose from a submenu. Add Tracks lets you insert as many tracks 
as you like, of a type and at a position you designate using the Add Tracks dialog.

Rearranging Tracks
You can rearrange tracks by right-clicking in a track’s header area and choosing either Move 
Track Up or Move Track Down in the contextual menu that appears.

Changing How Many Channels an Audio Track Has
If you had set up your timeline with one kind of audio track, but you discover you actually need 
a different kind, you can change any audio track’s type at any time. Just right-click anywhere in 
that audio track’s timeline header, and choose an option from the Change Track Type To 
submenu of the contextual menu.

Deleting Tracks
Right-click within a track’s Timeline header and choose Delete Track. If there are clips on a 
track you remove, they are also deleted from the Timeline, but preserved in the Media Pool.
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Linked Groups of Mono Tracks
Linked groups are an organizational construct that you can create using mono tracks (other 
kinds of tracks such as stereo, 5.1, 7.1, or Adaptive cannot be used in a Linked Group). Unlike a 
multi-channel track with lanes, a linked group of mono tracks functions as five independently 
editable tracks in the Timeline. However, each track is mapped just like an audio channel using 
one of the standard multi-channel mappings (stereo, 5.1, 7.1, Adaptive), and linked groups of 
mono tracks are mixed using only a single channel strip.

Linked groups are extremely useful when you’ve been given a set of six independent audio 
files that need to be assembled as a single surround mix, or when you have surround channels 
that need to be specifically re-edited on a channel by channel basis.

To create a Linked Group from individual mono tracks:
1 Create two or more Mono audio tracks that you want to group together. If you need 

to create a linked group with a specific channel mapping, such as 5.1, make sure you 
create enough tracks (in this case, 6).

2 Choose Fairlight > Link Group.

3 When the Link Group dialog appears, Mono audio tracks are represented by active 
buttons (all other channel mapped tracks are disabled, since they can’t be linked). Click 
to enable the button of every track you want to include in the group you’re about to 
create. Which mappings are available to use for creating your group depends on how 
many tracks you’ve selected.

Selecting six tracks to use for creating a link group

4 After you’ve selected all the tracks you need to, click one of the available “Link as” 
buttons below. In this example, six tracks have been selected, so you could click 5.1 
Film or 5.1.

When you select enough tracks, you can create 
groups linked as specific surround mappings

Afterwards, the tracks you selected should turn into a single block, showing they’ve 
been linked.

When you select enough tracks, you can create groups linked as specific surround mappings
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5 Close the Link Group window when you’re finished.

Once you’ve created a linked group, the mono tracks in the timeline that you linked 
appear with a bar to the left in the track header that spans every track that’s linked. 
If the tracks are tall enough, they’ll also be labeled to identify which track corresponds 
to which surround channel, L, R, C, Lfe, Ls, Rs, and so on. At this point, you can edit 
each channel of a surround mix into the appropriate track.

Tracks in a Linked Group are labeled to 
identify which track corresponds to which 
surround channel

If you’ve edited a multi-channel audio clip onto a multi-channel track, you can convert that track 
and its contents into a Linked Group of mono tracks, each of which contains a single clip for that 
track’s channel. This can be useful if you’ve been delivered a multi-channel surround audio clip 
with an incorrect track mapping. You can convert it into a Linked Group, at which point you can 
easily rearrange the channels.

To create a Linked Group from a single multi-channel timeline:
Right-click the track header of a multi-channel audio track, and choose Convert to 
Linked Group from the contextual menu. This automatically creates one new audio 
track for each channel, all of which are linked together. For example, converting a 5.1 
audio track results in six new tracks with six individual audio clips (one for each 
channel), all of which are linked together.

If necessary, you can also unlink a linked group to turn it back into independent mono tracks.

To unlink a Linked Group:
1 Choose Fairlight > Link Group.

2 When the Link Group dialog appears, select the Linked Group you want to unlink.

3 Click Unlink.

4 Close the Link Group window when you’re finished.
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Creating Buses
Choosing Fairlight > Bus Format opens the Bus Format window, which lets you create as many 
buses as you need (up to the limitations of your system) to organize the tracks and channels of 
your program.

The Bus Format window lets you add buses to the mixer

Four buttons at the top of the window let you create any type of bus Fairlight supports. Creating 
a new bus, whether it’s a Main, Sub, Aux, or Multi Track, adds the new bus to the list that 
appears below.

The Bus list lets you rename the bus, choose the format of each bus (a drop-down menu 
appears in the Format column of each entry of the list), and color-code each bus (a Color 
drop-down lets you choose that bus’s color). Simply click any item on the Bus list to select it, 
and choose different options from the Format and Color drop-down menus, or click on the User 
Name of any bus to select it, and type a custom name.

At the bottom of the list are two additional buttons that let you Duplicate or Remove selected 
Buses. When you’re done modifying the available buses, you can click OK to accept the change 
and close the Bus Format window, Cancel to close the window (although any buses you’ve 
made remain in place), or Bus Assign to open the Bus Assign window.

NOTE: Text at the upper left-hand corner of the window lets you know how many 
buses you’re using out of how many your workstation will support.

Chapter – 150 Setting Up Tracks, Buses, and Patching 3164



Assigning Buses
Once you’ve created one or more buses, you’ll want to assign different tracks to specific buses, 
and different Subs to specific Mains. This is accomplished in the Bus Assign window, which you 
can open by choosing Fairlight > Bus Assign, or by clicking the Bus Assign button in the Bus 
Format window.

The Bus Assign window lets you choose which tracks are connected to which 
buses, and which buses are connected to which mains

The top shows all of the available Main, Sub, and Multi Track buses, while the bottom shows all 
available tracks, Sub buses, and Aux buses. The Bus Assign window defaults to Icon view, in 
which each Bus and Track is shown as a button, but it can be switched to List view, in which the 
Available Tracks section is shown as a list.

Methods of making bus assignments:
 � To assign specific tracks to a bus: Click a button in the Buses section to select that 

bus, and then either click or drag a bounding box over all the available tracks that you 
want to assign to that bus. Once assigned, the Available Tracks buttons display which 
Bus they’ve been assigned to.

Assigning multiple tracks to a bus by dragging a bounding box

 � To assign every track, Sub, and Aux to a bus: Click a button in the Buses section to 
select that bus, and then click Assign All.

 � To clear all track assignments from a particular bus: Click a button in the Buses 
section to select that bus, and then click Unassign All.

When you’re done making bus assignments, click Save.
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Patching Signal Paths
While bus creation and assignment is a straightforward way of creating a cascade of routing 
from tracks to Subs to Mains, sometimes you need to create more specific signal paths. For 
example, if you need to record audio to a track, you need to patch the audio input you want to 
record from to the track you want to record to. This, and many other scenarios, are 
accomplished using the Patch Input/Output window.

Using the Patch Input/Output Window
Choosing Fairlight > Patch Input/Output opens the Patch Input/Output window, which can be 
displayed in either Icon or List view. This window is split into two halves, with the left half 
containing whichever Audio Source controls you choose, and the right half containing 
whichever Audio Destinations you choose. In the following screenshot, the Audio Inputs from a 
Scarlett2i2 USB audio interface are shown, while the available Track Inputs are shown to 
the right.

The Patch Input/Output Window showing Audio Inputs and Track Inputs

Creating a Patch
By default, the Patch Input/Output window shows the available Audio Inputs as the Source, and 
the Track Inputs as the destination. This makes it easy to patch whatever audio source (such as 
a microphone connected to a USB audio interface) to a specific audio track of the timeline to 
prepare for recording. Patching and unpatching a source to a destination is straightfoward.

To patch a source to a destination:
1 Choose a type of source from the Audio Source drop-down menu at the upper left-

hand side of the window.

2 Click the button or list item of the source you want to patch on the left side of the Patch 
Input/Output window.

3 Choose a destination from the Audio Destination drop-down menu at the upper right-
hand side of the window.
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4 Click the button or list item of the destination you want to patch on the right side.

A selected audio source and audio destination pair

5 Click the Patch button at the bottom right of the window. The source and destination 
will both display the connection they’re patched to.

To unpatch a source and destination pair:
1 Click a button or list item corresponding to a source or destination you want to unpatch.

2 Click Unpatch.

Choosing Audio Source and Destination Controls
The Audio Source and Destination drop-down menus let you choose different categories of 
source and destination controls to patch together.

The following Audio Source options are available:
 � Audio Inputs: The available physical audio inputs on your workstation, for example 

SX-36, MADI, or system audio. Useful when patching to record audio.

 � Track Repro: Short for Reproduction, this is the signal from the track playback, 
before any processing

 � Track Send: Track Insert send

 � Track Direct: Track Direct Out, can be pre or post the track fader, with an offset

 � MT-Bus Dir: Multitrack Bus Direct Out, can be pre or post the multitrack bus 
master fader, with an offset

 � MT-Bus Out: Multitrack Bus Out, always post the Multitrack bus master fader

 � Aux-Bus Send: Aux bus master insert send

 � Aux-Bus Dir: Aux Bus Direct Out, can be pre or post the Aux bus master fader, 
with an offset

 � Aux-Bus Out: Aux Bus Out, always post the Aux bus master fader

 � Sub-Bus Send: Sub bus master insert send

 � Sub-Bus Dir: Sub Bus Direct Out, can be pre or post the Sub bus master fader, 
with an offset

 � Sub-Bus Out: Sub Bus Out, always post the Sub bus master fader.

 � CR-Mon Dir: Monitor system Direct out. Post fold up/down matrix, pre the 
Monitor VolumeLevel/Dim/Mute

 � CR-Mon Out: Monitor system output. Post fold up/down matrix and 
Monitor VolumeLevel/Dim/Mute

 � Main Send: Main bus master insert send

Chapter – 150 Setting Up Tracks, Buses, and Patching 3167



 � Main Dir: Main Bus Direct Out, can be pre or post the Main bus master fader, 
with an offset

 � Main Out: Main Bus Out, always post the Main bus master fader

 � Osc: Oscillator outputs. Sine, Pink noise, White noise.

 � Solo Out: AFL and PFL Solo Bus Out, always post the respective bus master fader

The following Audio Destination options are available:
 � Track Input: Input to the Record and Thru path; simply put, the available audio tracks in 

the current timeline.

 � Track Return: Track insert return

 � Aux-Bus Return: Aux Bus master insert return

 � Sub-Bus Return: Sub Bus master insert return

 � Main Return: Main Bus master insert return

 � CR-Mon In: Input to the Monitor system’s fold up/down matrices

 � Talk Back: The Talkback system, showing Comm1 and Comm2

 � Audio Outputs: The available physical audio outputs on your workstation, for example 
SX-36, MADI, or system audio.

Using a Channel Strip’s Input Menu
The Input drop-down menu at the top of each track’s channel strip in the mixer provides some 
shortcuts for patching different inputs and buses to the tracks of your mix. Each option in this 
menu makes the Patch Input/Output window appear with different Audio Source and Audio 
Destination selections automatically set up.

Input
The Patch Input/Output window appears set up to let you patch different inputs (such as the 
system audio input) to the tracks of the timeline. This makes it fast for setting up audio inputs in 
preparation for recording.

Aux Bus
A shortcut to open the Patch Input/Output window (discussed previously in this chapter), which 
appears set up to let you patch different Aux buses to specific submix and timeline 
track channels.

Sub Bus
A shortcut to open the Patch Input/Output window (discussed previously in this chapter), which 
appears set up to let you patch different Sub (submix) bus channels to specific timeline 
track channels.

Main Bus
A shortcut to open the Patch Input/Output window (discussed previously in this chapter), which 
appears set up to let you patch different Main bus channels to specific timeline track channels.
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Path Settings
Choosing Path Settings opens the Path Settings window for that track. This window contains 
controls for adjusting the input level of audio signals being input via a BMD input/output device.

The Path Settings window showing audio inputs and track inputs

These parameters control the following:

 � Mic/Instr.: Adjusts the Mic/Instrument level for this source, from 0 to 100 dB.

 – On: Enables Microphone/Instrument level for this source.

 – 48V: Enables phantom power for that input.

 � Record Level: Controls the level going to the disk before recording. It does not affect 
the track when in Thru mode.

 – Rec: Enabling this button makes this track ready to record. Only turn this on if there 
is an audio source patched to the current track.

 – Thru: When on, this makes the affected track into the equivalent to a live feed. When 
enabled, this track will monitor its input, but will not respond to a record command. 
Only turn this on if there is an audio source patched to the current track.

 � Trim: This parameter controls the level as the channel enters the mixer. For timeline 
tracks, this controls the signal coming from disk, and does not affect any current levels 
being recorded.

 � Direct Output: Controls the level going from this channel to the direct output.

 – On: Toggles direct output on and off.

 – Pre: Toggles the direct output to connect either pre or post the main channel fader.

 � Insert: Controls the insert return only. When enabled, the channel connects to its insert 
return, otherwise the Channel connects to the straight-through path. The insert send, 
on the other hand, is always active (though it must be patched somewhere before it can 
be heard). 

NOTE: Insert sends and returns are only audible if patched to physical outputs or 
inputs, or to other paths. Sends can be sent to the input of any path in the system, and 
returns can come from the output or send of any path. This is done in the Patch I/O 
screen (press the Patch I/O button).
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Chapter 151

Transport Controls, 
Timeline Navigation, 
and Markers

The Fairlight page has unique transport control, zooming, and scrolling options 
not found in the other pages of DaVinci Resolve that help you to work with 
audio more efficiently. This chapter covers how to get around the Fairlight 
version of the Timeline.
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Transport Controls and JKL Navigation
Because of the Fairlight page’s audio-focused workflow, the transport and playback controls 
differ from those found in the Media, Edit, Color, and Deliver pages.

Transport Controls

Fairlight page transport controls

The Fairlight transport controls are also designed to mirror their counterparts on the Fairlight 
control panels. They include the following functions:

 � Rewind and Fast Forward: Initiates accelerated playback through the Timeline in either 
direction. Pressing either of these buttons multiple times speeds up this motion, cycling 
through 8x, 24x, 60x, 150x, and 360x play speeds.

 � Play: Plays forward. Identical to pressing the Spacebar or L keys while playback is 
stopped.

 � Stop: Stops playback. Identical to pressing the Spacebar or K keys while playback is 
engaged.

 � Record: Initiates recording if you have an audio source patched to a track, and if that 
track is enabled for recording. For more information about recording, see Chapter 152, 
“Recording.”

 � Loop: Toggles looped playback off and on. While looped playback is on, playback 
will loop at the end of the Timeline, and will also loop when you use the Play In to Out 
command, and will continue to loop automatically until you stop playback.

 � Automation controls: This button exposes the automation toolbar. For more information 
about recording automation, see Chapter 157, “Automation Recording.”

Using JKL to Control Playback
The JKL keyboard shortcuts are common to many editing applications, and experienced editors 
know these to be some of the most useful controls for playback and editing there are. Here’s a 
list of the many different ways you can use these three keyboard shortcuts to play through clips 
and timelines as you work.

J Plays 100% backward.

K Stops playback.

L Plays 100% forward.

Press J repeatedly Increases backward play speed each time you press J, for a range 
of fast-reverse speeds.

Press L repeatedly Increases forward play speed each time you press L, for a range of 
fast-forward speeds.

Shift-J Plays in fast reverse.

Shift-L Plays in fast forward.
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K+J Plays backward at slow motion (with slow motion audio playback).

K+L Plays forward at slow motion (with pitch-corrected audio playback 
on OS X).

Pressing K while tapping J Moves the playhead back one frame.

Pressing K while tapping L Moves the playhead forward one frame.

If you’re using Fairlight with the keyboard, then this will probably become one of the main ways 
you move the playhead around in DaVinci Resolve.

Dragging the Playhead to Scrub
You can also drag the playhead left and right to scrub through the visible area of the Timeline 
by clicking and dragging anywhere within the Timeline ruler at the top of the Timeline, directly 
below the toolbar. If you’re zoomed in at a reasonable level for editing, scrubbing the playhead 
using your pointer will result in smooth, tape-like slow and fast audio playback, giving you a 
great deal of precision while trimming audio.

Looping Playback
Two controls govern looping on the Fairlight page, similarly to how looping works on the 
Edit page.

 � Loop: Command-Forward Slash (/). Toggles looped playback off and on. While 
looped playback is on, playback initiated with any of the following commands will loop 
automatically until you stop playback.

 � Play In to Out: Option-Forward Slash (/). If you’ve marked a section of a clip or timeline 
with In and Out points, this command lets you preview how it will play.

Loop Jog Scrubbing
Currently available only on the Fairlight page, choosing Timeline > Loop Jog enables a brief 
sample preview to be heard while scrubbing the playhead through the Timeline. This can make 
it easier to recognize bits of dialog or music as you’re quickly scrubbing through tracks, in 
situations where you’re trying to locate specific lines or music cues. It also enables this brief 
sample preview to loop endlessly when you hold the playhead on a frame, so you can pause 
while scrubbing and hear (by default) the current 80 ms prior to the playhead as it loops.

A pair of settings in the User Preferences let you customize this behavior. 

 � Loop Jog Alignment: Three options let you choose whether you loop audio Pre 
the position of the playhead, Centered on the playhead, or Post the position of the 
playhead.

 � Loop Jog Width: A field lets you choose how many milliseconds of audio to loop 
when Loop Jog is enabled. How many milliseconds of audio corresponds to one 
frame depends on the frame rate of the video. For example, at a frame rate of 25 fps, 
there are 1000/25 = 40 ms per frame, so the default value of 80 ms equals two frames 
of˛looping.
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Moving the Playhead Using Timecode
You can use absolute or relative timecode entry to move the playhead in the Timeline. 
Timecode entry lets you move the playhead very precisely or jump to specific timecode values 
really quickly.

How to Enter Timecode Values
When entering timecode, type each pair of hour, minute, second, and frame values from left to 
right, with a period representing a pair of zeros for fast entry. The numbers you enter appear in 
the timecode field at the upper left-hand corner of the Viewer with focus. When you’re finished 
typing, press the Return key to execute the timecode command. The rules for timecode entry 
are as follows:

 � The right-most pair of timecode values (or period) you enter is always the 
frame number.

 � A period to the left or to the right of any number you type is considered to be a 
pair of zeroes. 

 � A single period between two numbers is considered to either be a single zero 
or ignored if it’s between two pairs of numbers.

 � Any untyped pairs of values to the left of what you enter are assumed to be whatever 
those values were prior to the timecode you entered; this makes it easy to type partial 
timecode values even when the Timeline starts at hour one. 

 � It’s not necessary to enter colons or semicolons. 

Absolute Timecode Entry
Absolute timecode is entered simply by typing the timecode value you want to move the 
playhead to, and when you press the Return key, the playhead will move to that timecode value.

Here are some examples of absolute timecode entry using this method:

Original TC Value User-Typed Value New TC Value

01:10:10:10 15245218 15:24:52:18

01:10:10:10 2.. 01:02:00:00

01:10:10:10 15 01:10:10:15

01:10:10:10 12 01:10:10:12

01:10:10:10 1.2 01:10:01:02

01:10:10:10 1115.. 11:15:00:00

01:10:10:10 23... 23:00:00:00
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Relative Timecode Entry
Relative timecode is entered by starting the timecode value with a plus (+) or minus (–). Adding 
a plus results in the value you type being added to the current timecode value for purposes of 
offsetting the playhead from its current position. Adding a minus will subtract the value you type 
from the current timecode value.

Here are three examples of  relative timecode entry:

User-Typed Value Result

+20. 00:00:20:00 is added to the current timecode value.

+3.. 00:03:00:00 is added to the current timecode value.

-5 00:00:00:05 is subtracted from the current timecode value.

Clip, Marker, and Track Navigation
As of Resolve 15, the Up and Down Arrow keys are used to move the playhead from one edit 
point to the next in the Fairlight page Timeline, just as in the Edit page Timeline. 

However, holding Command-Option down while using the Arrow keys gives you Fairlight 
page-specific behaviors that are used to navigate among clips, markers, and tracks in the 
Fairlight page in a way that’s different than other pages of DaVinci Resolve but very useful to 
the way the Fairlight page operates. This section covers the basics.

Selecting Tracks
Which tracks are selected determine the behavior of the Arrow keys.

 � In Selection mode: You can select tracks by clicking or Command-clicking (to select 
multiple tracks) anywhere in the background area or on the track number of the track 
headers. If you click and drag, you can use a bounding box to select multiple tracks.

 � In Range Selection or Edit Selection mode: You can select tracks by clicking or 
Command-clicking anywhere either in the background area or on the track number of 
the track header, or in any unused area of the track itself in the Timeline. If you click and 
drag, you can use a bounding box to select multiple tracks.

Moving the Clip Selection
The Command-Option-Left and Command-Option-Right Arrow key shortcuts are used to move 
the playhead left and right in the Timeline, navigating from clip to clip or from marker to marker. 
How these keys function depends on whether or not one or more tracks is selected in 
the Timeline.

 � If no tracks are selected: The Left and Right Arrow keys will jump the playhead from 
Timeline marker to Timeline marker. Clip markers will be ignored.

 � If one or more tracks are selected: The Left/Right Arrow keys will jump the playhead 
among clip In points, clip Out points, and Timeline markers.
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Moving the Track Selection
The Command-Option-Up and Command-Option-Down Arrow key shortcuts are used to move 
the track selection up and down in the Timeline, changing which tracks are selected. By 
changing which tracks are selected, you can alter which clip’s In and Out points are used to 
jump the playhead around the Timeline.

If no tracks are selected, then nothing happens.

Zooming and Scrolling
The Fairlight page has several methods of zooming into and out of the Timeline, and scrolling 
when you’re zoomed to the point where your edited sequence of clips extends past the left and 
right edge of the visible timeline.

Setting the Zoom Level of the Timeline
Depending on how you like to work, there are several methods of zooming into and out of 
the Timeline.

 � Using the Vertical Zoom slider: A pair of sliders at the right of the toolbar let you 
zoom vertically and horizontally. The first one lets you scroll vertically in order to see 
more detail in the height of your waveforms. If no tracks are selected, then zooming 
is centered on the top audio track in the Timeline. If one or more tracks are selected, 
then zooming is centered on the topmost selected audio track.

 � Using the Horizontal Zoom slider: A pair of sliders at the right of the toolbar let you 
zoom vertically and horizontally. The second one lets you zoom horizontally in order 
to see more detail in the width of your waveforms. Zooming is always centered on the 
position of the playhead.

 � Pressing Command-Equal (=) and Command-Minus (–): Command-Equal (also referred 
to as Command-Plus) and Command-Minus let you zoom horizontally into the Timeline. 
Zooming is always centered on the position of the playhead.

 � Use Shift-Z to Zoom to Fit: Command-Z lets you zoom horizontally to fit all clips in your 
program to the available width of the Timeline.

 � Using scroll controls of your pointing device to scroll horizontally: Holding the Option 
key down and using the scroll wheel (or scroll control) of your pointing device will zoom 
horizontally into the Timeline.

 � Using scroll controls of your pointing device to scroll vertically: Holding the Shift 
key down and using the scroll wheel (or scroll control) lets you zoom vertically in 
the Timeline. In this case, if no tracks are selected, then zooming is centered on the 
top audio track in the Timeline. If one or more tracks are selected, then zooming is 
centered on the topmost selected audio track.

 � Using the Fairlight panel’s Jog/Edit wheel: If you have a Fairlight panel, you can hold 
the ZOOM button down while turning the Jog/Edit wheel to zoom into the Timeline at 
the position of the playhead.
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Scrolling Through the Timeline
However closely you’re zoomed into the Timeline, if you’re zoomed enough so that clips extend 
past the visible area of the Timeline, scroll bars appear below. If the playhead is offscreen, a 
small orange tic mark indicates its position relative to the entire timeline, which is represented 
by the total width of the scroll bar’s background.

If you drag the playhead, or otherwise use any of the transport controls or playback key 
shortcuts to move through the Timeline, the contents of the Timeline refresh every time the 
playhead hits the left or right edge of what’s visible.

Using Flags
Flags are meant to mark an entire clip, and they also flag every other clip in the Timeline that 
shares the same Media Pool source clip, making this a handy way of quickly identifying which 
clips in a given timeline come from the same Media Pool source. Flags are visible in every page 
of DaVinci Resolve, making them an excellent method of tracking media from page to page.

The Flag and Marker buttons and pop-ups.

You can apply multiple flags to clips, with a variety of colors to choose from. In addition to 
flagging specific media files, flags can be useful for sorting by column in the Media Pool, as well 
as a variety of other operations.

Methods for flagging clips in the Fairlight page:
 � To flag a clip: Select one or more clips, and either click the Flag button to flag that 

clip with the current color, or click the Flag pop-up in the toolbar to choose a different 
color and then click the Flag button. In the Edit page, flags appear in the Timeline 
superimposed in the name bar of each clip.

 � To remove all flags from a clip: Select one or more clips with flags you want to remove, 
then click the Flag pop-up in the toolbar, and choose the top “Clear All” option. 

Using Markers
Markers are used to call attention to a particular frame within a specific clip. Markers can be 
individually colored, and can have customized name and note text. Whenever you enter text 
into a marker, that marker displays a small dot that indicates there’s more information inside of it. 
Once placed, markers snap to In and Out points, edit points, the playhead, and other markers 
whenever snapping is enabled, making it easy to use markers to “measure” edits and trims that 
you make in the Timeline. Markers are visible in every page of DaVinci Resolve, making them an 
excellent method of tracking frames in clips and specific moments in the Timeline from 
page to page.

You can add markers to the Timeline (in the Timeline ruler) or to clips. The full procedures for 
placing and editing markers in the Fairlight page’s onscreen interface are identical to those 
for the Edit page, so for more information, see Chapter 31, “Marking and Finding Clips in the 
Timeline.” For now, here’s a summary.
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Adding Markers to Clips
The following procedures describe how to add markers to clips in the Timeline of the 
Media page.

To mark a clip in the Timeline, do one of the following: 
 � Select one or more clips you want to mark, then move the playhead to the frame of a 

selected clip in the Timeline, and click the Marker button in the toolbar (or press M) to 
place a marker at that frame, using the current color (if multiple overlapping clips are 
selected, you’ll add a marker to all clips). 

 � To place a marker during playback and immediately open the marker dialog to enter 
a name or note within it, select one or more clips you want to mark, play through 
the selection until you want to place a mark, then press Command-M. Playback 
pauses until you enter some text and close the marker dialog again, at which point 
playback continues.

 � Select one or more clips you want to mark, and then click the Marker pop-up to choose 
a different color, and click the Marker button.

Adding Markers to Timelines
You can also place markers of any color into the Timeline ruler to denote specific times for 
future reference, or add notes about issues you want to keep track of. You should note that all 
markers placed on clips or in the Timeline also appear within the Mini-Timeline of the Color 
page, making it easy to place notes to reference particular audio cues that might be valuable 
when editing or grading.

To mark the Timeline itself, make sure all clips are deselected, and do one of the following: 
 � Click the Marker button (or press M) to place a marker of the currently selected color in 

the Timeline ruler. 

 � To place a marker during playback and immediately open the marker dialog to 
enter a name or note within it, select one or more clips you want to mark, then press 
Command-M. Playback pauses until you enter some text and close the marker dialog 
again, at which point playback continues.

 � Click the Marker pop-up to choose a different color, and click the Marker button. 

 � Right-click in the Timeline ruler and choose a marker color from the Add Marker 
submenu of the contextual menu.
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Chapter 152

Recording

It’s possible to record to one or more tracks on the Fairlight page, 
accommodating workflows as varied as editors recording scratch 
voiceover or temp sound effects, recording engineers recording narration, 
ADR, or foley as part of the audio finishing process, music studios 
recording orchestras for the music score, or garage bands recording their 
latest magnum opus. While DaVinci Resolve is a comprehensive post-
production environment for cinema and video, the Fairlight page can be 
used for any audio recording application you might have, from books on 
tape to live music to feature films and television.

This chapter covers the somewhat brief basics of audio recording in the 
Fairlight page. Keep in mind that this is a work in progress, and that the 
comprehensive recording capabilities of earlier versions of Fairlight will be 
migrating into DaVinci Resolve as time passes.
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Setting Up to Record
Depending on how your workstation is set up, it’s possible to simultaneously record to multiple 
tracks in the Fairlight page at once. How many tracks you can record to depend entirely on 
what hardware you have available. This section describes the process of recording to tracks in 
the Fairlight page.

Patching Inputs
Before you can record anything, you need to use the Patch Input/Output window to patch an 
available audio input to a track. If you’re computer has nothing else, the inputs of your 
workstation are available to connect whatever audio device is set up as the default audio input 
on your system to the track you want to record to.

To open the Patch Input/Output window, do one of the following:
 � Choose Fairlight > Patch Input/Output.

 � Click the Input menu at the top of the channel strip of the track you want to record to, 
and choose Input.

The Input pop-up menu lets you open the Patch Input/
Output window with that track selected

To patch an audio source to an audio destination:
1 Make sure that the Audio Source menu is set to Audio Inputs, and the Audio 

Destination menu is set to Track Input.

2 On the right, click the audio input that you want to patch so it’s highlighted.

3 On the left, click the audio destination that you want to patch so it’s highlighted also, 
if it’s not already. In this simplified example, channel 1 of the Scarlett 2i2 is being 
connected to Audio 1, which is the only track in the timeline.

Selecting a source and a destination to patch

4 Click the Patch button at the bottom of the window, and your recording setup will 
be patched. 
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5 Continue steps 2 and 3 until you’ve patched all the inputs you want to record from 
to all of the tracks that you want to record onto. You can patch as many inputs to as 
many tracks as your system is set up to accommodate. In this example, there are two 
available audio sources, but there’s only a microphone connected to the first channel, 
so that’s the only one being connected.

6 When you’re finished, close the window.

Arming Tracks
To record on a track, it must be armed. You should note that it’s impossible to arm a track that 
hasn’t been patched first, so make sure you’ve patched the audio source you want to record 
from to the track you want to record to first. Then arming that track is as simple as clicking the 
R button in the track header controls, or in the channel strip for that track in the Mixer.

(Left) The arm button turned on in the track header, 
(Right) the arm button turned on in the channel strip

Once a track has been armed, you’re ready to record.

Choosing Where to Record Audio Clips To
The process of recording in the Fairlight page creates new clips and generates additional media 
on disk. You can specify the location on disk you want to save these recordings by opening the 
Capture and Playback panel of the Project Settings and using the Browse button, found 
underneath the “Save clips to” field, to choose a new location (a folder named “Capture” on 
your scratch disk is the default location).

To choose where the new clips that are created are placed in the Media Pool, simply open the 
Media Pool and select any bin in the Bin list, or create a new bin and select it if you want to put 
your recordings in their own location.

User-Selectable Input Monitoring Options
The Fairlight > Input Monitor Style submenu presents five options governing how you want to 
monitor inputs while recording.

 � Input: You only hear the live signal being input; you never hear the contents of tracks.

 � Auto: When one or more tracks are armed for recording, you hear the live input signal; 
on playback you hear the contents of each track.

 � Record: You only hear the live input signal while actively recording, meaning the 
Record button has been pressed while one or more tracks are armed for recording. You 
don’t hear the input signal while tracks are merely armed.

 � Mute: You hear nothing.

 � Repro: While recording, you only hear what’s just been recorded, played from the track. 
In other words, you’re not listening to the live input, but you’re reviewing what’s just 
been recorded as it’s recording.
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Recording Using the Onscreen Controls
You can record anywhere you want on the currently armed track or tracks by placing the 
playhead where you want recording to begin. In this way, you can record to specific areas of 
your program as you record voiceover, sound effects, foley, or other timed performances that 
need to fit into a particular region of the edit.

To begin recording:
1 Position the playhead where you want recording to begin.

2 Click the Record button in the transport controls. Recording immediately begins, and 
the material being recorded immediately begins drawing a waveform in real time, giving 
you immediate feedback that the input you’re recording is properly connected or not, 
as well as where on the currently armed track material is being recorded.

To stop recording, do one of the following:
 � Click the Stop button in the transport controls.

 � Press the Spacebar.

Recording and Editing Multiple Takes 
Using Layering
There are two ways you can record multiple takes. You can either record them one after the 
other, sequentially, and then edit them later. However, you also have the ability to record 
multiple takes to the same region of the timeline, one on top of another, while at the same time 
preserving every take using track layering.

In the following screenshot, multiple takes have been recorded over the same section of the 
timeline, including some partial takes to correct specific phrases in the voiceover being 
recorded. When you do this, the result looks like a series of cuts and overwritten clips, with the 
most recently recorded segments being the ones that play back over the previously 
recorded segments.

Overlapping recordings with Audio Track Layers turned off

However, if you choose View > Audio Track Layers, you’ll see that all your recordings have 
actually been preserved via a vertical stack of overlapping audio clips.
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Overlapping recordings with Audio Track Layers turned on, showing layering within the same track

The layering of audio clips in DaVinci Resolve means that the topmost superimposed clips in a 
layered stack like this mutes the audio of overlapping clips that are lower in the stack.

Using layering, it’s easy to edit the best segments of the best takes, while preserving all other 
takes, simply by adding edits and rearranging clips in the stack so the best parts are on top.

For more information about audio layering, see Chapter 148, “Editing Basics in the 
Fairlight Page.”

Recording VSTi Instruments
DaVinci Resolve 15 introduced support for VSTi instruments working with connected MIDI 
controllers to trigger instrument sounds that can be recorded live on audio tracks of the 
Timeline. This is intended to be used for loading a VSTi sampler with foley sounds such as 
footsteps or punches, so you can perform these sounds in real time and record the result to 
another track as you watch performers walking or punching in the edit, even if you lack a 
recording booth with foley pits and props.

On the other hand, if you’re a musician, there’s nothing stopping you from loading VSTi musical 
instruments of different kinds for playback, and using the Fairlight page as a multi-track 
recorder. DaVinci Resolve doesn’t have MIDI sequencing functionality, but you can record live 
playback straight to the Timeline, using layered audio to manage multiple takes for later 
re-editing. Bet you never thought you’d be recording music in DaVinci Resolve…

A VST Instrument (in this case Serato Sample) 
loaded into a track of the Timeline
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To enable a MIDI controller in macOS:
1 If DaVinci Resolve is running, quit before connecting your MIDI controller and 

setting it up.

2 On macOS you’ll use the Audio Midi Setup utility to choose output hardware and 
select a speaker configuration to be made available on your system. In the Finder, 
use Spotlight and search for Audio MIDI Setup to open it.

3 In Audio MIDI Setup, choose Window > Show MIDI Studio. A window showing icons 
for all connected MIDI controllers appears. Your controller should be showing an icon. 
If it’s not, you may need to install drivers for it.

4 Select the icon for your controller and turn on the “Enter test MIDI setup mode” button 
(it looks like a little keyboard) to test if your keyboard is connecting with the computer. 
If it is, then turn this off.

For more information on setting up MIDI on different systems, see the DaVinci Resolve 
Configuration Guide, available on the web from the Blackmagic Design support page at 
https://www.blackmagicdesign.com/support/family/davinci-resolve-and-fusion. 

To set up the Fairlight page for VSTi instrument recording using a sampler:
1 Open DaVinci Resolve 15.

2 Make sure you have at least two available audio tracks in the Timeline, one for the 
instrument you’ll be playing, and one to record into. This example will use tracks 
A4 and A5 for this.

3 Open the Effects Library, find a VSTi sampler you have installed on your system, and 
drag it to the track header of the track you want to use for playing, for example track A4. 

Massively-featured sampler/synth combinations such as Native Instruments Kontakt 
and Steinberg Halion are ubiquitous and useful when you want to specifically map a 
collection of sound effects to specific keys or pads to create re-usable multi-purpose 
instruments. However, more streamlined samplers that emphasize automatic audio clip 
slicing such as Serato Sample (Windows and macOS) or Image Line Slicex 
(Windows only) can make short work of the more specialized task of loading library 
sound effects recordings (or custom recordings you create) with multiple footsteps, 
punches, keyboard presses, cloth rustles, or other foley activities, and quickly splitting 
them up into individually playable samples you can trigger with pads or a keyboard.

4 When the VSTi interface window appears, open the MIDI menu at the upper right-hand 
corner of the VSTi window and choose the correct MIDI channel from your MIDI 
controller’s submenu. If you’ve selected the correct MIDI channel, the instrument 
should start responding to the keys or pads on your controller.
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Enabling MIDI control

5 Next, configure the VSTi instrument you’re using to play the sound effects you want 
to use for foley. In this example, the Serato Sample VSTi plug-in is being used to 
automatically slice up a recording of footsteps from one of Sound Ideas’ many sound 
effects libraries.

Because the VSTi you added is patched to that track’s Insert (if you look at the Mixer 
you should see that the I button is enabled on the channel strip the instrument is 
patched to), the Send is PRE the Instrument. This means you need to patch that track’s 
Track Direct output to the input of another track to record the instrument.

6 Choose Fairlight > Patch Input/Output to open the Patch Input/Output window, then set 
the Source pop-up menu to Track Direct and the Destination pop-up menu to Track 
Input. Click Audio 4 to the left, and Audio 5 to the right, and click the Patch button; this 
sets you up to play the VSTi plug-in on track A4, and record its output on track A5.

Be aware that after patching Track Direct from the track with the instrument to the track 
you’re recording onto, you also need to turn “Direct Output” on for that track in the Path 
Settings of that track’s channel strip in the Mixer. 

7 Open the Mixer (if necessary), click the Input pop-up menu at the top of the channel 
strip that shows the VSTi instrument you’re using, and choose Path Settings. When the 
Path Settings window appears, click the ON button for Direct Output, then close the 
Path Settings window. 

At this point, you’re ready to begin recording.

To play and record a VSTi instrument:
1 Click the Record Arming button of the track you’re recording to (in this example A5), 

move the playhead to where you want to begin recording, and then click the Record 
button to begin recording.

2 As the video of your program plays, use your MIDI controller to trigger sound effects as 
necessary. When you’re finished, click the Stop button. 

If necessary, you can record multiple takes using track layering until you get the timing 
right. When you’re finished, you can remove the instrument from the track it’s on since 
the recorded audio is all you need.
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Chapter 153

ADR 
(Automated Dialog 
Replacement)

The Fairlight page of DaVinci Resolve has a sophisticated interface for 
doing ADR, or automated dialog replacement, in a structured and 
straightforward manner. Simple, yet powerful, the ADR panel incorporates 
Cue list management, industry-standard audio beeps and visual cues, and 
sophisticated take management with star ratings and layered take 
organization to create and manage the re-recording of dialog in any 
program. With this sophisticated organization and layering, it’s easy to edit 
together the best parts of each take into your program.

Chapter – 153 ADR (Automated Dialog Replacement) 3187



ADR (Automated Dialog Replacement) 3189

The ADR Interface 3189

Setting up to Do an ADR Session 3193

Creating and Importing ADR Cue Lists 3194

Manually Creating an ADR Cue List 3194

Importing Cues 3195

Recording ADR to the Timeline 3196

Contents

Chapter – 153 ADR (Automated Dialog Replacement) 3188



ADR (Automated Dialog Replacement)
Clicking the ADR button on the Interface toolbar opens up the celebrated Fairlight ADR panel, 
which provides a thoroughly professional workflow for doing automated dialog replacement. 
Dialog replacement, for those who don’t know, is the process whereby audio professionals 
bring in actors to re-record unsalvageably bad dialog recordings from the comfort of their 
recording studios, line by line and with a great deal of patience.

The ADR panel on the Fairlight page

It’s an old joke that ADR isn’t really automatic, but the Fairlight page aims to give you all the help 
it can to make this a structured and straightforward process. Simple, but powerful, Cue list 
management lets you efficiently assemble a re-recording plan. Industry-standard audio beeps 
and visual cues via your BMD video output device help the actors in the booth nail their timings 
and their lines. Then, sophisticated take management with star ratings and layered take 
organization in the Timeline help you manage the resulting recordings to pick and choose the 
best parts of each take when you edit the results.

The ADR Interface
When open, the ADR interface consists of three panels to the left of the Timeline: a Record 
panel, a List panel, and a Setup panel. The controls of these panels are described in the order 
in which they’re used.

The Setup Panel
As its name implies, the Setup panel is where you configure your ADR session. 

The Setup panel of the ADR interface
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This panel presents the following controls:

 � Pre Roll and Post Roll: Specifies how many seconds to play before and after each 
cue’s specified In and Out points, giving actors a chance to listen to what comes before 
and after each cue in order to prepare. If you enable the Beep options below, beeps 
provide a countdown during the specified pre-roll.

 � Record Source: (Disabled until you select a Record Track) A drop-down menu lets you 
choose the input you want to record from, creating a patch to the Record Track.

 � Record Track: A drop-down menu lets you choose the track you want to record to. 
Selecting a track with this menu creates a patch from the Record Source to the Record 
Track, and automatically toggles Record Enable on.

 � Guide Track: A drop-down menu lets you choose which track the original production 
audio you need to re-record is on. This is used for sending audio playback to the talent 
to use as a guide for recording their own replacement performance.

 � Record File Name: A text entry field that lets you provide a name for the audio files 
being recorded to be saved with.

 � Character Setup: A list for adding the names of all the characters that have dialog 
cues you’ll be re-recording, to help with cue creation and management. An Add New 
button lets you add additional names to this list, while a Remove button lets you delete 
characters you no longer need.

 � Beep to In Point: Enables a three-beep sequence to be heard leading up to the 
recording. For beeps to be audible, the Beeps channel of the System Generator is 
a source that must be patched to your audio outputs using the Patch Input/Output 
window.

 � Beep at In Point: Enables one last beep at the In point. For beeps to be audible, the 
Beeps channel of the System Generator is a source that must be patched to your audio 
outputs using the Patch Input/Output window.

 � Count In: An onscreen counter that counts down to the start of the cue.

 � Video Streamer: A visual cue for the talent to watch during pre-roll to ready them for 
recording. A pair of vertical lines superimposed over the program being output to video 
move towards one another across your video output screen during the pre-roll to the 
cue. This gives the talent a visual indication of the time remaining until they should 
begin talking. When the beeps play, these lines get taller. Both lines come together at 
the Time In frame, at which point a cross shows that recording is beginning.

 � Smart Timeline: When turned on, this option automatically moves the playhead to each 
cue as it’s selected in the Cue list, and zooms in to frame the duration of that cue in the 
Timeline.

 � Mixing Control: Enables automated switching of audio playback, to independently 
control what the talent and the audio engineer hear at various stages of the ADR 
recording process. For example, with this enabled, the Guide track is not routed to the 
Control room while the engineer is reviewing a take.

Chapter – 153 ADR (Automated Dialog Replacement) 3190



The List Panel
This is where you create a list of cues you need to re-record, either from within the Fairlight 
page, or imported from a .csv file that someone provides you.

The List panel of the ADR interface

This panel presents the following controls:

 � Cue editing controls: Displays the data for the currently selected cue (or a cue that was 
just created). In and Out timecode fields store the Timeline In and Out points that were 
set when the cue was created but can be manually edited for fine tuning. A Character 
drop-down menu lets you choose which character that line of dialog belongs to. A text 
entry field lets you enter the dialog cue that’s to be re-recorded, so you and the talent 
can both refer to it.

 � New Cue button: Clicking this button adds a new cue to the list using whatever In and 
Out points have been set in the Timeline, and whatever character was last selected.

 � Cue list: The list of all cues that have been entered or imported. The Cue list can be 
filtered using the Filter drop-down menu at the top-right of the ADR panel (next to the 
option menu). You can choose to show the cues for all characters, or for any selected 
combination of characters. You can also choose to hide all cues that are marked as 
done to experience the joy of this list shrinking more and more the closer you are to 
being finished.

Additionally, the ADR interface option menu has three commands pertaining to the List panel:

 � Import Cue List: Lets you import a properly formatted .csv file to create cues that have 
been prepared in a spreadsheet. Correct formatting for cue lists you want to import 
is no headers, one line per cue, with four individual columns for In timecode, Out 
timecode, Character Name, and Dialog.

 � Export Cue List: Lets you export the contents of the Cue list to a .csv file, for exchange 
or safe-keeping.

 � Clear Cue List: Deletes all cues in the Cue list. It’s recommended you export a copy of 
your Cue list before eliminating it completely, in case you ever need to revisit a cue.
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The Record Panel
This is where you actually run the ADR recording session you’ve set up, using the dialog cues 
you’ve put into the Cue list. 

The Record panel of the ADR Interface

This panel presents the following controls:

 � Record and rehearse controls: Four transport controls and two buttons let you control 
recording during ADR sessions. These controls are only clickable when you’ve selected 
a cue from the Cue list to record.

 – Rehearse: Runs the section of the Timeline specified by a cue without actually 
recording anything, giving the talent an opportunity to run through their dialog and 
practice their timing and delivery. Beeps and on-screen streamers are not played 
during a rehearsal.

 – Play: Plays the currently selected take from the Take list (described below). If no take 
is selected, the most recently recorded one on top is played.

 – Stop: Immediately stops rehearsal, playback, or recording.

 – Record: Initiates recording of the cue to the specified audio track, with cue beeps 
and video streamer cues.

 – Keep Playing: At the end of a take you may wish to keep playing, so the talent 
can hear the next section of the track. Pressing the Keep Playing button at any 
time, even while recording, results in post roll being ignored and normal playback 
resuming after the cue’s Out time.

 – Keep Recording: At the end of a take you may wish to keep recording until you 
manually stop. Pressing the Keep Recording button at any time, even while 
recording, results in the Out point of the current cue being ignored and recording 
continuing until you stop it.

 � Take list: The Take list shows every take you’ve recorded for the current cue, with 
take number, name, and a five-star rating that you can set to keep track of which takes 
worked and which didn’t. Earlier takes are at the bottom of this list, while recent takes 
are at the top (the same order in which the corresponding layered audio clips appear in 
the Timeline track they’ve been recorded to).
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 � Cue list: The list of all cues that have been entered or imported. The Cue list can be 
filtered using the Filter drop-down menu at the top-right of the ADR panel (next to the 
Option menu). You can choose to show the cues for all characters, or for any selected 
combination of characters. You can also choose to hide all cues that are marked as 
done to experience the joy of this list shrinking more and more the closer you are to 
being finished.

 � Cue list Done column: A sixth column appears in the Record panel only, labeled Done. 
It contains check boxes for each cue that you can turn on to keep track of which cues 
you’ve successfully finished.

Additionally, the ADR interface Option menu has one command pertaining to the Record panel:

 � Record Early In: Enables recording during pre-roll, in the event you’re working with 
talent that likes to start early.

Setting up to Do an ADR Session
Setting up to record ADR is straightforward but requires a few steps.

Creating tracks in preparation to record ADR:
1 In the Timeline, create a new audio track to which you’ll be doing ADR recording. 

Make sure it has the correct channel configuration for your recording (mono is typical 
for dialog).

2 If you’re recording ADR to your main timeline, you may want to Solo both the Guide 
track and the Record track, so you and the talent can focus on the audio being re-
recorded without hearing all the other tracks of the current mix.

Now you’re ready to configure the Setup panel.

Configuring the Setup panel:
1 Open the ADR interface, and then open the Setup panel.

2 Choose the Pre Roll and Post Roll you want to use, in seconds. A pre roll of at least 3 
seconds is recommended to give the talent time to get ready.

3 From the Record Source drop-down menu, choose the microphone you patched earlier.

4 From the Record Track drop-down menu, choose the Record track you created.

5 From the Guide Track drop-down menu, choose the track with the original production 
audio that you’re replacing.

6 At the bottom of this panel, turn on which Preroll Cue options you and the talent want to 
use as you record each cue. Options include:

a.  Beep to In Point and Beep at In Point provide an audible count down to when to 
start performing.

b.  An animated Video Streamer gives a countdown to the start time, shows the 
duration of the cue being recorded, and also displays the text of the dialog for that 
cue on screen for the actor to refer to, so they can keep their eyes on the screen 
and not a script.

7 Next, if you’ve enabled Beep to In Point and Beep at In Point, you need to patch the 
Fairlight oscillator to your output channels so the talent can hear the preview beeps.
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Patching the Oscillator to play beeps over your audio output:
1 Choose Fairlight > Patch Input/Output to open the Patch Input/Output window.

2 Choose System Generator from the Source drop-down menu, and click to 
select Beeps.

3 Choose Audio Outputs from the Destination drop-down, and choose the left/right 
outputs you want these preview beeps to play out of. You can drag a bounding box to 
select multiple outputs, thereby connecting the mono Beeps input to stereo output for 
comfortable listening.

4 Click Patch to make the connection, then close the Patch Input/Output window.

Creating and Importing ADR Cue Lists
You must have a list of cues to be able to use the ADR interface properly. There are two ways 
you can create a Cue list to record with, make one from scratch on the Fairlight page, or import 
one. The ADR panel accommodates both workflows.

Manually Creating an ADR Cue List
If you’ve been doing all of your dialog editing inside of DaVinci Resolve, you can go ahead and 
create a list by marking the sections of the Timeline you need to re-record and creating cues 
from those timings. To create cues properly, you should start by adding the names of each 
character you’ll be creating a cue for in the Setup panel. These names make it easier to enter 
cues and will help you to filter and sort the list as necessary later on.

To add character names before entering cues:
1 Open the Setup panel of the ADR interface.

2 Click Add New.

3 When a selected entry appears in the Character Setup list, type a name.

4 Press Return when you’re done.

To edit the Character Setup list, do one of the following:
 � If you mis-spell a name, you can double-click any name in this list to edit it. 

 � To delete a name, you can select it and click Remove to eliminate it.

Once you’ve created a complete set of character names, you can begin creating your Cue list.

To manually add cues to the Cue list:
1 Open the List panel of the ADR interface. This is where all the controls for creating and 

editing cues are.

2 In the Timeline, set In and Out points to mark the section of dialog you want to turn into 
a cue. Those timecode values appear in the Cue Editing section of the List panel.

3 Click New Cue to add a blank cue to the Cue list.

4 In the Cue Editing section, choose the character who’s speaking that cue from the 
Character drop-down (only names that have been entered in the Setup tab appear in 
this list). 
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5 If necessary, select the text field below, and type the dialog that needs to be 
re-recorded.

6 Repeat steps 2 through 5 until you’re finished creating all the cues you intend to re-
record. If you need to edit any cue, simply click to select that cue, and edit it in the Cue 
Editing section above.

Importing Cues
If you or an assistant has already created a Cue list using a spreadsheet with separate columns 
for character names, dialog, and In/Out timecode values, then you can also create a Cue list by 
importing this data from an exported .csv file.

To import a .csv file to the Cue list:
1 Choose Import Cue List from the ADR option menu, then use the dialog to choose the 

.csv file containing the Cue list you were given, and click Open. 

2 An ADR Setup dialog appears, showing the data from the .csv file previewed as a 
series of columns. This lets you see if each column of incoming data is being assigned 
correctly. If it’s not, you can reassign each column of the incoming data to the correct 
column of the ADR panel.

Correct formatting for Cue lists you want to import is to have no header text, and to 
enter information using one row per cue, with four individual columns for In timecode, 
Out timecode, Character Name, and Dialog. If any of these columns are transposed, 
you can correct this by choosing the correct data type for each column from the 
drop-down menus at top.

Dialog for rearranging columns of cue data, if necessary

3 Click Import CSV. The cues should appear in the Cue list.

To export a .csv file from the Cue list:
 � Choose Export Cue List from the ADR option menu, choose a location to save the file, 

and click Save.
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Recording ADR to the Timeline
Once you’ve configured your workstation for recording, and you’ve set up a Cue list to work 
with, it’s time to start recording each cue.

To record a cue from the Cue list:
1 Open the Record panel of the ADR interface.

2 If you want to record a particular character’s cues, you can select each unnecessary 
character in the ADR Option menu to uncheck that character, hiding their dialog in 
the Cue list.

3 With the list showing the character cues you need, select the cue you want to start 
recording. That cue contains the timecode necessary to determine which part of the 
Timeline to record to, and the playhead automatically moves to that part of the Timeline.

4 Click the Rehearse button a few times to run through the cue with the talent. When you 
click Rehearse, both audio and video corresponding to that cue will play, including pre 
roll and post roll, along with all beep and onscreen cues.

5 When the talent is ready to try a take, click the Record button, and let the Fairlight page 
do the work of playing through pre roll with beep notifications and visual streamer 
cues, initiating recording, and then stopping recording automatically once the cue is 
done. To record another take, simply click the Record button again.

Every time you complete a recording, a take appears in the Take list. Making multiple 
recordings results in multiple takes in the list. In the Timeline, all new takes appear as 
layered audio, so you can record as many takes as you like into the same area of the 
Timeline. Once you’ve finished recording takes, you’ll have a neatly organized stack of 
alternate takes to draw upon as you edit together the best parts of each recording.

6 If you or the talent want to hear a particular take again, select it in the Take list and click 
Play. You can use the 5-star ratings control to keep track of how you liked each take.

7 When you’re finished recording a cue, click the Done checkbox for that cue, and select 
the next cue you want to record. When you’re finished re-recording dialog, simply close 
the ADR interface. 

Chapter – 153 ADR (Automated Dialog Replacement) 3196



Chapter 154

Editing Basics in 
the Fairlight Page

You can use the Fairlight page to refine the editing of audio that was 
initially assembled in the Edit page, or you can use the Fairlight page to 
both record and edit audio programs from scratch. Because audio clips 
have properties that video clips do not, audio editing encompasses 
additional procedures that are not available in the Edit page. This chapter 
takes you through the fundamental steps of editing audio the Fairlight way.

Chapter – 154 Editing Basics in the Fairlight Page 3197



Compatible Audio Formats 3200

Editing Audio Clips Into the Timeline 3200

Overwriting Vs. Layering Clips That Overlap 3200

Choosing Parts of Clips to Edit in the Media Pool 3200

Dragging Audio Clips Into the Timeline 3201

Support for Mixed Audio Track Formats from Source Clips 3203

Making Audio Clip Selections in the Timeline 3204

Selecting Tracks 3204

Using Selection Mode 3206

Using Range Selection Mode 3207

Using Edit Selection Mode 3211

Commands For Editing and Extending the Selection 3214

Locking Audio Tracks You Don’t Want to Change 3214

Splitting Clips 3215

Trimming Clips Without Rippling the Timeline 3215

Multi-Point Editing Overview 3216

Resizing the In and Out Points of a Clip 3216

Trim Start and Trim End 3217

Trim to Selection 3217

Moving (Sliding) and Overwriting Clips 3218

Slipping 3218

Duplicating Clips 3218

Disabling and Re-Enabling Clips in the Timeline 3219

Deleting Audio Clips and Regions 3219

Cut, Copy, and Paste 3220

Conventional Cut, Copy, and Paste 3220

Using the Cut/Copy Head and Tail Commands 3222

Contents

Chapter – 154 Editing Basics in the Fairlight Page 3198



Paste and Remove Attributes 3223

Copying and Pasting Clip Attributes 3223

Copying and Pasting Track Attributes 3224

Removing Attributes 3224

Audio Clip Layering 3224

Audio Compound Clips 3226

Audio Crossfades 3226

Fades and Crossfades 3227

Using Fades 3227

Fade In and Out to Playhead 3228

Creating Crossfades With Overlapping Fades 3228

Using Crossfades From the Edit Page 3229

Finding Clips in the Media Pool 3229

Changing Clip Color in the Timeline 3230

Editing Audio Clips in External Editors 3230

Bouncing Audio Clips to External Files 3231

Sample Editing 3232

Chapter – 154 Editing Basics in the Fairlight Page 3199



Compatible Audio Formats
DaVinci Resolve is compatible with WAVE, Broadcast WAVE, AIFF, MP3, AAC (M4A), CAF 
(macOS only), both MTS and QuickTime containers that use the AC3 audio format, and 
Enhanced AC-3 (macOS and Windows only). DaVinci Resolve is compatible with audio at 
sample rates including 32, 44.1, 48, 88.2, 96, and 192 kHz.

Editing Audio Clips Into the Timeline
The Fairlight page offers a complete audio editing environment that lets you either record and 
assemble clips from scratch, or refine tracks full of audio clips that have been edited together in 
different ways. There are four ways of adding media to the Timeline in the Fairlight page, 
depending on the type of work you do:

 � Recording new audio into one or more tracks (for more information, see Chapter 152, 
“Recording”)

 � By dragging and dropping new audio clips from the Media Pool into the 
Fairlight timeline

 � By editing audio clips into audio tracks on the Edit page

 � By importing a project with audio clips

However audio clips come to be in your timeline, the rest of this chapter covers the myriad 
methods available to edit and sweeten the contents.

Overwriting Vs. Layering Clips That Overlap
When you add clips to the Timeline, what happens when you add a clip that overlaps another 
clip that’s already in the track you’re editing to depends on the Timeline > Layered Audio 
Editing setting. By default, with Layered Audio Editing turned off, overwriting one audio clip with 
another results in the overlapping part of the overwritten clip being non-destructively deleted 
from the Timeline by the incoming clip.

However, if you turn Layered Audio Editing on, then incoming clips do not overwrite overlapping 
clips in the Timeline; instead, they’re layered within that track, such that the incoming audio clip 
takes precedence over what was previously there, but overlapping audio segments that were 
previously in the Timeline are preserved, which can be seen when you choose View > 
Show Audio Track Layers.

In this way, you can choose whether you want to overwrite previously edited clips, or layer 
newly edited clips, as your needs require, regardless of whether or not Audio Track Layers are 
visible. Audio layering can be enabled in both the Edit and Fairlight pages.

For more information about audio layering, see the section later in this chapter.

Choosing Parts of Clips to Edit in the Media Pool
The Media Pool has a preview player at the top that provides a place to open selected source 
clips in the Media Pool, play them, add marks to log them, and set In and Out points in 
preparation for editing them into the Timeline via drag and drop. The Media Pool Preview Player 
effectively acts as a Source monitor for editing in the Fairlight page.
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The preview player in the Media Pool

 � Various viewing controls populate the title bar at the top. A drop-down menu at the 
upper left lets you choose a zoom level for the audio waveform that’s displayed. To 
the right of that, a Timecode window shows you the duration of the clip or the duration 
that’s marked with In and Out points. Next to the right, a real-time performance 
indicator shows you playback performance. In the center the title of the currently 
selected clip is shown, with a drop-down menu to the right that shows you the most 
recent 10 clips you’ve browsed. To the far left, a Timecode field shows you the current 
position of the playhead (right-clicking this opens a contextual menu with options to 
change the timecode that’s displayed, and to copy and paste timecode).

 � The center of the Media Pool Preview Player shows you the waveforms in all channels 
of the currently selected clip, at whatever zoom level is currently selected.

 � Transport controls at the bottom consist of a jog bar for scrubbing, Stop, Play, and Loop 
buttons, and In and Out buttons.

Dragging Audio Clips Into the Timeline
You can show the Media Pool in the Fairlight page, and edit audio clips into the Timeline in their 
entirety by dragging and dropping individual clips onto whichever audio track you want them to 
appear. You can drag any clip onto any track, regardless of whether or not the channels of the 
clip match the channel mapping of the track. However, if you edit a clip with more channels than 
a track has (for example, editing a stereo clip onto a mono track), only the channels supported 
by that track will be output, with all other channels in that clip being muted. If this happens, you 
can always remap the audio track by right-clicking the track header and choosing a new 
mapping from the Change Track Type To submenu.

TIP: Dragging one or more clips to the empty area underneath the existing audio 
tracks of the Timeline results in the creation of new tracks, each of which is 
automatically mapped to however many channels are required by each audio clip 
being edited.

If you want to edit several clips into the Timeline at once by dragging them from the Media Pool, 
you’ll probably want to do a bit of preparation to make sure they’re edited in the right order.
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Dragging several clips into the Timeline as one contiguous series of edited clips:
1 Change the sort order of the Media Pool’s browser area to put the clips into the order 

in which you want them to appear. In Thumbnail view you can use the Sort Order 
menu, but in List view you can click the header of any metadata column to sort by that 
column’s data.

Using the Sort Order menu to change the 
sort order of clips in the Media Pool

2 Use the Media Pool thumbnails, the Media Pool List view Filmstrip, or the Source 
Viewer to set In and Out points to define the part of each clip that you want to edit into 
the Timeline.

3 Select the Media Pool clips you want to edit into the Timeline by dragging a bounding 
box, Command-dragging multiple bounding boxes over different sets of clips, by 
Shift-clicking a range of clips, or by Command-clicking individual non-contiguous clips.

4 Drag any of the selected clips to the desired position in the Timeline to perform 
an overwrite edit.

The clip(s) you drag overwrite whatever other clips they overlap in the Timeline. 
Multiple clips dragged from the Media Pool will be edited in the order in which 
they’re sorted in the Media Pool, using each clip’s In and Out points.

It’s possible to edit audio clips into the Timeline so that each clip’s timecode lines up with the 
Timeline Ruler. This can be useful if you’re organizing multiple source audio recordings that you 
want to synchronize together on multiple tracks.

Dragging multiple clips to edit them into a track at their timecode positions:
1 Select the Media Pool clips you want to edit into the Timeline by dragging a bounding 

box, Command-dragging multiple bounding boxes over different sets of clips, by Shift-
clicking a range of clips, or by Command-clicking individual non-contiguous clips.

2 Hold Command-Shift down, and drag the selected clips into the track you want them to 
appear, to perform an overwrite edit.

Each clip edited into that track appears at the same timecode position as its embedded 
timecode. This means that if you were recording time-of-day timecode, each clip will appear on 
the Timeline at the time it was recorded. A series of clips recorded during hour 10 through 13 
will appear distributed throughout hours 10-13 on your timeline.
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A series of audio clips edited into the Timeline by timecode position

You can also edit two or more audio clips into the Timeline as a stack, in preparation for layering 
multiple sound effects for doing sound design work.

Dragging multiple clips to edit them into a track as a parallel stack:
1 Select the Media Pool clips you want to edit into the Timeline by dragging a bounding 

box, Command-dragging multiple bounding boxes over different sets of clips, by Shift-
clicking a range of clips, or by Command-clicking individual non-contiguous clips.

2 Command-drag the selected clips into a track of the Timeline. The first of the selected 
clips appears in the track you’re dragging to, the other clips appear either in audio 
tracks underneath the first one, or if there are no audio tracks available, in new audio 
tracks that will be created to hold those clips.

All clips you’ve edited appear as a parallel stack, in separate tracks, one on top of another.

Support for Mixed Audio Track Formats from Source Clips
As of DaVinci Resolve 15, there is support for media with multiple audio tracks that have 
differently formatted channels embedded within them. For example, a clip with one stereo 
track, one 5.1 surround track, and six mono tracks can all be appropriately set up in the Audio 
panel of Clip Attributes after that clip has been imported.

The Audio panel of Clip Attributes now has controls over what format (Mono, Stereo, 5.1, 7.1, 
Adaptive) the channels embedded within a particular audio track should be configured as. 
This means you can set up clips with multiple tracks, each one using different formats of audio 
employing different combinations of channels, which is useful for setting up imported audio mix 
files that you want to output when mastering a program.

Clip Attributes now lets you assign channels among different 
tracks with different channel assignments
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Making Audio Clip 
Selections in the Timeline
Nearly every editing operation described in this chapter and others requires you to make a 
selection to define which clips will be affected. Three editing modes in the toolbar give you 
different ways of selecting clips, depending on what you’re trying to do, and how you like to 
work. These are (from left to right) the Selection mode, the Range mode, and the Edit Selection 
mode. Which mode you choose determines how clips and clip segments are selected in the 
Timeline in preparation for all manner of editorial operations.

The Selection and Range 
Selection tools seen in the toolbar

Why Are There Three Edit Modes?

While the Selection and Range modes can also be used with the pointer, they’re really 
designed to enable automatic selections based on the position of the playhead. This is 
accomplished when using either the Fairlight Editing console or keyboard shortcuts to 
control Timeline transport, while specific tracks are selected to enable selection and 
editing on those tracks.

The Edit Selection mode is designed for efficient selections made using the pointer via 
a mouse, trackpad, or pen and tablet, made in conjunction with a variety of commands 
for extending and editing selections triggered via keyboard shortcuts. If you’re editing 
with a keyboard and mouse, this mode is designed to let you work quickly by enabling 
a variety of different selection functions based on clicking different parts of clips.

Selecting Tracks
In order to understand clip selection, you must first understand track selection. The Timeline on 
the Fairlight page lets you select entire tracks to facilitate the automatic selection of clips that 
intersect the playhead on those tracks using keyboard shortcuts or the Fairlight Editing panel, 
in Selection and Range Selection modes (described in upcoming sections).

For example, were you to select tracks A2, A3, and A4, then moving the playhead to intersect 
two clips on those tracks in Selection mode automatically selects them, so they’re ready for any 
operation you want to perform on both clips. To give a few examples, you could now split both 
clips at the playhead, Cut Head or Tail to the playhead, Delete both clips, or Copy them in 
preparation for pasting elsewhere.
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Command-clicking multiple track headers selects those tracks

Additionally, there are times when clicking or dragging on one or more clips with the pointer 
results in both those clips being selected, along with the tracks on which they sit. For example, 
selecting clips using the Edit Selection mode will also select the tracks those clips are on.

TIP: Selecting tracks in the Fairlight page is analogous to using the Auto Select 
controls in the Edit page Timeline, which define which clips on which tracks will be 
automatically selected whenever you set In and Out points in the Timeline.

If you’re manually selecting tracks using the pointer, there are different ways to do so.

Methods of selecting and deselecting tracks in the Fairlight page Timeline:
 � To select a single track: Click anywhere in the background or on the track number of 

that track’s header (not on a button). In Range Selection mode you can also click in any 
unused area of the track itself.

 � To deselect a single track: Click anywhere in the background or on the track number 
of a previously selected track’s header (not on a button). In Range Selection mode 
you can also click in any unused area of the track itself. If multiple tracks are selected, 
Command-clicking one will remove just that track from the selection.

 � To select multiple tracks: Command-click in the track header background of every 
track you want to select. In Range Selection mode you can also Command-click in any 
unused area of the tracks themselves. Command-clicking an already selected track will 
deselect it.

 � To select multiple continuous tracks: Click anywhere in the background or on the 
track number of a track header, and then drag a bounding box up or down over all 
other tracks you want to select. In Range Selection mode you can also drag a bounding 
box over any part of the tracks themselves, while also defining a range in which you 
want to work.

 � To move the selection to higher or lower tracks: Press Control-Option-Up Arrow or 
Down Arrow to move the selection state to the next track higher (Control-Option-Up 
Arrow) or lower (Control-Option-Down Arrow). If multiple tracks are selected, then 
the multi-selection will be moved as a block; for example, selecting tracks A2 and 
A3 and then pressing Control-Option-Down Arrow will result in tracks A3 and A4 
being selected.
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Using Selection Mode
Selection mode uses the position of the playhead to make automatic selections when using the 
Fairlight Editing console or keyboard shortcuts to make clip selections on selected tracks. 
However, you can also use this mode in conjunction with the pointer and keyboard shortcuts to 
make selections in a different style. Selection mode is primarily intended to allow efficient 
editing of whole clips.

 � If no tracks have been selected: Clips that intersect the playhead are not selected. 
You can use the pointer to select one or more clips by clicking, Command-clicking, 
or dragging a bounding box. Clips you select in this way are highlighted in orange. 
Making selections in this way is similar to making clip selections in the Timeline of the 
Edit page.

 � If tracks have been selected: All clips that intersect the playhead on selected tracks 
will be automatically selected in gray, but no In and Out points will be set. Clips on 
de-selected tracks will be ignored. Selecting one or more clips with the pointer 
(by Command-clicking or dragging a bounding box) creates an orange-highlighted 
selection that overrides the gray automatic selection.

 � If you set In and Out points: Some functions will affect ranges of clips between In and 
Out points on selected tracks. Clips on unselected tracks are ignored.

To choose Selection mode:
 � Click the Selection tool (the arrow) in the toolbar.

 � Choose Trim > Selection Mode.

 � Press A.

To automatically select clips using the playhead position in Selection mode:
1 Press A to enter Selection mode.

2 Select one or more tracks with clips you want to select.

3 Move the playhead to intersect those clips.

All clips that intersect the playhead on selected tracks of the Timeline are automatically 
selected in their entirety. Automatic selections are gray. Intersecting clips on unselected tracks 
are not selected.

Clips intersecting the playhead in Selection mode are automatically selected with orange highlights
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Methods of selecting clips using the pointer in Selection mode:
 � Click any clip to select it.

Click a clip to select it

 � Command-click multiple clips to select them all at once.

Command-clicking multiple clips selects those clips, even if they’re separated by other clips

 � Click anywhere in the background of the Timeline and drag a bounding box over 
multiple clips.

Dragging a bounding box over multiple clips selects all of them

Using Range Selection Mode
Range Selection mode also uses the position of the playhead to make selections of a partial 
range of clips in the Timeline when using the Fairlight Editing console or keyboard shortcuts. 
You can also use this mode in conjunction with the pointer and keyboard shortcuts to make 
partial selections of clips.

 � If no tracks have been selected: Clips that intersect the playhead are not selected. You 
can use the pointer to click a clip and select it in its entirety along with the track it’s on. 
You can also use the pointer to drag on one or more clips to select a partial range in 
preparation for different editing operations. Whenever you make a selection with the 
pointer, Timeline In and Out points are set to the boundaries of the selection.

 � If tracks have been selected: Any clip on a selected track that intersects the playhead 
will be automatically highlighted in gray. Clips on de-selected tracks will be ignored. 
Dragging a crosshairs over one one or more clips with the pointer overrides all 
automatic selections and selects the regions of the clips you drag over, and the tracks 
they’re on.
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 � If you set In and Out points: Partial regions of all clips on all selected tracks between 
the In and Out points will be highlighted in gray. Clips on unselected tracks are ignored. 
While In and Out points are set, the playhead no longer makes automatic selections; 
you must set new In and Out points to modify the selection in this mode.

To choose Range Selection mode:
 � Click the Range Selection tool (the crosshairs) in the toolbar.

 � Choose Trim > Range Selection Mode. 

 � Press R.

To automatically select clips in Range Selection mode using the playhead position:
1 Press R to enter Range Selection mode.

2 Select whichever tracks have clips you want to select.

3 Move the playhead to intersect those clips.

All clips that intersect the playhead, on the tracks you selected, define a selected range from 
the beginning of the first selected clip to the end of the last selected clip.

Clips intersecting the playhead on a selected track in 
Range Selection mode are automatically selected

To create custom clip ranges using In and Out points in the Timeline:
1 Press R to enter Range Selection mode.

2 Select whichever tracks have clips you want to select.

3 Move the playhead and press the I (Mark In) and O (Mark Out) keys to define a 
range in the Timeline.

All clip segments that fall within the range of your In and Out points on selected tracks 
will be selected.
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Using the Range mode to select clip segments on selected tracks using In and Out points

Methods of selecting clips in Range Selection mode via clicking and dragging:
 � To select a single clip: Click any clip to select both it and the track it’s on, and define a 

range in the Timeline that matches the duration of that clip.

Click to select a single clip as well as the track it’s on

 � To select multiple clips: Command-clicking multiple clips to select them all at once 
defines a range in the Timeline that matches the total overlapping duration of all clips 
in the selection, from the beginning of the first selected clip to the end of the last 
selected clip.
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Range selection by Command-clicking multiple clips

 � To drag to select a range within a single clip: With the Range Selection tool selected, 
drag anywhere on top of a clip to drag a bounding box over whatever segment of that 
clip (or of one or more clips) to select both that clip segment and the track it appears 
on. This is a good way of selecting part of a recording you want to move or delete.

Ranged selection within a clip using a bounding box

 � To drag to select a range within multiple clips: Click and drag a bounding box over 
whatever segment of one or more clips you want to select to select both those clip 
segments and the tracks they appear on. Or, Command-click and drag anywhere on 
top of any clip to drag a bounding box over whatever region of clips and tracks you like.
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Ranged selection across multiple clips using a bounding box

In Range Selection mode, whenever you make a selection, the In and Out point fields 
update with the range that you’ve created. 

The range fields showing you 
the In and Out point values 
that define the current range

These ranges can be cleared if necessary.

Methods of clearing In and Out points to clear the current range:
 � Press Option-I to clear the current In point.

 � Press Option-O to clear the current Out point.

 � Press Option-X to clear both the In and Out points.

Using Edit Selection Mode
Edit Selection mode is designed for making efficient pointer-based selections and edits, in 
conjunction with an assortment of commands for extending and editing selections that can be 
triggered via customizable keyboard shortcuts. If you’re editing with a mouse and keyboard, 
this mode is designed to let you work quickly by enabling a variety of different functions based 
on clicking different parts of each clip in the Timeline.

Additionally, an important aspect of working in Edit Selection mode is that this is the only mode 
that lets you edit the Timeline during playback, which you can’t do in Selection and 
Range modes.

 � If no tracks have been selected: Whenever you make a selection with the hand, 
Timeline In and Out points are set to the boundaries of the selection. Whenever 
you make a selection with the crosshairs, Timeline In and Out points are set to the 
boundaries of the region you dragged. In all cases, the tracks that contain selected 
clips and regions of clips are also selected.
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 � If tracks have been selected: Any clip on a selected track that intersects the playhead 
will be automatically highlighted in gray. Clips on de-selected tracks will be ignored. 
Dragging a crosshairs over one one or more clips with the pointer overrides all 
automatic selections and selects the regions of the clips you drag over, and the tracks 
they’re on.

 � If In and Out points have been set: Clicking the bottom half of clips in the Timeline will 
select that clip and track, and the In and Out points will change to encompass that clip.

To choose Range Selection mode:
 � Click the Edit Selection tool (the crosshairs at the bottom of a track) in the toolbar.

 � Choose Trim > Edit Selection Mode. 

 � This mode has no keyboard shortcut at this time.

To select an entire clip using the hand tool of the Edit Selection mode:
 � Move the pointer to the bottom half of a clip until a hand cursor appears, and click once 

to select that clip in its entirety.

Clicking the bottom half of a clip to select that clip in Edit Selection mode

 � Use the Hand to Command-click multiple clips to make either contiguous or 
noncontiguous selections.

To select a range using the crosshairs tool of the Edit Selection mode:
 � Move the pointer to the top half of a clip until a cross-hairs cursor appears, and drag to 

select a region of one or more clips. As you drag, the playhead follows the Out point.

Dragging within the top half of a clip to select a region in Edit Selection mode
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 � Using the crosshairs, you can also Command-click to expand or contract the selected 
region across one or more clips. 

 � Using the crosshairs, you can also double-click to select an entire clip.

To select a single frame using the Crosshairs tool of the Edit Selection mode:
 � Move the pointer to the top half of a clip until a cross-hairs cursor appears, and click 

once to place a point selection at the frame you clicked. The playhead also moves to 
this frame. 

Clicking within the top half of a clip to make a single frame selection

 � Using the crosshairs, you can also Command-click clips on higher and lower tracks 
to add them to the single frame selection, aligned at the same frame. For example, 
you could do this to split multiple clips at once. One frame selections can be on 
discontiguous tracks.

Command-clicking within the top half of multiple clips on multiple 
tracks to add single frame selections at the same frame

To move a selection using the Hand tool of the Edit Selection mode:
 � Once you’ve made a selection of one or more clips or regions using the Hand or 

Crosshairs tool of the Edit Selection mode, you can move the pointer to the bottom half 
of any selected clip and drag the selection to another position on the Timeline.
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Commands For Editing and Extending the Selection
Once you’ve made one or more selections in the Timeline, there are a series of commands you 
can use to modify or expand the selection. These commands were designed to be used 
alongside the Edit Selection mode, but they can be used in any mode.

Editing the Selection
There are six commands for changing the current selection, moving it from one clip or group of 
clips in the Timeline to another. These commands only move the range of clips/frames that are 
selected: they do not move the clips themselves. These commands are found within the 
Timeline contextual menu when you right-click on a clip.

 � Move To Previous/Next Edit: Moves the current selection to the next clip/edit 
point to the left or right in the Timeline.

 � Move To Previous/Next Track: Moves the current selection to the next track 
up or down in the Timeline.

 � Move to Previous/Next Frame: Nudges the current selection to the left or 
right in the Timeline.

Extend Edit Selection

There are four commands for expanding the range of what’s selected in the Timeline, one clip 
or track at a time. These commands are found within the Timeline contextual menu when you 
right-click on a clip.

 � To Previous Edit: Expands the selection to include the previous clip to the 
left in the Timeline.

 � To Next Edit: Expands the selection to include the next clip to the right in the Timeline.

 � To Previous Track: Expands the selection to include the clip in the next 
track up in the Timeline.

 � To Next Track: Expands the selection to include the clip in the next track 
down in the Timeline.

Locking Audio Tracks You 
Don’t Want to Change
Another step you can take to prepare before performing any kind of editorial operation is to 
lock tracks with media that you don’t want to be affected by whatever it is you’re about to do. 
For example, if you have a complex set of music edits on track A3 that you don’t want to be 
affected by operations that will delete media that overlaps it, you can lock track A3 so those 
clips remain unaffected.

Locking an audio track
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Clips on locked tracks cannot be moved, deleted, cut, or otherwise affected by editorial 
operations. Furthermore, parameters of locked clips cannot be edited in the Inspector. 
However, clips on locked tracks can be played back and mixed like any other audio clips.

To toggle the lock or unlock state of audio tracks in the 
Fairlight page, do one of the following:

 � Click any track’s lock control to toggle lock on and off.

 � Click any track’s lock control and drag over the lock controls of other tracks in the 
Timeline to quickly lock or unlock several adjacent clips.

 � Open the Index and click/drag one or more track lock controls to toggle lock on and off.

Splitting Clips
In many situations you may find yourself splitting audio clips in order to separate multiple 
rolling takes.

To split one or more clips in either Selection or Range Selection mode:
1 Select each track that has a clip you want to split.

2 Move the playhead to intersect the clips you want to split at the frame where you want 
the split to happen.

3 Do one of the following:

a Choose Timeline > Split Clip or press Command-\ (backslash).

b Choose Timeline > Razor or press Command-B.

When you split a clip in the Edit page, a through edit appears to show that you currently have 
an edit with continuous timecode running from the outgoing to the incoming half. This is called 
a through edit and is displayed in the Edit page with a dotted line running along its edge so you 
know that it’s special. The Fairlight page doesn’t display through edits as of the time of 
this writing.

NOTE: Clips cannot be joined as of the time of this writing.

Trimming Clips Without 
Rippling the Timeline
Most basic adjustments in the Fairlight page only affect the selected clip or region of the 
Timeline. Clips to the right of the adjusted area of the Timeline are generally left alone so as not 
to inadvertently change sync when you don’t expect it. This section covers the most basic parts 
of the Fairlight page’s “seven-point editing” paradigm.
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Multi-Point Editing Overview
Each clip in the Timeline has several draggable handles and click targets that let you perform 
different editing tasks using the pointer.

 � In point: The left edge of the clip can be dragged to resize the beginning of the clip.

 � Out point: The right edge of the clip can be dragged to resize the end of the clip.

 � Fade In handle: A handle at the upper left-hand corner of the clip that only appears 
when the mouse is positioned over that clip, used to fade the audio in by dragging 
it to the right, or as part of a crossfade between two audio clips. Fades can be reset 
(eliminated) by double-clicking the fade handle.

 � Fade In curve:  A handle at the center of the Fade In curve that only appears when the 
curve is exposed, used to adjust the power of the fade in. This handle can be dragged 
vertically to change the X-Level of the fade, and horizontally to change the X-Point of 
the fade. Fade curves can be reset by double-clicking the curve handle.

 � Fade Out handle: A handle at the upper right-hand corner of the clip that only appears 
when the mouse is positioned over that clip, used to fade the audio out by dragging 
it to the left, or as part of a crossfade between two audio clips. Fades can be reset 
(eliminated) by double-clicking the fade handle.

 � Fade Out curve: A handle at the center of the Fade Out curve that only appears when 
the curve is exposed, used to adjust the power of the fade out. This handle can be 
dragged vertically to change the X-Level of the fade, and horizontally to change the 
X-Point of the fade. Fade curves can be reset by double-clicking the curve handle.

 � Level: Considered an editorial characteristic, the level of any given audio clip can be 
adjusted via a level overlay running across each clip. The level of any clip can be reset 
to the default 0.0 dB by double-clicking the level overlay.

 � Position: Clicking anywhere within the middle of a clip in Selection or Range mode, 
or on the bottom of Edit Selection mode, lets you drag that clip either forward or 
backward in time, or to another track.

Resizing the In and Out Points of a Clip
Trimming the head or tail of a clip in the Fairlight page means to resize the In or Out point of that 
clip, making it shorter or longer accordingly.

To resize the beginning or end of a clip:

 � To shorten or lengthen clips: Move the pointer over the beginning or end of a clip, 
and when it turns into the Resize cursor, drag the In or Out point to the left or right 
to change the clip’s length. As you drag the In or Out point of an audio clip in the 
Fairlight page, an overlay appears showing the waveform of all available media at the 
head (if you’re dragging the In point) or tail (if you’re dragging the Out point) of the clip 
you’re resizing.

The overlay seen when resizing the In 
point of an audio clip in the Fairlight page
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To quickly resize the beginning or end of a clip to the very 
beginning or end of available media:

 � Double-click the In point of the clip to move the In point to the very beginning of that 
clip’s media.

 � Double-click the Out point of the clip to move the Out point to the very end of that 
clip’s media.

If you resize a clip’s In or Out point to overlap one or more neighboring clips in the Timeline, the 
overlapping parts of the neighboring clips will be overwritten by the clip you’ve resized.

Trim Start and Trim End
The Trim > Trim Start (Shift-[) and Trim End (Shift-]) commands let you move the In or Out point of 
all clips that intersect the playhead as either a ripple operation (in Trim mode) or a resize 
operation (in Selection mode). You do not need to make a selection to use Trim Start and Trim 
End, making these commands fast to use in the right situation. A classic use of Trim End is when 
you have several superimposed clips of different lengths that you want to either start or end at 
the same time.

 � Trim Start resizes or ripples (depending on what mode you’re in) all clips that intersect 
the playhead, so that each clip’s In point is moved to the current playhead position. 

 � Trim End resizes or ripples intersecting clips so that each intersecting clip’s Out point is 
moved to the current playhead position.

Clips that don’t intersect the playhead are not affected. Furthermore, you can exclude clips on 
specific tracks from this operation by locking those tracks.

Trim to Selection
The Trim to Selection command simultaneously trims the heads and tails outside of a selection 
of one or more clips so that the selection is all that remains. This command is found within the 
Timeline contextual menu when you right-click on a clip.

(Left) A selection that includes parts of two clips, (Right) The result of using Trim to Selection to eliminate the 
heads and tails outside of this selection
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Moving (Sliding) and Overwriting Clips
Formerly called slipping in previous versions of Fairlight, sliding refers to moving a clip to the 
left or right in the Timeline, changing the timing of that clip’s position in the edit.

To move or slide clips in the Timeline, do one of the following:
 � To move one or more selected clips in the Timeline: Drag any clip in the Timeline to 

any other position. If you’re in Edit Selection mode, you must drag using the bottom 
half of the selection. If you drag a clip to overlap another clip, the clip you’re dragging 
overwrites the clip you’re moving it over. 

 � To nudge one or more selected clips in the Timeline using the keyboard: Make a 
selection, then press the Comma key (nudge 1 frame left) or Period key (nudge 1 frame 
right) to roll the selected edit to the left or right. Shift-Comma and Shift-Period nudges 
by 5 frames.

 � To move one or more selected clips up or down to other tracks at the same time: 
Make a selection, then hold the Shift key down while dragging one of the selected clips 
up or down in the Timeline to lock their position in time while moving them to other 
tracks. Or, you can hold the Option key down and press Up or Down Arrow.

Sync Offset Indicator
Audio clips in the Fairlight page display an “out-of-sync” or sync offset indicators when they’re 
moved out of sync with the video items they’re linked to.

Slipping
Formerly called resyncing, slipping an audio clip keeps that clip in the same place in the 
Timeline while changing the range of media that appears in that spot. Slip edits do not change 
the duration of the overall Timeline, and they don’t move the clip’s position relative to the other 
clips in the Timeline. Slipping simply changes the range of media that clip represents.

NOTE: While available in previous versions of Fairlight, slipping is not available at the 
time of this writing.

Duplicating Clips
The Duplicate Selection command duplicates one or more selected clips, placing the duplicates 
immediately after the Out point of the selection. If you’re duplicating a region of a clip with tails, 
or a clip that’s in between other clips, the duplicated selection will overwrite whatever is to the 
right of the current selection, for the duration of the duplicate. 
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Using the Duplicate Selection command to duplicate a selected region

You can also hold the Option key down while dragging a clip in the Timeline; you’ll place a 
duplicate clip wherever you drop it.

Option-dragging to duplicate a clip in the Timeline

Disabling and Re-Enabling 
Clips in the Timeline
Sometimes there’s one or more audio clips in the Timeline that you don’t want to play along with 
the rest of the edited sequence, but you don’t want to remove from the Timeline either, in case 
you change your mind later. For this reason, it’s possible to disable clips, effectively turning 
them off without removing them. Previous versions of Fairlight referred to this operation as 
Mute clip.

Disabled clips appear dimmed in the Timeline. They don’t play back, they’re not rendered, and 
they’re not output to video. However, their position is preserved in the Timeline, so you can 
always re-enable them at a later time if you change your mind and decide you want 
to use them.

To disable or re-enable one or more selected clips:
 � Right-click part of the selection and choose Enable Clip from the contextual menu.

 � Choose Clip > Enable Clip.

 � Press D.

Deleting Audio Clips and Regions
You can delete any clip(s) or clip region(s) that you can select, in either Selection or Range 
Selection modes by pressing the Delete or Forward Delete keys, or by right-clicking a clip and 
choosing Delete Selected from the contextual menu. In the Fairlight page, deleting anything 
leaves a gap. You can not ripple delete anything.
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Cut, Copy, and Paste
The Fairlight page has a unique copy and paste methodology that takes advantage of the 
“ghost” overlays that are used for the waveforms of selected audio clips. This method makes it 
easy to copy and paste clips using keyboard shortcuts and the JKL keys.

Conventional Cut, Copy, and Paste
The typical cut, copy, and paste commands expected of every software application are 
available in the Fairlight page, but with a unique twist that’s particularly advantageous for users 
of the Fairlight control surface, or for anyone who uses the JKL transport key shortcuts to move 
around the Timeline for keyboard-driven editing. 

To cut or copy and paste either all or part of a clip:
1 If you’re cutting or copying a whole clip, then choose either the Selection (press A) or 

Range Selection (press T) mode. If you’re cutting or copying part of a clip, then make 
sure you’re in Range Selection mode (press T).

2 To use the playhead to make a clip selection, select the track that contains the clip 
you want to copy or cut. If one or more tracks are already selected, you can use the 
Control-Option-Up or Down Arrow key shortcuts to move the track selection state up or 
down to the tracks with the clip you want to cut or copy.

Selecting the track with a clip you need to cut

3 Do one of the following:

a To cut or copy a whole clip, move the playhead so that it intersects the clip you 
want to cut or copy. If the playhead intersects a clip on a selected track, that clip 
should become selected. You should note that even if you use the mouse to select 
a clip without selecting a track first, you should still move the playhead to intersect 
the clip you’re copying or pasting, as this sets up an important reference point for 
the operation.
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b To cut or copy segment of a clip, move the playhead so that it intersects the clip you 
want to cut or copy. If the playhead intersects a clip on a selected track, that clip 
should become selected. Then, using JKL and the I (In) and O (Out) keys, mark a 
range in the Timeline that includes the segment of the clip you want. That segment 
should appear highlighted as a result.

Cutting or copying a segment of a clip using In and Out points

4 Making sure the playhead is over the section of the waveform that you want to use as 
the frame to move the clip by, press Command-X to cut or Command-C to copy that 
clip (you can also right-click a clip and choose Copy or Cut). That clip will immediately 
become highlighted.

Cutting or copying a clip at the position of the playhead

5 At this point, there are two things you can do to position the cut or copied clip to the 
position in the Timeline at which you want to paste it:

a Moving the playhead will now also move the clip you cut or copied, shown as a 
ghost clip with waveform that’s “attached” to the playhead at the frame you chose. 
Whether you drag the playhead with your mouse or use JKL to move the playhead 
through the Timeline, the cut or copied clip will move along with it, so that moving 
the playhead repositions the cut or copied clip on that track.
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b If you want to move the cut or copied clip to another track, use the Control-Option-
Up or Down Arrow key shortcuts to change the selected track; the ghost clip will 
move along with change in track selection.

Positioning the cut or copied clip before you paste it

This way, you can use the playhead to align the ghost waveform with other audio clips 
surrounding it in preparation for pasting it.

6 When the clip is positioned where you want it, press Command-V to paste the clip at 
the position you’ve chosen (you can also right-click a track and choose Paste from the 
contextual menu). The clip becomes solid, and you’re finished.

The pasted clip

Using this method of cutting and pasting makes it quick to cut or copy clips using only 
keyboard commands, with the clip’s ghost overlay making it easy to precisely align the 
clip you’re pasting to fit exactly where you need it to, perfectly in sync.

Using the Cut/Copy Head and Tail Commands
Four additional commands make it easy to cut or copy portions of one or more clips that 
intersect the playhead, either from the In point to the current position of the playhead (the 
Head), or from the current position of the playhead to the Out point (the Tail).

To cut or copy the head or tail of a clip, and paste the result:
1 Using these commands, there’s no need to make a partial selection, so you can use 

either the Selection (press A) or Range Selection (press T) modes.

2 Select the track that contains the clip you want to copy or cut. If one or more tracks are 
already selected, you can use the Control-Option-Up or Down Arrow key shortcuts 
to move the track selection state up or down to the tracks with the clip you want to 
cut or copy.
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3 Move the playhead so that it intersects the clip you want to cut or copy at the frame you 
want to define, either the end of the head or the beginning of the tail. If the playhead 
intersects a clip on a selected track, that clip should automatically become selected. 
You should note that even if you use the mouse to select a clip without selecting a track 
first, you should still move the playhead to intersect the clip you’re copying or pasting, 
as this sets up an important reference point for the operation.

4 Choose Edit > Cut/Copy Head/Tail to cut or copy the portion of the selected clip you 
want to paste. That portion of the clip will immediately become highlighted.

5 At this point, there are two things you can do to position the cut or copied head or tail 
of the clip to the position in the Timeline at which you want to paste it:

a a ghost clip with waveform that’s “attached” to the playhead at the frame you chose. 
Whether you drag the playhead with your mouse or use JKL to move the playhead 
through the Timeline, the cut or copied clip will move along with it so that moving 
the playhead repositions the cut or copied clip on that track.

b If you want to move the cut or copied clip to another track, use the Control-Option-
Up or Down Arrow key shortcuts to change the selected track; the ghost clip will 
move along with change in track selection.

This way, you can use the playhead to align the ghost waveform with other audio clips 
surrounding it in preparation for pasting it.

6 When the clip is positioned where you want it, press Command-V to paste the clip at 
the position you’ve chosen (you can also right-click a track and choose Paste from the 
contextual menu). The clip becomes solid, and you’re finished.

Paste and Remove Attributes
The Fairlight page has Paste Attributes and Remove Attributes commands that allow for the 
copying and resetting of audio parameters and effects, similar to the same commands on the 
Edit page.

Copying and Pasting Clip Attributes
For clips, this works as simply as copying a clip, then selecting one or more audio clips and 
right-clicking another clip and choosing Paste Attributes from the contextual menu. A dialog 
appears letting you choose which audio attributes you want to paste before clicking Apply.

The Paste Attributes dialog in the Fairlight page

Chapter – 154 Editing Basics in the Fairlight Page 3223



Copying and Pasting Track Attributes
For tracks, it works a little differently. Right-click on a track header and choose Copy Attributes 
to copy all track settings and effects. Then, select one or more other track headers, right-click 
the selection, and choose Paste Attributes. A dialog appears letting you choose which track 
attributes you want to paste before clicking Apply.

The Paste Attributes dialog in the Fairlight page, 
used to copy attributes from one track to another

Removing Attributes
For either clips or tracks, you can right-click and choose Remove Attributes to open a dialog 
with which to choose which attributes you want to reset to their default settings.

Audio Clip Layering
Audio layering is a special audio editing mode that lets you superimpose multiple audio clips in 
the same track, with audio clips edited into the top layers muting overlapping sections of audio 
clips appearing on lower layers. With audio layering enabled, superimposed audio clips are 
treated similarly to superimposed video clips that have opacity set to 100%, with clips on top 
obscuring (or muting) clips underneath. 

An example of multiple audio performance editing using layers, where the 
top layer mutes overlapping sections of audio clips in lower layers

Audio layering is incredibly useful for any situation where you’re combining segments of 
multiple takes together to create a single voiceover, audio vocal track, or dramatic performance, 
as you can choose which segments to use via their superimposed position in the stack of clips 
appearing in that track, while at the same time you’re preserving the other takes underneath in 
case you might want them later.

TIP: Track layering can be used on the Edit page as well.
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To enable audio layering:
Choose Timeline > Layered Audio Editing so that a check mark appears by the 
command. All overlapping audio will be layered instead of overwritten from that 
point forward.

To view audio layering:
1 Choose View > Show Audio Track Layers to reveal track layers for each audio track 

(and each lane within a given audio track) in the Timeline. When layering is on, space 
appears at the top of each track in the Timeline which provides a region into which you 
can edit layered audio clips.

2 To edit an audio clip or segment as a layer within a particular audio track, drag it from 
elsewhere in the Timeline or from the Media Pool, and drop it into the empty area 
above whatever audio is already in that track.

Dragging an audio clip to become layered above another clip

3 Edit the different superimposed layers of audio such that the segments of each 
take that you like are on top. Only the topmost clip segments will be audible. Audio 
segments that overlap underneath are silent. To put another layer on top, drag it from 
its current position to the empty area at the top of the track.

Dragging a bottom audio layer to appear on top

4 When you’re finished editing clips in track layers, choose View > Show Audio Track 
Layers again to hide the individual layers, so that only the topmost clips appear as a flat 
sequence in each track and lane.

Hiding layers makes all audio layers appear on a single track, as if the top clips are 
overwriting what’s underneath, except the muted material underneath is preserved
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Audio Compound Clips
DaVinci Resolve supports audio compound clips, which are created just like any other 
compound clip, by selecting multiple audio clips, right-clicking one of them, and choosing New 
Compound Clip. Alternately, compound clips with video clips may now contain multiple audio 
items as well. 

When compound clips containing audio are opened in the Edit or Fairlight pages by right-
clicking an audio compound clip and choosing Open in Timeline, breadcrumb controls appear 
beneath the Timeline that let you exit the compound clip and get back to the master Timeline.

Opening an audio compound clip; note the path 
control at the bottom left of the Timeline

Audio Crossfades
You can add Cross Fade transitions to any edit point between two audio clips that have enough 
handles similarly to how you add video transitions, by dragging and dropping from the Effects 
Library, by right-clicking an edit and choosing an option from the contextual menu, or by 
selecting an audio edit point and choosing Timeline > Add Audio Only Transition (Shift-T). 

Cross Fade transitions are a quick and easy way to fade the volume of the outgoing clip down 
while simultaneously fading the volume of the incoming clip up, letting you create a smooth 
aural transition between two audio clips.

An audio Cross Fade transition applied between two clips

You can double-click a Cross Fade transition to open it into the Inspector, revealing the 
following parameters:

 � Duration: The duration of the transition, shown in both seconds and frames.

 � Alignment: A drop-down that lets you choose the transition’s position relative to 
the edit point it’s applied to. Your choices are “End on Edit,” “Center on Edit,” and 
“Begin on Edit.”

 � Transition style: You can choose –3dB, 0dB, or +3dB to set both the Fade In and Fade 
Out levels to the same value. For more information on what these levels mean, see the 
following parameter.

Chapter – 154 Editing Basics in the Fairlight Page 3226



 � Fade In/Fade Out levels: There are three options that affect the incoming and outgoing 
halves of the Cross Fade effect independently. 0dB applies a linear fade (this is the 
default). +3dB applies a boosted curve; when applied to both Fade In and Fade Out, 
this can compensate for diminished levels in the middle of a Cross Fade. –3dB applies 
an attenuating curve, which deliberately lowers the level of the Cross Fade.

Crossfades can be created and edited on both the Edit and Fairlight pages.

Fades and Crossfades
Part of audio editing in the Fairlight page is the use of fades and crossfades. This section shows 
you how to create these effects for smoothly segueing from one audio clip to another.

Using Fades
Like the Edit page, each audio clip has fader handles that appear at the upper right and left 
corners of a clip you’re hovering the pointer over.

Fader handles appear when you 
hover the pointer over a clip

Pulling these handles out creates a fade effect with a duration equal to the length you 
extended the handle.

Creating a fade effect by pulling 
out one of the fader handles

Once you’ve created a fade effect, you can adjust the curve of the fade by dragging 
the handle that appears right on top of the fader curve. Dragging the handle up and 
down affects the angle of the curve, and dragging the handle left and right affects the 
shape of the curve. In this way, you can create all manner of fade effects.

Adjusting the curve of the fade
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Fade In and Out to Playhead
A pair of commands in the Trim menu let you move the playhead over a clip, and use the 
playhead position to “Fade In to Playhead” or “Fade Out to Playhead.” These commands work 
in both the Edit and Fairlight pages.

(Left) Placing the playhead where you want a fade in to end, (Right) Using Fade In to Playhead

Creating Crossfades With Overlapping Fades
While a fade gradually fades a single track of audio up or down, a crossfade fades two 
overlapping clips at the same time, fading one clip up and another clip down, for the aural 
equivalent of a cross dissolve. There are currently two ways of creating a crossfade in the 
Fairlight page. Both depend on clip layering to allow you to have overlapping fades over 
overlapping clips.

To create a crossfade by overlapping two clips together:
1 Add a fade out to the end of one clip, and a fade in to the beginning of another clip. 

By default, all fades you add in this way are linear, although you can adjust them to 
whatever gain you want.

Adding fades to adjacent clips

2 Drag the first clip to overlap the second clip by the length of the fade you’ve created.

Dragging the clips to overlap, the overlapping 
parts will be preserved via clip layering
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3 Drop the clip. The overlapping fades will both be preserved thanks to clip layering, and 
a crossfade will appear in the Timeline.

The resulting crossfade

To create a crossfade over two clips that are already layered:
Drag a fader handle at the beginning or end of a clip that’s layered, and a crossfade will 
automatically appear.

Creating a crossfade by adjusting the 
fader handle of a layered clip

Using Crossfades From the Edit Page
You can also add crossfades in the Edit page, but they appear in the Fairlight page as 
transitions in the Edit page style.

The resulting crossfade

Finding Clips in the Media Pool
You can right-click any clip in the Timeline and choose Find in Media Pool to automatically 
select that clip in the Media Pool, for instances where you might want to edit another copy of 
that clip somewhere else in the Timeline, or re-edit another segment from that clip into the 
same area.
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Changing Clip Color in the Timeline
You can right-click one or more selected clips in the Timeline to change the clip color, to be 
more organized. For example, you might set production audio clips containing dialog from 
different actors to different colors, or you could set clips with dialog, music, and effects to 
different colors in order to easily differentiate each clip’s purpose.

Editing Audio Clips in External Editors
While working in the Fairlight page, you have the ability to process an audio file using a third-
party application if necessary, in the event you need to use another application’s capabilities to 
create an effect or solve an issue that can’t be accomplished in the Fairlight page itself. To do 
this, you must first add one or more applications to the External Audio Process list in the Audio 
Plug-ins panel of the System Preferences.

The External Audio Process list configured to send audio to Adobe Audition

To add an external audio process:
1 Open the System tab of the DaVinci Preferences, and select the Audio Plugins panel.

2 Click the Add button in the “Setup External Audio Processes” section.

3 To give the audio process a different name, double click in the Name column and type 
a new name.

4 Double-click in the empty Path column for the new process, and choose an application 
to assign to that process from the dialog.

5 Choose the type of process you want it to be from the drop-down menu in the 
Type column.

Once you have one or more external audio applications configured in Preferences, you can use 
them to process any audio clip in the Fairlight page by right-clicking an audio clip and choosing 
the application you want to use from the External Audio Process submenu of the 
contextual menu.

When you do this, a duplicate of the audio clip media is copied (bounced) to the directory 
location specified by the “Save clips to” field of the Capture and Playback panel of the Project 
Settings. At that point, the external application is either opened or launched as a command 
from the command line (depending on how the external application has been configured in 
Preferences). 
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Once the bounced audio is opened in the external application, you can process it however you 
need to and bake in any changes made by saving/rendering/outputting and overwriting the 
original copied audio media file. DaVinci Resolve detects when changes have been made, and 
the altered result is automatically reimported as an additional audio layer on top of the original 
clip in the Timeline.

The way an audio application is configured in the DaVinci System Preferences dictates how the 
bounced audio file is passed to the external program. There are three choices: 

 � Command Line: As a command line parameter, if your audio application is able to be 
run from the Terminal.

 � Clipboard: By placing the path to the bounced file in the clipboard, so you can paste 
it into the application which has been automatically launched, or import it via a File > 
Open dialog.

 � Reveal: By revealing the bounced copy in the file manager of your workstation, so you 
can drag and drop it onto the application which has been automatically launched.

Bouncing Audio Clips to External Files
For any workflow where you need to write clips from the Timeline to external files without 
whatever levels, EQ, dynamics, filters, or other filters have been applied in the Fairlight page, 
you can use the Bounce Clips to Files command.

To bounce clips to external files:
1 Select one or more clips in the Timeline.

2 Right-click one of the selected files and choose Bounce Clips to Files from the 
contextual menu.

3 When the Bounce Clip to File dialog appears, do the following:

a. Click Browse to choose a location to save the bounced audio files.

b. (Optional) Enter a tag and one of the various Name options.

c. Choose a Format and Bit Depth for the bounced clips.

The dialog that lets you choose options for bouncing clips to files

4 Click Bounce.

The selected audio files are written to the location you chose.
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Sample Editing
You can zoom quite far into audio clips on the Fairlight page timeline, until you see the 
individual samples that comprise the audio waveform of each clip. Samples are represented by 
control points once you’ve zoomed in far enough. 

When you zoom in far enough, you can see the individual samples of an audio clip as control points

You can non-destructively edit these control points to eliminate clicks and pops, and to effect 
other fixes to problem audio clips. 

Methods of editing audio samples:
 � To see the editable audio samples: Zoom all the way into an audio clip until you see 

the sample control points, using either Command-Plus or Command-Minus, the scroll 
wheel of your pointing device, or by holding down the ZOOM button of your Fairlight 
editing panel and turning the JOG/EDITING wheel.

 � To edit a single audio sample: Click and drag that audio sample up or down to change 
its height.

 � To edit a section of samples: Click and drag horizontally left or right across the 
samples you want to edit to “redraw” the waveform any way you’d like.

Black points show the previous levels when samples have been edited in a clip

Sample editing can be undone, just like any other editing procedure, as the edited sample 
points are stored non-destructively within the DaVinci Resolve project.
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Chapter 155

Audio Clip 
Specific Inspector 
Adjustments

Each audio clip in a track has individual settings that are specific to 
that clip, which can be adjusted and animated in the Inspector. 
This makes it easy to adjust the levels and EQ of several clips to match 
one another, while reserving the track level for your overall mix. 
An additional set of clip-specific pitch controls make it easy to make 
small pitch adjustments, either static or keyframed, where necessary. 

This chapter describes how to use these clip-specific controls.
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Audio Settings in the Inspector
Each selected clip, and each selected Main, Submix, or Auxiliary bus channel strip in the Mixer 
exposes some simple audio-related parameters in the Audio panel of the Inspector.

 � Clip Volume: Each clip has a single volume control, which corresponds to the volume 
overlay over each audio clip.

 � Clip Pan: (Only exposed for clips) A simple Pan slider that controls stereo panning.

 � Clip Pitch: (Only exposed for clips) Each clip has two pitch controls, for altering clip 
pitch without altering clip speed. You can control pitch in Semi Tones and Cents.

 � Clip Equalizer: (Only exposed for clips) Each clip also has a four-band EQ, complete 
with low-pass, high-pass, and parametric settings for fine tuning and problem-solving 
audio issues at the clip level.

 � Audio Effects: If you’ve applied any FairlightFX, VST plug-ins, or Audio Unit plug-ins, 
those controls will also appear in the Inspector. For more information, see Chapter 158, 
“Audio Effects.”

Additionally, when you apply other audio plug-ins from the Audio FX panel of the Effects 
Library, additional parameters and controls are exposed (covered towards the end of 
this chapter).

Making Adjustments in the Inspector
Clip-specific Volume, Pan, Pitch, and Equalization are adjusted and can be animated in the 
Inspector. This section walks you through how this works.

Using the Inspector
Audio clips in the Fairlight page expose similar controls to those found in the Audio Inspector 
Panel of the Edit page. Additionally, the Inspector will display controls for audio plug-ins that 
you apply to clips as well. All parameters are organized into groups, with a title bar providing the 
name of that group, along with other controls that let you control all parameters within that 
group at the same time. 

Closed and open Inspector group 
controls in the Fairlight page
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These controls include:

 � Enable button: A toggle control to the left of the parameter group’s name lets you 
disable and re-enable every parameter within that group at once. Orange means that 
track’s enabled. Gray is disabled.

 � Parameter group title bar: Double-clicking the title bar of any group of parameters 
collapses or opens them. Even more exciting than that, Option-double-clicking the title 
bar of one parameter group collapses or opens all parameter groups at once.

 � Keyframe and Next/Previous Keyframe buttons: This button lets you add or remove 
keyframes at the position of the playhead to or from every single parameter within the 
group. When the button is highlighted orange, a keyframe is at the current position of 
the playhead. When it’s dark gray, there is no keyframe. Left and right arrow buttons let 
you jump the playhead from keyframe to keyframe for further adjustment.

 � Reset button: Lets you reset all parameters within that group to their default settings.

Making Simple Adjustments
Every group of controls in the Inspector largely consists of sliders, checkboxes, drop-down 
menus, buttons, and the occasional custom control.

Adjusting Multiple Clips at the Same Time
There’s an easy way to make adjustments to the Inspector parameters of multiple clips at the 
same time, without needing to use Paste Attributes (described later in this chapter). All you 
need to do is simultaneously select every clip you want to alter, and then modify the parameter 
in the Inspector that you want to change. As a result, every selected clip will be adjusted by the 
same amount. This works for compositing effects, transforms, text parameters, filters, and audio 
settings, just about anything that can be simultaneously exposed in the Inspector for multiple 
selected clips.

When you select multiple clips, the Inspector will display “Multiple Clips” as the title. If each of 
the selected clips have different values in the parameter you’re adjusting, that parameter will 
have two dashes in the value field. There are two ways you can make adjustments to 
multiple clips:

 � If you want to make a relative adjustment to all selected clips while keeping their 
original offsets from one another, then drag the virtual slider in the parameter field 
which will display a + or – before however many units your adjustment is.

 � However, if you want to set all selected clips to the same value, you can double-click in 
the number field, type the value, and press Return.

Making a relative adjustment of plus 4.00 
in the Volume level of all selected clips
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Animated Inspector Adjustments
Keyframing in the Edit page works slightly differently than when using the Keyframe Editor in 
the Color page. Most simple keyframing tasks can be performed in the Inspector using three 
buttons that appear to the right of any parameter that’s capable of being keyframed. It takes 
two keyframes at minimum to create an animated effect.

The three keyframe controls that 
appear in the Inspector, from left to 
right: Previous keyframe, Create/
Delete keyframe, Next keyframe

Methods of keyframing parameters in the Inspector:
 � To add a keyframe: Select a clip, open the Inspector, then move the Timeline playhead 

to the frame where you want to place a keyframe, and click the Keyframe button next 
to the parameter of the Inspector you want to animate. Once you’ve added at least 
one keyframe to a parameter, all other adjustments you make to parameters in the 
Inspector, or using the onscreen Transform/Crop controls in the Timeline Viewer, add 
new keyframes automatically if the playhead is at another frame.

 � To move the playhead to the next or previous keyframe: Click the small left- or right-
hand arrow to either side of a parameter’s keyframe control to jump the playhead to the 
next or previous keyframe. You can also press Right-Bracket ( [ ) and Left-Bracket ( ] ) to 
go from keyframe to keyframe.

 � To edit an existing keyframe of a parameter: Move the playhead to be on top of the 
keyframe you want to edit, and then change that parameter, either in the Inspector, or 
using the onscreen controls of the Timeline Viewer.

Methods of changing keyframe interpolation in the Inspector:
 � To change a keyframe to Ease In or Ease Out: Eased keyframes create animated 

changes that begin slowly and accelerate to full speed, or slow down gradually to 
decelerate to a stop. This only works when you have two or more keyframes creating 
an animated effect. Move the playhead to a frame with a keyframe using the next/
previous keyframe controls, then right-click the orange keyframe button and choose 
Ease In, Ease Out, or Ease In and Out, depending on which keyframe you’re editing and 
the effect you want to create.

 � To change a keyframe to Linear: Move the playhead to a frame with a keyframe using 
the next/previous keyframe controls, then right-click the orange keyframe button and 
choose Linear.

Methods of deleting keyframes and disabling keyframed effects:
 � To delete a single keyframe: Open the Inspector, move the Timeline playhead to a frame 

with a keyframe, and click the orange Keyframe button in the Inspector to delete it.

 � To delete all keyframes for one parameter: Click the reset button to the right of a 
parameter’s keyframe control in the Inspector.

 � To delete all keyframes in a group of parameters in the Inspector: Click the reset 
button to the right of a parameter group’s title bar in the Inspector.
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 � To disable or enable a single parameter’s keyframed effect: In the Timeline, click the 
toggle control at the left of a parameter’s keyframe track. Orange means that track’s 
enabled. Gray is disabled.

 � To disable or enable a group of parameters in the Inspector: Click the toggle control 
at the left of a parameter group’s title bar in the Inspector. Orange means that group is 
enabled. Gray is disabled.

Paste and Remove Attributes
The Fairlight page has Paste Attributes and Remove Attributes commands that allow for the 
copying and resetting of audio Inspector parameters and effects, similar to the same commands 
on the Edit page. For more information on how to do this, see Chapter 154, “Editing Basics in 
the Fairlight Page.”

Seeing Effects in the Timeline
When you adjust any clip’s Inspector controls, or add any kind of plug-in to a clip in the 
Timeline, be it an adjustment in the Inspector or a plug-in you’ve applied, clips with that effect 
applied appear a darker shade of whatever color they are. Removing all effects from a clip (for 
example, using the Remove Attributes command) returns that clip to its original color. This 
makes it easy to see, at a glance, which clips have effects, and which clips don’t.

A closeup of the Timeline with a darker clip with effects between 
two other regularly-colored clips without effects

Setting Clip Volume
Each audio clip, or audio item in the case of audio clips with linked audio on multiple tracks, has 
its own Volume level. This means that audio clips with multiple channels share a common 
Volume setting. There are several ways you can adjust these levels simply.

Adjusting Volume in the Inspector
Each clip has individual Volume parameters that are accessible in the Audio panel of the 
Inspector when one or more audio clips are selected.

The Volume parameters available for 
audio clips in the Inspector
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Selecting an audio clip in the Timeline and adjusting its Volume only alters the volume levels of 
that clip, which lets you adjust basic levels for individual clips in your program. The Volume 
control affects every channel within that clip simultaneously. 

If you select multiple clips in the Timeline, then adjusting the Volume or Pan sliders or virtual 
sliders for all of them simultaneously will make a relative adjustment to all of the clips, 
preserving their offsets from one another. If you want to set all clips to the same level, then 
making a numeric adjustment will set all selected clips to the same absolute level.

Adjusting Volume in the Timeline
Each clip (or item) of audio in the Timeline has a Volume overlay that lets you set that clip’s level 
by simply dragging it up or down with the pointer. This overlay corresponds to the Volume 
parameter in the Inspector.

Dragging a Volume overlay to adjust the clip level

Additionally, you can click any clip’s Audio Curve Editor button, at the bottom right-hand corner 
of each audio clip, to open an audio-specific Curve Editor with which you can keyframe not just 
Volume, but Pan, and the parameters of any audio filters you might have applied to that clip.

Adding and Adjusting Volume Keyframes in the Timeline
Mixing audio by adding and adjusting individual keyframes can be a fast and effective way of 
balancing clip levels with one another and of fixing clip-specific dynamic level problems. When 
manually editing any audio parameter curve, you can use the following procedures.

Methods of adjusting the Volume curve using the pointer:
 � To adjust any curve segment: Position the pointer over the overall segment for clips 

with no keyframes, or position it between any two keyframes, directly on top of the 
curve segment you want to raise or lower. When the move cursor is displayed, click and 
drag up to raise the Volume, or down to reduce the Volume.

 � To add keyframes to the level curve: Hold the Option key down and click the curve 
to place a keyframe at that frame. You must add at least two keyframes to create an 
automated change in Volume.

 � To adjust a keyframe in any direction: Move the pointer over a keyframe so that the 
four-way cursor appears, and then click and drag up or down to change the Volume, or 
side to side to change it’s timing.

 � To adjust a keyframe in only one direction: Move the pointer over a keyframe so 
that the four-way cursor appears, and then click and drag in the intended direction 
of adjustment, either vertically to change the volume of the clip at that frame, or 
horizontally to move the keyframe to a different point in time. Once you start dragging a 
keyframe into a particular direction, keyframe movement is constrained in that direction 
until you release that keyframe.
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 � To select one or more keyframes: Click any keyframe to select it. 

 � To select multiple discontiguous keyframes: Command-click all keyframes you want to 
select, whether they’re next to one another or not.

 � To select multiple contiguous keyframes: Click the first keyframe you want to select, 
and then shift-click the last keyframe you want to select, and all keyframes between will 
also be selected.

Normalize Audio Levels Command
The Normalize Audio Levels command automatically adjusts the level of clips to a specific 
target level, and you can choose the method used to analyze each audio clip’s levels to 
determine how to normalize each clip’s volume. Options include a variety of loudness 
normalization algorithms specific to various international standards, which are useful for 
balancing the perceived overall loudness of several clips to one another, regardless of transient 
levels throughout each clip. You can also do Peak normalization, with options for both Sample 
Peak and True Peak.

The various loudness options are designed to analyze an audio signal based on its perceived 
loudness to the listener, which results in a more accurate automatic balancing of different clips’ 
audio levels to one another, regardless of transient peaks occurring throughout different clips.

The target peak meter now uses the BS.1774 standard for measuring maximum “true peak,” 
which means that this meter is capable of measuring “inter-sample peaks,” rather than only the 
peaks at each sample of a waveform. However, you still have the option to measure Sample 
Peak, which is the previous method of measuring the actual peak of the samples in a media file.

The change made by the Normalize Audio Volume command is only a volume adjustment; no 
dynamics are applied, so the result of using this command is that the loudest parts of each 
selected clip are going to match one another at the target level. This command is also available 
in the Fairlight page.

To normalize one or more selected audio clips:
1 Right-click one of the selected clips and choose Normalize Audio Levels. The 

Normalize Audio Level dialog appears.

The Normalize Dialog in the Fairlight page

2 Choose the Normalization Mode you want to use. You can choose among a variety of 
standardized loudness measurement algorithms, or Sample Peak, or True Peak.

3 Choose the reference level that you want to set the peak volume of the selected clips 
to match, in dBFS.

Chapter – 155 Audio Clip Specific Inspector Adjustments 3240



4 Choose how you want to set the level of multiple selected clips:

 – When Set Level is set to Relative, all selected clips are treated as if they’re one clip, 
so that the highest peak level of all selected clips is used to define the adjustment, 
and the volume of all selected clips is adjusted by the same amount. This is good if 
you have a series of clips, such as a dialog recording, where the levels are consistent 
with one another, and you want to normalize all of them together.

 – When Set Level is set to Independent, the peak level of each clip is used to define 
the adjustment to that clip, so that the volume of every selected clip is adjusted by 
an amount specific to that clip. The end result may be a set of very different volume 
adjustments intended to make the peak levels of each audio clip match one another. 
This is good if, for example, you’re trying to balance a series of different sound 
effects with one another that have very different starting levels.

For more information about loudness normalization, see Chapter 160, “Audio Meters 
and Audio Monitoring.”

Clip Pan
Each audio clip in the Timeline has a simple stereo Pan control that lets you pan that clip. 
While most professional mixes will restrict panning to the more robust panner found in the 
Fairlight page Mixer, this simple clip-based Pan control is useful for editors of visuals working in 
the Edit page to quickly create simple panning effects to aid in a craft edit. Dragging the slider 
lets you pan audio left to right. This control is centered at 0 by default.

Clip Pan Control

Clip Pitch Controls
Each audio clip in the Timeline has Clip Pitch controls that let you alter the pitch of a clip without 
changing the speed. Two sliders let you adjust clip pitch in Semi Tones (large adjustments, a 
twelfth of an octave) and Cents (fine adjustments, 100th of an octave).

Clip Pitch control in the Inspector

Clip EQ
Each audio clip in the timeline has a four-band equalizer that has both graphical and numeric 
controls for boosting or attenuating different ranges of frequencies within that clip, before it 
even gets to the EQ built into the mixer. Each band has controls for the filter type (Bell, Lo-Shelf, 
Hi-Shelf, Notch), Frequency, Gain, and Q-factor (sharpness of the band), with the available 
controls for each band of EQ changing depending on the filter type.
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When a channel strip’s EQ is enabled, the EQ button displays the equalization curve that’s 
being applied. This indicator cannot be adjusted; you must open the EQ window to 
make modifications.

The channel strip’s EQ indicator, (Left) EQ is at detent, (Right) EQ is adjusted

Master EQ Controls
The Equalizer window has the following overall controls:

 � Enable button: Turns the overall EQ effect off and on, without resetting the controls.

 � Reset button: Resets all controls of the EQ window to their defaults.

Graphical EQ Controls
A graph at the top shows a curve with handles that correspond to each of the enabled 
EQ bands listed below. You can drag any numbered handle to boost or attenuate the range of 
frequencies governed by that band, using whatever type of equalization that band has 
been set to.

The EQ graph with user-draggable handles

Dragging the numbered handles on this graph in turn modifies the parameters of the 
corresponding band, and changing each band’s parameters will also alter the EQ graph, which 
serves the additional purpose of providing a graphical representation of the equalization being 
applied to that track.
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Bands 1 and 4
The outer two sets of band controls let you make high-pass and low-pass adjustments, 
if necessary.

 � Band enable button: Turns each band of EQ on and off.

 � Band filter type: Bands 1 and 4 can be switched among four specific filtering options 
for processing the lowest or highest frequencies in the signal. These include (from top 
to bottom) Hi-Shelf, Hi-Pass, Bell, Notch, Lo-Pass, and Lo-Shelf. Bands 2 and 3 can be 
switched among Lo-Shelf, Bell, Notch, and Hi-Shelf.

 � Freq: Adjusts the center frequency of the EQ adjustment.

 � Gain: Adjusts the amount by which the affected frequencies are affected. Negative 
values attenuate those frequencies, while positive values boost those frequencies.

Bands 2 and 3
 � The middle two sets of band controls let you make a wide variety of equalization 

adjustments.

 � Band enable button: Turns each band of EQ on and off.

 � Band filter type: Bands 2–5 can be switched among four different filtering options 
(from top to bottom): Lo-Shelf, Bell, Notch, and Hi-Shelf.

 � Frequency: Adjusts the center frequency of the EQ adjustment.

 � Gain: Adjusts the amount by which the affected frequencies are affected. Negative 
values attenuate those frequencies, while positive values boost those frequencies.

 � Q Factor: Adjusts the width of affected frequencies. Lower values include a wider 
range of frequencies; higher values include a narrower range of frequencies.

Paste and Remove Attributes 
for Clips and Tracks
The Fairlight page has Paste Attributes and Remove Attributes commands that allow for the 
copying and resetting of audio parameters and effects, similar to the same commands on 
the Edit page.

The Paste Attributes dialog in the Fairlight page
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Chapter 156

Mixing in the 
Fairlight Page

The Mixer is the spider at the center of the web that is the Fairlight page, 
and provides the primary tools you’ll use to mix the various audio tracks of 
your program into a harmonious whole using EQ, Dynamics, Panning, level 
control, and VST and Audio Units audio effects of all kinds, all with full 
automation, to hone your sound and balance each track’s elements with 
the others. This chapter focuses on explaining the various functions of the 
Mixer so you can harness its power for yourself.
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Introduction to Mixing
This chapter describes the use of the Mixer to adjust the levels and fine-tune the audio of each 
track in the timeline. It’s focused on the function of the channel strip controls, with the 
following exceptions:

 � For more information about busing, see Chapter 150, “Setting Up Tracks, Buses, 
and Patching.”

 � For more information about recording audio, see Chapter 152, “Recording.”

 � For more information about recording automation, see Chapter 157, 
“Automation Recording.”

The Mixer
The Audio Mixer provides a set of graphical controls you can use to assign track channels to 
output channels, adjust EQ and dynamics, set levels and record automation, pan stereo and 
surround audio, and mute and solo tracks. At its most basic, each audio track in your timeline 
corresponds to an individual channel strip in the Mixer, and by default there’s a single Main bus 
labeled M1 that combines all these tracks into an overall mix.

The Audio Mixer, with channel strips corresponding 
to the tracks in the Timeline

Tracks and Buses
Once you start creating buses, the Audio Mixer exposes two sets of channel strips. 
The left-most set of channel strips correspond to the audio tracks in the Timeline, while the 
right-most set of channel strips expose sets of controls for each Main, Sub (submix), and 
Aux (auxiliary) bus that you’ve created. 
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The Audio Mixer is divided into two sections, one for tracks (at left) and one for buses (at right)

If you have more tracks and buses than can be displayed all at once given the width of your 
computer display, then each half of the mixer has independent scroll bars so you can choose 
which tracks and which buses you want to see next to one another.

Each audio track’s channel strip has a set of Main and Sub bus buttons that let you assign the 
audio output by that channel strip to a Sub (typically used to combine different subsets of tracks 
into submixes) or to a Main (typically used to output or render overall mixes). Each Sub and 
Aux’s channel strip has a set of Main buttons so that different combinations of Subs can be 
assigned to each Main. Main channel strips have no buttons because, from a busing 
perspective, they’re the final output.

Main and Submix buttons let you assign tracks to buses, and buses to other buses

Customizing the Onscreen Mixer Controls
The Option menu at the upper right-hand corner of the Mixer provides a number of different 
options for customizing the look of the Mixer, as well as which controls are shown or hidden.

First, you have the options of showing the Full Track Mixer or the Small Track Mixer. While the 
Full Track Mixer provides more room for buttons and controls that are large enough you don’t 
have to squint to see them, the Small Track Mixer lets you have many more channel strips 
onscreen at one time, for those times where you’re doing incredibly ambitious mixes.

The Small Track Mixer view
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Second, there’s an option to Show Labels, which are the control names listed in a column to the 
left of the mixer channel strip area. If you’re first getting started, these Labels are useful, but 
once you’ve gotten used to the layout of the Mixer, hiding these will give you a bit more room to 
work with for another channel strip or two.

Third, there’s a set of options that let you toggle the visibility of specific channel strip controls, 
so you can hide controls you know you’re not going to be using, or that you’ve used but no 
longer need to adjust or want to protect from accidental adjustment by a wandering 
mouse or pen.

Managing Channel Strips Using the Index
The Index is a consolidated list view of all the tracks in the current Timeline, designed to make it 
easier to manage timelines with lots of tracks. Columns let you see each track’s visibility, track 
number, name, controls, channel format, and Group assignment. The controls in these columns 
let you manage the tracks in the current Timeline by showing or hiding them, toggling track 
controls, or rearranging them. You can also right-click on one or more selected tracks to color 
code them, or change the channel assignment.

The Tracks panel of the Index hiding tracks 1–4 on 
both the Timeline and the Mixer

Showing and Hiding Tracks
You can use the Tracks panel of the Index to hide tracks you don’t need to work on in order to 
create more room for tracks you need to see. To quickly show or hide a number of tracks, you 
can click and drag up or down over the eyeball button of each track for which you want to 
reverse the visibility.

Color Coding Tracks
Select one or more tracks, then right click one of the selected tracks and choose a color from 
the Change Track Color submenu of the contextual menu.

Toggling Lock, Record, Solo, and Mute
You can also use the Lock, Record, Solo, and Mute controls to quickly enable or disable 
multiple tracks by clicking and dragging up or down over the Lock, R, S, or M buttons you want 
to toggle.

Rearranging Tracks
Finally, you can rearrange tracks using the Index by clicking any track strip area between other 
controls, and then dragging that track up or down in the Index. As you drag, a white line shows 
you where that track will be inserted when you drop it. You can even select a contiguous series 
of tracks and drag them all to a new position in the Timeline at once.
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Reassigning Channel Mappings
Select one or more tracks, then right click one of the selected tracks and choose a channel 
assignment from the Change Track Type to submenu of the contextual menu.

Selecting Channel Strips and Tracks
When you select a track in the Timeline, you also select that track’s accompanying channel 
strip, and vice versa. It’s possible to select multiple tracks in the Timeline and thereby select 
multiple channel strips, but you can also Command-click to select multiple channel strips in 
order to select multiple tracks. 

Selecting multiple channel strips results in the selection of multiple tracks

Track Organization
Each channel strip has three organizational properties that let you keep track of which channel 
strip is responsible for which part of the mix.

 � Track color: Each track can be differently color-coded, to help you keep organized. 
These colors appear in the timeline track header, the mixer, and the meters to help you 
keep track of which track corresponds to which channel strip and meter.

 � Track number: The number of the timeline audio track corresponding to each channel 
strip appears here.

The track color and track number appear at the top of each channel strip

 � Track name: This mirrors the track name found in the header controls of the timeline. If 
you customize an audio track’s name in the timeline, that name appears here.

Each track’s name appears between the assignment 
buttons and the arm/solo/mute buttons
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Input
A drop-down menu that lets you patch inputs, patch buses, and configure the input settings of 
audio signals routed through Blackmagic hardware interfaces.

The Input drop-down menu provides 
shortcuts for patching different buses 
using the Patch Input/Output window

For more information on using the options of the insert menu, see Chapter 144, 
“Setting Up Tracks, Buses, and Patching.”

Effects
When you apply VST or Audio Unit effects to a track from the Effects Library, those effects 
appear here. Clicking the Plus button opens a drop-down menu with which you can apply any 
VST or AU effects installed on your machine to that track. 

Moving the pointer over the plus to add effects

Hovering the mouse over any listed effect reveals controls for enabling/disabling each effect, 
opening an effect’s custom controls, and deleting that effect.

Moving the pointer over 
an effect reveals controls 
for that effect

For more information on using audio effects, see Chapter 152, “Audio Effects.”
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Insert
Enables the routing of effects from Blackmagic audio interface hardware to outboard effects 
boxes and back again. This button can be toggled to enable/disable such routing.

EQ
Double-clicking exposes a four-band parametric equalizer with additional Hi and Lo Pass filters, 
that has both graphical and numeric controls for boosting or attenuating different ranges of 
frequencies of audio on each track. You can select from among four types of EQ filtering from 
the Equalizer Type drop-down menu, with options for Earth (the default), Air, Ice, and Fire. Each 
band has controls for the filter type (Bell, Lo-Shelf, Hi-Shelf, Notch), Frequency, Gain, and 
Q-factor (sharpness of the band), with the available controls for each band of EQ changing 
depending on the filter type.

The channel strip EQ window

When a channel strip’s EQ is enabled, the EQ button displays the equalization curve that’s 
being applied. This indicator cannot be adjusted, you must open the EQ window to 
make modifications.

The channel strip’s EQ indicator, 
(Left) EQ is adjusted, (Right) EQ is detent

Master EQ Controls
The Equalizer window has the following overall controls:

 � Enable button: Turns the overall EQ effect off and on, without resetting the controls.

 � Reset button: Resets all controls of the EQ window to their defaults.
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 � Equalizer Type: Changes the EQ control functionality to emulate different EQ 
characteristics from “classic” mixing consoles. There are four options:

 – Earth: (Default) Native Fairlight controls

 – Air: Emulates the SSL 4K

 – Ice: Emulates the Neve V

 – Fire: Emulates the Focusrite

 � Gain fader: A post-EQ level control that lets you boost or attenuate the signal to 
compensate for the EQ adjustment you’re making raising or lowering the level.

Graphical EQ Controls
A graph at the top shows a curve with handles that correspond to each of the enabled EQ 
bands listed below. You can drag any numbered handle to boost or attenuate the range of 
frequencies governed by that band, using whatever type of equalization that band has 
been set to.

The EQ graph with user-draggable handles

Dragging the numbered handles on this graph in turn modifies the parameters of the 
corresponding band, and changing each bands parameters will also alter the EQ graph, which 
serves the additional purpose of providing a graphical representation of the equalization being 
applied to that track.

Bands 1 and 6
The outer two sets of band controls let you make high-pass and low-pass adjustments, if 
necessary. They’re off by default.

The Band 1 and 6 controls

 � Band enable button: Turns each band of EQ on and off.

 � Band filter type: Bands 1 and 6 can be switched among four specific filtering options 
for processing the lowest or highest frequencies in the signal. These include (from top 
to bottom) Hi-Shelf, Hi-Pass, Lo-Pass, and Lo-Shelf.
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 � Frequency: Adjusts the center frequency of the EQ adjustment

 � Gain: Adjusts the amount by which the affected frequencies are affected. Negative 
values attenuate those frequencies, while positive values boost those frequencies.

Bands 2–5
The middle four sets of band controls let you make a wide variety of equalization adjustments. 
They’re on by default, to make it easy to begin making adjustments.

The Band 3 controls

 � Band enable button: Turns each band of EQ on and off.

 � Band filter type: Bands 2–5 can be switched among four different filtering options 
(from top to bottom) Lo-Shelf, Bell, Notch, and Hi-Shelf

 � Frequency: Adjusts the center frequency of the EQ adjustment

 � Gain: Adjusts the amount by which the affected frequencies are affected. Negative 
values attenuate those frequencies, while positive values boost those frequencies.

 � Q Factor: Adjusts the width of affected frequencies. Lower values include a wider 
range of frequencies, higher values include a narrower range of frequencies

Dynamics
Double-clicking exposes a set of dynamics controls with three sets of controls corresponding to 
an Expander or Gate, a Compressor, and a Limiter that can be used separately or in concert to 
manage the dynamics of the audio on that track.
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The channel strip Dynamics control window

When you enable whatever combination of dynamics controls you need for that track, the 
dynamics graph updates with curves that show you how the signal is being affected by the 
Expander or Gate, Compressor, and/or Limiter settings that are being applied.

The dynamics graph shows how the signal 
is being affected by the current settings

With these dynamics enabled, the Dynamics button on the channel strip displays these curves, 
so you know what’s happening to that channel. This indicator cannot be adjusted, you must 
open the Dynamics window to make modifications.

The channel strip’s Dynamics 
indicator, (Left) Dynamics at 
detent, (Right) Dynamics adjusted
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Master Dynamics Controls
The Dynamics window contains the following overall controls at the top of the window:

 � Reset button: Resets all controls of the EQ window to their defaults.

 � Make Up fader: A post-Dynamics level control that lets you boost the signal to 
compensate for dynamics settings that have lowered the level.

Expander/Gate
The first of three sets of dynamics parameters, these controls can be switched between 
expansion and gating. Expansion emphasizes differences in volume by lowering the level of 
soft parts of the signal relative to the level of louder parts, and can be used to minimize noise 
while increasing the dynamic range of a signal. Gating reduces the level or even silences parts 
of a signal that fall below a certain level threshold in order to reduce or eliminate noise in quiet 
parts of a recording.

 � Expander: A button that lets you enable these controls and switch them to 
perform expansion.

 – Threshold: Sets the signal level below which gain reduction occurs. Defaults to 
–35dB. The range is from –50 to 0dB.

 – Range: Unused for expansion.

 – Ratio: Sets the gain reduction ratio (input to output) that’s applied to signals which 
fall below the threshold level. Defaults to 1:1.1. The range is 1.0:1 to 10:1.

 – Attack: Adjusts how quickly the sidechain detector applies expansion when a signal 
exceeds the threshold. Defaults to 1.4mS (milliseconds). The range is 0 to 100mS.

 – Hold: Keeps dynamics from being triggered again until a certain amount of time has 
passed, in mS. Defaults to 0mS. The range is from 0 to 4000mS.

 – Release: Adjusts how quickly or gradually the sidechain detector stops applying 
dynamics when a signal goes back below the threshold. Defaults to 93mS. The 
range is 0.03 to 4.03mS.

 � Gate: A button that lets you enable these controls and switch them to perform gating.

 – Threshold: Sets the signal level below which gain reduction occurs. The range is 
from –50 to 0dB.

 – Range: Sets the maximum amount of gain reduction that will be applied when the 
signal falls below the gate threshold. Once the signal has fallen below the level 
determined by the gate threshold minus the gate range, no gain reduction is applied. 
The default is 18. The range is from 0 to 60.2dB.

 – Ratio: Unused for gate.

 – Attack: Adjusts how quickly the sidechain detector applies gating when a signal 
exceeds the threshold. Defaults to 1.4mS. The range is 0 to 100mS.

 – Hold: Keeps dynamics from being triggered again until a certain amount of time has 
passed, in mS (milliseconds). Defaults to 0mS. The range is from 0 to 4000mS.

 – Release: Adjusts how quickly or gradually the sidechain detector stops applying 
dynamics when a signal goes back below the threshold. Defaults to 93mS. The 
range is 0.03 to 4.03mS.
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Compressor
The second set of dynamics parameters let you apply compression, which detects the 
envelope of an audio signal in order to automatically change its level. Typically used to detect 
and reduce the peaks of an audio signal so that the overall level can be boosted without 
clipping, thus reducing the dynamic range of a given signal. Compression is often used to allow 
voices to have more presence within a mix, and to smooth out changes in the levels of tracks 
with too much dynamic range for the task at hand.

 � Compressor: A button that lets you enable compression.

 – Threshold: Sets the signal level above which compression is applied.  
The default is –15dB. The range is –50 to 0dB.

 – Ratio: Adjusts the compression ratio. This sets the gain reduction ratio 
(input to output) applied to signals which rise above the threshold level. The default 
is 2.0:1. The range is 1.0:1 to 10:1.

 – Attack: Adjusts how quickly the sidechain detector applies compression when 
a signal exceeds the threshold. The default is 1.4mS (milliseconds). The range 
is 0 to 100mS.

 – Hold: After the attack phase has been completed, the Hold parameter controls how 
long this initial attenuation is maintained, before entering the release phase. Defaults 
to 0mS. The range is from 0 to 4000mS.

 – Release: Adjusts how quickly or gradually the sidechain detector stops applying 
dynamics when a signal goes back below the threshold. The default is 93mS. The 
range is 0.03 to 4000mS.

 � Send: Enable Send when you want to use the audio levels of the currently selected 
track to attenuate those of another track using sidechain compression. For example, 
you can turn on the compressor and enable Send for all tracks with dialog, in order to 
use those levels to attenuate the levels of another track containing music. 

 � Listen: Enable Listen when you want to use the audio levels of tracks that you set 
to Send to attenuate the levels of the currently selected track. If there are no tracks 
with Send enabled, then the current track is compressed as usual, using itself as the 
sidechain.

The following procedure shows how to set up a Compressor to automatically attenuate, or 
“duck” a music track whenever someone speaks in clips on one or more other tracks of 
the Timeline.

To use sidechain compression to automatically “duck” music in the presence of 
dialog on other tracks:

1 Edit dialog into one track of the Timeline, and edit overlapping music into another track 
of the Timeline.

Choosing the track header in the Fairlight timeline to add Dynamics
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2 Click the track header or channel strip of a track with dialog to select that track, 
and then double-click the Dynamics indicator on the channel strip to open the 
Dynamics window.

3 Turn on the Send button to automatically send all levels from that track to the sidechain 
of a Compressor on another track (it’s not necessary to turn on Compressor for this). If 
you hover the pointer over the Send button, a tooltip will show you which tracks of the 
current timeline are set to Send.

4 If you have multiple tracks with dialog, you can repeat steps 2-3 for each so that the 
output levels of all dialog are sent to the sidechain.

Turning on Send in the 
Compressor of a track with dialog

5 Next, click the track header or channel strip of a track with music to select that track. If 
you haven’t closed the Dynamics window, the header will show you that the Dynamics 
controls are now those of the newly selected track.

6 Turn on Compressor, and then turn on the Listen button to automatically feed all “sent” 
levels to the sidechain of the Compressor on this track. If you hover the pointer over 
the Listen button, a tooltip will show you which tracks of the current timeline are set 
to Listen.

7 At this point, you need to lower the Threshold and raise the Ratio controls to the 
appropriate levels so that as dialog is heard, the music is compressed to be less loud. 
You may also want to raise Hold so this gain reduction doesn’t fluctuate too wildly, and 
raise Release so the volume adjustment doesn’t end too abruptly.

Turning on Listen in the 
Compressor of a track with music
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If you’ve set this up correctly, then during playback the Sidechain meter should show 
the levels of the dialog tracks with Send enabled, and the Gain Reduction meter should 
show you how much the gain of the music track is being reduced when triggered by the 
dialog being fed to the Sidechain. 

As a result, you should hear that whenever speech plays, the music volume is 
automatically lowered. Adjust Threshold and Ratio to set the amount of this gain 
reduction, and adjust Attack, Hold, and Release to set how quickly gain reduction 
responds to changes in the Sidechain level (as defined by the Send levels).

Limiter
The third set of dynamics parameters let you apply limiting, which imposes a hard limit on the 
maximum level allowed for a particular signal.

 � Limiter: A button that lets you enable Limiting.

 – Threshold: Sets the maximum allowable output level. The default is –21dB. 
The˛range is from –50 to 0dB.

 – Attack: Adjusts the attack rate time constant of the sidechain detector. The default is 
0.71mS. The range is 0 to 100mS.

 – Hold: Keeps dynamics from being triggered again until a certain amount of time has 
passed, in mS (milliseconds). Defaults to 0mS. The range is from 0 to 4000mS.

 – Release: Adjusts how quickly the sidechain detector stops applying dynamics when 
a signal goes back below the threshold. The default is 90mS. The range is 0.03 to 
4.03mS.

Aux
Lets you route that track’s channels through an Aux send bus. Each Aux bar corresponds to a 
specific Aux bus that you created. Double-clicking any of these bars opens up the Auxiliaries 
window, with which you can enable or disable auxiliaries, set each one to be routed pre the 
channel strip or post the channel strip (the default), and set the send level and pan value for 
each Aux bus. The controls for multiple Aux buses appear stacked within a single window.

The Auxiliaries control window for a mix with two Aux Buses

Each Aux bus you create exposes the following controls in the Auxiliaries window:

 � On: Turns that Aux send on or off.

 � Pre: Switches that Aux send to be processed either pre or post fader. Turning this 
button on enables that track to send levels to the Aux bus before level adjustments on 
that track are applied. One common use of this is to enable a plug-in applied by the 
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Aux bus to continue to produce a “wet” version of that track’s audio while the mixing 
level is set all the way down, while raising the mixing level up mixes a “dry” version of 
the audio track against the “wet” levels produced by the Aux bus effect. For example, 
with Pre turned on you could slowly mix fade the original track level up over time over 
an Aux bus with a Delay effect to create the illusion that the echos of someone talking 
down a long hallway are giving way to a character’s own voice as they walk closer to 
the microphone.

 � Send Level: Adjusts the amount of signal sent from the selected feed to the auxiliary 
bus. The range is OFF to +10dB.

 � Pan: Provides panning across stereo Aux bus destinations.

The level to which you set an Aux bus will be shown within the bar that represents that Aux bus 
in the Mixer’s channel strip.

The Auxiliaries levels shown in the 
channel strip of the Mixer

Pan
The Mixer provides access to two kinds of pan controls, depending on whether you’re doing 
stereo and surround or 3D positioning in your mix.

The Stereo and Surround Pan Controls
A Pan control that’s compatible with stereo and surround panning. You can drag the panning 
handle within this control to adjust panning for stereo or surround mixing, or you can 
double-click this control to expose a large Pan window. What controls are available in the 
Pan window depend on the mapping of the audio track, but both stereo and surround panning 
controls are available, with corresponding numeric controls. You can either adjust panning 
using the graphical Pan control, or you can adjust specific panner characteristics using the 
controls to the left.

The Pan control window
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When a channel strip’s Pan control is enabled, the Pan area displays the panning that’s being 
applied. Unlike the EQ or Dynamics controls, you can adjust a channel’s panning by dragging 
the handles that appear within this small area of the channel strip.

The channel strip’s Pan indicator

The Audio Pan window contains the following controls:

 � Left/Right: Changes the balance of signal between the left and right side speakers 
you’re outputting to, depending on what speaker format you’re mixing to. At its simplest, 
accommodates stereo output.

 � Front/Back: Changes the balance of signal between the front and back sets of 
speakers you’re outputting to, depending on what speaker format you’re mixing to.

 � Rotate: Simultaneously adjusts the left/right and front/back pan controls in order to 
rotate a surround mix about the centre of the room.

 � Spread: Only available when a linked group of mono tracks is selected. Spread adjusts 
the perceived size of a surround mix.

 � Divergence: Spreads the signal for an individual feed across more of the adjacent 
loudspeakers, making the perceived size of the sound source larger.

 � Boom: The send level of that track to the LFE part of the mix.

 – On: Enables this functionality.

 – Pre: Lets you adjust the “dry” part of the signal separately from the “wet” part of the 
signal when effects are applied.

The 3D Audio Pan Controls
Option-double-clicking on the Pan control of the Mixer opens an alternate 3D Audio Pan 
window. Whereas the regular Pan window lets you do stereo and conventional 5.1 and 7.1 
surround panning, the 3D Audio Pan window lets you do the kind of spatial audio positioning 
enabled by advanced surround formats such as Auro 3D and NHK 22.2 (more information about 
specific support for these and other formats will come later). 

The 3D Pan window
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The 3D Audio Pan window has a few more controls than the ordinary Pan window:

 � Pan enable: Toggles the entire panning effect on and off.

 � Panner viewer: A large 3D representation of the listener’s perceived sound stage, with 
a blue sphere that represents the position of the track’s audio being positioned within 
that space, which casts a shadow straight down on the floor and projects a blue box on 
the four walls of this space to indicate its position more concretely.

 � Front panner: A 2D panning control that represents the horizontal left/right axis and the 
vertical up/down axis, letting you make these specific spatial adjustments.

 � Side panner: A 2D panning control that represents the horizontal front/back axis and 
the vertical up/down axis, letting you make these specific spatial adjustments.

 � Top panner: A 2D panning control that represents the horizontal left/right axis and the 
vertical front/back axis, letting you make these specific spatial adjustments.

 � Left/Right: A 1D knob that changes the balance of signal between the left- and right-
side speakers you’re outputting to, depending on what speaker format you’re mixing to.

 � Front/Back: A 1D knob that changes the balance of signal between the front and 
back sets of speakers you’re outputting to, depending on what speaker format you’re 
mixing to.

 � Rotate: A 1D knob that simultaneously adjusts the left/right and front/back pan controls 
in order to horizontally rotate a surround mix about the center of the room.

 � Tilt: A 1D knob that simultaneously adjusts the left/right and up/down pan controls in 
order to vertically rotate a surround mix about the center of the room.

 � Spread: Only available when a linked group is selected. Spread adjusts the perceived 
size of a surround mix.

 � Divergence: Spreads, or bleeds, the signal of an individual feed across the adjacent 
loudspeakers, making the perceived size of the sound source larger. A 2D button lets 
you set how this is done. With the 2D button turned off, divergence creates a one-
dimensional bleed between the left/right planes only. With the 2D button turned on, 
divergence creates a two-dimensional bleed between both the left/right and front/back 
planes of sound.

 � Boom: The send level of that track to the LFE part of the mix. An On button enables this 
functionality, while a Pre button lets you adjust the “dry” part of the signal separately 
from the “wet” part of the signal when effects are applied.

Bus Assignment Buttons
Two sets of buttons let you route audio from one channel strip’s output to Sub and Main buses 
that you’ve set up for your mix.

The channel strip’s bus assignment buttons

 � Main: These buttons let you assign a track or Sub’s channels to one or more of the main 
busses.

 � Submix: These buttons let you assign that track’s channels to one or more 
submix buses.
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Fader Groups (VCA Groups)
You can assign multiple faders to a Fader Group, also referred to as “VCA group,” which is 
controlled by a dedicated group channel strip that appears at the right of the mixer. Fader 
Groups let you simultaneously adjust multiple faders using one group fader, for instances where 
that will help you manage the levels of complex collections of audio tracks. 

The controls for doing this are found in the Group label area of each control strip, which also 
display which group each fader has been assigned to.

Group Labels in each control strip, 
above the control strip label

Making Fader Group Assignments
You can assign any fader to one of 16 groups by right-clicking the group label area and 
choosing a group from the drop-down that appears. If a fader is already assigned to a group, 
you can choose “No Group” to remove it.

Right-clicking a Group Label reveals a 
drop-down menu that lets you assign 
faders to or remove faders from groups
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Using Fader Groups
Once you’ve assigned multiple faders to a group, a dedicated channel strip for that group 
appears. Making adjustments to the group channel strip simultaneously controls all the faders, 
solo buttons, and mute buttons of all channel strips that are members of that group, as 
seen below.

Adjusting the Group 1 fader also adjusts the faders 
for Audio 1, 3, and 4 that are assigned to that group

While in a group, you can still move the faders of each individual channel strip independently to 
make relative adjustments. Channel strip faders only move together when you adjust the group 
fader, and while the group fader is being moved, each individual fader’s relative offset from 
other faders in that group is maintained, as seen in the previous screenshot, where the Group 1 
fader is moving the faders in tracks Audio 2, 3, and 4, but each individual channel strip fader in 
this group is offset from the others.

Recording Fader Automation for Groups
You can record automation data to the group fader, and all faders in that group will follow even 
though they’re not actually automated themselves. This makes it easy to record complex 
automation involving multiple faders when you still might want the freedom to finely adjust each 
individual fader later on.

Arm, Solo, and Mute Buttons
Identical to the controls found in the track header controls of each timeline audio track.

The channel strip’s Arm, Solo, and Mute bottons
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 � Record Arm: (highlights red when enabled) Lets you enable a track to be 
recorded onto. 

 � Solo: (highlights green for Solo, blue for Solo Safe) Lets you mute all other tracks in 
order to play a track you need to focus on in isolation. If solo is enabled for multiple 
tracks, all soloed tracks will play, and all non-soloed tracks will be muted. This 
affects rendering, so if one or more tracks are soloed, the muted tracks won’t be 
output or rendered.

 – Solo Safe: Command-Option-click a Solo button to put it into “Solo Safe” mode. 
Tracks set to Solo Safe, in which the Solo button is highlighted in blue, always play 
even if Solo is enabled for other tracks. This is good for tracks you want to continue 
listening to for reference even as you solo other specific tracks you want to pay more 
attention to.

 � Mute: (highlights orange when enabled) Turning on Mute disables audio playback from 
that track. This affects rendering, so if one or more tracks are muted, they won’t be 
output or rendered.

TIP: You can click a button and drag across multiple channel strips to turn that button 
on or off for multiple tracks easily.

Fader Controls
Each track’s vertical fader lets you control the level that’s output by that track, either using your 
mouse, or using the physical fader of your Fairlight console. If you’re working with a console, 
then the onscreen faders serve as a visual reference of what levels are set.

The fader area
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 � dB: Shows you the volume, in decibels, that track is currently set to.

 � Fader: Each track’s vertical fader can be dragged with your mouse or other pointing 
device to adjust the volume of that track and perform automation recording. Dragging 
up increases volume, dragging down decreases volume. Fader handles turn red while 
you record levels automation, and they turn green when automation has been recorded 
for that track.

Methods of adjusting channel faders:
 � To change the level of that channel with the mouse: Click and drag any 

fader up or down.

 � To reset the level of that channel to 0 dB: Double-click a fader’s handle. This does not 
work after you’ve recorded automation for a track.

Bouncing Audio
Bouncing audio refers to mixing and rendering audio from one or more Timeline tracks onto 
another track of the Timeline, in the process “baking in” processor intensive effects and 
complicated or intricate audio edits to create a new continuous piece of audio media that’s 
written to the directory location specified by the “Save clips to” field of the Capture and 
Playback panel of the Project Settings.

There are two commands available for bouncing audio on the Fairlight page when you hit the 
wall with how many tracks and effects you can mix in real time.

 � Timeline > Bounce Selected Tracks to New Layer

 � Timeline > Bounce Mix to Track

To use Bounce Selected Tracks to New Layer:
1 Set In and Out points to define the range of the Timeline you want to bounce. If you 

don’t do this, nothing will happen.

2 Command click the track headers or mixer channel strips of all tracks you want to 
bounce in order to select them.

3 Choose Timeline > Bounce Selected Tracks to New Layer.

The audio on each track is processed and rendered and appears as the top layer of 
audio on that track. While View > Show Audio Track Layers is turned off, it will appear 
as if the new bounced audio is the only clip on that track. However, the original audio 
with live effects is still available as the bottom of the stack of layered audio on that 
track, and turning View > Show Audio Track Layers on will show this. The bounced 
audio is a new audio media file that’s written to the directory location specified by the 
“Save clips to” field of the Capture and Playback panel of the Project Settings.

To use Bounce Mix to Track:
1 Choose Timeline > Bounce Mix to Track. The Bounce Mix to Track window appears, 

showing each main, submix, and auxiliary that’s currently available.

2 In the Destination Track column, set which mixes you want to bounce by choosing 
either New Track, or choosing a specific existing track from the drop-down menus.

3 Click OK.
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The specified mix is processed, mixed, and bounced to the specified track as a new 
piece of audio. This creates new audio media that’s written to the directory location 
specified by the “Save clips to” field of the Capture and Playback panel of the 
Project Settings.

TIP: There’s also a Bounce Audio Effects command in the contextual menu of audio 
clips in the Timeline that have audio plug-ins applied to them. For more information, 
see Chapter 158, “Audio Effects.”

Third-Party Control Panel 
Support for Mixing
DaVinci Resolve supports HUI- and MCU-compatible third-party mixing control panels with up 
to eight faders, such as the Mackie MCU Pro Control Surface, connected via USB MIDI, and 
selectable in the Control Panels panel of the Resolve System Preferences. Supported basic 
panel controls that correspond to Fairlight features at the time of this writing include the 
following.

Transport controls including:

 – Rewind (REW)

 – Fast Forward (FF)

 – Stop (double-press the Stop button for Home in the Timeline)

 – Play (double-press the Play button to “play again”)

 – Record (press Record+Play to begin recording if one or more tracks is record-
enabled)

 – Jog control (Press SCRUB and rotate the jog wheel)

Channel Strip controls including:

 – Rotary controls for panning, with Rotary Value display and Rotary touch

 – Alphanumeric Track Name display

 – Record button to record-enable tracks (only works if an input is patched to a track 
input)

 – Solo, with a double-press selecting or de-selecting that track

 – Mute

 – Select to select the track corresponding to that channel strip

 – Fader control and optional Level display

 – Channel and Fader Bank buttons to move left and right among banks of channel 
strips

 – Double-press the Fader Bank Left button to move the playhead Home 
in the mixer (track 1)

 – Double-press the Fader Bank Right to move to the Master channel strips
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Marker buttons:

 – Marker to add a marker

 – Pressing the Marker+Stop buttons sets Home

 – Pressing the Marker+FF/REW buttons jumps the playhead forward or backward

Additional supported controls for control panels that have them include: 

 – Master Solo clear/restore

 – Undo (pressing the Undo+Option buttons does Redo)

 – Arrows to move the selection

 – Zoom horizontal and vertical controls

 – Audio Tracks, to turn Automation On/Off 

 – Write/Trim/Touch/Latch switches

 – Nudge controls

 – Cut, Copy, and Paste

Monitoring controls include: 

 – Level control

 – Dim

 – Mute

 – Alt Speaker

For more information on third-party mixing control panel support, see the Blackmagic Support 
site at https://www.blackmagicdesign.com/support/family/davinci-resolve-and-fusion.
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Chapter 157

Automation 
Recording

The Fairlight page provides simple, flexible, and com prehensive facilities 
for recording and editing mix automation data. Once recorded, all feed 
and bus mix parameter automation can be played back in perfect 
synchronization with the audio, including channel parameters, bus 
assignments, inserts, and direct outs.

The Fairlight page is designed to allow the operator to record every static 
and dynamic parameter change you make in the process of balancing the 
mix of tracks in the timeline. Mixer adjustments may be recorded for one 
or multiple parameters or channels at a time. Additionally, more 
adjustments may be added with each automation recording pass, which 
lets you create complex and detailed mixes that can be frame-accurately 
replayed at will.

This chapter covers automation mixing using the combined controls of the 
onscreen mixer and timeline. For more information on basic mixing 
operations, see Chapter 156, “Mixing in the Fairlight Page.”
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Automation Recording
While the recording of keyframe automation is most commonly associated with either the 
onscreen mixer or the Fairlight console, you can also record automation using controls found in 
the Inspector, or using the controls of the EQ, Dynamics, and Pan windows, thereby enabling 
you to record automation for the various audio effects that you’ve applied to a track. 

Recording automation refers to creating high-fidelity data that records changes you make to 
onscreen controls and/or Fairlight console controls, in real time as the Timeline plays, that will 
then control how those parameters will play back. In this way, you can create a dynamic mix 
where different audio level, pan, and EQ, dynamics, and other audio filter settings change over 
time to fade swells of music up and down, pan the sound effect of a car driving by from the left 
to the right speaker, or slowly increase the strength of a reverb effect applied to foley footsteps 
as a character walks into a long, dark cavern.

What You Can Automate
You can record automation for nearly every control in the mixer for channel strips 
corresponding to individual tracks, track groups, or busses, including the fader. Additionally, you 
can record automation for controls found in audio plug-ins that you use in your mix.

Automation Controls
The automation button, to the right of the transport controls, lets you show and hide the 
Automation toolbar.

Clicking the Automation button displays the automation toolbar

The Automation toolbar has buttons for each option that’s available for preparing to record 
automation in your mix.

Options found in the Automation toolbar

The Automation toolbar displays the following options:

 � Automation: Controls how automation data is recorded.

 – Write: Records absolute changes to control automation.

 – Trim: Records relative changes to control automation in order to increase or reduce 
levels that have already been recorded.

 � Touch: Defines what happens when you first adjust an automatable control.

 – Off: No automation is recorded.

 – Latch: Automation is recorded once you begin moving a control and continues 
recording after you release the control.

 – Snap: Automation is recorded once you begin moving a control and stops recording 
after you release the control; there is a brief interpolation from the last level you set 
to the prior recorded level.
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 � On Stop: Defines what happens when you release an automatable control.

 – Event: The last recorded automation value overwrites previous levels to the start of 
the next available recorded automation data (or event) in that track.

 – Hold: Deletes all previously recorded mixing data after what you’ve just recorded, to 
hold the last recorded level for the rest of that track.

 – Return: The last recorded automation value is interpolated to ramp back to the 
previously recorded automation values on that track.

 � Enables: The following buttons let you enable or disable different controls for 
recording automation.

 – Fader: Automates track and bus volume.

 – Mute: Automates the mute button.

 – Pan: Automates all pan controls.

 – EQ: Automates all EQ controls.

 – Comp: Automates just the Compressor controls in the Dynamics window.

 – Gate: Automates just the Gate controls in the Dynamics window.

 – Lim: Automates just the Limiter controls in the Dynamics window.

 – Aux: Automates the Auxiliary controls in the Auxiliaries window.

 – Plug-ins: Automates all plug-ins.

 – Misc: Automates the parameters of VST and Audio Unit plugins.

How to Record Automation 
There are two different ways you can set up the recording of automation for levels, panning, 
EQ, Dynamics, and other audio controls in the mixer.

Recording Automation for Multiple Tracks
You can use the following steps to record automated changes to any audio control in any 
control strip:

1 Open the Automation toolbar, and do the following three preparatory steps:

a Choose whether you’re going to write new automation, or trim automation that’s 
already recorded. Write mode is appropriate when you’re recording automation for 
the first time, or when you’re overwriting previous automation with brand new 
values. Trim mode is appropriate when you’re making incremental changes to 
previously recorded automation.

b Next, choose Touch and On Stop behaviors that are appropriate for the kind of 
automation recording you need to do.

2 Move the playhead to the beginning of the section of the timeline you want to record 
automation for. 

3 Next, initiate playback using any method (Spacebar, L, Play button, third-party or 
Fairlight audio control panel), and make whatever adjustments you want to the controls 
for which you’ve enabled automation recording. As you make adjustments, the affected 
fader control turns red to let you know you’re recording automation.

4 When you’re finished, stop playback using any method (Spacebar, K, Stop button, 
third-party or Fairlight audio control panel). Automation recording stops as well.
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Recording Automation for Specific Individual Tracks
You can use the following steps to record automated changes to controls in specifically armed 
control strips:

1 Open the Automation toolbar, and do the following three preparatory steps:

a Choose whether you’re going to write new automation, or trim automation that’s 
already recorded. Write mode is appropriate when you’re recording automation for 
the first time, or when you’re overwriting previous automation with brand new 
values. Trim mode is appropriate when you’re making incremental changes to 
previously recorded automation.

b Next, set Touch to Off, which disables across-the-board automation recording and 
requires you to arm specific tracks that you want to automate.

2 Click the automation arm button above the fader of any Mixer track to which you want 
to record automation. Even though the Touch control is set to off, moving a control on 
an armed channel strip will record automation in Latch mode.

The automation arming 
button above a fader in 
the Mixer

3 Move the playhead to the beginning of the section of the timeline you want to record 
automation for. 

4 Next, initiate playback using any method (Spacebar, L, Play button, third-party or 
Fairlight audio control panel), and make whatever adjustments you want to the controls 
for which you’ve enabled automation recording. While you make adjustments, the 
affected fader control turns red to let you know you’re recording automation. If you’re 
displaying the same automation data in the Timeline that you’re recording, you can see 
the new automation being drawn in real time, in red.

Automation being displayed while it’s recorded
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5 When you’re finished, stop playback using any method (Spacebar, K, Stop button, third-
party or Fairlight audio control panel). Automation recording stops as well. Displayed 
automation turns green once recording has stopped.

If you don’t like what you’ve done, you can undo and start over, or you can edit the 
automation using methods described later in this chapter. Or, you can back the 
playhead up and overwrite automation at any time with new automation.

Automation Preview Mode
Preview is an additional mix automation workflow, specifically for working across scene-based 
material. When enabled, mix items that are in preview are not controlled by pre-recorded 
automation, so they respond manually to their controls. These can subsequently be placed into 
write (or trim) to write actual automation. 

Typically, Preview mode is used to audition new mix settings for one particular section of a 
timeline, while other sections already have recorded automation data. Preview mode prevents 
pre-recorded automation from moving the controls the user is trying to adjust in the targeted 
section. As soon as the user is happy with the new adjustments, they can be written to the 
targeted section. 

Preview mode frees the faders (and other controls) from automation control, and lets you move 
them while you experiment with different levels and settings. Ordinarily, moving one or more 
controls implies writing automation data for those controls, but entering Preview mode lets you 
play with the controls as much as you like without committing to anything, only writing 
automation data when you’re ready. 

To engage the Preview state on enabled mix items, first enter Preview mode 
by doing one of the following: 

 � Toggle Preview in the Automation toolbar.

 � Press the Preview key on the Mix page of the Fairlight controller.

Once Preview is engaged:
 � Individual parameters can be switched into Preview Touch Latch.

 � You can use the AUTO key next to a fader to preview all enabled parameters 
on a channel.

 � You can use the Auto button on the screen mixer strips.

When you’re in Preview mode, all parameters in Preview are indicated by a BLUE 
automation indicator. 

Once in Preview mode, mix items can be placed into write (or trim) by:
 � Dropping in manually via the “Punch In” menu item. 

 � Dropping in manually with the In key on the Fairlight controller. 

 � Automatically using the Active In and Out points on the Fairlight controller.

Once enabled for Preview, parameters remain in that state regardless of transport 
starts and stops. This is different from putting mix items into WRITE, which must be 
done again after each transport stop. 

Other Preview-related operations include: 
 � Filling a range defined by In and Out points with all parameters currently in Preview. 

 � Gliding all parameters from their existing values at the Range In point to the Preview 
values at the Range Out point.
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Viewing Automation in the Timeline
Once you’ve recorded automation keyframes for a particular parameter, they can be made 
visible in an automation graph in the Timeline. While the automation controls are visible, an 
additional pair of controls appear in the header of each audio track. A drop-down lets you 
choose which automation waveform to view, with options for Fader, Mute, Pan, EQ, Compressor, 
limiter, Aux, and Plugins controls.

Mixing automation for the Fader shown in the Timeline

At the time of this writing, automation data cannot be cut, copied, or pasted.

Overwriting Automation
Once you’ve recorded automation for a particular clip, you can overwrite that automation in 
subsequent passes. Using either of the previously described methods of recording automation, 
adjusting the levels of a track control with previously recorded automation displays a red line 
that shows the new level relative to the previously recorded level.

Setting new levels to overwrite previously recorded automation displays a red line

Pressing play to actually record this new automation will overwrite the previous levels at this 
new value.

New automation overwrites the previous levels
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Editing Automation
When the automation toolbar is displayed, two additional tools appear in the regular toolbar. 
From left to right, these are the Pencil and the Select Range tools. These tools let you edit 
automation in different ways.

The Pencil and Select Range 
tools appear when you open the 
Automation toolbar

Drawing Automation Keyframes
You can use the pencil tool to literally draw new automation curves in the Timeline for 
whichever parameter’s automation data is visible. This can be a good way to smooth out ragged 
sections of automation without needing to re-record everything you did.

Simply click the Pencil tool, choose the automation data you want to edit in a track of the 
Timeline using the drop-down menu in the track header, and then click and drag to draw a new 
curve. While you’re drawing, the new curve appears in red, while the old curve appears in 
green, to help you see what you’re doing. When you’re finished, release the pointer button and 
the automation curve will be redrawn.

Using the Pencil tool to smooth out a section of automation

Adjusting and Deleting Automation Keyframes
The Select Range tool lets you adjust automation in two different ways. 

Adjusting Individual Keyframes
Using the Select Range tool, you can click and drag any automation keyframe up or down and 
left or right (bounded by its neighboring keyframes) to adjust it directly. When zoomed in, this 
can be an effective way of making minute adjustments to troublesome keyframes. The segment 
of automation affected by the keyframe you’re dragging appears red to show you the new 
curve you’re creating, while the previously recorded curve remains green. When you release 
the pointer button, the new shape will be drawn.
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Using the Select Range tool to adjust an automation keyframe

Adjusting and Deleting Multiple Keyframes
You can also use the Select Range tool to drag a bounding box to select multiple keyframes, in 
preparation for moving them or deleting them.

Dragging a bounding box over a section of 
automation using the Select Range tool

Once you release the box, that section of keyframes becomes highlighted.

Multiple automation keyframes selected

Once it’s highlighted, you can drag the selection to move it, or you can press the Delete key to 
delete it. The remaining section of the curve flattens out to fit the first and last keyframe of the 
selection.

The newly flattened section of the 
automation curve after deleting the 
selected keyframes
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Adding New Keyframes
You can also use the Select Range tool to add new keyframes to an automation curve. 
However, these are not Bezier keyframes, so they only let you create a single level adjustment 
at that frame. If you make a large adjustment with only a single new keyframe, you’ll end up with 
a squared off section of automation. For this reason, adding new keyframes should only be 
done when making small adjustments, unless you intend to create an abrupt change.

Adding and adjusting a keyframe using the Select Range tool, exaggerated for print

Playing Automation
After you’ve automated a mix, playing it back is as simple as moving the playhead to an area of 
the timeline prior to the recorded automation, and initiating playback. As the timeline plays, the 
onscreen controls for each automated parameter are shown in green, and move and update to 
show the recorded levels for those controls.

Green controls show 
which ones have recorded 
automation during playback
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Chapter 158

Audio Effects

Audio plug-ins let you apply effects to the audio clips in your mix, such as 
echo or reverb, noise reduction, aural enhancement, click and pop 
removal, and so on. DaVinci Resolve is compatible with a wide variety of 
third-party VST and Audio Unit effects for audio processing, and these 
can then be used either in the Edit or Fairlight pages. This chapter goes 
through the different methods available for applying and customizing 
effects for clips and for tracks.
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Elastic Wave Audio Retiming
Elastic Wave retiming is a fast and easy keyframe-based way of dynamically retiming audio, 
squishing and stretching different parts of a waveform to subtly retime audio playback for a 
variety of reasons, all while maintaining constant pitch. For example, if you’re using the audio 
from another take to replace that of the current take, but the performer’s timing is just a little bit 
different, you can use Elastic Audio to make small adjustments to retime the second 
performance to match the first.

To use Elastic Wave retiming on an audio clip:
1 In this example, two tracks of foley effects have been recorded, and the bottom one 

needs to be retimed to match the top one.

2 Right-click an audio clip and choose Elastic Wave retiming from the contextual menu to 
reveal the Elastic Wave retiming controls.

Enabling Elastic Wave

3 Command-click anywhere on the clip to add speed keyframes to parts of the waveform 
you want to retime by stretching or squishing. You can also place speed keyframes to 
lock parts of a waveform you don’t want to retime.

Adding a speed keyframe with Elastic Wave retiming enabled
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4 Dragging the speed keyframe to the left or right speeds up the audio on one side 
of the keyframe and slows down the audio on the other side of the keyframe, from 
that keyframe to the neighboring keyframes applied to that clip. Using an audio clip’s 
waveform as your guide, you can use multiple speed keyframes to match the waveform 
of one performance to the waveform of another, in order to make the timing match. Or, 
you can adjust speed keyframes freeform to manipulate performances or sounds for 
creative effect.

Adjusting a series of speed keyframes to 
retime one performance to match another

You can also drag the beginning or end of an audio clip to retime that portion of the clip 
going forwards or back to the next speed keyframe that’s been added.

5 If you’ve made some speed keyframe adjustments, but you find yourself wishing a 
speed keyframe you created had been placed at a different position relative to the 
audio waveform being adjusted, you can hold the Command key down and drag any 
speed keyframe to move it closer to or farther away from a part of the waveform you 
want it to retime. This fine-tunes the audio retiming adjustment occurring at that point 
in the clip.

 (Left) Before Command-dragging a speed keyframe to be closer 
to the original beginning of the sound being retimed, (Right) After

6 When you’re done, you can click the close button at the upper-left-hand corner to hide 
the Elastic Wave retiming controls.
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To remove Elastic Wave retiming keyframes, do one of the following:
 � To remove a single speed keyframes: Right-click on a speed keyframe and choose 

Remove Speed Keyframe from the contextual menu.

 � To remove all speed keyframes and eliminate the Elastic Wave retiming effect: Right-
click a clip and choose Reset Speed Curve.

NOTE: All Elastic Wave retiming adjustments you make in the Fairlight page appear in 
the Edit page as variable speed effects, accessible using the Retime controls. Be 
aware that while all Elastic Wave retiming effects can appear as Edit page retime 
effects, not all Edit page retime effects can appear as Elastic Wave retiming effects on 
the Fairlight page.

About Audio Plug-Ins
Single or multiple plug-ins can be applied to clips and to tracks. A total of 96 mono channels of 
plug-ins can be applied (a stereo plug-in uses two of these channels, a 5.1-aware plug-in six 
channels, and so on). Plug-ins are accessed via each track’s control strip, or via the Inspector 
which provides access to both clip and track plug-ins.

FairlightFX
FairlightFX are a DaVinci Resolve-specific audio plug-in format that runs natively on macOS, 
Windows, and Linux, providing high quality audio effects with professional features to all 
DaVinci Resolve users on all platforms.

VST and VSTi  
VST (Virtual Studio Technology) is an audio plug-in standard created by Steinberg. The VST 
standard allows third-party developers to create VST plug-ins for use within VST host 
applications, or to create VST host applications themselves. The VST plug-in standard is the 
most widespread audio plug-in standard in use today, with thousands of available plug-ins 
spanning the gamut from EQ and compression to reverb, denoising, de-essing, aural exciting, 
and much more.

The Fairlight page supports VST effects from Mono to 7.1 - and beyond. These effects can be 
inserted on mono channels or Link Groups. If a stereo VST effect is inserted on a LCR, LCRS, or 
5.1 Link Group, the left and right channels will be allocated to left and right Link Group channels 
automatically.

As of this writing, DaVinci Resolve supports VST version 2.4. VST effects are available on 
macOS and Windows workstations, but not on Linux.

VST Effects versus VST Instruments (VSTi)
A VST effect is a type of VST plug-in that is used to process audio. A VST effect might be a 
Reverb, Compressor, or EQ. VST Instruments are typically used to synthesize sound or play 
back sampled audio. VSTs have rapidly replaced hardware synthesizers and dedicated 
samplers due to their flexibility, repeatability, and low cost.

Chapter – 158 Audio Effects 3282



Audio Units
Audio Units are an audio plug-in API created by Apple. Similarly to VST, Audio Units (AU) can 
either process audio, or work as instruments. Audio Units are only available on macOS 
workstations.

Using Audio Plug-Ins
FairlightFX are pre-installed on all DaVinci Resolve installations. If you install additional VST or 
Audio Unit effects on your workstation, they appear in the Audio FX panel of the Effects Library, 
organized in separate categories.

Audio plug-ins in the Effects Library

You can click on the far right of any effect to flag it with a star as a favorite effect. When 
you do so, the favorited effects appear in a separate Favorites area at the bottom of the 
Effects Library Bin list, and it also appears at the top of the Effects button’s menu on the 
Mixer when you click the “plus” button.

Stars indicate a flagged favorite effect; all favorites are currently filtered

Audio plug-ins let you apply effects to individual audio clips or entire tracks worth of 
audio, to add creative qualities such as echo or reverb, or to take care of mastering 
issues using noise reduction, compression, or EQ.
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Methods of applying audio plug-ins to clips on the Fairlight page:
 � To apply an audio filter to a clip: Drag any filter from the Audio FX panel of the Effects 

Library onto the clip in the Timeline you want to apply it to.

 � To apply an audio filter to multiple clips: Select all of the clips you want to apply an 
audio filter to, then drag any filter from the Audio FX panel of the Effects Library onto 
any of the selected clips.

When you apply an audio plug-in to a clip, a badge appears to the left of that clip’s name bar in 
the Timeline to let you know there’s an effect applied to it.

Timeline clips with audio plug-ins applied appear with a badge

Also, when you apply any kind of an effect to a clip in the Timeline, be it an adjustment in the 
Inspector or a plug-in you’ve applied, clips with that effect applied appear a darker shade of 
whatever color they are. Removing all effects from a clip (for example, using the Remove 
Attributes command) returns that clip to its original color. This makes it easy to see, at a glance, 
which clips have effects, and which clips don’t.

A closeup of the Timeline with a darker clip with effects between 
two other regularly-colored clips without effects

Methods of applying audio plug-ins to tracks on the Fairlight page:
 � To apply an audio filter to an entire track in the Timeline: Drag any filter from the 

Effects Library onto the track header.

Applying an audio filter to a whole track via the Timeline

 � To apply an audio filter to a track or bus in the Mixer: Drag any filter from the Audio 
FX panel of the Effects Library onto the clip in the Timeline you want to apply it to.

Applying an audio filter to a whole track 
via drag and drop to the Mixer
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 � To apply an audio filter to a track or bus using the Mixer controls: Click the plus 
button in the channel strip of the track you want to apply an effect to, and then choose 
a filter from the drop-down menu that appears. All filters appear within categories to 
make them easier to find. If you’ve clicked the star button of any filters in the Effects 
Library to favorite them, these favorite filters appear at the top of the plus button’s 
drop-down list.

Applying an audio filter to a whole track via the Mixer’s own controls

TIP: The categories that audio filters are organized into in the Mixer can be 
edited in the audio plug-ins panel of the DaVinci Resolve System Preferences 
window. All plug-ins on a workstation are shown in the  Available Plug-ins list, 
and clicking within the Category column lets you use a drop-down menu with 
which to change categories.

To edit a clip’s audio plug-ins:
 � Select that clip and open the Inspector. All audio plug-ins applied to that clip 

appear under the volume and pan controls, with that filter’s controls appearing directly 
in the inspector.

To edit a track’s audio plug-ins, do one of the following:
 � Click in the background of the Timeline header to select that track, and then open the 

Inspector. Click the custom UI button for that filter to open its controls.

The custom UI button 
for audio plug-ins in the 
Inspector
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 � Move the pointer over the plugin’s name in the Effects area of the Mixer, and click on 
the custom UI button to open its controls.

The custom UI button for audio 
plug-ins in the Mixer

Nearly all FairlightFX, VST, and Audio Unit audio plug-ins have a custom user interface that 
makes it much easier to manipulate that filter’s controls. These can be opened from within 
DaVinci Resolve.

The custom audio filter interface for iZotope RX4

Methods of working with audio plug-ins in the Inspector:
 � To rearrange the order of multiple video filters applied to a clip: Click the move up or 

move down buttons in any filter’s title bar, to the left of each filter’s Trash Can button.

 � To disable or re-enable a filter: Click the toggle button at the far left of 
each filter’s title bar.

 � To remove a filter: Click the Trash Can button.

 � To reset any filter parameter: Click the Reset button at the far right of the parameter 
you want to reset.

 � To open or collapse a filter’s parameters: Double-click the title bar.

 � To open or collapse the parameters of all filters: Hold the Option key down and 
double-click any filter’s title bar.

Once applied to a clip or track, audio plug-ins can also be keyframed or automated just like 
volume and pan settings, to create dynamic audio effects that change over time.
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Applying Audio Plug-Ins to Buses
You can apply audio plug-ins to Main and Sub buses just like any other track, with which to 
apply any audio mastering effects operations you require to individual submixes, or even to an 
entire main.

Dealing With Processor Intensive Plug-Ins
As you apply more and more plug-ins directly to clips in complicated mixes, you may discover 
you lack the processing power to play all audio tracks and effects in real time. When this 
happens, there are two ways you can ease the burden that audio clip effects are placing on 
your workstation.

Caching Audio Clips With Plug-Ins
One quick fix is to manually enable the caching of one or more selected audio clips with audio 
effects applied to them to improve your project’s performance. Once an audio clip is cached, all 
plug-in effects are “baked in” and that clip’s audio waveform updates to reflect the altered 
audio. Cached clips appear with a small badge to the right of the FX badge in the name bar 
of the clip.

A cache badge lets you know this audio clip has cached effects

This is a non-destructive operation that has no lasting effect on the source media of cached 
clips. You can still alter a cached clip’s plug-in parameters whenever you want. Opening the 
graphical controls of a cached clip temporarily suspends audio caching, and when you’re 
finished, the clip is automatically re-cached and its waveform is updated to reflect the change 
so long as Cache Audio Effects remains enabled.

To cache audio effects for one or more selected clips:
 � Right-click an audio clip with a plug-in applied and choose Cache Audio Effects to 

enable audio effect caching for that clip. If you right-click one of multiple selected clips, 
you’ll enable Cache Audio Effects for all selected clips at once. Once enabled, that clip 
will be continue to be cached (and re-cached if you change the plug-in’s parameters) 
until you manually disable audio caching.

To disable audio caching for one or more selected clips:
 � Right-click an audio clip that’s been cached and choose Cache Audio Effects to disable 

audio effect caching for that clip.
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Bouncing Audio Clips With Plug-Ins
Another way of easing the burden of audio clip effects on your system is to bounce the effected 
clip to another layer. This creates a new piece of audio media with the effect “baked in,” which 
is written to the directory location specified by the “Save clips to” field of the Capture and 
Playback panel of the Project Settings.

To bounce one or more selected audio clips with effects to another layer:
 � Right-click an audio clip with a plug-in applied and choose Bounce Audio Effects. If you 

right-click one of multiple selected clips, you’ll Bounce Audio Effects for each selected 
clip all at once. After bouncing an audio clip with effects, the original clip will be muted.

Bounced clips no longer have editable effects, but you can always choose View > Show Audio 
Track Layers to see the original underlying clip that still has the original plug-in effect applied, 
and you can unmute it, move it back up to the top, edit the effect, and bounce another version 
of the clip, which appears as the topmost layer.
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Chapter 159

FairlightFX

FairlightFX are a DaVinci Resolve-specific audio plug-in format that runs 
natively on macOS, Windows, and Linux, providing high-quality 
audio effects with professional features to all DaVinci Resolve users on all 
platforms. Thirteen new audio plug-ins that can be used both in the 
Edit and the Fairlight page include a wide variety of plug-ins for repairing 
faulty audio, creating effects, and simulating spaces. This chapter explains 
what they do and how to use them.
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Common Controls For All FairlightFX
Before going into the specific controls of each FairlightFX plug-in, there are some common 
controls that all plug-ins share, found at the top of the custom GUI window for each plug-in.

Common controls for all FairlightFX

 � Presets: A cluster of controls that let you recall and save presets specific to 
each plug-in.

 – Add Preset button: Click this button to save the current settings of the FairlightFX 
you’re using. A dialog lets you enter a Preset name and click OK.

 – Preset drop-down menu: All presets for the currently open plug-in 
appear in this menu.

 – Previous/Next preset buttons: These buttons let you browse presets one by one, 
going up and down the list as you evaluate their effects.

 � A/B Comparison: A set of buttons that lets you compare two differently adjusted 
versions of the same plug-in. The A and B buttons let you create two sets of 
adjustments for that plug-in, and toggle back and forth to hear which one you like 
better. The arrow button lets you copy the adjustments from one of these buttons to 
the other, to save the version you like best while experimenting further.

 � Reset: A single reset control brings all parameters in the current plug-in to their 
default settings.

Chorus
An effects plug-in. A classic Chorus effect, used to layer voices or sounds against modulated 
versions of themselves to add harmonic interest in different ways.

An animated graph shows the results of adjusting the Modulation parameters of this plug-in, 
giving you a visualization of the kind of warble or tremolo that will be added to the signal as you 
make adjustments.

The Chorus FairlightFX

Chapter – 159 FairlightFX 3291



Chorus has the following controls:

 � Bypass: Toggles this plug-in on and off.

 � Input Format: (Only visible when Echo is inserted on a multi-channel track.) Lets 
you choose how multiple channels are input to the echo.  Stereo sets separate Left 
and Right channels.  Mono sums Left and Right to both channels. Left inputs the Left 
channel only, and Right inputs the Right channel only.

 � Delay: The amount of delay between the original sound and the Chorus effect.

 – Delay Time: Length of the Chorus delay lines.

 – Separation: Time separation of the delay voices.

 – Expansion: Sets L/R length differences, phase offset of modulators

 � Modulation: These controls adjust the low frequency oscillator (LFO) that drives the 
tremolo of the chorus effect in different ways.

 – Waveform: Specifies the shape of the LFO that modulates the rate of the Chorus, 
affecting the timing of the oscillations. There are six options: Sine (smooth 
oscillations), Triangle (sudden oscillations), Saw1, Saw2 ( jerky oscillations), Square 
(hard stops between oscillations), and Random (randomly variable oscillations).

 – Frequency:  Rate of LFO controlling the Chorus. Lower values generate a warble, 
higher values create a tremolo.

 – Pitch: Amount of frequency modulation, which affects the pitch of the Chorus.

 – Level: Depth of level modulation. Affects the “length” of the segment of Chorus 
that’s added to the sound. Low values add only the very beginning of the Chorus 
effect, high values add more fully developed Chorus warble or tremolo.

 � Feedback:

 – Amount (%): The percentage of signal fed back to the Chorus Delay Line. Values can 
be positive or negative, the default is 0 (no effect). Increasing this parameter adds 
more of the Chorus effect to the signal, lowering this parameter adds more of the 
inverted Chorus effect to the signal. At values closer to 0, only a faint bit of Chorus 
can be heard in the audio, but at values farther away from 0 (maxing at +/- 99), a 
gradually pronounced Chorus becomes audible.

 – Bleed (Hz):  Amount of feedback which bleeds into the opposite channel (Stereo 
mode only).

 � Output: Controls for adjusting the final output from this plug-in.

 – Dry/Wet (%): A percentage control of the output mix of “dry” or original signal to 
“wet” or processed signal. 0 is completely dry, 100% is completely wet.

 – Output Level (dB): Adjusts the overall output level of the affected sound.
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De-Esser
A repair plug-in specific to dialog. The De-Esser is a specialized filter that’s designed to reduce 
excessive sibilance, such as hissing “s” sounds or sharp “ts” sounds, in dialog or vocals. 

A graph shows you which part of the signal the controls are set up to adjust, while reduction 
and output meters let you see which part of the signal is affected and what level is 
being output.

The De-Esser FairlightFX

The De-Esser has the following controls:

 � Bypass: Toggles this plug-in on and off.

 � Frequency Range: Two controls let you target the frequency of the “s” sound for a 
particular speaker.

 – Target Frequency: A knob that lets you target the frequency of the offending 
sibilance. Sibilant sounds are usually found in the range of 5 - 8kHz.  

 – Range: switches the operational mode of the De-esser. Three choices 
(from top to bottom) let you switch among Narrow Band, Wide Band, and All High 
Frequency which processes all audio above the source frequency.

 � Amount: Adjusts the amount de-essing that’s applied.

 � Reaction Time: Adjusts how suddenly de-essing is applied. There are three choices.

 – Relaxed: Equivalent to a slow attack.

 – Fast: Equivalent to a fast attack.

 – Pre-emptive: A “lookahead” mode.
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De-Hummer
A repair plug-in with general applications to any recording. Eliminates hum noise that often 
stems from electrical interference with audio equipment due to improper cabling or grounding. 
Typically 50 or 60 cycle hum is a harmonic noise, consisting of a fundamental frequency and 
subsequent partial harmonics starting at twice this fundamental frequency. 

A graph lets you see the frequency and harmonics being targeted as you adjust this plug-
in’s controls.

The De-Hummer FairlightFX

De-Hummer has the following controls:

 � Bypass: Toggles this plug-in on and off.

 � Frequency: Target source fundamental frequency. A knob lets you make a variable 
frequency selection, while radio buttons let you select common frequencies that 
correspond to 50Hz/60Hz electrical mains that are the typical culprits for causing hum.

 � Amount: Adjusts how much De-Hum extraction you want to apply.

 � Slope: Adjusts the ratio of fundamental frequency to partial harmonics, the adjustment 
of which lets makes it possible for various kinds of hum to be targeted. For example, a 
value of 0 biases hum extraction towards the fundamental frequency, while a value of 
0.5 gives equal extraction of all harmonics (up to 4), and finally a value of 1.0 targets the 
higher frequency partials.
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Delay
An effects plug-in. A general purpose stereo delay effect, suitable for tasks varying from track 
doubling, to early reflection generation, through simple harmonic enhancement. Processes in 
stereo or mono, depending on the track it’s applied to.

A graph shows the timing and intensity of the echoes generated by this plug-in on each 
channel, and an Output meter displays the output level of the resulting signal.

The Delay FairlightFX

Delay has the following controls:

 � Bypass: Toggles this plug-in on and off.

 � Input mode: (Only visible when Delay is inserted on a multi-channel track.) Lets you 
choose how multiple channels are input to the delay. Stereo sets separate Left and 
Right channels. Mono sums Left and Right to both channels. Left inputs the Left channel 
only, and Right inputs the Right channel only.

 � Filters: Alters the proportion of frequencies that are included in the delay effect. When 
the Delay plug-in is inserted on a Mono Channel, the Left and Right sections are 
replaced with a single “Delay” section.

 – Low Cut (Hz): A global High Pass filter.

 – High Cut (Hz): A global Low Pass filter.

 � Delay: Adjusts the timing of the delay.

 – Left/Right Delay (ms): Delay time of each channel.

 – Left/Right Feedback (%): Feedback % of the Left or Right channel back to itself. A 
negative value equates to % of feedback with a phase reverse from the original signal.

 � Feedback: Controls for adjusting the amount of bleed between channels.

 – High Ratio: Adjusts the frequency of a damping filter for the feedback signal.

 – Stereo Bleed: Adjusts the proportion of signal from Left and Right channel feedback 
which feeds into the opposite channel. When the Delay plug-in is inserted on a 
Mono channel, Stereo Bleed control does not appear.

 � Output: Controls for adjusting the final output from this plug-in.

 – Dry/Wet (%): A percentage control of the output mix of “dry” or original signal to 
“wet” or processed signal. 0 is completely dry, 100% is completely wet.

 – Output Level (dB): Adjusts the overall output level of the affected sound.
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Dialog Processor
The Dialog Processor chains together six different common audio processing operations inside 
of a single plug-in, each tuned to the specific needs of making adjustments to improve human 
speech. The specialized De-Rumble, De-Pop, De-Ess, Comp(ressor), Expander, and Excite 
controls each have a streamlined set of controls tailored to speeding up the types of common 
adjustments every dialog track uses.

The Dialog Processor plug-in

Distortion
An effects plug-in. Creates audio distortion that’s useful for sound design and effects, ranging 
from simple harmonic distortion simulating an audio signal going through primitive or faulty 
electronics (such as bad speakers, old telephones, or obsolete recording technologies), all the 
way to mimicking an overdriven signal experiencing different intensities of hard clipping (think 
someone yelling through a cheap bullhorn, megaphone, or PA system). This plug-in includes 
soft tube emulation in the output stage.

An animated graph shows the results of adjusting the Distortion parameters of this plug-in, 
giving you a visualization of the kind of harmonic distortion, waveshaping, and clipping that will 
be modifying the signal as you make adjustments. Input and Output meters let you see how the 
levels are being affected.

The Distortion FairlightFX
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Distortion has the following controls:

 � Bypass: Toggles this plug-in on and off.

 � Filters: Two filters let you simulate devices reproducing limited frequency ranges.

 – LF Cut: Low frequency distortion shaping.

 – HF Cut: High frequency distortion shaping.

 � Distortion: Three sets of controls let you create the type and intensity of distortion 
you want.

 – Mode buttons: Switch the operational mode of distortion. The one to the left, 
Distortion, creates harmonic distortion. The button to the right, Destroy, is a more 
extreme polynomial waveshaper.

 – Distortion: Adjusts the amount of distortion that’s applied to the signal. Higher 
values distort more.

 – Ceiling: Adjusts the level of input signal that triggers clipping.

 – Output: Controls for adjusting the final output from this plug-in.

 – Dry/Wet (%): A percentage control of the output mix of “dry” or original signal to 
“wet” or processed signal. 0 is completely dry, 100% is completely wet.

 – Output Level (dB): Adjusts the overall output level of the affected sound.

 – Auto Level button: Applies automatic compensation for gain added to the signal due 
to the distortion being applied. Having this button turned on prevents the signal from 
becoming dramatically and unexpectedly increased, while turning it off frees you to 
do what you want, if what you want is to hear a lot of distortion.

Echo
An effects plug-in. A classic Echo effect, simulating the fate of the cursed Oread from Greek 
mythology. Processes in stereo or mono, depending on the track it’s applied to.

A graph shows the timing and intensity of the echoes generated by this plug-in on each 
channel, and an Output meter displays the output level of the resulting signal.

The Echo FairlightFX
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Echo has the following controls:

 � Bypass: Toggles this plug-in on and off.

 � Input Format: (Only visible when Echo is inserted on a multi-channel track.) Lets you 
choose how multiple channels are input to the echo.  Stereo sets separate Left and 
Right channels. Mono sums Left and Right to both channels. Left inputs the Left channel 
only, and Right inputs the Right channel only.

 � Filters: Alters the proportion of frequencies that are included in the delay effect. When 
the Delay plug-in is inserted on a Mono Channel, the Left and Right sections are 
replaced with a single “Delay” section.

 – Low Cut (Hz): A global High Pass filter.

 – High Cut (Hz): A global Low Pass filter.

 – Feedback: Adjusts the frequency of a damping filter for the feedback signal.

 � Left Channel: Parameters that independently affect delay on the Left Channel. When 
the Echo plug-in is inserted on a Mono Channel, the Left Channel and Right Channel 
sections are replaced with a single “Echo” section with only the Delay Time, Feedback 
Delay, and Feedback controls.

 – Delay Time: Global Delay time for the Left Channel.

 – Feedback Delay: Echo Delay time for the Left Channel.

 – Feedback: Feedback percentage of the Left channel back to itself.

 – L > R Feedback: Percentage of Left feedback signal which feeds back to 
Right˛Channel.

 � Right Channel: Parameters that independently affect delay on the Right Channel.

 – Delay Time: Global Delay time for the Right Channel.

 – Feedback Delay: Echo Delay time for the Right Channel.

 – Feedback: Feedback percentage of the Right channel back to itself.

 – R > L Feedback: Percentage of Right feedback signal which feeds back to 
Left˛Channel.

 � Output: Controls for adjusting the final output from this plug-in.

 – Dry/Wet (%): A percentage control of the output mix of “dry” or original signal to 
“wet” or processed signal. 0 is completely dry, 100% is completely wet.

 – Output Level (dB): Adjusts the overall output level of the affected sound.

Flanger
An effect plug-in, giving that unmistakable Flanger sound dating from the days of dual tape 
machines with a slight delay added to one in periodic intervals causing flanging as they got 
back in sync with one another. Typically used to add a sort of warbling harmonic interest to a 
signal, in a wide variety of ways.

An animated graph shows the results of adjusting the Modulation parameters of this plug-in, 
giving you a visualization of the kind of warble that will be added to the signal as you make 
adjustments.

Chapter – 159 FairlightFX 3298



The Flanger FairlightFX

The Flanger has the following controls:

 � Bypass: Toggles this plug-in on and off.

 � Input mode: (Only visible when the Flanger is inserted on a multi-channel track.) 
Lets you choose how multiple channels are input to the Flanger. Stereo sets separate 
Left and Right channels. Mono sums Left and Right to both channels. Left inputs the Left 
channel only, and Right inputs the Right channel only.

 � Modulation: A low frequency oscillator (LFO) used to drive the Flanger effect.

 – Waveform (Hz): Specifies the shape of the LFO that modulates the rate of the 
Flanger. The three choices are Sine (a smooth change in rate), Triangle (a jerky 
change in rate), and Sawtooth (an abrupt change in rage). Affects the timing of the 
warble that is added to the sound.

 – Rate (%): Speed of the LFO, affects the speed of the warble that is added to 
the sound. Low rate values create a slow warble, while high rate values create more 
of a buzz.

 – Depth: Affects the “length” of the warble that is added to the sound. Low values add 
only the very beginning of a warble, high values add more fully developed warble.

 � Width: Consists of a single parameter, Expansion, which sets Left/Right channel length 
differences, along with the phase offset of modulators.

 � Feedback: These controls determine, in large part, how extreme the Flanging 
effect will be.

 – Amount (%): The percentage of signal fed back to the Delay Line. Values can be 
positive or negative, the default is 0 (no effect). Increasing this parameter adds 
more of the Flange effect to the signal, lowering this parameter adds more of the 
inverted Flange effect to the signal. At values closer to 0, only a faint phase shift 
can be heard in the audio, but at values farther away from 0 (maxing at +/- 99), a 
gradually increasing warble becomes audible. The type of warble depends on the 
Modulation controls.

 – LPF Filter (Hz): Lets you filter the range of frequencies that will affect the 
feedback signal.
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 � Output: Controls for adjusting the final output from this plug-in.

 – Dry/Wet (%): A percentage control of the output mix of “dry” or original signal to 
“wet” or processed signal. 0 is completely dry, 100% is completely wet.

 – Output Level (dB): Adjusts the overall output level of the affected sound.

Foley Sampler
The Foley Sampler is a built-in sampler that makes it easy to add sound effects that you want to 
play using a keyboard, pad, or other MIDI performance device connected to your computer, to 
add timed sound effects to sync with onscreen visuals. This new plug-in has also been 
designed to simplify the process of recording performed audio cues on the current track to 
which the sampler has been added.

Setting Up the Foley Sampler
Using the Foley Sampler to record samples played with a MIDI controller is easy.

1 Create an audio track you want to record sound effects or instruments to.

2 Drag the Foley Sampler onto the track header to assign it to that track. The Foley 
Sampler window automatically appears. The Fairlight page knows this is an instrument 
with no inputs to the plug-in, so this effect is automatically patched to that track’s input, 
ready for recording.

3 If you have a MIDI controller of some kind connected to your computer and properly 
configured, it will appear in the MIDI drop-down menu at the upper-right corner of the 
Foley Sampler window (next to the Keyboard button). Choose your device from this 
menu, and the Keyboard button will highlight to show it’s enabled.

At this point, the Foley Sampler is ready to be used, but by default it has no samples loaded to 
play. The next step is to add sound effects.

Adding Sound Effects
You can add prerecorded sound effects or instruments to the Foley Sampler in the 
following ways:

 � Drag and drop an audio file in a supported format from the file system onto the 
Foley Sampler window

 � Drag and drop a sound effect from the Sound Library onto the Foley Sampler window

 � Click the Foley Sampler window’s Option menu and choose 

Once you’ve loaded a sound effect of some kind, it’s automatically mapped to the top four keys 
of your instrument, starting at C2. Pressing a key or pad of your controller will play that sound.

If you want to see the sound’s waveform, you can click the Sample button at the top of the 
Sound panel. In this example, there are a series of continuous footsteps recorded in a row that 
we can use.
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A footsteps recording loaded into the Foley Sampler

Splitting Sound Effects
It’s common to use pre-recorded library sound effects that consist of a series of recorded 
footsteps, cloth rustles, punches, or other “foleyed” sound recordings, in order to play variations 
of a specific kind of repetitive sound effect in sync to action that’s happening on screen. The 
Foley Sampler lets you do this easily.

1 After you’ve loaded a sound effect, click the Foley Sampler window’s Option menu 
and choose Split Sample to automatically split the current sample into slices based 
on an analysis of its noise floor, and assign each slice to a set of keys or pads on your 
selected MIDI device. Continuing with the previous example, each footstep has been 
split and assigned to a different key.

2 To adjust the timing of each slice of the sound effect that’s been split apart, you can 
click on the assignment text above the keyboard at the bottom of the window to see 
that slice in the Sample view.

3 You can adjust the Range Start and Range End parameters to encompass as much or 
as little of that slice as you want to play back. 

4 If you want a sample to loop if a note is held down, you can enable the Loop button, 
and then adjust the Loop Start and Loop End parameters to choose how much of each 
slice will loop.

5 To delete slices that aren’t useful, you can select a slice you don’t like and press Shift-
Delete to clear that slice from the virtual keyboard.
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A single slice of the footsteps recording after being split in the 
Foley Sampler, with the range of the effect adjusted

Assigning Sound Effects Manually
When you first load sound effects into the Foley Sampler, they’re automatically assigned to a 
series of notes. Each additional sound effect that you load is automatically assigned to the next 
series of notes to the right. Once all notes are occupied, additional sound effects will shuffle all 
previous assignments to the left.

You also have the option of manually assigning sound effects that you load. This is useful when 
you want to manually load a variety of different sound effects all at once (such as a combination 
of punch sounds, human grunts, and cloth rustles to use in a fight scene), and assign them to 
particular notes of your choosing.

1 Load a sound effect you want to map.

2 Click the Mapping button to remap the range of notes it corresponds to.

3 Use the Low and High parameters to select a range of notes for the selected sound.

4 You also have the option of tuning the pitch of specific sound effects, if necessary.

The Mapping controls used to assign a 
sound to a particular set of notes
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Adjusting Sound Effects
If you want to customize a sample or slice further, you can select it above the virtual keyboard 
and use the controls on the Level panel to control the dynamics of audio playback, or you can 
use the controls on the Filter panel to EQ the sound.

TIP: If a sample or slice is set to loop, you can press the Control key and click a key on 
the virtual keyboard to initiate looping, so you can hear these adjustments as you’re 
making them.

Playing and Recording Sound Effects
Once you’ve set up the Foley Sampler with sound effects you can play from a MIDI controller, 
recording those sound effects is simple. 

1 Make sure that the “Save clips to field” in the Capture and Playback panel of the Project 
Settings is correctly set up to record to the desired storage volume, using the Browse 
button, if necessary.

2 Click the R button in the track header of the audio track to which you applied the Foley 
Sampler, to put that track into Record Enable mode.

3 Click the Record button in the Fairlight toolbar.

4 While Fairlight records, use the keys or buttons of your MIDI controller to play sounds in 
sync to the picture on your display. When you’re done, click the Stop button.

You should now have a recorded clip containing the sound effects you played, in sync to the 
picture. If they’re a bit out of sync, you can always use the Elastic Wave audio retiming controls 
to tighten the sync without re-recording everything.

A new clip of audio created by recording sounds played via the Foley Sampler
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Frequency Analyzer
This lets you see a visualization of the levels across all frequencies of a clip or track. A Mode 
drop-down lets you choose to see the full audible spectrum, or to restrict the visualization to 
low, medium, or high frequencies.

The Frequency Analyzer plug-in

LFE
A low-pass filter that you can apply to a main that’s in a surround sound format, to feed low-
frequency sound to an LFE channel as part of a surround sound mix. If there is no LFE channel 
available, this plug-in does nothing. A Frequency control lets you choose which low frequency 
range you want to include, and a Trim control lets you set the level of the resulting LFE channel.

The LFE plug-in
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Limiter
A true peak limiter that is capable of looking 64 samples ahead of the input, in order to limit the 
audio in a very smooth fashion. An Input control lets you adjust the level of the incoming signal, 
while Threshold and Release controls let you adjust the limiting that’s being done. A graph 
shows you an analysis of the audio as it’s processed, with a visual indication of what parts of the 
signal are being affected by this plug-in.

The Limiter plug-in

Meter
A sample peak processing meter that’s useful for for temporarily adding a meter to a specific 
track, Sub, Aux, or Main. These are sample peak processing meters that are useful for instances 
where you want a large meter that focuses on a specific bus while you’re working. 

These meters are presented very simply, with a gray bar indicating level and a red peak line 
that holds for two seconds, which indicates the highest peak. A numeric reading at the top of 
the meter gives the exact level, in dB. This number continues to hold, indicating the loudest 
level measured for any given stretch of playback.

The Meter FairlightFX

Chapter – 159 FairlightFX 3305



Meter has the following controls, all located in the option menu:

 � Width: Lets you resize the width of the meter window. Options are: Narrow, 
Normal, and Wide.

 � Height: Lets you resize the height of the meter window. Options are: Small, Medium, 
and Large.

 � Reset Peak on Play: When enabled, the numeric peak level is reset every time 
playback stops and starts again. When disabled, the numeric peak level persists until 
changed by a higher peak.

 � Reset: Resets the numeric peak level.

Modulation
An effect plug-in. General purpose modulation plug-in for sound fx/design. Four effects 
combine an LFO, FM adjustment, AM adjustment, Sweep and Gain filters to allow simultaneous 
frequency, amplitude and space modulation. In conjunction with the additional Rotation 
controls, simple Tremelo and Vibrato effects can be combined with auto-filter and auto-Pan 
tools in order to provide texture and movement to a sound.

An animated graph shows the results of adjusting the Modulator, Frequency, and Amplitude 
parameters of this plugin, giving you a visualization of the kind of modulations that will be 
applied to the signal as you make adjustments. Output meters let you see what level is 
being output.

The Modulation FairlightFX

Modulation has the following controls:

 � Bypass: Toggles this plug-in on and off.

 � Modulator: A low frequency oscillator (LFO), shown in blue in the animated graph.

 – Shape: Specifies the shape of the LFO waveform that modulates the audio. Six 
options include Sine, Triangle, Saw1, Saw2, Square, Random.

 – Rate (Hz): Adjust the speed of the modulating LFO. Lower settings result in warbling 
audio, while extremely high settings result in buzzing audio the timbre of which is 
dictated by the shape you’ve selected.  
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 � Frequency: Frequency modulation (FM) of a secondary oscillator, shown as green in 
the animated graph.

 – Level (%):  Controls the amount of Frequency Modulation that’s applied, intensifying 
or easing off the effect.

 – Phase: Since each of the four primary effects within this plug-in can be applied 
together, along with the fact that modulation with level components (Tremelo/
Rotation/Filter) have the ability to combine or cancel out one another, phase controls 
are available. Altering the phase of an individual effect allows control of such 
interaction (e.g., cancel out a high level change, or offset a cancellation).

 � Filter: Sweep and gain filters.

 – Level:  Lets you set the amount of filter sweep and gain to additionally use to modify 
the signal. The amount you’ve selected is previewed in a 1D graph to the side.

 – Tone:  Adjusts the center frequency of sweep.

 – Phase: Since each of the four primary effects within this plug-in can be applied 
together, along with the fact that modulation with level components (Tremelo/
Rotation/Filter) have the ability to combine or cancel out one another, phase controls 
are available. Altering the phase of an individual effect allows control of such 
interaction (e.g., cancel out a high level change, or offset a cancellation).

 � Amplitude: Amplitude modulation (AM) of a secondary oscillator, shown as green in the 
animated graph.

 – Level:  Amount of Amplitude modulation applied. (Disabled in Ring 
Modulation Mode.)

 – Phase: Since each of the four primary effects within this plug-in can be 
applied together, along with the fact that modulation with level components 
(Tremelo/Rotation/Filter) have the ability to combine or cancel out one another, 
phase controls are available. Altering the phase of an individual effect allows control 
of such interaction (e.g., cancel out a high level change, or offset a cancellation).

 – Ring Modulation Mode:  Enables a Ring Modulation effect (where the signal is 
multiplied by the modulator, rather than modulated by it).

 � Rotation: These controls are only available when applied to a multi-channel track.

 – Depth:  Amount of Rotation applied.

 – Phase: Since each of the four primary effects within this plug-in can be applied 
together, along with the fact that modulation with level components (Tremelo/
Rotation/Filter) have the ability to combine or cancel out one another, phase controls 
are available. Altering the phase of an individual effect allows control of such 
interaction (e.g., cancel out a high level change, or offset a cancellation).

 – Offset:  Start offset of rotation in order to further place the signal in space.

 � Output: Controls for adjusting the final output from this plug-in.

 – Dry/Wet (%): A percentage control of the output mix of “dry” or original signal to 
“wet” or processed signal. 0 is completely dry, 100% is completely wet.

 – Output Level (dB): Adjusts the overall output level of the affected sound.
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Noise Reduction
A repair plug-in designed to reduce a wide variety of noise in all kinds of recordings. Based on 
spectral subtraction, it’s able to automatically detect noise in sections of dialog, or it can be 
used manually by “learning” a section of noise that can be subsequently extracted from the 
signal. A graph shows a spectral analysis of the audio being targeted, along with a purple 
overlay that shows what noise is being targeted. Two audio meters let you evaluate the input 
level (to the left) versus the output level (to the right), to compare how much signal is being lost 
to noise reduction.

The Noise Reduction FairlightFX in action

Noise Reduction has the following controls:

 � Bypass: Toggles this plug-in on and off.

 � Auto Speech Mode/Manual radio buttons: These buttons toggle the overall 
functionality of the Noise Reduction plug-in between two modes:

 – Auto Speech Mode: Specifically designed for human speech/dialog, applying dialog 
extraction to the incoming signal to dynamically detect the noise profile outside of 
the detected speech. As a result, Auto Speech Mode does not require an initial a 
“learn” pass, and adapts itself better to noise that changes over time.

 – Manual Mode: Enables the Learn button, as this mode requires the user to locate 
a section of the audio recording that is only noise that the plug-in can analyze. 
To initiate this analysis, position the playhead at the beginning of a section of 
the recording that is only noise, click the Learn button so it’s highlighted, and 
play forward through the noise, stopping before any sound you want to preserve 
is reached, and clicking the Learn button to turn it back off. A noise profile is 
generated (shown in Purple on the graph), which is subsequently extracted from the 
remaining signal.

 � Threshold (in dB): Relates to the signal-to-noise ratio (SNR) in the source recording. 
Recordings with a poor signal-to-noise ratio will require a higher threshold value, 
resulting in more noise reduction being applied.
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 � Attack (in ms): Primarily useful in Auto Speech mode, this controls the duration over 
which the noise profile is detected. Ideally, the attack time should match the variability 
of the unwanted noise. A low value corresponds to a faster update rate of the noise 
profile and is useful for quickly varying noise; a high value corresponds to a slower 
update rate and can be used for noise that’s more consistent.

 � Sensitivity: Higher sensitivity values exaggerate the detected noise profile; the result 
is that more noise will be removed, but more of the dialog you want to keep may 
be affected. 

 � Ratio: Controls the attack time of the signal profile relative to the attack time of the 
noise profile. A faster ratio detects and preserves transients in speech more easily, but 
the resulting speech profile is less accurate.  

 � Frequency Smoothing: Smooths the resulting signal in the frequency domain to 
compensate for harmonic ringing in the signal after the noise has been extracted.

 � Time Smoothing: A toggle button enables smoothing of the resulting signal in the time 
domain as well.

 � Dry/Wet: A percentage control of the output mix of “dry” or original signal to “wet” or 
processed signal. 0 is completely dry, 100% is completely wet.

 � Makeup Gain: To let you compensate for level that may be lost due to the noise 
reduction operation you’re applying, this applies a pre-gain in, from -6dB to +18dB, just 
before the dry/processed mix. 

Phase Meter
Phase cancellation is a phenomena where the waveforms of a stereo recording (for example a 
stereo recording of a music performance) go slightly out of sync with one another for whatever 
reason, and begin to cancel one another out in unpredictable ways, resulting in the audio 
sounding strange. This results in poor quality audio and can cause problems when you’re trying 
to compress a mix to a distribution format such as AAF or MP3. 

The Phase Meter plug-in is a visual meter that lets you evaluate whether or not a signal is in 
phase and is meant to be applied to a bus so you may evaluate the phase of a mix and correct 
whatever problems may be occurring. The position of a green dot within a horizontal meter 
indicates the phase of the signal. When there’s no signal or a signal on only one half of a stereo 
bus, the dot appears in the center (0). When the signal is out of phase, the dot appears all the 
way to the left (–). When the signal is in phase, the dot appears all the way to the right (+).

The Phase Meter plug-in
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Pitch
An effects plug-in. Shifts audio pitch without altering clip speed.

The Pitch FairlighFX

Pitch has the following controls:

 � Bypass: Toggles this plug-in on and off.

 � Semitones: A “coarse” adjustment that can shift audio pitch up to +/- 12 semitones.

 � Cents: A “fine” adjustment that can tune audio pitch in +/- 100ths of a semitone.

 � Dry/Wet: A percentage control of the output mix of “dry” or original signal to “wet” or 
processed signal. 0 is completely dry, 100% is completely wet.

Reverb
A spatial simulation plug-in, capable of recreating multichannel reverberation corresponding to 
rooms of different sizes, adjustable via a graphical 3D cube control. This plug-in lets you take a 
“dry” recording and make it sound as if it’s within a grand cathedral, an empty room, or a 
tiled bathroom.

To understand this plug-in’s controls, it helps to know that the signal follows three paths which 
are combined to create the final effect:

 � A direct path.

 � An early reflection path (ER) simulating early reflection rays obtained from the first 
multiple reflections on the walls, traveling from the virtual source to the virtual listener.

 � A late reverberation path (Reverb) simulating the behavior of an acoustic model 
of the room.

A graph shows an approximate visualization of the reverb’s effect on the frequencies of the 
audio signal.
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The Reverb FairlightFX

 � Reverb has the following controls:

 � Bypass: Toggles this plug-in on and off.

 – Room Dimensions: By controlling the size of the virtual room a sound is to inhabit, 
these parameters simultaneously control the configuration of Early Reflection and 
Late Reverberation processing. The acoustic modes from this simulated room are 
computed and fed to Late Reverberation processing. The shape, gain, and delay of 
the first reflections are computed and then fed to Early Reflection processing.

 – Height, Length, Width: Defines the dimensions of the reverberant space, in meters.

 – Room Size: The calculated Room Width x Length, in meters2.

 � Reverb: Additional controls that further customize the configuration of Early Reflection 
and Late Reverberation processing.

 – Pre Delay: Increase or negate the propagation time from the virtual source to the 
virtual listener. As a result, it modifies the initial delay time between the source signal 
and the first reflection.

 – Reverb Time: Decay time of the Reverb tail. It controls the overall decay time of the 
acoustic modes from late reverberation processing. 

 – Distance: Modifies the distance between the virtual source and the virtual listener. 
It modifies only the configuration of early reflections processing.

 – Brightness: Modulate the shape of the decay time over frequency. At maximum 
brightness, decay time is identical at any frequency. At minimum brightness, higher 
frequencies result in shorter decay time and therefore duller sound.  

 – Modulation: Adds random low-frequency phase modulation from the tapping point 
of ER processing. At 0%, modulation is not used.

 � Early Reflection Tone: Four post equalization controls modify the tone of early 
reflections to suit a particular room’s characteristics.

 – Low Gain

 – Low Frequency

 – High Gain

 – High Frequency
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 � Reverb Tone: Four post equalization controls modify the tone of the reverb tail to suit a 
particular room’s characteristics.

 – Reverb Tail Low Gain

 – Reverb Tail Low Frequency

 – Reverb Tail High Gain

 – Reverb Tail High Frequency

 � Output: These controls recombine the three audio processing paths into a single 
output signal.

 – Dry/Wet: A percentage control of the output mix of “dry” or original signal to “wet” or 
processed signal. 0 is completely dry, 100% is completely wet.

 – Direct Level: The amount of the direct level to mix into the final signal.

 – Early Reflection Level: The amount of early reflection to mix into the final signal.

 – Reverb Level: The amount of reverb to mix into the final signal.

Soft Clipper
The Soft Clipper is a limiting processor that reduces the output level above a defined threshold 
in a rounded manner so that peaks are more cleanly attenuated. The Soft Clipper plug-in will 
impart saturation effects when pushed hard above the threshold, allowing for the introduction 
of warmth and subtle distortion to the sound. A graph shows the shape of the curve adjustment 
this plug-in makes to the audio.

A soft clipper is often combined with a standard limiter in order to increase perceptual loudness 
of material without imparting harshness.

The Soft Clipper FairlightFX

 � Threshold: Introduces input gain to the signal prior to hitting the clipper, forcing audio 
peaks over the threshold by that amount. As such, it will drive the saturation and 
distortion.

 � Shape: The shape of the clipper can be varied to change the character of the soft 
clipper from full soft-clipping (all the way right, where the peaks are rounded) to full 
hard-clipping (all the way left, where the peaks are squared off).  

 � Audio Level: Lets you adjust the output gain to compensate for signal lost during soft 
clipping, if necessary.
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Stereo Fixer
A simple plug-in designed to fix stereo source material in cases where only one side of a stereo 
signal was recorded, where one side of a stereo recording is a different level to the other, or 
where the stereo channels have been incorrectly Left/Right swapped.

This plug-in can also be used as a “Mid/Side” decoder, for recordings that were made using this 
microphone technique. 

This plug-in is for stereo clips only.

The Stereo Fixer FairlightFX

 � Format: The input processing mode you want to use to fix the stereo output.

 – Stereo: (Default) No format conversion is performed.

 – Reverse Stereo: Swaps the Left and Right side.

 – Mono: The output from the plug-in is a mono mix of the two inputs.

 – Left Only: The left input is sent to both left and right outputs.

 – Right Only: The right input is sent to both left and right outputs.

 – M/S: The left output is the left (Mid) input minus the right input (Side). The right output 
is the left (Mid) input plus right input (Side).

 � Left/Right Gain: Lets you apply independent gain on the left or right outputs. This gain 
is applied after (post) the input processing mode.

TIP: For a comprehensive M/S decoder solution, simply chain two Stereo Fixer plug-ins 
together. Use the first unit to control the Side signal level, thus controlling the width of 
the second unit (set to M/S).
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Stereo Width
An enhancement plug-in that increases or reduces the spread of a stereo signal in order to 
widen or reduce the separation between channels. If this plug-in is added to a Mono channel, 
it will be disabled, as there is no stereo width to either distribute or control.

A graph shows the currently selected width of stereo distribution as a purple arc, while inside of 
that graph a stereo meter shows the Left and Right distribution of the audio signal. Two audio 
meters measure levels, an Input meter to the left, and an Output meter to the right.

The Stereo Width FairlightFX in action

Stereo Width has the following controls:

 � Width: Lets you control the spread of the stereo output. Settings range from 0 (Mono) 
to 1 (Stereo) to 2 (extra wide stereo).

 � Diffusion: Adds more complexity to the output.

 � Sparkle: Adds more high frequencies to the spread.
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Vocal Channel
An enhancement plug-in for general purpose vocal processing consisting of High Pass filtering, 
EQ, and Compressor controls.

Side by side EQ and Dynamics graphs are presented above the controls. An output audio meter 
lets you monitor the final signal being produced by this plug-in.

The Vocal Channel FairlightFX

Vocal Channel has the following controls:

 � High Pass: Enabled by a toggle, off by default. Has a single frequency knob that sets 
the threshold below which frequencies are attenuated to reduce boominess or rumble.

 � EQ: A three-band EQ for fine tuning the various frequencies of speech, enabled by a 
toggle, including Low, Mid, and High Mode, Frequency, and Gain controls 

 – Low/Mid/Hi Mode: Lets you choose from different filtering options to use for 
isolating a range of frequencies to adjust. Different bands present different options.

 – Low/Mid/Hi Freq (Hz): Lets you choose the center frequency to adjust.

 – Low/Mid/Hi Gain (dB): Lets you boost or attenuate the selected frequencies.

 � Compressor:

 – Thres (dB): Sets the signal level below which compression occurs. Defaults to -25dB. 
The range is from -40 to 0dB. 

 – Reaction: Adjusts how quickly compression is applied when a signal exceeds the 
threshold. The default is 0.10.

 – Ratio: Adjusts the compression ratio. This sets the gain reduction ratio (input to 
output) applied to signals which rise above the threshold level. The default is 1.5:1. 
The range is 1.1 to 7.0.

 – Gain (dB): Lets you adjust the output gain to compensate for signal lost during 
compression, if necessary.
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Chapter 160

Audio Meters and 
Audio Monitoring

The Meters panel, which appears at the top of the Fairlight page when it’s 
enabled, provides a visual reference of the levels of each track in your mix, 
along with specialized meters showing the buses, monitoring mix, 
loudness, and a Viewer for seeing the video of the current project as 
you work. This chapter describes the use of these meters, and provides 
information about the different options that are available.
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The Monitoring Panel
Turning on the meters in the UI toolbar displays the Monitoring panel that runs along the top of 
the Fairlight page, which shows all of the audio meters that correspond to the tracks in the 
Timeline, as well as the Bus meters that correspond to the Mains, Subs, and Aux buses of your 
mix, the Control Room meters, and a video viewer.

The Monitoring panel

Track Meters and Monitoring Controls
At left, a row of audio meters corresponds to the channel strips of the Mixer, one meter for 
every audio track in the timeline. Each track displays the number of meters that corresponds to 
that track’s audio mapping, with mono tracks having a single audio meter, stereo tracks having 
two, 5.1 tracks having six, and so on.

Track audio meters with different 
numbers of meters depending on 
that track’s audio mapping

Each track and bus meter (with the exception of the Loudness meters) display RMS (root mean 
square) levels against a dB scale. A single line indicating the maximum value at any given 
moment in time is held briefly just above the current RMS levels, which appear as a solid bar 
extending from the bottom of the meter. RMS meters display a weighted “average” 
representation of the audio level that’s closer to the way audio is actually perceived, although 
not as accurate as the loudness meters discussed later in this section.

Each meter bar is color coded to indicate two different thresholds of sound level, from low 
(green) to high (yellow) to very high (red).
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The peak meter at top 

Each meter is identified by the track number it represents (track names are not shown over 
track meters) as well as the color of that track.

Using Post Fader or Track Source Meters
The Track Meters setting in the General Options of the Project Settings lets you choose how 
meters in the Fairlight page display their audio analysis. There are two options:

 � Post Fader: Meters always display the level of each clip’s signal after whatever fader 
adjustments have taken place. Fading a track’s level down diminishes the visible level 
of that audio signal in the meter. This setting is good if you prefer a visual indication 
of the relative levels you’ve set your various audio tracks to, which is a very NLE-
oriented behavior.

 � Track Source: Meters always use the volume levels of the audio clips in that track, 
even if you’ve lowered the level using the sliders. If you’ve keyframed a clip’s volume, 
that change will be reflected by the audio meters, even though fader changes are not. 
Viewing meters this way means you can always see how much level is available to clips 
in your mix regardless of what the current fader levels are set to, in the event you want 
to keep track of audio you want to bring back into the mix later on. This is a very DAW-
oriented behavior.

Bus Meters
To the right of the track meters are the bus meters, in which all Mains, Subs, and Aux buses 
appear, separated by type, and each displaying the number of meters that corresponds to that 
track’s audio mapping. This way you can see the sum of all tracks that have been routed to a 
particular bus.

Bus meters for the Mains, Subs, and Aux buses
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Meter Plug-in
There is a Meter plug-in available for temporarily adding a meter to a specific track, Sub, Aux, or 
Main. These are sample peak processing meters that are useful for instances where you want a 
large meter that focuses on a specific bus while you’re working. 

These meters are presented very simply, with a gray bar indicating level and a red peak line 
that holds for two seconds, which indicates the highest peak. A numeric reading at the top of 
the meter gives the exact level, in dB. This number continues to hold, indicating the loudest 
level measured for any given stretch of playback. The option menu in this meter’s floating 
window presents different settings you can choose. For more information, see Chapter 159, 
“FairlightFX.”

The Meter FairlightFX

Compound Meters and 
Output Bus Selection Menu
The compound meters, to the right of the bus meters, consist of Control Room meters and 
Loudness meters, shown side-by-side to provide a comprehensive analysis of your overall 
audio mix. Below, drop-down menus let you choose which bus you want to monitor, as well as 
which set of speakers you want to use to do the monitoring.

The Control Room meters (at left), 
and Loudness meters (at right)
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Monitoring Menus
The monitoring menus determine which bus gets analyzed by the compound meters. When the 
compound meters are displayed, the Monitoring drop-down menu that otherwise appears to 
the left of the monitoring controls in the Transport toolbar instead moves to a position 
underneath the Loudness meters. 

This drop-down menu lets you choose which bus you want to monitor as you work. You can 
choose one of your mains, or you can choose a Sub or an Aux that you want to focus on for 
more detailed work.

The monitoring menu lets you choose which bus 
you want to monitor while working

The next drop-down menu to the right lets you choose one of the available sets of speakers 
once you’ve configured them in the Video and Audio I/O panel of the System Preferences. This 
gives you the flexibility to quickly listen to your mix on a variety of speakers and configurations 
to see how it holds up in different situations. For more information on configuring different 
speaker setups, see Chapter 3, “System and User Preferences.”

The monitoring menu lets you choose which bus 
you want to monitor while working

Control Room Meters
The mustard-colored Control Room audio meters show the sum of all audio channels that are 
routed to the currently selected bus being monitored (as selected in the drop-down menu 
below). These are peak meters measured in dBFS.

Loudness Meters
The set of meters all the way to the right are the Loudness meters, which consist of a set of two 
graphical meters and a numerical readout. These meters let you analyze the “integrated 
loudness” of the overall mix, which is the standard to which all contemporary mixing 
specifications refer when describing the deliverables you’re expected to provide to the client. 
Unlike the RMS audio meters found in the Timeline or mixer which measure audio in dB, 
loudness meters do a different kind of analysis, measured in LU (loudness units).
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What Is LU?

A value of 1 LU (loudness unit) represents the smallest difference in audio levels that 
humans can actually perceive. Human hearing naturally sums all channels that reach 
the ear, so the summed channel meter to the right in the compound meters is an 
analysis of the loudness you actually hear.

Loudness Meter Options
Two options in the General Options of the Project Settings let you customize the 
Loudness meters. 

 � Target Loudness level: Lets you set the LUFS value that’s used as a reference level 
for loudness metering. Defaults to –23 LUFS, which conveniently makes the display of 
these meters scale similarly to traditional audio meters that you’re already used to.

 � Loudness Scale: Lets you choose which scale you want to use with which to measure 
the meters. Options currently include the default of EBU +9 Scale (–18 to +9), and EBU 
+18 Scale (–36 to +18).

Support for Multiple Loudness Standards
The Loudness Meter can be switched among a variety of international industry-standard 
loudness monitoring standards. The standard you choose uses the integrated loudness value 
(along with a specified tolerance defined by each selected standard) to indicate whether or not 
the current mix level is of acceptable loudness via color coding of the Integrated Loudness 
value, and in the Integrated Loudness graph described below. Blue values indicate loudness 
levels that are below tolerance, yellow indicates loudness values that are within tolerance, and 
red indicates loudness values that are above tolerance.

The built-in standards you can switch among include the following:

 � BS.1770-1: An older loudness standard used by DaVinci Resolve version 15 and before

 � BS.1770-4: The most up-to-date loudness standard as of DaVinci Resolve 16; the 
algorithms specified by this standard govern the other standards that are listed below 
in this drop-down menu

 � ATSC A/85: The American standard for acceptable loudness in broadcast

 � EBU R128: The European standard for acceptable loudness in broadcast

 � OP-59: The New Zealand and Australian standard for acceptable loudness in broadcast

 � TR-B32: The Japanese standard for acceptable loudness in broadcast

 � AGCOM 219: The Italian standard for acceptable loudness in broadcast

NOTE: The target peak meter now uses the BS.1774 standard for measuring maximum 
“true peak,” which means that this meter is capable of measuring “inter-sample peaks,” 
rather than only the peaks at each sample of a waveform.
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Graphical Loudness Meters
Two separate meters give you a dynamic graphical measurement of the loudness of the 
selected bus being monitored according to the loudness standard you’ve selected, which 
determines how to analyze the subjective loudness of a given audio mix for purposes of 
compliance with required quality control (QC) standards.

 � A steel-blue meter labeled M (for momentary) has as many channels as the selected 
bus you’re monitoring, excluding the LFE channel(s) of surround formats, which aren’t 
factored into loudness metering. This meter measures LEQ (equivalent sound level), 
within a 400ms window following the playhead as measured every 100ms. This lets 
you evaluate the LUFS (Loudness Units Full Scale) level of the mix at the current frame 
as you play. This discrete-channel analysis is used to calculate all other values of the 
loudness metering system.

 � A second steel-blue mono meter to the right displays the sum of all channels in the 
M meter, displayed in LU (loudness units). The number value displayed at the top of 
this meter is the maximum LU value that’s been analyzed during any stretch of timeline 
playback. This value is held until it’s reset, either by stopping and initiating playback a 
second time while Link to Playhead is enabled, or when you click the Reset button at 
the bottom of the loudness meter area.

Numeric Loudness Meters
A set of values to the right of the meters give running reports on the audio level of your mix. 
While the graphical meters are useful for analyzing your mix as you work, these numeric 
readouts are particularly valuable for providing the strict information you need to adhere to 
written QC standards. Their meaning is as follows:

 � Short: Measures the average LU level over a 30-second window following the 
playhead.

 � Short Max: Shows the maximum level over the same 30-second window. This analysis 
is required by EBU R128.

 � Range: Measures the dynamic range of the Loudness of your mix (in LU), which is the 
difference between the average soft and average loud parts of your mix. Analyzes the 
overall loudness over a played range of the mix, discounts the lowest 10% and highest 
5%, and then gives a standardized expression of the difference between the remaining 
soft and loud levels that were analyzed. The window of analysis is as long as you’ve 
been playing. This analysis is required by most QC specifications.

 � Integrated: Measures the LUFS value of the portion of the range of the mix you’ve 
played through. As you play, this integrated value accumulates. This analysis is required 
by most QC specifications.

Using the Loudness Meters
When using the Loudness meters to do a structured analysis of your mix to determine QC 
adherence, a group of controls let you determine when analysis begins and ends.

 � Lock Metering to Transport: This setting is found in the compound meter option menu. 
When enabled, all loudness metering analysis is automatically reset whenever you 
move the playhead to another location in the Timeline. This is useful when you’re spot-
checking different parts of your mix, or working on a particular scene.

 � Pause and Reset buttons: When you’re doing a formal analysis of your mix, the Reset 
button lets you reset all currently accumulated analyses, and the Start button initiates 
loudness value accumulation. If you need to stop playback briefly to do something else, 
you can click Pause, and then click Resume when you’re ready to continue the analysis.
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Visualizing Loudness Monitoring
When you show the track of a Main bus in the Timeline, as long as the track is high enough 
(ahem, tall enough), you can show or hide a series of “Loudness History” curves to visualize the 
loudness analysis of the mix on that bus over the duration of the mix. 

The available curves are:

 � Integrated: A thick curve shows the averaged “integrated” loudness analysis of the 
current mix, which is a measurement that’s taken from the beginning to the end of 
playback. This graph is the primary gauge of whether or not measured loudness is 
acceptable. The color of each segment of this curve indicates whether that part of the 
mix is “to spec.” Blue indicate loudness levels that are below tolerance, yellow indicates 
loudness values that are within tolerance, and red indicates loudness values that are 
above tolerance. By evaluating the colors of the curve, you can easily spot which parts 
of your mix might need adjustment to meet the necessary specification.

 � Momentary: A measurement of the loudness measured in the past 400ms, shown by a 
thin green-blue curve, which provides an analysis of transient level changes.

 � Short Term: A measurement of the loudness of the past 3 seconds, shown by a thin 
blue line, which provides a more averaged analysis than the Momentary curve, yet still 
indicates the dynamics of the mix.

To show the loudness history for Main 1:
1 Open the Automation controls by clicking the automation button on the Fairlight toolbar.

2 Open the Index, and click the eye button for the Main you want to see in the Timeline. 
Loudness History appears as an option in the track header controls as long as the track 
is tall enough to show the controls. These controls will be hidden on short tracks.

3 Turn on the Loudness History toggle, and check the curves you want to see. The 
Integrated, Momentary, and Short Term loudness analyses can be individually 
displayed or hidden, to expose overlapping graphs in that track in which you can see 
your program’s loudness over time.

Viewing the loudness graph of the mix going out of a Main

NOTE: At the time of this writing, loudness history is only supported for Main 1.
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Viewer
A small viewer to the left of the Monitoring panel shows the frame of video at the position of the 
playhead. This is the same image that’s output to the external broadcast display of your 
workstation if you have one connected.

The Viewer lets you see the picture you’re mixing to

Clicking the Expand Viewer button at the bottom right-hand corner lets you open the Viewer 
into a floating window, which you can then position anywhere you want.

To close the floating Viewer, click the Dock Viewer button at the upper right-hand corner of the 
floating viewer window.

Click the button at the upper right-hand corner to dock the Viewer again
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Chapter 161

Signal Flow 
Diagrams

The diagrams in this chapter describe the audio signal flow that takes 
place within the Fairlight audio processing used by DaVinci Resolve. 
They’re intended for people who want an in-depth understanding of how 
audio is processed.
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Chapter 162

Using the Fairlight 
Audio Editor

The Fairlight Audio Editor lets you quickly navigate large projects and 
precisely edit audio much faster than using a regular mouse and 
keyboard. Using the Audio Editor to control the Fairlight page provides 
fingertip access to nearly every Audio tool, function and workflow you’ll 
need to create incredible soundtracks within DaVinci Resolve. In addition 
to editing audio tracks, clips and waveforms, the Fairlight Audio Editor can 
also be used to set up, record, arrange, sweeten, mix and master your 
projects.

Whether you are using a Fairlight Desktop Audio Editor or a Fairlight Audio 
Editor panel in a Fairlight console, the tools and functionality of both 
models are the same. This chapter covers details about the Fairlight Audio 
Editor’s powerful design features, controls, edit modes, multi-functional 
keys and how they work with DaVinci Resolve.

Please refer to the previous Fairlight chapters for details on using the 
Fairlight page.
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About the Fairlight Audio Editor
Fairlight Audio Editor panels are designed to meet modern audio post production workflow 
demands while providing ease of use so that audio professionals can quickly and precisely 
execute both simple and demanding audio editing tasks. These dedicated Fairlight editing 
control panels are available in either desktop or console models. The difference is that the 
desktop model is a stand-alone panel designed for audio editors working at individual 
computer workstations, while the console model has an extended frame that fits into the 
Fairlight console chassis and is then connected to all of the console’s modular panels. Both 
models are essentially the same panel, aside from how they are mounted, so if necessary, you 
can use a Console Audio Editor on your desktop, and likewise a Desktop Audio Editor can be 
connected to a Fairlight console that does not already include an Audio Editor component. 

With its modest size that fits any desk or workspace, the Fairlight Audio Editor keeps every 
function within reach for simple navigation as well as performing complex two-handed 
operations. Plus, the user-friendly design is easy to learn and master with a variety of highly 
visual, intuitive controls including: touch-sensitive control knobs, macro buttons, built-in Editor 
screen with soft buttons, number keypad, jog wheel, and a full QWERTY keyboard with multi-
functional picture keys. 

Fairlight Audio Editor

The Fairlight Audio Editor is organized into six sections, each with a specialized set of controls 
that work in tandem with the Fairlight page interface to perform high-speed, audio tasks within 
your DaVinci Resolve project. 

Audio Editor Sections in Clockwise Order
On the upper-right of the Editor, you’ll find the Monitor section complete with knobs and buttons 
to control the level of the speakers in both the control room and studio as well as talkback. 
Below the Monitor section is a numeric keypad for entering timecode and go-to operations. 
The lower-right of the Editor includes an electronic jog wheel for full shuttle and jog transport 
control, along with a handy set of fixed transport buttons, Undo, Redo, Zoom and Shuttle 
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playback and Jog response keys. To the left of the jog wheel and control buttons is the full-
sized QWERTY keyboard with multi-functional self-labeling picture keys for nearly every audio 
action, tool, function, or workflow. Located directly above the keyboard is the built-in Editor 
screen which offers an interactive graphical display of the signal processing parameters for the 
selected track or master bus. The Editor screen is surrounded by sixteen soft menu buttons and 
three touch-sensitive knobs on the left- and right-side of the screen for dial parameter control. 
Finally, along the top there is a row of 15 fixed buttons that include ESC and 14 user-defined 
Macro Quick keys.

Editor Screen with  
Soft Buttons  

and Knobs

QWERTY keyboard  
with Picture Keys

Macro Buttons
Monitor Controls

Numeric Keypad

Jog Wheel and 
Transport Buttons

Audio Editor Functional Overview
At face value, the control knobs, jog wheel, buttons, and keys function as expected, based on 
the current Audio Editor mode. However, the way you press keys and the addition of modifiers 
can place even more options at your fingertips, without the need for changing editing modes or 
mousing through menus on the Fairlight page interface. So, before diving into a detailed 
rundown of the Fairlight Audio Editor, it’s important to understand some of the multifaceted 
controls and functional nuances designed to minimize your keystrokes while maximizing your 
speed and productivity.

This section offers a quick overview of the types of controls, editing modes, transport and 
modifier keys, key-press options, as well as pointing out the designated Track Selection, Menu 
and DaVinci Resolve interface page keys. 

Types of Controls
A good starting point for getting to know the Fairlight Audio Editor is to acquaint yourself with 
the different types of physical controls. 

 � Jog Wheel: To quickly navigate, zoom, change clip levels and more, this fully 
integrated, highly responsive electronic dial offers smooth free rotation or clutch 
action control.

 � Knobs: When you want to make fast changes to specific parameters, these versatile 
knobs give you precision rotary control, as well as touch-sensitive input for enabling 
automation or resetting levels. The Audio Editor includes two fixed-parameter knobs 
with the monitoring controls and six multifunctional soft menu knobs around the Editor 
screen which are assigned to parameters based on the current Editor mode and 
active toolset. Holding the Shift modifier key changes the gearing for finer controls, 
while holding the Control modifier key while touching one of these knobs will reset 
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the knob’s current parameter to its default value. For example, if the Audio Editor is in 
Monitor mode, holding the Control key while touching the knob controlling Fixed Level 
resets the parameter to 0 dB. 

 � Fixed Keys: These keys are located along the top and right side of the Audio Editor. 
Unlike the multi-functional soft menu buttons and picture keys, the fixed keys have 
printed labels based on their designated purpose. Among the fixed keys you’ll find 
the Macro quick keys, Monitoring Control keys, Numeric keypad keys, Jog and 
Transport Control keys, along with Undo, Redo, Record, Zoom, and Enter. Fixed 
keys are white with black labels, with the exception of the two red Mute keys in the 
Monitoring controls. 

 � Soft Menu Buttons: Above and below the Editor screen are two rows of eight soft 
menu buttons for a total of 16 buttons used to either toggle or show alternate pages 
of controls in the Editor screen based on the current Editor mode. The upper row of 
soft menu buttons are always toggles, such as the EQ In or EQ Bypass, when the EQ 
parameters are active, or a Boom toggle that alternates between: Boom Post, Boom 
Pre and Boom Only when the Pan parameters are active. The eighth button in the 
upper row toggles between page 1 and page 2 of functionality assigned to the first 
seven soft menu buttons. The lower soft menu buttons control parameters assigned 
to the six knobs, with the middle six lower soft menu buttons controlling which primary 
set of parameters are assigned to the knobs, like Track Level, Left/Right and Front/
Back controls when the Pan parameters are active in the Editor screen. The left and 
right lower soft menu buttons reveal alternative controls assigned knobs, such as the 
alternate Pan parameters, Rotate, Tilt and Up/Down, assigned to the right three knobs. 

 � Picture Keys: These self-labeling picture keys change their appearance and function 
dynamically, based on whatever the user is doing at that time and offer control for 
nearly every tool, panel, action, and task on the DaVinci Resolve Fairlight page. 
Additionally, the picture keys default to a standard QWERTY keyboard whenever 
user text input is needed (this setting is governed by the QWERTY: Auto/Off setting 
in the Setup mode), or when the DaVinci Resolve software displays a page other 
than Fairlight.

Audio Editing Modes
To accommodate the numerous audio post production toolsets and workflows, the Fairlight 
Audio Editor includes six primary Editor modes that change the picture keyboard layout and 
Editor functions based on the operational task at hand. These six “mega” Editor modes are 
conveniently named after their toolsets as follows: 

 � Setup: This mode provides quick access to non-editing operational windows, view 
options, and functions such as opening the Bus Format and Bus Assign windows, 
toggling on and off audio track layers, and saving a project. 

 � Record: As you probably guessed, this mode presents the precision tools you’ll need to 
perform manual, punch-in and ADR recording. 

 � Monitor: Use this mode to quickly change your fixed monitoring levels, isolate 
speakers, buses or mains, switch to alternate speaker sets, toggle phase, and other 
control room playback monitoring functions. 

 � Macros: This mode presents 30 programmable Macro keys where you can record 
sequences of keystrokes for repetitive tasks to each Macro key. 
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 � Mix: Transforms the Fairlight Audio Editor into a robust mixing tool with full control 
of Fairlight page Mixer functions like track EQ, Dynamics and Pan settings, copy and 
paste settings between tracks, as well as utilizing the full automation recording and 
editing toolset. 

 � Edit: This is where the Fairlight Audio Editor got its name and reputation for 
unparalleled speed and accuracy for every aspect of audio post editing from 
auditioning and syncing sound effects to checkerboard editing dialogue tracks 
on the fly. 

Editor mode keys: Setup, Record, Monitor, Macros, 
Mix, and Edit, with Mix mode currently active

Transport, Modifier, and Escape Keys 
While working with the Fairlight Audio Editor, you will always have access to the standard 
Transport, Modifier, and Escape keys, even while using the QWERTY keyboard for entering 
data. The Transport and Modifier keys are located at the bottom of the keyboard, and the 
Escape (ESC) key is at the top row of the editor with the Macro Quick keys. 

You’ll use the Transport keys: Rewind, Fast Forward, Play, Stop, and Record for navigation, 
playback and recording along with the jog wheel and its adjacent fixed transport keys. 

The standard modifier keys: Shift, Control, Command and Alt, work in conjunction with the 
QWERTY keys for default and user-defined keyboard shortcuts along with your mouse while 
operating other pages of DaVinci Resolve. When you are using the Fairlight Audio Editor to 
control the Fairlight page, the Control key (CTRL) is an essential modifier for revealing 
secondary functions on the self-labeling picture keys. For example, when you press the 
Control modifier key, the Rewind and Fast Forward transport keys become Project Start and 
Project End keys. Additionally, the Shift modifier key can be used in conjunction with the knobs 
for refined incremental parameter control. 

Another important key that you’ll find on a standard computer keyboard as well as the 
Audio Editor is the Escape key. This key lives up to its name as an all-purpose “escape” that 
can be used at any time to exit an operation, action, data entry or menu without saving the 
changes since the last save. The Escape key works as an operational override for a variety of 
functions including: GoTo functions, naming clips, setting values in dialog boxes, opening, 
closing and saving files, and any time a Cancel button is shown in a dialog on the 
computer screen. 

As you learn your way around the Editor, you’ll soon appreciate the convenient locations of 
the Transport, Modifier and Escape keys in the lower-right, lower-left, and upper-left 
positions respectively.
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Escape

Modifier Keys Transport Keys

Escape key

Modifier keys: Shift, Control, Command, and ALT

 

Transport keys: Rewind, Fast Forward, Play, Stop, and Record

 

Transport keys with Control modifier engaged to reveal  
Project Start and Project End keys 

NOTE: If your Audio Editor is connected to a Fairlight console, the Control key on the 
Editor works in tandem with the Control buttons on the Fairlight Console Channel 
Control panel and Channel Fader panels to access secondary functions, parameters 
and controls. Also, there is an independent ALT key below the built-in Editor screen 
that is used to toggle between additional parameters on the left- and right-side of the 
screen. This ALT key is dedicated to the Editor Screen controls. 
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Latch, Long, and Momentary Key Press Functions
Unlike standard keyboard and numeric keypad keys, which deliver the same result whether the 
keys are typed or held down, many Fairlight Audio Editor keys have multiple operational states 
which elicit different results depending on how you press or hold the key. The three types of 
key presses are: 

 � Latch: Quickly pressing and releasing a key, just as you would with normal typing, is 
referred to as latching and results in toggling on or off that key’s function.

 � Long-press: A long-press is performed by simply pressing a key longer than you would 
if you were simply typing it. When performing a long-press, you only need to press 
the key long enough to see the desired result, such as opening or closing a window 
on the Fairlight page GUI. Long-presses are only slightly longer than typing, about 
300 milliseconds, so they don’t slow you down, they just offer more functions within a 
fixed number of keys. These long-presses can be real time savers, and in many cases 
replace the need to reach for the mouse to click the Fairlight page interface.

 � Momentary hold: A momentary hold involves pressing and holding a key with one 
hand to reveal additional keys and functions that can be quickly latched with the 
other hand.

NOTE: From this point forward, descriptions such as type or press indicate a latched 
operation, long-press means to press longer than usual until you see the desired 
result, and instructions to hold and release refer to momentary operations.

Examples of Long-Press and Momentary Key Press Actions
Here are three examples of these types of button presses in action.

Using a long-press to open or close GUI windows:
There are five signal processing picture keys, including Pan, EQ, Dynamics, Aux, and Plug-in. 
These correspond with the graphical display in the built-in Editor screen as well as the Fairlight 
Mixer on the computer screen. If you latch one of these keys, such as EQ, the Editor screen 
displays EQ parameters for the selected track. In turn, these parameters can be controlled by 
the adjacent soft buttons and knobs without opening the GUI controls on the computer screen. 
However, long-pressing the EQ key both selects these controls and opens the EQ window on 
the computer screen. The EQ window will stay open until you long-press the EQ key again to 
close it. This works the same as double-clicking the EQ control on the Fairlight Mixer UI, and 
then clicking the Close button on the EQ window to close it. 

 

Signal Processing keys: Pan, EQ, Dynamics, Aux, 
and Plug-in with EQ key latched
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Editor screen displaying EQ processing controls assigned to adjacent soft buttons and knobs

DaVinci Resolve Fairlight interface displaying EQ window that can  
be opened and closed with a long-press on the EQ key

NOTE: Once you open a signal processing window using a long-press, the GUI 
window will automatically change to follow the current latched signal processing 
displayed in the Editor Screen and vice versa. So if you open the EQ window with a 
long-press, then latch the Pan key, the GUI window on the computer screen will 
change to the Pan window and the Editor screen will display controls for the Pan signal 
processing. If you want to see more than one signal processing window at a time on 
the computer screen, you’ll need to double-click them independently with the mouse.

Using a momentary key press to briefly enter a different Editor mode:
Each Editor mode includes a picture key toolset unique to that mode, however, audio work is a 
fluid process that sometimes requires users to jump back and forth quickly between toolsets 
while they work. Rather than reach for the mouse to access a menu, panel, setting, or tool via 
the Fairlight page interface, you can momentarily jump into another mode to access the tool you 
need, then jump back and continue your current task. 
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For example, you could be monitoring playback levels and recording automation data in 
Mix mode when you decide to reset the Loudness meters to check the section that is coming 
up. The Loudness Reset controls are accessed via the Monitor mode Editor Screen controls. 
To get to them, momentarily hold the Monitor mode button with your left hand to reveal the 
Monitor mode picture keys and Editor screen controls. With your right hand, quickly latch the 
Loudness soft key below the Editor screen to display the Loudness settings, then press the 
Reset Loudness toggle key above the Editor screen to reset the Loudness meters. Release the 
Monitor mode button to return to Mix mode without interruption in playback or automation 
recording. This type of momentary operation is one of the secrets to harnessing the Fairlight 
Audio Editor’s speed and power because at any time, in any workflow, you can momentarily 
jump to a different mode to access a key to do something else and return to the previous task 
without stopping. In fact, it is common to momentarily jump into the Setup mode toolset while 
you work because that is where you’ll find keys to quickly toggle on and off track layers, show 
or hide the Video Scroller, set the playhead (CTI) to fixed or moving, as well as save your project 
and modify the Audio Editor’s playback controls.

Another advantage of momentary key presses is that they don’t change the latched state of the 
key you are holding. Working with momentary key presses requires a bit of skill to master, but it 
can greatly increase your overall speed and efficiency.

Using a momentary key press to reveal related menu option keys:
Latching the Play Jog key starts playback and unlatching the same key engages the jog wheel. 
Momentarily holding the Play Jog key reveals six related menu option keys in the picture keys 
along the left side of the jog wheel without changing the current latched or unlatched state of 
the Play Jog key. While momentarily holding the Play Jog key, you can quickly latch any of the 
menu option keys. When you release the Play Jog key, the menu option keys are no longer 
visible. This maneuver can easily be done with the right hand while controlling the jog wheel.

 

Track Selection Keys
Quickly identifying and selecting tracks and buses is a vital part of recording, editing, and 
mixing workflows. Therefore, the Fairlight Audio Editor includes a dedicated row of picture keys, 
at the top of the keyboard, for selecting either tracks or master buses.
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Track Selection Keys

Track Selection keys utilize the Fairlight Audio Editor’s unique self-labeling picture key 
technology to display each track’s user-defined name and color just as it appears in the Fairlight 
page Timeline. Additionally, the Track Selection keys change appearance to reflect their current 
state so that you can quickly identify which tracks are selected and which track is actively 
displayed in the built-in Editor screen. When multiple tracks are selected, the most-recently 
selected track is always the track actively displayed on the Editor screen. Track Selection keys 
also reflect each track’s status with a colored icon that indicates if the track has been muted (M), 
soloed (S), or armed for recording (R).

TIP: Holding the CTRL key down reveals alternate commands, including Mute Clear 
and Solo Clear (to clear either Mute or Solo states from all tracks). Holding the 
CTRL key and pressing Mute Clear or Solo Clear a second time acts as a specialized 
undo/redo toggle to restore all tracks to their previous Mute or Solo state prior to being 
cleared. This is incredibly useful during mixing so that you can focus on a set of soloed 
tracks, un-solo them all simultaneously to hear them with the mix, then quickly return 
them to their soloed state.

Track Selection key states and appearance changes include:
 � Unlatched: The track is deselected, with the track’s color showing as a bar above the 

track’s name.

 � Latched: The track is selected, with the track’s color expanding over two thirds 
of the button.

 � Active: The active track can easily be identified by a white bar on the lower third of 
the key and the track’s color in the upper two thirds. Additionally, the active track’s 
name, track number, track color and signal processing parameters are displayed on the 
Editor screen.

ADA VO wFX and ROOM tracks are selected, Room track is active, PFX muted, 
MEDLAB 1 and MEDLAB 2 tracks are soloed, and the DRONE track is deselected.
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Master buses showing in the Track Selection keys 
with Main 1 active and the main named 5.1 muted.

NOTE: Pressing a Track Selection key is the same as clicking a track header or 
channel strip in the Fairlight page Mixer with your mouse. 

Pressing a Track Selection key does all of the following simultaneously: 
 � Latches or unlatches that Track Selection key with visual feedback accordingly. 

 � Selects or deselects that track in the Fairlight page Timeline and Mixer.

 � Displays that track’s signal processing in the built-in Editor screen.

 � Tallies on or off that track’s Channel Select button and calls up that channel’s 
parameters on the Fairlight Console Channel Control panel, if you are working on a 
Fairlight console. 

The dedicated Track Selection keys are located in the top row of the picture keyboard, where 
the number keys would be on a standard keyboard. Here you’ll find 12 track selection keys as 
well as All Tracks, Page Up ( ^ ), and Page Down ( v ) keys. 

You can select multiple tracks by pressing additional Track Selection keys. However, there can 
only be one active track at a time and it’s always the last Track Selection key pressed. Like most 
Fairlight Audio Editor keys, the Track Selection keys include some unique selection nuances to 
improve your efficiency without the need for a mouse. 

Track Selection keys and key-press options:
 � Track Selection keys: There is one Track Selection key for each track in the Fairlight 

page Timeline. From left to right the first 12 keys are Track Selection keys that follow 
the order of the tracks in the Timeline from top to bottom. Press once to select or 
deselect a track. Select as many tracks as needed, one track at a time, by simply 
latching the corresponding Track Selection keys. Double-press any Track Selection key 
to deselect all other tracks and actively select the current track. Hold a Track Selection 
key, then double-press another Track Selection key to select both tracks as well as all 
contiguous tracks between them. In this case, the key that was double-pressed will 
become the active track.

 � All Tracks: Press this key to quickly select or deselect all tracks in the Timeline. Long-
press the All Tracks key to change the entire picture keyboard to Track Selection keys 
for up to 48 tracks from left to right top to bottom. When All Tracks is latched, you’ll also 
have the option to continue to show tracks, or display master buses such as the Mains, 
Submix and Aux buses, and VCA groups. Below the All Tracks key, on the far right side 
of the picture keyboard, you’ll see the Tracks and Masters keys. Here you can choose 
which type of feed is displayed in the top row of the picture keyboard. Tracks are all of 
the Timeline tracks, and Masters are the buses for mixing and output. Long-press the 
key again to return to the default picture keyboard with one row of 12 Track Selection 
keys at the top. 
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 � Page Up (  ): Pages up to display the previous 12 tracks in the top row of Track 
Selection keys, or the previous 48 tracks when the picture keyboard is set to display 
48 Track Selection keys. Holding Ctrl- changes the Page Up key to a Bank button for 
loading a user-defined bank of tracks.

 � Page Down (  ): Pages down to display the next 12 tracks in the top row of Track 
Selection keys, or the next 48 tracks when the picture keyboard is set to display 48 
Track Selection keys. Holding Ctrl- changes the Page Down key to a Bank button for 
loading a user-defined bank of tracks.

NOTE: Hiding track visibility in the Timeline, using the Index, or using the Hide Track 
key on the Audio Editor hides a track from the Timeline and Mixer, but does not 
change the corresponding track’s state, output or Track Selection key. Additionally, in 
DaVinci Resolve 16 and higher you can show all master buses including Mains, Subs 
and Aux buses as tracks in the Timeline as long as the Automation toolset is showing 
and the buses are marked visible in the Tracks Index. 

Moving Track Selection with the Jog Wheel
Whether you select a single track or multiple tracks, you can quickly move the entire selection 
up or down with the use of the Move Selected picture key and the jog wheel. The Move 
Selected key is available in both the Record and Edit mode toolsets. This is incredibly useful 
when working with high track counts so that you can select a track or group of tracks much 
higher or lower in the Timeline without the need to grab your mouse to scroll. Simply hold the 
Move Select key while you turn the jog wheel clockwise to scroll the selection down to lower 
tracks, or counter-clockwise to scroll up to higher tracks. Keep in mind this only moves the 
selection and does not move the tracks or the contents of the tracks. 

Move Selected key available in 
Record mode and Edit mode 

Switching Pages
Although the Fairlight Audio Editor is designed to work exclusively with the Fairlight page in 
DaVinci Resolve, there may be times when you need to switch to a different page in 
DaVinci Resolve, such as importing and syncing audio files in the Media page, or rendering a 
finished mix in the Deliver page. The Menu key, located next to the modifier keys in the lower-
left corner of the picture keyboard, lets you quickly access the QWERTY keyboard, or any of the 
other pages in DaVinci Resolve. A momentary-press on the Menu key reveals keys for each of 
the DaVinci Resolve pages in the order that they are listed at the bottom of the software 
interface: Media, Cut, Edit, Fusion, Color, Fairlight, and Deliver. There is also a QWERTY key to 
temporarily change the picture keys to a QWERTY keyboard.
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Menu key next to Modifier keys in lower-left of keyboard; momentary-press on  
Menu key reveals QWERTY and DaVinci Resolve Page keys

NOTE: The Fairlight Audio Editor is designed to work with the Fairlight page. If you 
switch to a different page in DaVinci Resolve, you’ll need to use your computer 
keyboard and mouse for any operations in the user interface. While other pages are 
open, the Fairlight Audio Editor shows a QWERTY keyboard that you can use to trigger 
keyboard shortcuts while working on those pages, just like an ordinary computer 
keyboard. Once you return to the Fairlight page, the Audio Editor will resume working.

Fairlight Audio Editor
Now that you are familiar with the general layout, types of controls, Editor modes and key-press 
options in the Fairlight Audio Editor, it’s time to dive deeper into the different areas of operation 
and how everything works together. Keep in mind that the Fairlight Audio Editor is essentially an 
over-sized mouse designed specifically to control the DaVinci Resolve Fairlight page. Therefore, 
the better you understand the Fairlight page, the more proficient you’ll be with your Audio 
Editor panel. 

Please refer to the previous Fairlight chapters for detailed information on the software interface, 
tools, functions, and audio workflows. However, with the increased functionality and physical 
controls available on the Fairlight Audio Editor, there are some functions and workflow 
enhancements that are only available via the Editor panel. This section will give an overview of 
the entire Fairlight Audio Editor and focus more in-depth on unique features and functions that 
go beyond the standard keyboard and mouse options in the Fairlight page. 

Monitor Section
The Monitor section in the upper-right corner of the Fairlight Audio Editor panel is where you 
control playback levels for the Control Room and Studio speakers. Control Room monitor levels 
can be changed at any time using the Control Room knob. Adjusting these controls also adjusts 
the corresponding onscreen monitoring controls in DaVinci Resolve.
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Control Room monitoring controls include: 
 � Control Room knob: this can be used to quickly dial the level of the speakers selected 

in the control room. You can select alternate control room speaker sets in the Monitor 
mode toolset.

 � DIM: This button reduces the Control Room monitor volume by a user-defined 
amount. Press to toggle Dim on or off. You can set the Dim level on the Editor screen in 
Monitor mode. 

 � MUTE: Use this button to mute or unmute the Control Room monitors. 

The Studio controls control the Studio monitoring circuit of a Fairlight Accelerator card installed 
on your workstation.

Studio monitoring controls include: 
 � Studio knob: Use this to dial the level of the speakers in the Studio.

 � Talk: Latch this button to toggle on or off a talkback microphone. When latched, the 
talkback mic remains live. Momentary-press the talk button to use talkback without 
latching, in this case, the talkback mic will remain live only during the momentary-press 
and shut off when you release. Press Control with the Talk button to open or close the 
Talkback Settings window on the computer screen. Engaging Talk also dims the Control 
Room circuit. You can modify the talkback functionality and general purpose input and 
output (GPI/GPO) via the Talk Setup menu option keys in the Setup mode picture keys.

 � MUTE: Use this button to mute the Studio monitors.

 

Monitor controls

Talkback Settings window, opened or closed by 
pressing Control with the Talk button 
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User-defined Fixed Control Room and Dim levels
Sometimes the monitoring environment must be set to a standard level and not changed. This is 
called Fixed Level monitoring. For example, if your control room has been calibrated with a 
sound pressure level (SPL) meter, you will probably want to set a Fixed monitoring level. When 
fixed, the Control Room knob has no affect on the monitoring levels. You’ll find controls for 
Fixed Level monitoring on the built-in Editor screen in Monitor mode. Here you can also toggle 
on and off Fixed level monitoring and adjust the Dim level. When Fixed Level monitoring is 
toggled on, the Control Room meter in the GUI turns from green to blue. 

To set and reset Fixed and Dim Control Room monitor levels:
1 Latch or momentary-press the Monitor mode key to enter the Monitor toolset and show 

the Dim Level and Fixed Level controls on the left side of the Editor screen. 

2 Use the top control knob to adjust the adjacent Dim level amount onscreen. As you turn 
the knob left or right, the Dim level GUI changes accordingly. 

3 Use the middle knob to adjust the adjacent Fixed Level control using the GUI display in 
the Editor as a guide. 

4 To toggle Fixed Level monitoring on or off, press the soft button directly above the 
Fixed Level On/Off button on the Editor screen. This can be done anytime during 
playback, recording, or mixing sessions by simply using a momentary-press on the 
Monitor mode key then toggling on or off the Fixed Level On/Off soft button.

5 Hold the Control key while touching a touch-sensitive knob to reset it to the default 
value. In this case, the default Dim level is -15dB and the default Fixed Level is 0.0dB. 

6 When finished, release the Monitor key If you were performing a momentary-press. 
Otherwise, simply latch a different Editor mode key to exit Monitor mode.

DIM Level Control

Monitoring and Loudness 
soft menu buttons

Monitor Mode Key

Fixed Level Toggle soft 
menu button

Fixed Level Control
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TIP: Setting monitor levels is an example of how different areas of the Fairlight Audio 
Editor work together to quickly achieve a goal. To further define an example, a user 
could be in the middle of a session and decide to change the Dim level. Without 
interrupting the current task, the user could momentarily hold the Monitor mode key 
with one hand and with the other hand, quickly adjust the Dim Level. When finished, 
the user only needs to release the Monitor key to resume whatever they were working 
on. Latching the Dim button on the Monitor controls will now reduce the Control Room 
monitors to the newly defined Dim level.  

Numeric Keypad
For the most part, the numeric keypad on the Fairlight Audio Editor is self explanatory and 
functions exactly the same as the numeric keypad on an extended keyboard for entering 
timecode and number values. There are, however a few specialized keys, such as Colon (:), 
Clear, and GoTo, that can be used to expedite timecode entry, set locators, and quickly move 
the playhead or clip to a specific time. Additionally, there are some user-definable operations, 
such as Review, where you can combine a momentary hold on the Review key plus a Number 
Key (1 to 9) to set the number of seconds you’d like the playhead to jump back for the Review 
operation. The timecode is displayed in the Timecode field in the upper-left corner of the 
Timeline on the computer display, so you can always see the new timecode values as you type.

Corresponding Timecode Display and Range 
buttons on Fairlight page Timeline

Numeric Keypad Keys: 
 � Number Keys 0 to 9 : Used for entering number values and timecode entry. 

Timecode entry requires  latching the GoTo Key first. 

Numeric keypad 
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 � GoTo: When latched, the numeric keypad is in GoTo entry mode and numbers you enter 
determine where the playhead will move when you unlatch the GoTo key. Numeric 
entry can include numbers, timecode, or timecode increments. Positive numbers move 
forward in the Timeline and negative numbers move back. 

 – Use a momentary press on the GoTo key to jump to one of the three user-definable 
locator positions in the Timeline. 

 – Additionally, when the GoTo key is latched, the standard Play and Stop transport 
keys become GoTo Play and GoTo Stop keys. This can save a keystroke for the 
operator so they can type in timecode and immediately go to that location and play 
or stop without first unlatching the GoTo key.

Transport controls while GoTo key is 
latched on the numeric keypad. 

 � Plus (+): Used in typing or to increment numbers. Typing a Plus before entering a 
numeric timecode value moves the playhead forward by that value. For example, 
latching the GoTo key, then typing +0500 and unlatching the GoTo key moves the 
playhead forward five seconds. When typing values with Plus or Minus keys, the values 
are entered as timecode from right to left. In this example, +0500 = move playhead 
05:00 later.

 � Minus (-): This key is used in typing or to increment numbers. Typing a Minus before 
entering a number value moves the playhead forward by that value. For example, 
latching the GoTo key, then typing -0500 and unlatching the GoTo key moves the 
playhead back five seconds earlier in the Timeline. When typing values with Plus or 
Minus keys, the values are entered as timecode from right to left. In this example, 
-0500 = move playhead 05:00 earlier.  

 � Clear: Clears the current number or timecode entry while in GoTo entry mode. The 
Clear key can also be used to clear user-defined number values, such as locators. 

 � Colon (:): This key can be used to separate Hours:Minutes:Seconds:Frames in timecode 
entry, or as a numeric shortcut key that represents a timecode position and replaces 
00 when entering timecode. When you type two numbers, a colon is automatically 
added before the third number. Likewise, typing two numbers followed by a colon also 
places the colon directly after the two numbers you just typed. This follows standard 
timecode entry rules for typing in timecode numbers. In this case, to substitute 00 with 
the colon key, you need to type a second colon. Subsequent typed colons in the same 
timecode entry event will automatically substituted 00.

The number of colons typed before or after a number indicates the timecode position of the 
number in the GoTo command. For example, latching GoTo then typing 02:::02 (zero, two, colon, 
colon, colon, zero, two), then unlatching GoTo moves the playhead to 02:00:00:02. Additionally, 
the Colon key is a real time saver for navigating to specific areas of the Timeline without the 
need to type the entire number. The position of the Colon in the numeric shorthand value typed 
determines if the numbers entered as timecode start from the right as frames, or if you keep the 
current timecode and move to a designated hour from the left. 

For example, if the playhead is currently positioned at 01:00:00:00 and you latch GoTo, then 
type :20 (colon, two, zero) when you unlatch GoTo, the playhead will move to 01:00:00:20. 
However, if you then latch GoTo and type 02: (zero, two, colon), then unlatch GoTo, the 
timecode entry is incremental from right to left, so the result is 01:00:02:00. 
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TIP: Timecode entry appears in the upper-left corner of the Fairlight Timeline on the 
computer screen. If you wish to change the timecode to display subframes, you can 
right-click the timecode display and choose the display setting you wish from the 
drop-down menu. You can also open a floating Timecode window that displays the 
playhead position (CTI) from the Workspace menu.

Numeric Keypad Locators
The Fairlight Audio Editor includes three user-defined locators that are used to quickly move 
the playhead to a stored timecode location. These non-permanent locators are designed to use 
freely in editing and mixing, but are not saved with the project. A momentary-press on the GoTo 
key is required to use, set, or clear the locators, which are assigned to the 1, 2 and 3 keys on the 
numeric keypad. Navigating with locators is a fast and easy way to jump to key positions in the 
Timeline. Setting a locator based on the current timecode position is often the first and last 
operation when recording macros so that the macro can start and end at the current timecode 
position. At this time, locators are only available in the Fairlight Audio Editor.

To set one of the three user-defined locators:
1 Move the playhead to the timecode position that you wish to save as a locator 

position. In this example you will assign the current playhead position to the first locator 
on the 1 key. 

2 Momentary-press the GoTo key. This illuminates the 1, 2, and 3 keys on the numeric 
keypad. Continue to hold the GoTo key.

3 Momentary-press the 1 key until it tallys on to show that it has been set. 

4 Release both the GoTo and 1 keys. You can follow the same steps to set the second 
and third locators that are assigned to the number 2 and 3 keys. Locators can be set to 
new timecode positions anytime while you work and do not have to be cleared before 
setting a new location. 

To use a locator for navigation: 
1 Momentary-press the GoTo key. The number keys, 1, 2, and 3 illuminate. In this example, 

you will go to locator number 2.

2 Continue to press the GoTo key. Quickly press and release the 2 key. 

3 Release the GoTo key. The playhead jumps to the second locator timecode position.

NOTE: You need to first set a locator before it can be used. Locators are not saved 
with the project. 

To clear all locators: 
1 Momentary-press the GoTo and Clear keys. The number keys, 1, 2, and 3 illuminate, 

but continue pressing the GoTo and Clear keys. 

2 Long press each of the 1, 2, and 3 number keys to tally them on.

3 Release the GoTo and Clear keys. The locators are now clear and will not affect the 
playhead position until they are set to new timecode locations.  
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Numeric keypad with Locator keys illuminated 
during momentary hold of the GoTo key

Jog Wheel with Fixed Keys and Soft Menu Picture Keys 
The jog wheel and surrounding Fixed keys offer a complete set of transport commands, 
designed to let you keep your hand in one position while editing. Here you can not only 
navigate the Timeline from end to end or anywhere in between in seconds, but also go from 
seeing all tracks to a focused zoom on a single clip at the sample level faster than you could 
reach over and pick up a traditional mouse. The combination of the jog wheel and Fixed keys 
offer standard and advanced playback and navigation options that can be defined in Setup 
mode and with the adjacent picture keys. The soft menu picture keys to the left of the jog wheel 
display menu options related to Fixed key and Shuttle functions. Since this section of the 
Fairlight Audio Editor includes such an extensive set of features and functionality, let’s start with 
the jog wheel as a means of navigation and playback, then move on to the Play menu picture 
keys, Fixed keys, and subsequent additional soft menu picture keys. 

Shuttle/jog wheel with Fixed keys and 
default Play menu and Loop picture keys
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Shuttle/Jog Wheel
The jog wheel is the most versatile control on the Fairlight Audio Editor, and is designed for 
ease-of-use with all of the associated keys within reach. As a means of navigation and 
playback, the wheel has two modes of operation, shuttle and jog, that are initiated by the 
respective Shuttle Position and Play Jog keys above the wheel. 

In Shuttle mode, turning the wheel forward (clockwise) or back (counter-clockwise) starts 
playback in fast forward or rewind at variable speeds based on the amount the wheel is turned. 
Releasing the wheel while shuttling forward or back will continue constant playback at the 
current speed until the playhead reaches the beginning or end of the project. 

In Jog mode, the playhead movement is contingent on the movement of the wheel, so you can 
freely jog forward or in reverse at variable speeds while turning the wheel and playback stops 
immediately when the wheel is released. Jog mode is generally used to scrub a specific area to 
focus on audible cues for editing and trimming, or for subframe loop-jog scrubbing to pinpoint 
issues and fine-tune edits. Shuttle mode is used to quickly navigate to a specific location or 
start playback at a variable speed. Additionally, the wheel can be used for common functions 
such as zooming, quickly scrolling track selection to different tracks, changing clip volume 
levels or even dialing the shape of clip fades.

TIP: Holding CTRL and latching Play/Jog puts the heel into Shuttle mode. This 
maneuver also initiates Free shuttle movement even if the Editor setup controls are set 
to Fixed Shuttle. Thus, pressing CTRL + Play/Jog is a common audio editor shortcut for 
Free Shuttle control.  Additionally,  holding CTRL while turning the jog wheel increases 
the speed 8X. Releasing CTRL returns the wheel to standard jog speed.

Soft Menu Picture Keys
The six picture keys to the left of the jog wheel display soft menu options when you 
momentarily press the Play/Jog, Rewind, Fast Forward, and Zoom keys. The default soft menu 
keys that are always available are the Play Menu and Loop keys. Latching the Play Menu key 
shows six specialized playback options and likewise a long-press on the Loop key shows the 
Loop Playback options keys that change the looped playback mode assigned to the Loop key.

Latching the Play Menu key displays special play commands 
on the adjacent soft menu picture keys:

 � Play Again: Plays from the same place as the last time, such as the timecode where 
the transport last entered Play. This could also include Play and Record at the same 
time. This key is the same as the Play Menu key so when the Play Menu keys are not 
displayed, you can simply press Play Menu twice for Play Again.

 � Play Range: This operation plays from the In Point (beginning) to the Out Point (end) of 
a range in the Timeline. 

 � Play Clip: This plays the clip beneath the playhead on the active selected track. If there 
is no clip beneath the playhead, the next clip on selected track is played. 

 � Play In: Plays from one second before the In Point of a range in the Timeline. 

 � Play Out: Plays from one second before the Out Point of a range in the Timeline.

 � Exit: Exits the Play Menu.
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A long-press on the Loop key displays the Loop Playback Options menu keys:
 � Loop Range: Loops playback around the marked range, from In Point to Out Point in the 

Timeline. 

 � Loop Clip: This operation loops playback around the clip beneath the playhead on the 
most-recently-selected track. If there is not a clip beneath the playhead on the active 
track, the next clip in the track is played. If a track is not selected, this key has no affect 
on playback.

 � Loop +/- 1: This creates a two second playback loop around the current playhead 
position that starts one second before the playhead and ends one second after the 
playhead. 

 � Loop +/- 3: This creates a six second loop around the current playhead position that 
starts three seconds before the playhead and ends three seconds after.

 � Exit: Exits the Loop Options menu without changing the current loop playback mode.

(Left) Default soft menu keys with Play Menu key unlatched with Loop key set to Loop Clip, (Center) Play Menu 
key latched, showing Playback Options keys, (Right) Loop key latched, showing Loop Options menu for 
assigning Loop Playback mode 

Fixed Keys in Clockwise Order Starting in the Upper-left Above the Jog Wheel:
 � Shuttle/Position: Latch this key to engage the wheel as a shuttle control for navigation 

and playback. Unlatch or press Stop to stop playback and disengage the shuttle wheel. 
While Shuttle is active, the Rewind and Fast Forward transport keys light up to indicate 
which direction the transport is moving. In the Setup mode, Editor Setup keys you can 
change the shuttle to either Free or Fixed mode. 

 – Free Shuttle mode: When engaged, the shuttle wheel turns freely clockwise or 
counter-clockwise, can change direction instantaneously, and shuttles at variable 
speeds based on the amount and direction you turn the wheel. 

 – Fixed Shuttle mode: Turning the wheel forward or back starts fast-forward or 
reverse playback at a fixed speed with built-in stops whenever you change direction. 

 – Position mode: Hold the Shuttle/Position key while turning the wheel to quickly 
position the playhead (CTI) in the Timeline. In position mode, you can move 
the playhead from the beginning to the end of the Timeline in a single rotation 
of the wheel.
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TIP: When the shuttle is set to Fixed Shuttle mode you can temporarily 
override the fixed setting with a long-press on the Shuttle/Position key after it 
is latched. 

 � Review: This key jumps the playhead back a number of second, then plays. Press 
this key repeatedly to make multiple jumps. The default review jump back time is four 
seconds. You can change this setting to any number of seconds by long-pressing the 
Review button and pressing any button between one and nine on the numeric keypad. 

 � Rewind/Jump Back: This key can operate as either a Rewind key or Jump Back key. 
You can toggle between key functions in the Setup mode, Editor Setup option keys.

 – Rewind key: The operation works exactly as the Rewind key in the Transport 
keys section of the keyboard; you can press the Rewind key repeatedly to 
increase speed. 

 – Jump Back: Use this key to jump back to the previous target based on user 
selection in the Jump soft menu picture keys to the left of the shuttle wheel. Press 
and hold either the Fast Forward or Rewind key to choose jump to targets, including 
To Clip, To Mark, and To Fade from the soft menu picture keys. Jump Back moves to 
the previous Clip or Fade based on track selection. 

 � Fast Forward/Jump Forward: This key can operate as either a Fast Forward key or 
Jump Forward key. You can toggle between key functions in the Setup mode, Editor 
Setup option keys. Since there is already a dedicated Fast Forward key, as well as a 
shuttle wheel for engaging variable speed Fast Forward, this key is often set to Jump 
Forward instead.

 – Fast Forward: This operation works exactly as the Fast Forward key in the Transport 
keys section of the picture keyboard. You can press the Fast Forward key repeatedly 
to increase speed.

 – Jump Forward: You can use this key to Jump forward to the next target based on 
user selection in the Jump soft menu picture keys to the left of the shuttle wheel. 
Press and hold the Jump Forward key to choose jump to targets, including Clip, 
Marker, and Fade. Jump forward to the next Clip and Fade targets are based on 
track selection. Marker targets can be either Timeline markers or Clip markers.  

Momentary-press on Rewind or Fast Forward fixed keys shows 
jump targets in the soft menu keys: To Clips, To Marks and To 
Fades; latch the jump targets you wish to use for navigation with 
the Jump Forward and Jump Back keys
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 � Play/Jog: Use this key to start playback or engage the jog wheel for manual jog control. 
By default, the first press of the Play/Jog key engages the jog wheel. The second 
press latches the key in Play mode and starts playback. If the Play/Jog key is latched, 
unlatching the key re-engages the jog wheel. Once the key has been latched, it toggles 
between Play and Jog. To disable the jog wheel, press the Stop key. Press and hold 
Play/Jog to show the associated soft menu options in the adjacent picture keys on the 
left side of the jog wheel.

Play/Jog soft menu keys with Momentary-press on Play/Jog key:  
Loop Jog, Rescale Jogger, Jog DIM, Gear, Width, and Follow Zoom.

 – Loop Jog: This key toggles Loop Jog on and off. When Loop Jog is on, the transport 
plays a small length of audio (between 5ms and 2000ms), repeatedly, at play speed. 
The loop moves as you jog the transport forward or backward. This is a great tool 
for editing, because it maintains the correct pitch of the audio, allowing you to hear 
clicks, pops, sibilants in the middle of words, and so on. Some of the other soft keys 
in this menu control additional Loop Jog parameters.

 – Rescale Jogger: Use this key to change the gear ratio based on the current zoom 
level so that three revolutions a second of the jog wheel reaches normal play speed. 

 – Jog DIM: Toggles Jog Dim on and off. When on, it causes the monitoring level to 
automatically dim during Loop Jog to the user-defined value set in the Monitor mode 
Dim level. 

 – Gear: This changes the “gear ratio” when jogging between 1 and 20. In other words, 
it determines how quickly the transport moves in response to turning the jog wheel. 
You can change the Gear ratio by pressing the Gear key while turning the jog wheel. 
The lower the Gear number, the slower the transport will go; the higher the Gear 
number, the faster the transport will go.

 – Width: Sets the width for the Loop Jog in milliseconds between 5ms and 2000ms. 
This is the amount of audio that is repeated in each loop. You can set this amount 
by holding the Width key and turning the jog wheel.   

 – Follow Zoom: This toggles Follow Zoom on or off. When on, the gear ratio of the 
jog wheel is affected by the Zoom setting. The default setting for this control is 
toggled on.  

 � Record: Latch this key along with the Play key in the standard Transport keys to begin 
recording to the armed track or tracks. Press the Stop key to stop recording. To arm a 
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track for recording, press and hold the Record key, then press the Track Selection key 
for the track you want to arm. Tracks must be patched to an input before they can be 
armed for recording. 

 � Stop: As you may have guessed, this key stops playback or recording. 

 � Up: You can use this key to move the track selection up to the previous track in the 
Timeline. 

 � Down: Use this key to move the track selection down to the next track in the Timeline. 

 � Redo: Reverses the effect of the last Undo. This can be used repeatedly to step 
forward through the editing history. 

 � Undo: Reverses the effect of the last edit and can be used repeatedly to step back 
through the editing history. Also returns to the location and track selection of the edit 
being undone. A list of the actions can be seen in the Edit menu > History. There you 
can also Open History Window to see a full edit history list. 

NOTE: Undo and Redo works on all editing actions while in Editing mode. 
While in Mix mode, you can choose either Undo All or Undo Editor. The default 
Undo setting for mixing is Undo Editor, which limits Undo to editing functions 
and disables Undo for mixing and automation in Mix mode. The Undo settings 
can be changed in the Setup mode. For more information about Undo and 
Redo operations in DaVinci Resolve, See Chapter 1, “Introduction to 
DaVinci Resolve.”  

 � Zoom: The Zoom key in combination with the jog wheel and modifier keys offers 
numerous quick zooming and scaling options while you work. 

 – Hold Zoom and turn the jog wheel to change the horizontal scale of the Timeline on 
the computer screen. 

 – Hold Control + Zoom and turn the jog wheel to change the vertical scale of the 
Timeline, which in turn, changes the height of the tracks and the subsequent 
number of tracks visible in the Timeline. Horizontal scaling always zooms around the 
playhead, while vertical zooming focuses on the active selected track. 

 – Double-tap Zoom to zoom your entire program to fit within the current visible width 
of the Timeline.

 – Press and hold Zoom to show the Zoom menu option keys in the adjacent picture 
keys. These Zoom menu option keys are a fast way to change vertical scaling while 
zooming horizontally with the jog wheel for dynamic scaling while you work. 

These options are:

1 Track Vertically scales the Timeline tracks to show only the active track.

2 Tracks
Vertically scales the Timeline to show two tracks, including 
the active track. 

4 Tracks
Vertically scales the Timeline to show four tracks, including 
the active track. 

8 Tracks
Vertically scales the Timeline to show eight tracks, including 
the active track. 

16 Tracks
Vertically scales the Timeline tracks to show sixteen tracks, 
including the active track. 

All Tracks Vertically scales the Timeline tracks to show all tracks.
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 – Hold Control + Zoom to show a secondary set of Zoom menu option keys, 
including the following: 

32 Tracks
Vertically scales the Timeline to show 32 tracks, including 
the active track. 

48 Tracks
Vertically scales the Timeline tracks to show 48 tracks, 
including the active track.

U1 Scales the Timeline to a user-defined view.

U2 Scales the Timeline to a user-defined view.

U3 Scales the Timeline to a user-defined view.

U4 Scales the Timeline to a user-defined view.

Zoom soft menu picture keys, including 1 Track, 
2 Tracks, 4 Tracks, 8 Tracks, 16 Tracks, and All Tracks

 � Enter: When using the Fairlight Audio Editor for Cut, Copy, and Paste operations, the 
Enter key functions as a Paste key. Additionally, the Enter key completes and executes 
many operations. For example, if you are renaming a track using the QWERTY picture 
keyboard, pressing Enter after typing the name updates the track name, clears the 
keyboard, and returns to the previous Editor mode. 

NOTE: In DaVinci Resolve 16.2 and later, a second Zoom button was added to the left 
side of the picture keyboard while in Mix and Edit mode, so editors can easily reach it 
with either the left or right hand while working.
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The Review, Shuttle mode, Rewind, and Fast Forward keys can all be customized and used in a 
variety of ways.

To change the Review jump back amount, do the following:
1 Momentary-press the Review key to illuminate the current Review setting in the 

numeric keypad.

2 Long-press a different number of seconds from 1 to 9 on the numeric keypad until it 
tallys on to set a new review duration. 

3 Release the number and the Review key.

a  Free Shuttle mode: When engaged, the shuttle wheel turns freely clockwise 
or counter-clockwise, can change direction instantaneously, and shuttles at variable 
speeds based on the amount and direction you turn the wheel. 

b  Fixed Shuttle mode: Turning the wheel forward or back starts fast-forward 
or reverse playback at a fixed speed with built-in stops whenever you 
change direction.

To toggle Shuttle mode between Free Shuttle and Fixed Shuttle, do the following:
1 Latch or Momentary-press the Setup mode key. 

2 Latch the Editor Mode key in the Setup toolset to show the Editor Mode menu 
option keys.

3 In the Editor Mode menu option keys, latch or unlatch the Shuttle option key to toggle 
between Shuttle Fixed and Shuttle Free settings. 

 To toggle the Rewind and Fast Forward keys to Jump keys or vice versa, do the following:
1 Latch or Momentary-press the Setup mode key. 

2 Latch the Editor Mode key in the Setup toolset to show the Editor Mode menu 
option keys.

3 In the Editor Mode menu option keys, latch the Mode Wind key to toggle on 
Mode Jump. The Fixed Rewind and Fast Forward keys above the jog wheel are 
now set as Jump keys. 

4 If the Fixed Rewind and Fast Forward keys are in Jump mode, you can toggle them 
to Wind mode by following steps 1 and 2, then unlatch the Mode Jump key to toggle 
it back to Mode Wind. 

To set a user-defined Zoom view in the Timeline.
1 Momentary-press the Zoom and CTRL keys. 

2 In the soft menu picture keys, long-press one of the user keys (U1, U2, U3, or U4) until 
the main picture keyboard shows all tracks.

3 In the picture keyboard, latch the track selection keys for all of the tracks you would like 
to include in the user-defined view.  

4 At the bottom of the picture keyboard, momentary-press the Menu key and the Fairlight 
key to exit the user Zoom setup mode. 

5 You can repeat steps 1-3 for each of the four user-defined Zoom view keys. 
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To use a user-defined Zoom view in the Timeline.
1 Momentary-press the Zoom and CTRL keys. 

2 In the soft menu picture keys to the left of the jog wheel, press the user view key (U1, 
U2, U3, or U4) to choose that view. 

3 Release the Zoom and CTRL keys. 

4 Latch or unlatch track selection keys to add or remove them from the current 
zoomed view.

Self-Labeling Picture Keyboard
The picture keyboard offers six different key layouts based on the six Editor modes. It also 
functions as a QWERTY keyboard for typing and data entry. Each Editor mode includes a 
specialized toolset of keys, unique to that mode. If you are familiar with the Fairlight page in 
DaVinci Resolve, the picture key functions are self-explanatory as they are clearly labeled with 
text and icons. For even easier identification, you can change the appearance of the picture 
keys to text only in the Editor Setup options on the Setup mode keyboard toolset by toggling 
the Icon Buttons key to reflect as Text Only. 

Since there are hundreds of picture key tools for nearly every function on the Fairlight Page in 
DaVinci Resolve, this section will focus on the types of picture keys, the different Editor mode 
toolsets, and keys in each Editor mode that offer tools and options that are only available in the 
Fairlight Audio Editor. 

Types of picture keys: 
 � Editor Mode Keys: These keys determine the current mode of operation in the 

Fairlight Audio Editor. There can only be one active mode at a time, however, you 
can momentarily jump into a different mode to choose a setting, tool, or task, then jump 
back to the current mode. These modes include: Setup, Record, Monitor, Macro, Mix, 
and Edit. 

 � Menu and Menu Option Keys: Pressing or latching a Menu Key reveals a group of 
Menu Option keys adjacent to the latched Menu key. In most cases the Menu Option 
keys remain visible until you unlatch the parent menu key. For example, in Edit mode, 
you can latch the Track Menu key to show seven Track Menu-related option keys, 
including Unlock Height, Lock Micro, Lock Mini, Lock Large, Track Safe, Hide Track, 
and Un-Hide All. These options are also available when you right-click a track’s header, 
or click the Visibility icons on the Tracks pane of the Index Panel in the Fairlight page. 
When the picture keys are in Text Only mode, the Menu keys can be easily identified 
by the colored tag in the upper-left corner of the key. 

NOTE: At this time, there is not an Un-Hide all tracks function on the Index 
panel in the Fairlight page. However, you can click your mouse on the Hide 
icon and drag it down over other hidden tracks to quickly swipe on or off track 
visibility. The Un-Hide All key is an example of a feature that is only available in 
the Fairlight Audio Editor. 
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 � Toolset Group Keys: These are groups of similar operation keys that are placed 
together within an Editor mode toolset. For example, in Mix mode there is a group of 
Paste tools for pasting attributes from one track to others, including Paste EQ, Paste 
Dynamics, Paste Aux, Paste Path, Paste Plug-ins, and Paste All. This toolset group 
offers the same options that are available in the Paste Attributes sub-menu options in 
the Edit menu and right-click menu on a Track Header. 

 � Toggles: Toggle keys choose between a pair of options, often On or Off. In some 
cases, toggle keys toggle through multiple options. For example, in Record mode, the 
OSC key toggles the Oscillator on or off. However, the Input Monitor mode key toggles 
between all five Input Monitoring modes: Input, Auto, Record, Mute, and Repro. You 
can also latch the Input Monitor key to show the five input monitoring modes as menu 
option keys, similar to a drop-down menu. These same Input Monitoring modes are 
available via the Fairlight > Input Monitoring Style menu. 

 � Open/Close: These keys open or close the associated panel or window on the Fairlight 
page interface. If pressing the key opens the panel or window, pressing the key again 
closes it, in most cases. 

 � Action: Action keys cause an immediate result when pressed, such as Mark In, 
Mark Out, Trim Head, and Trim Tail in Edit mode. 

 � Secondary Functions: Instead of reaching for the mouse for some commonly used 
operations, you can simply press the Control modifier key to reveal them as secondary 
functions in the picture keyboard. For example, press the Control key to transform the 
Mix, Edit, and Monitor mode keys into toggle keys to Show/Hide the Mixer, Index, and 
Meters panels respectively on the Fairlight page. Having the option to quickly show 
and hide these panels can really speed up your workflow. 

Selecting a Clip vs a Range
The Fairlight page in DaVinci Resolve has two prioritized selection options for recording and 
editing functions, both of which use track selection to determine the contents included in 
the selection. 

 � Clip selection: Selects clips beneath the playhead on a selected track or tracks. 
The exception is if clips are manually selected with the mouse. Clips that have been 
manually selected with the mouse are outlined in red and override selection based on 
the playhead and selected tracks. Clip selection is ideal If you only wish to edit a single 
clip or clips beneath the playhead on selected tracks. 

 � Range Selection: Involves setting In and Out points in the Timeline by either using the 
In and Out keys, or marking either In or Out and moving the playhead to create a range. 
Marking a range automatically toggles on the Range key. Range selection allows you 
to select a portion of a clip or multiple clips on all of the the selected tracks. When the 
Range key is latched, recording and editing operations may include all selected tracks 
within the range. If no tracks are selected, all of the timeline material within the Range 
boundary will be selected. This is useful if you are copying or cutting and pasting an 
entire range of the Timeline and pasting it elsewhere in the Timeline.
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As you learn the different Record and Edit mode toolsets, remember that they will change 
based on the state of the Range key and the type of selection you have at the time of the 
operation. 

Range key unlatched and Range key latched 

Range selection within the selected track and clip selection  
of the clip beneath the playhead on the selected track

Setup Mode Toolset
The Setup mode toolset is for the behind-the-scenes setup of operational elements that in 
many cases are set up when you start a project and left alone for the duration of the project. 
Here you’ll find specialized keys for setting up the Audio Editor’s functionality, toggling controls, 
or opening and closing settings windows that would otherwise require a mouse and menu 
selections on the Fairlight page. There are also some specialized setup keys that are only 
available on the Audio Editor, where you may wish to momentarily jump into Setup mode to 
enable or disable functions, then jump back to your current task. 

Setup mode default toolset
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Setup mode keys for enhanced features only available in the Fairlight Audio Editor:
 � Video Online/Offline: When toggled On (Online) the playhead is sync locked to the 

current video timecode in the Timeline. When toggled off (Offline), the playhead 
moves freely, and can be used to go to another area of the Timeline or Media Pool 
to add or edit a clip. Toggling this key back On (Online), returns the playhead to the 
exact position it was prior to going offline. This is a great way to temporarily move the 
transport offline so that you can go to a clip in another part of the Timeline, use the 
playhead as a sync point to copy or cut the clip, then toggle the Video back Online to 
jump the playhead and copied clip to the previous timeline location. 

 � Display Setup: This menu key reveals Display Setup Source keys to accommodate all 
of the Fairlight LCD screens on a console. Each Source key toggles between DATA, 
HDMI and SDI as needed.

 � Fader Spill: Temporarily spilling the member tracks of a master bus or VCA group to 
nearby faders is a fast way to finesse member track levels while mixing. Use this menu 
key to reveal two menu Spill option keys that determine the type of fader channel and 
direction in which member tracks are temporarily mapped to the adjoining faders on 
the Fairlight Channel Fader panel.

 – Spill Left/Spill Right: This menu options key toggles between Spill: Left and Spill: 
Right, which in turn dictates whether the member tracks of a bus are assigned to 
neighboring faders to the left or right of a bus when Spill is engaged in the Channel 
Fader panel. 

 – Spill Any/Spill Tracks: When in the default (unlatched) state, the Spill: Any menu 
option allows member tracks of a bus to be spilled to the nearest faders to the left or 
right, including faders assigned to Master buses and VCA groups. When latched to 
the Spill: Tracks option, member tracks of a bus spill either left or right, starting with 
the nearest track fader in the designated direction. This option is useful if you need 
to maintain fader control of your buses while you spill their constituent tracks to the 
nearest track faders.

NOTE: Fader spill is engaged on the Channel Fader panel with a momentary-
press on the Bank/Flip key, then latching the call button on a bus channel in 
the current fader bank. For more detailed instructions on using Fader Spill and 
creating custom Fader Banks, see Chapter 163, “Fairlight Consoles.”  

 � DL Off: This is the Decklink Offset key that lets you offset the Decklink Output so the 
picture and audio are in sync. Momentary press the DL Offset key and turn the jog 
wheel to increase or decrease the frame offset between 0 and 7 frames. This feature is 
also available in the Fairlight, Video I/O Offset section of the the DaVinci Resolve User 
Preferences.  

 � ADV In Jog: Latch this key to apply the Decklink Output offset while playback is in Jog 
or Shuttle mode. This feature is also available as a checkbox in the Fairlight section of 
the DaVinci Resolve User Preferences.  
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Fairlight - Video I/O Offset settings in DaVinci Resolve User Preferences that mirror 
the DL Offset and ADV in Jog picture key functions on the Audio Editor. 

 � Talk Setup: This menu key reveals three menu option toggle keys to customize the 
Editor’s Talkback functionality:

 – Smart Talk/Push-2-Talk: This key toggles between the default unlatched Smart 
Talk option and the latched Push-2-Talk option.  Smart Talk allows the user to 
either latch the Talk button for extended hands-free talkback, or Push-2-Talk with a 
momentary press on the Talk button. Latching this key toggles on the Push-2-Talk 
mode, which limits talkback to the momentary-press Push-2-Talk method similar to 
using a 2-way radio. 

 – GPI: Talk/DIM/None: This key toggles the Monitoring Controls for the general 
purpose input (GPI) between None, Talk plus DIM, or DIM only.

 – GPO: Talk/None/Armed/Record: Use this menu options key to determine when the 
general purpose output (GPO) sends a signal during a session. This key toggles 
between Talk, None, Armed and Record. 

 � Editor Setup: This menu key reveals toggle keys to customize the Editor 
functionality, including:

 – Mode Jump/Wind: This key toggles between Jump and Wind modes for the Rewind 
and Fast Forward keys above the jog wheel. 

 – Shuttle Fixed/Shuttle Free: This key toggles between Fixed or Free Jog Shuttle 
mode. 

 – Jump/Wind: This key toggles between Jump and Wind modes for the Rewind and 
Fast Forward keys above the jog wheel. 

 – Icon Buttons/Text Only: Use this key to toggle the picture keys between Icon and 
Text or Text only. 

 – ALT Layout: Latch this key to switch from the Normal layout to a new alternative 
text-only keyboard layout. This new Alt text-picture key layout shows keys that are 
relevant to the current task, with keys grouped toward the middle and lower rows of 
the keyboard for easy access. In this layout, the Editor Mode keys are located in the 
center of the the lower two rows of the picture keyboard. They are easy to spot with 
white text labels and a white line at the bottom of each mode key. The alternative 
layout also utilizes the six soft menu picture keys to the left of the jog/shuttle wheel 
for toolset group keys based on the current Editor mode and task at hand. 

Chapter – 162 Using the Fairlight Audio Editor 3361



To return to the normal layout of the picture keyboard, do the following: 
1 Press the white SETUP mode key, if necessary. 

2 Press the yellow UTILS (Utilities) key. To reveal the Utilities menu options keys in the 
row above the UTILS key. The yellow tag in the upper-left corner of the UTILS key 
indicates it is a menu key.

3 Press the orange ALT LAYOUT menu options key to return to the normal layout in 
Text Only mode. To return to standard Icon and Text mode, unlatch the Text Only key 
in the Editor Setup menu options keys in Setup mode.

Alt Layout with the SETUP mode key latched and the 
UTILS menu key on the far right unlatched 

Alt Layout with the UTILS menu key latched and subsequent menu 
options keys in the row above including the latched Alt Layout key

NOTE: You’ll find pictures of each of the Alt Layout toolsets later in 
this chapter.
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Additional enhanced features only available in the Fairlight Audio Editor:
 � Call Follows key: In addition to selecting a track, there are other criteria for making 

a track active and “calling” its information into the Editor screen and corresponding 
Channel Control bay if you are on a Fairlight Audio Editor connected to a Fairlight 
console. These Call Follows menu options depend on the physical buttons, 
touch-sensitive knobs, and faders on the Fairlight console. The Call Follows menu key 
offers five Call Option keys that can be used alone or in combination to determine 
which track or master bus is active:

 – Current Track: When toggled on, the most recently selected track is the active track.

 – Fader Touch: When toggled on, touching a fader on the Fader panel makes it active.

 – Pan Touch: When toggled on, touching the Pan knob on the Fader panel makes it 
the active track.

 – Inline Touch: When toggled on, touching any touch sensitive knob on the Channel 
Control panel, while set to Inline mode, calls that track and makes it active.

 – Solo Button: Latching the Solo button on the Fader panel makes it active. 
Using a mouse or the Solo button on the Fairlight Audio Editor does not “call” 
the track active. Only the Solo button on the Fairlight Fader Control panel works in 
this scenario. 

 � Undo Editor/Undo All: This key is a matter of operator preference. When set to the 
default (unlatched), Undo Editor, tasks performed in Mix mode, including recording 
and editing automation data, will not be undoable. You can, however, simply record 
new mixing data to override the previous data as needed. Latching this key enables 
the Undo All mode, which in turn will undo all actions including automation applied in 
Mix mode. 

 � CTI Fixed/Moving: This key lets you choose whether the playhead (CTI) moves across 
the Timeline, or is fixed in place with the Timeline scrolling past.

 � Preview Track/Mon: This key determines where preview monitoring goes when 
auditioning a sound and comes in handy when you need to preview a clip in the 
Media Pool or Sound Library.  When toggled to Preview Track, you will put the track in 
Thru mode so it works like a live mic input and the sound you preview will be subject 
to the track’s fader levels, solo or mute state, and any processing applied to the 
track. If toggled to Preview Mon, the sound goes directly to the monitors without any 
processing or controls via the track’s channel strip in the mixer or console.  

 � Normal Solo/Solo Follows: This lets you customize how the Solo commands work. 
Normal Solo/Solo Follows is a bypass toggle for the Call Follows, Solo Button option. 
If the Call Follows, Solo Button menu options key is latched, and the Normal Solo/Solo 
Follows key is latched, soloing a track in the Audio Editor or Channel Fader panel “calls” 
that track’s information into the Editor display on the Audio Editor, and the Channel 
display in a Fairlight Console Channel bay. Unlatching the Normal Solo/Solo Follows 
key bypasses the Solo Call feature and returns Solo functionality to Normal Solo 
behavior, as the name suggests.

Using the Playhead as a Sync Point indicator to sync sound to picture using 
Video Online/Offline key:

1 With the Video Online/Offline key latched on, move the Playhead to the desired frame 
in the Timeline. For this example, let’s make it the frame where a door slams closed in 
the Viewer.

2 Unlatch the Video Online/Offline key so that it is offline.
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3 Move the playhead to another location in the Timeline where there is a door closing 
sound effect that you’d like to copy. 

4 Select the track with the clip you want to copy, and move the playhead over the frame 
that you  want to sync with the door closing frame. 

5 In Edit mode, press the Copy Clip key. 

6 Latch the Video Online/Offline key so that it is Online. The playhead jumps to the 
previous location  using the playhead as a sync point to match the door closing audio 
clip to the video frame of the door closing.

7 If necessary, press the Track Selection key for the track where you wish to paste the 
synced clip.

8 Press the Enter key to paste the clip.

Record Mode Toolset
The Record mode toolset is where you do your recording and offers specialized toolsets for 
both Manual and ADR recording. There are keys for every recording feature available on the 
Fairlight page including keys to open and close the Patch Input/Output window and ADR panels 
as well as rate takes without needing your mouse. Latch the ADR List, ADR Record or ADR 
Setup keys to open the associated panels on the computer screen. When either the ADR List or 
ADR Record keys are latched, you’ll see picture keys for each interface button in the associated 
workflows. For example, latching the ADR Record key reveals a set of seven specialized keys 
for ADR Recording, including Previous Cue, Next Cue, Previous Take, Next Take, Rehearse Cue, 
Record Cue, and Play Cue. These keys work exactly the same as using a mouse and keyboard 
on the ADR Record panel in the Fairlight page interface. 

The Fairlight Audio Editor includes a special set of Manual recording options that are only 
available on the Editor. These options use either playhead, clip, or range boundaries, as well as 
user-defined pre-roll and post-roll that can be set in the User Preferences, Editing panel. 

NOTE: When recording in the Fairlight page, tracks must be armed before recording, 
and only tracks with inputs patched to them can be armed. Luckily, there is a key in the 
Record Mode toolset for opening the Patch Input/Output window. Use a momentary 
press on the Record key and Latch a Track Selection Key to arm that track. 

Record mode default toolset
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Record Mode Manual Recording special toolset keys include:
 � Record Here: Playhead goes back the pre-roll duration, then punches into Record at 

the location where you issued the command. This can be useful when you zoom in to 
find the exact timecode position where you want to punch in to record, then simply 
issue this command by pressing the Record Here key and the system does everything 
for you.

 � Record Range: The playhead includes a pre-roll and punches into Record at the Range 
In point, and then punches out at the Range Out point. 

 � Record Clip: After pre-roll, the playhead punches in and out to match the duration of 
the clip under the playhead on the selected track. If no clip is beneath the playhead, 
the transport moves forward to the next clip in the track and records there. 

 � Record Again: Pressing this key repeats the last recording you made, both entry and 
exit, whether it was manually or automatically punched in.

 � Punch In Again: The system pre-rolls, then enters record at the exact same place as 
last time, whether it was manually for automatically activated. When entering this record 
operation, you still need to manually punch out. This allows you to get the same start 
point for recording but with a manual exit.

 � Record Head: Pre-rolls, then starts recording at the head of the first clip to come 
beneath the playhead in the selected track. When entering this record operation, you 
still need to manually punch out. 

Monitor Mode Toolset
As the name suggests, this mode is for setting up your monitor system. In most cases, this is set 
up at installation, but there are also controls for setting up the monitors for a particular session 
and quickly switching between different sources, including external sources, speaker sets, and 
surround formats. You can even mute any of the current speakers by latching its associated 
picture key marked with a Speaker icon. 

Monitor mode default keys showing Control Room monitoring 

Monitor mode keys for enhanced features only available in the Fairlight Audio Editor:
 � C/R / Studio toggle: This key toggles the Monitor mode keys between 

Control Room (C/R) and Studio monitoring keys. 

 � Phase: Hold this key and press any speaker button to toggle its phase.
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 � Alt Source: Use this key to toggle between the Main system bus and the most recently 
selected Alternative source. The standard monitoring source is the Main system 
bus. However, you can choose many other sources, including other system buses or 
external sources, such as a CD player. The system remembers the last non-standard 
source that you chose as the Alternative source. 

 � Mono Comp: If your current speaker set is not mono, you can press this button to 
monitor playback in mono. 

 � Stereo Comp: If the current speaker format is not stereo, you can press this key to 
monitor the playback in stereo. 

Macros Mode Toolset
Macros are programmable keys where you can record sequences of keystrokes. The Macro 
mode toolset includes 30 programmable Macro keys, as well as Delete, Rename, and Record 
keys for recording and managing your macros. The first 14 Macro keys are also assigned to the 
Macro quick-keys at the top of the Audio Editor’s display (Pad). Macros can record any 
keystroke on the Fairlight Audio Editor, including a momentary press to enter a different mode 
and keypresses in that mode during the momentary press. For example, it is common, when 
recording a macro, that you start in the mode with the first key you want to record, then 
momentary-press the Macro mode key to enter Macro mode just long enough to start recording 
the macro. Upon releasing the Macro mode key, the first key you press on the original mode will 
be the first one recorded. 

The most important thing to remember when recording macros is that they are reliable once 
created, but have no context except what you program. It’s a good idea to think of the starting 
and ending context for your macro prior to recording. For example, if the macro requires moving 
clips from one track to an empty track, make sure you create the new track before executing 
the macro. If the macro uses jump keys, make sure you have them set up ahead of time and so 
on. It is up to the user to remember a starting point and ending point, if relevant. Once a macro 
has been recorded, the associated quick key at the top of the Editor lights up to show that it is 
available as a macro.

Macro mode keys

NOTE: To prevent accidentally recording, renaming or deleting a Macro key, the Macro 
action keys require a momentary press plus a numbered Macro key. 
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Macro Mode action keys:
 � Delete: Press and hold this key and press a Macro key to delete the macro.

 � Rename: Press and hold this key and press a Macro key to open the User Macros 
dialog and rename the macro.

 � Record: Press and hold this key and press a numbered Macro key to record. Press 
Control and the Menu key to stop recording. The Menu modifier key changes to Menu 
(rec) when recording a macro and Stop Recording when you press the Control modifier 
key while recording a macro. 

Standard modifier keys in Macros mode and Macros action keys, 
including Delete, Rename, and Record

 

Menu becomes Menu Record key during macro recording and 
Stop Record when Control key is pressed during macro recording

Recording a Macro:
1 Set up the Editor for whatever steps you plan to record in the Macro and 

latch that mode.

2 Momentarily press the Macros mode key to enter that mode temporarily. 

3 Do not release the Macros key.

4 With the other hand, in the Macro mode toolset, momentarily press the Record key and 
the numbered Macro key that you want to record. Release the Record and numbered 
Macro key.

5 Release the Macros mode key to return to the latched Editor mode. 

6 Press the keys one at a time as needed to complete the steps that you want to record 
to the macro.

7 Stop playback, if necessary. 

8 Press the Control key and press the Stop Recording key in the modifiers 
section of the keyboard. 

NOTE: You can take as long as you need to record a macro, and if you make a mistake 
you can either delete the macro or re-record it using the Delete or Record keys.
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Example of recording a simple macro to move a clip from one track to the track below: 
1 Prepare the Editor for recording the first macro. In this case, press the Edit mode key 

and latch the A1 track selection key to select that track. Move the playhead over the 
first clip in the track. 

2 Momentary press the Macros key with the left hand. Do not release the 
Macros mode key.

3 In the Macros toolset, press the Record key and the Macro 1 key, to initiate recording 
of the Macros 1 key. Release both keys. The Macros keys disappear from view in the 
Macros toolset. 

4 Release the momentary press on the Macros key to return to the Edit mode. The next 
keypress will be the first recorded to the Macro 1.

5 Press the Cut Clip key to cut the clip on the selected track beneath the playhead.

6 Press the Down key to the left of the jog wheel to move the track selection, and the 
shadow of the clip that was cut, down one track. 

7 Press the Enter key to paste the clip.

8 Press the Up key next to the jog wheel to move the selection back up to the A1 track.

9 Press the Control modifier to change the Menu key to a Recording Stop key. Press the 
Recording Stop key.

From this point forward, pressing the Macro 1 key in the Macros Mode toolset, or the Macros 1 
quick key at the top of the Editor will perform the macro of cutting a clip on one selected track 
and moving it to the track below then returning to the original track. With this macro, you could 
easily use jump keys to move down the Timeline a clip at a time, and move any clips that need 
to go to the A2 track with the press of the Macro 1 key.  

NOTE: You could also use this same macro to move a clip from any selected track to 
the track below because it contains the Up and Down arrow keys instead of specified 
track selection keys. Additionally, you could take this macro idea to a whole new level 
and include jump keys and fades at the edges of the clips as you edit. 

Renaming a Macro key
1 Enter the Macros mode toolset.

2 Long-press the Rename key and press the Macro key that you want to rename. 

3 In this case Macro 1. Release both keys.

4 The picture keyboard changes to QWERTY keys and the User Macros dialog opens on 
the computer screen. 

5 Type a new name for the Macro and press Return.

6 The Macro is named in the Macro mode keys. 

User Macros dialog on Computer screen

Chapter – 162 Using the Fairlight Audio Editor 3368



Named Macro 1 in the Macros Mode keys

TIP: If you are going to name your macros, it’s a good idea to give them a brief but 
literal name to help you remember the macro’s function. In the above example, the 
macro was named A1 to A2 because it was designed to move a clip from the A1 track to 
the A2 track. 

Mix Mode Toolset
Whether you are using the Fairlight Audio Editor with your computer, or as part of a Fairlight 
Console, the Editor’s Mix mode offers easy access to a powerful array of mixing and automation 
tools. Here you can copy and paste EQ, Dynamics, Aux, Path, Plug-ins or all of the above to 
other tracks and buses as well as automate any parameter. The heart of the Mix mode toolset is 
the Mix On/Off key. Latching Mix On brings all of Fairlight’s powerful automation tools and menu 
options to the picture keyboard so you can control every aspect of your automation without 
ever reaching for the mouse. If you are familiar with Fairlight’s mixing and automation tools in 
DaVinci Resolve, you’ll have no trouble finding your way around this toolset because there is a 
picture key for every switch, toggle, menu, and sub-menu option available in the Fairlight page’s 
robust automation toolset. 

The functionality of each specialized key is exactly the same as using the software alone. 
However, the advantage of mixing with the Fairlight Audio Editor or a Fairlight Console is that 
you’ll have physical controls including touch-sensitive knobs for precision automation recording 
and mixing maneuvers without the distraction of a mouse and menus.

NOTE: For a detailed rundown of the Fairlight Automation tools and features, please 
refer to Chapter 157, “Automation Recording.”  

Default Mix Mode keys with the Mix On key unlatched and Copy/Paste latched
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Mix Mode keys with Mix On latched; the automation toolset showing and Copy/Paste unlatched 

The Mix Mode automation keys are organized and grouped as action keys, toggles and menus 
with related submenu keys with the same tools and menu choices that you’ll find on the Fairlight 
page and Fairlight menu in DaVinci Resolve. 

Mix Mode toolset toggles, groups, and menu keys:
 � Copy/Paste: This key automatically toggles on when automation is turned off. You can 

manually latch this key while the automation toolset is showing. When latched, the 
Copy/Paste key reveals the Copy and Paste toolset group. 

 � Copy and Paste Toolset Group: When the Mix On key is unlatched, the Copy/Paste 
key latches, and you will see a Copy key next to a toolset with six paste action keys, 
including Paste EQ, Paste DYN, Paste AUX, Paste PATH, Paste PLUGS, and Paste ALL. 
These keys are all used to copy attributes from the active track and paste them on a 
selected track. To use these keys, press the Copy key to copy all of the track attributes 
for the active track. Select another track and choose the Paste action key that 
corresponds with the attributes you want to paste to the newly selected track. 

 � Mix ON: This key toggles on or off the Automation toolset. When toggled on, the Copy/
Paste key toggles off and the Copy and Paste toolset group switches to the automation 
specific toolset such as the Mix, Punch Menu, and Preview menu keys.

 � Automation Menu keys: Enable, Mix list, Mix Menu, Punch Menu, and Preview Menu all 
reveal a set of submenu option keys when latched. The subsequent option keys offer 
the exact same options available on the Fairlight page interface. For example, latching 
the Enable menu key reveals ten option keys that represent each of the ten Enable 
buttons on the Fairlight page Automation toolbar, in the exact order that they appear 
onscreen. The Enable option keys are as follows from left to right: Write FADER, Write 
MUTE, Write PAN, Write EQ, Write COMP, Write LIMITER, Write AUX, Write PLUGINS, 
Write MISC, including a dedicated All button. 

 � Open/Close GUI window keys: The Patch, Mix List, and Presets keys open and close 
the corresponding windows on the computer screen. 

 � Toggles: The Touch and @Stop keys toggle between the different Touch and Stop 
automation modes when toggled. The Touch toggles between OFF, LATCH, and SNAP 
while the @Stop key toggles between RETURN, EVENT, and HOLD.

 � Preview: Switches the Automation controls into Preview mode for auditioning settings 
without writing new automation data.

 � Write Quick Keys: Write FADER, Write MUTE, Write PAN. These keys can be used to 
quickly enable the three most common Automation parameters.

Chapter – 162 Using the Fairlight Audio Editor 3370



Edit Mode Toolset
If you’re read the previous Fairlight chapters, you’re already familiar with the Audio Editing tools 
and menu options. The Edit mode toolset includes over twenty specialized picture keys for 
adding, moving, editing, and trimming clips in the Timeline. The keys represent all of the audio 
editing options available in the Fairlight page via the Edit and Trim menus as well as a handful of 
tools that are only available in the Audio Editor. You’ll also find keys to open, preview, and edit 
clips from the Sound Library and Media Pool. 

Fairlight audio editing is by nature fast and fluid, even when you are working with the software 
and computer alone. Where the Fairlight Audio Editor enhances the process is that with the 
combination of the jog wheel and Edit mode action keys, you can move and edit clips at 
incredible speeds and even edit clips on the fly without ever picking up your hands. In fact, the 
Fairlight Audio Editor is designed for two-handed operations. The added functionality of 
two-handed workflows really comes into play when working in the Edit mode.  For example: 
with your left hand, you can easily select tracks and press action keys, while you use your right 
hand to drive the jog wheel controls and press the Enter key to paste material that its copied to 
the clipboard.  

The Edit mode action keys work off of two principals: removing material you don’t want to keep 
in the Timeline, or moving material to another location. To remove material, you use tools that 
erase or trim. To move material, you use the Clipboard tools that cut or copy and therefore store 
the material in memory to be pasted elsewhere. When you cut or copy material, a 
semi-transparent version of the Clipboard clip appears in the Timeline and can be moved to 
another track or location and pasted. Another consideration when editing is to determine if you 
are modifying the head, tail, whole clip, or a range containing only part of a clip or multiple clips. 
All audio edits are non-destructive and reversible with the Undo key.

NOTE: For more details about the fundamentals of editing audio clips in the 
Fairlight page, please refer to Chapter 154, “Editing Basics in the Fairlight Page.” 

Edit mode keys

Default Edit mode actions and associated keys include: 
 � Cut: Cut Head, Cut Clip, Cut Tail keys all cut the material based on the selected track, 

clip and playhead position and place the removed material in the clipboard for pasting 
with the Enter key. For more fluid editing, hold down a Cut key, such as Cut Tail, and 
use the jog wheel to move the cut portion of the clip to a new location, then release the 
Cut Tail key to automatically paste the cut clip in the new position. 

 � Copy: Copy Head, Copy Clip, Copy Tail keys all copy the material based on the 
selected track, clip and playhead position and place the copied material in the 
clipboard for pasting with the Enter key.
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 � Trim: Trim Head, Trim Tail uses the playhead’s position to remove the current clip’s 
head or tail. You can also press and hold Trim Head or Trim Tail while using the jog 
wheel to extend either the head or tail of the current clip. While doing this, you see the 
full waveform the clip you’re trimming as you turn the jog wheel, but when you release 
the Trim Head or Trim Tail button, the Head or Tail of the selected clip appears trimmed 
at the current frame at the playhead.

 � Split: The Split key splits the clip at the playhead position creating a new edit point 
between two clips.

 � Fade: The Fade Head and Fade Tail keys add fades respectively from the playhead to 
the head or tail of a clip.

 � Erase: Erase clip deletes the clip from the Timeline.

Edit mode actions when Range is active:
 � Cut Range: Use this key to cut all clips and partial clips within the range on the selected 

track or tracks. The Cut Range key replaces the Cut Clip key when Range is toggled on. 
This cuts clips within the range on all selected tracks.

 � Copy Range: Use this key to copy all clips and partial clips within the range on the 
selected track or tracks. The Copy Range key replaces the Copy Clip key when Range 
is toggled on. This copies clips on all selected tracks within the range.

 � Split Range: This key splits any clips lying across the range boundaries into two pieces 
at the range In Point and Range Out Point. This affects clips at the range boundaries on 
selected tracks.

 � Erase Range: Erase Range deletes the range from the Timeline. This Erase Range key 
replaces the Erase Clip key when Range is toggled on.

NOTE: For ease of use and quick mastery, the Edit mode action keys are logically 
grouped in pairs or trios so that keys involving the head of a clip are first and tails are 
last. For example, the Cut Head, Cut Clip, and Cut Tails keys are grouped together as a 
trio. Placing three fingers over those keys make it easy to remember the first key is the 
head, middle key is the full clip, and last key is the tail. 

In addition to the default Edit mode action keys, there is also a set of refinement action keys 
that can be used to finesse edits, fades, and clip positions. The refinement action keys require 
the Control modifier key as well as the jog wheel in most cases. These refinement action keys 
are logically placed for quick decisions so you can first execute an edit and then refine it 
without lifting your left hand or searching for a refinement key. 

Control modifier-based editing refinement actions and associated keys include: 
 � Erase: Erase Head and Erase Tail keys appear on the same keys as Cut Head and Cut 

Tail so that you can quickly choose between a cut, which keeps the material in the 
clipboard and erasure of the material, with the touch of your left Pinky finger on the 
Control key. 

 � Fade: Head X-Level and Tail X-Level keys appear on the Fade Head and Fade tail keys 
so that you can first add a fade, then press Control and use the same key to refine the 
fade level with the jog wheel. Additionally, long-press SHIFT to reveal Head XPoint and 
Tail XPoint that can be changed with the jog wheel or long-press CTRL + SHIFT to use 
the jog wheel to refine Head Shape and Tail Shape. 
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 � Slip: Slip Head, Slip Clip, and Slip Tail keys are located on the same keys as Copy 
Head, Copy Clip, and Copy Tail. That way you can seamlessly copy, move, and paste 
material to a new location, then hold the Control key while pressing the respective Slip 
key, and turn the jog wheel to refine the Head, Clip position or Tail based on the jog 
movement of the playhead. 

 � Trim: The Trim Clip refinement tool shares a key with the Split Clip key so that you can 
split a clip at the playhead position, then hold Control and the same key while using the 
jog wheel to refine the position of the edit point created by the split. 

 � Clip Level: This key plus the jog wheel and the Control modifier key adjusts the Display 
level of the selected clip’s waveform.

Edit mode keys for enhanced features only available in the Fairlight Audio Editor:
The Edit mode tools work exactly as expected if you are familiar with the Fairlight page in 
DaVinci Resolve. There are, however, a few specialized keys that don’t have counterpart tools in 
the Fairlight page. These unique tools perform valuable time-saving tasks.

 � Clip Level: This key is both a Menu and Jog Wheel modifier key. Hold the Clip Level 
key to reveal seven option keys to raise or lower the selected clip’s volume up +/- 3 
dB. Incremental menu options keys from left to right include: -3dB, -2dB, -1dB, 0dB, 
+1dB, +2dB, +3dB. As a Jog Wheel modifier key, hold the Clip Level key with the left 
hand and turn the jog wheel with the right hand to raise or lower the clip’s volume level 
dynamically based on the amount and direction that you turn the wheel. This can be 
performed on the fly during playback, so you can dial up or down the volume level of 
any clip on the selected track as the playhead passes over the clip. Clip level changes 
can also be applied to multiple clips on multiple selected tracks simultaneously. 

NOTE: At the time of this printing, The Edit page in DaVinci Resolve includes a 
Clip menu option and keyboard shortcuts for incremental decibel changes, 
however there is no comparable shortcut, or menu in the Fairlight page.

 � Reverse Clip: This key is available as one of the Clip Menu action keys. When pressed, 
this key reverses the clip beneath the playhead on the selected track. This creative 
sound design tool is also available in the Record mode Clip Menu toolset.

 � Range Menu Keys: A momentary-press on the Range key revels six invaluable Range-
defined tools for speeding up your tasks. Although they are also available in the Record 
and Mix mode toolsets, you will primarily use them in Edit mode. 

 � Copy Segment: This action key copies all timeline material within a marked range.

 � Paste Segment:This key pastes a copied segment to a new timeline location based on 
the playhead position.

 � Previous Gap: Use this key to extend a range by moving the range In Point to the 
previous gap in the selected track or tracks. 

 � Next Gap: Use this key to extend a range by moving the range Out Point to the next 
gap in the selected track or tracks. 
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 � Fill: Fills the current range on a track from end to end with the clipboard clip. Without 
the need to cut, copy and paste, Fill automatically duplicates the clipboard clip, with 
a slight overlap and fade to stitch together background noise or room tone within the 
marked range.

 � B/F Fill: Back/Front Fill works exactly the same as Fill, except that it reverses the 
audio in every second copy of the clipboard used for filling. Alternating the direction 
of the stitched clips is useful for creating a seamless background sound because the 
waveform is continuous.

Alternate Picture Key Toolsets
In the Alternate picture key layout mode, all of the picture keys are text only, with the Editor 
mode keys arranged in the lower center white text. The menu keys are easy to spot with yellow 
text and a mark in the upper left corner. Alternate Edit, Monitor, and Mix mode toolsets include 
action keys in the six soft keys to the left of the jog wheel for quick access. For example, in Edit 
mode, the Cut, Copy, Erase, Fade, Nudge, and Trim action keys are all located in the upper-left 
corner of the picture keyboard, while the action keys associated with the active action key 
appear in the picture keys near the jog wheel. For example, if the Copy action key is latched, 
the Copy Clip, Copy Head, and Copy Tails keys are available near the jog wheel.  If you latch 
the Cut action key, the middle keys near the jog wheel change to Cut Clip, Cut Head, 
and Cut Tail.

Alternate picture key toolsets include the same keys as the default normal layout. The 
difference is the location of the keys, how they are grouped, and the additional usage of the 
picture keys near the jog wheel. 

Alternate Macro toolset

Alternate Setup toolset
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Alternate Record toolset

Alternate Monitor toolset with Phase, Main/Near Speaker selection, 
and Alt Source keys available near the jog wheel

Alternate Mixer toolset with Mix On unlatched, Copy/Paste latched, 
and Copy/Paste keys available near the jog wheel
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Alternate Mixer toolset with Mix On latched and Mix automation keys available near the jog wheel

Alternate Editor toolset with Copy latched and Copy action keys available near the jog wheel

TIP: One way to get to know your way around the Audio Editor keyboard is to start with 
knowing how to perform a task in the Fairlight page using a mouse and standard 
keyboard. Then, consider which Editor mode category the task belongs to, and find 
the associated keys from there. Making the transition from mouse and keyboard to the 
Audio Editor is a journey of discovery where you will find numerous ways to execute 
different tasks, shortcut keys and advanced controls and options that can increase 
your speed and productivity exponentially the longer you use it.
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Editor Screen with Soft Controls
The Editor screen, located above the picture keyboard, displays all signal processing and 
mixing information related to the most-recently-selected (active) track or master bus. It also 
displays labels and visual feedback for the soft keys and knobs that surround the screen. 
Additionally, the ALT key below the screen extends its functionality with an alternative set of 
parameters when necessary. This is where you can quickly view and adjust various mixing 
parameters associated with the active track or master bus. Whether you select a track manually 
with a mouse click, press the associated Track Selection key on the Audio Editor, or latch a 
Channel Select button on the Fairlight Channel Control panel, the most-recently-selected 
track’s parameters appear in the Editor screen. 

These parameters include Level and Pan, EQ, Dynamics and AUX, and Plug-in parameters that 
correspond with the active track of bus. The graphical display for signal processing remains the 
same in the Editor screen for nearly all Editor modes and types of signal processing, except for 
Monitor mode and Aux signal processing.

As you learn your way around the Fairlight Audio Editor you’ll soon find that glancing at the 
Editor screen is akin to glancing at your dashboard while you drive your car. Following this 
example, your primary computer screen is like your windshield where you can always see what 
is happening as you drive the Fairlight Console or Audio Editor. However, like a dashboard, you 
can glance at the Editor screen at any time to see which track or master bus is selected, as well 
as the current signal processing settings. Also, like your car’s dashboard, you can reach out and 
change settings for any of the interactive graphical parameters by simply choosing that element 
and modifying the adjacent controls. 

At this time there are five different Editor Screen layouts that you will encounter while you work 
with the Fairlight Audio Editor, including Clip EQ, Standard Mixing, Plug-In, Aux sends, and 
Monitor mode layouts. 

The Clip EQ layout gives you soft menu controls of the 4-Band EQ parameters for the selected clip when you 
latch the Clip EQ key. The Clip EQ key is one of the Clip Menu option keys available in the Record and Edit mode 
toolsets. Here you have all the same EQ controls that are available in the Clip Inspector in DaVinci Resolve. 
Along the top of the the second page of Clip EQ controls (shown above), you’ll find new Clip EQ preset options 
that are not currently available in the Fairlight page UI. These options include: Save Preset, Apply Preset, Copy, 
and Paste.
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Standard Mixing layout used in all Editor modes, except Monitor, or when the Aux controls are showing. At a 
glance you can see that the Pan controls are active based on the illuminated soft button in the bottom row with 
the bright red line over the Pan label adjacent to the latched button.

Plug-In layout used to control first plug-in on the selected track and is available in all Editor modes. except 
Monitor mode and when Aux controls are showing. The Plug-In Editor screen controls include a three page 
layout. Page 1 provides the Insert IN toggle to bypass the plug-in. Page 2, shown above, has toggle options to 
Reset the plug-in as well as options to Save, Load, and Apply presets, Automate, and Lock the plug-in. Page 3 
offers Mapping mode where the user can map specific plug-in parameters to the six Editor rotary knobs.

Aux layout showing send levels and panning for up to 24 Aux channels simultaneously. In this example, the 
sends for Aux 1 and Aux 3 are enabled (green) for the active track, while Aux 2 has been disabled for this track. 
The soft buttons along the top enable the different Aux channels for the active track. Red text over black labels 
indicate which Aux channels and soft buttons are toggled On. 
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Monitoring mode layout with visual feedback for Dim and Fixed levels, Control Room, Loudness, and Studio 
meters, as well as a graphical representation of the speaker configuration and listening environment.

Visual Feedback between Soft Controls 
and the Editor Screen
The Editor screen offers highly visual feedback that is easy to follow and corresponds with the 
identical controls in the Fairlight page, as well as the visual feedback on the Channel bay if you 
are working with a Fairlight Console. When looking at the soft buttons and touch-sensitive 
knobs, here are some guidelines to help you recognize their current state and options:

 � Soft buttons and knobs around the Editor screen directly control the closest on-screen 
parameter. 

 � The soft buttons above and below the screen have three visual states; 
Bright, dim and off. 

 � At a glance all soft buttons with adjacent controls are illuminated (dim), while soft 
buttons without controls are black (off ). 

 � The upper row of soft buttons are toggles that either toggle a parameter On/Off or 
toggle between options, such as the type of curve for EQ filtering. The last soft button 
on the top row toggles between pages of controls. 

 � Soft buttons above the Editor screen brighten when active or latched on, and the 
corresponding soft menu control onscreen shows in black with red text. 

 � Soft buttons below the Editor screen display alternative pages of controls assigned to 
the left and right knobs. 

 � It is easy to identify which page of controls is active because the latched soft button 
below the Edit screen is illuminated along with the adjacent label that is also marked 
with a bright red line.

 � When you touch one of the knobs to adjust the current settings, the background of the 
corresponding visual feedback onscreen darkens. 

 � You can reset any of the parameters controlled by a touch-sensitive knob by pressing 
the Control key then touching the knob. 

 � The first and last soft buttons on the bottom row are modifier keys that offers 
momentary control of additional parameters for the controls for the knobs when 
available. For example, when the Aux controls are shown in the Editor screen, the 
knobs control the send level. While, a momentary press on the modifier soft button 
changes the knob controls to the Aux channel Pan settings. 
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Visual cues, like the red line over the illuminated soft button below the screen and the darkened parameter 
control next to the active knob on the left of the screen, indicate which EQ parameters are currently assigned to 
the control knobs, as well as which touch-sensitive knob is in use 

Macro Quick Keys
The top row of the Fairlight Audio Editor is dedicated to the Macros quick keys. Here you’ll find 
Macro quick keys for triggering each of the first 14 programmed macros. Once a Macro key has 
been recorded in the Macro mode layout, the associated Macro quick key illuminates to show it 
can be used to trigger the corresponding macro. These are a fast way to use macros as you 
work, without switching to the Macro mode toolset. 

Escape and 14 Macro quick keys at the top of the Fairlight Audio Editor for the first 14 macros
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Chapter 163

Fairlight Consoles 

The Fairlight consoles make it easier to perform audio editing, recording, 
and mixing tasks by providing professional audio controls for nearly every 
function and feature in the DaVinci Resolve Fairlight page. 
Additionally, using a Fairlight console to control the Fairlight page is 
vastly more efficient and ergonomic than working with a traditional mouse 
and keyboard. This is especially important when your audio 
post-production job requires long hours doing complex, focused, and 
often repetitive work. 

This chapter covers details about the different modular Fairlight console 
components, the available console configurations, and how they work 
with DaVinci Resolve. 

NOTE: To set up a Fairlight Audio console to work with your DaVinci Resolve 
system, you first must perform a custom installation of DaVinci Resolve Studio and 
check the box to include the Fairlight Studio Utility. For complete setup and 
installation instructions, refer to the Fairlight Console Assembly Instruction Manual. 

https://documents.blackmagicdesign.com/UserManuals/Fairlight_Console_Assembly_
Manual.pdf?%20_v=1561618810000
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About the Fairlight Console Components 
Fairlight consoles are a modular design that let you build your console to suit your production 
requirements. Within each console, four different Fairlight console components work together 
as Fairlight page control panels in a stand-alone chassis. These modular console components 
are either channel bay panels or audio-editing bay panels, and are paired with an adjoining 
Fairlight LCD Monitor component. The channel bay components work in tandem to control 
specific parameters on tracks, buses, and mains and include the Fairlight Console Channel 
Control, the Fairlight Console Channel Fader, and the Fairlight Console LCD Monitor that is used 
as a dedicated channel control screen. The audio editing bay components consist of the 
Fairlight Audio Editor and adjacent Fairlight Console LCD Monitor, which mirrors your computer 
screen and displays the DaVinci Resolve interface. 

Four different Fairlight console configurations range in size from 2-bay to 5-bay, with each bay 
spanning the width of a console module. The primary difference between the Fairlight consoles 
is the number of channel bays they contain. For example, a standard Fairlight console 2-bay 
comes with one set of channel bay panels plus one set of audio editing bay panels for a total of 
three control panels and two LCD screens, while a standard 5-bay console includes enough 
panels to fill four channel bays and one editing bay for a total of nine control panels and five 
LCD screens. 

Standard Fairlight Console 2-bay 

Because you will still need to control your computer and other software functions from the 
console, it is also important to have a wireless keyboard and mouse within reach. 
To accommodate wireless computer controls, Fairlight consoles include a Channel Control 
Blank and an Infill module. The Channel Control Blank fits in the Channel Control slot between 
the Audio Editor and editing LCD monitor, and easily holds a full-sized wireless computer 
keyboard. The Fairlight console Infill module provides a convenient flat surface for a wireless 
mouse, track-pad, or notebook. You can place the Infill module at the left or right of any bay 
within the console chassis. The most common Infill position is on the right side of the audio 
editing bay; however, a left-handed sound designer may prefer to place the Infill set on the left 
side of the editing controls. 

Each self-contained modular console is designed to meet the demands of modern work flow 
ergonomics and ease of use so that audio editors, sound designers, and re-recording mixers 
can quickly and accurately complete both simple and highly complex audio post-production 
tasks with minimal fatigue. 
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This chapter provides details and functions descriptions of each console component and 
should be read in conjunction with the previous Fairlight chapters to get the best from 
your console. 

Standard Fairlight Console 5-bay 

For professional sound editors working on tight deadlines, the Fairlight Audio Editor, 
gives you quick access controls for high speed, precision audio editing. This dedicated 
Fairlight editing control panel is available in either desktop or console models. It’s easy 
to learn and master with a variety of highly visual, intuitive controls including touch-
sensitive control knobs, macro buttons, LCD editor screen, number pad, electronic 
clutch-action shuttle, and a full keyboard with multi-functioning keys. 

Fairlight Audio Editor 

For high-resolution viewing of your DaVinci Resolve interface as well as channel 
controls, meters, video, and more, you’ll use the Fairlight Console LCD Monitor. These 
custom designed LCD monitors fit perfectly at the top of each console bay to form a 
bridge of screens at just the right angle for comfortable viewing while you work. Each 
modular LCD monitor includes switchable inputs from console screen to HDMI or SDI 
inputs for flexible display of plug-ins and reference video. 
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Fairlight Console LCD Monitor displaying the Master mode

Fairlight Console LCD Monitor displaying the DaVinci Resolve UI

The Fairlight Console Channel Control is a multi-functional panel that works in 
conjunction with the Fairlight Console Channel Fader and LCD Monitor to provide 
12 groups of touch-sensitive control knobs, buttons, and visual feedback for each 
of the 12 fader channels. These controls offer instant access to the parameters available 
in the DaVinci Resolve Fairlight page Mixer. 

Fairlight Console Channel Control 
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For precision recording, mixing, and mastering, the Fairlight Console Channel Fader 
module offers 12 touch-sensitive motorized faders and Pan knobs with corresponding 
Fader Channel Control buttons, automation controls, and bank buttons for mapping 
tracks and buses to the 12 faders. 

Fairlight Audio Console Fader Control

Fairlight Console Audio Editor
The legendary Fairlight Console Audio Editor lets you quickly navigate large projects and 
precisely edit audio much faster than using a regular mouse and keyboard. The Fairlight 
Console Audio Editor has an identical feature set and controls as the Fairlight Desktop Audio 
Editor. The difference is that the Console Audio Editor is connected to all the console’s control 
panels, so recording, playback, and editing functions are reflected on the corresponding 
channel bays and vise versa. For example, if a track is called in the Fader Panel, it is also loaded 
in the Audio Editor’s built-in display. Another example is if a track button is selected in the Audio 
Editor, the track is also selected in the Fairlight Page interface on the Editing LCD monitor, and 
the corresponding selection button shows active in the In-Line Channel Control Extension 
buttons as well as the Channel Control LCD monitor. A Fairlight Desktop Audio Editor can also 
be connected to a Fairlight console that does not include an Audio Editing bay. 

Please refer to the previous chapter, “Using the Fairlight Desktop Audio Editor,” for details on 
the Fairlight Console Audio Editor’s features and functions. 

Fairlight Console Audio Editor
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Although the three channel bay components are separate modules, they work together in 
tandem as a single multifaceted unit to display and control various channel parameters. The 
Channel Fader panel offers traditional channel mixing controls, while the multi functional 
Channel Control panel focuses on controlling specific parameters as needed as well as how 
they are displayed on the Channel LCD monitor. 

Channel Control Modes 
Within a Fairlight channel bay, the Channel Control panel works in three distinct channel control 
modes. These modes, in turn, change the functions of the multipurpose channel control knobs 
and buttons as well as the corresponding display in the LCD module: 

 � In-line: This mode effectively separates the knobs and buttons on the channel control 
module into 12 groups that line up vertically with the 12 faders on the channel fader 
control. As the name suggests, in-line mode shows each set of parameters in a line 
that continues from the fader channels up through the channel controls and into the 
display on the LCD monitor. In-line Display buttons on the right side of the Channel 
Control panel determine which in-line parameters are shown. This mode is common in 
live recording so that the operator can easily see and control parameters of multiple 
microphone inputs simultaneously.

Channel Control components set to In-Line mode
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 � Channel: Use Channel mode to control up to 192 parameters on one channel. 
In channel mode, the12 groups of controls on the channel control module are used 
collectively to adjust parameters for a specific channel from left to right as displayed 
on the LCD Monitor. In Channel mode, there are several ways to choose which 
channel is displayed, including the Channel Call buttons on the Channel Fader panel, 
the Channel Select buttons on Channel Control panel, the Call Follows menu, the edit 
controller, or by selecting a track in the Fairlight page Timeline or Mixer. This is the most 
common channel control mode in audio post production, as it provides quick access to 
all parameter controls for a specific track. 

Channel Control components in Channel mode

 � Master: This mode utilizes all channel controls to adjust parameters for the buses and 
main output. In Master mode, the 12 groups of controls on the channel control panel 
adjust the adjacent main output parameters displayed on the LCD. The channel controls 
in Master mode are organized from left to right in order of processing. Master mode is 
commonly used while mixing and mastering soundtracks. 

Channel Control components in Master mode 
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Fairlight Console Channel Control
The secret to managing high track counts for large projects is the Fairlight Console Channel 
Control, because it provides instant knob-per-function access to channel parameters along with 
real-time high resolution visual feedback on-screen. The Fairlight Console Channel Control 
module fits directly below the LCD monitor so that you can always see the graphical 
representation of each parameter as it is modified with the adjacent channel controls. There are 
four types of channel controls organized in three areas of the panel. 

On the far left and right sides of the panel, you’ll find dual-function Channel Display buttons that 
determine the current channel control mode and which parameters are displayed on the 
LCD monitor. 

The middle of the panel contains 12 groups of multi functional Channel Control buttons and 
knobs that align with the 12 faders on the Channel Fader panel. The knobs are used to adjust 
parameter values, while the control buttons act as toggles, On/Off, or In/Out switches 
for active parameters. 

The fourth type of controls are the In-Line Channel Extension Buttons, which are arranged in 
groups of six below each of the 12 channel control groups. Here you’ll find dedicated channel-
specific buttons for functions available in the Fairlight page Mixer and Timeline track headers. 
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In-Line Channel Extension buttons

Channel Control buttons and knobs for 
each corresponding fader channel

In-Line Channel Display buttonsChannel Display buttons

The primary display controls for the channel control components are the dual-function channel 
display buttons located on the left and right sides of the Channel Control panel. These bi-
colored LED buttons determine the channel mode and current parameters displayed on-screen. 
There are a total of 16 display buttons split evenly into groups of eight buttons on each side of 
the panel. On the left side of the panel, you’ll find eight channel display buttons used to select 
the channel control mode as well as display plug-ins and automaton parameters; while the 
display buttons on the right side of the panel are used to show the in-line channel parameters 
found in the Fairlight page Mixer, such as Pan, EQ, and Dynamics. The top and bottom display 
buttons are identical on both sides of the panel to provide easy access to the CTL (control) and 
ALT (alternate) functions for selecting secondary display features, resetting parameters to 
default values, and showing alternate controls in the LCD. 
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The default color for all display buttons is yellow, except for the Control button, which is always 
blue. When the Control button is pressed, inactive display buttons with secondary functions 
turn blue or purple. Active display buttons remain in their active state color until another display 
button is selected. For example, if a secondary function is selected, that display button remains 
purple as long as it is active, while the other display buttons return to yellow when the Control 
button is released. 

Left side of panel, Channel display buttons from top to bottom: 
 � CTL: This display button is the same as the Control modifier key on the computer 

keyboard and can be used to switch to the secondary functions for the dual-function 
display buttons below. The handy blue color makes it easy to locate and use as 
needed, to switch inactive display buttons to their secondary functions. Additionally, 
holding the Control button while touching one of the knobs or faders will reset any of 
the touch-sensitive controls to their default values. For example, holding the Control 
button while touching a fader or Aux send knob resets the value to 0 dB and is the 
Fairlight Console Control equivalent to double-clicking the mouse on a fader or knob in 
the Fairlight page GUI. There are a total of three conveniently located Control buttons 
on a Channel Control bay; two on the Channel Control panel, and one on the Channel 
Fader panel. 

 � MSTR/U1: This button is used to set the channel controls to Master mode which 
displays all the system bus controls for the Main output bus on the LCD monitor, while 
all the adjacent channel control buttons and knobs are dedicated to controlling the 
busing parameters as displayed. The secondary U1 function is not implemented in this 
version of the software. 

 � PLUG/U2: Use this button to show active plug-ins on the LCD monitor and allocate 
controls for the plug-in parameters to the corresponding channel controls. The Plug 
function as well as the secondary U2 function are not implemented in this version of 
the software. 

 � CHAN/U3: To change the channel controls display mode to Channel mode, use 
this button. Once in Channel mode the channel control buttons and knobs control 
the parameters for a single channel. Use Control + CHAN to get to the channel’s 
Aux Sends. If multiple channels are selected, you’ll see parameters for the last track 
selected or called. In this version of the software, the secondary U3 function is not 
implemented. 

 � ENAB/COPY: To quickly enable parameters for automation, you can hold this button 
and touch any channel control button, knob, or fader. The alternative function, COPY, 
is used to copy parameters between channels by simply touching the control knob or 
fader where you’d like to copy the specific parameter values. At the time of this writing, 
these functions are not yet implemented. 

 � CURVE: When you want to display a parameter’s automation curves on the active track 
in the Timeline, hold this button and touch any channel control or the fader, mute, or 
pan pot on the Channel Fader panel. 

 � SPLL: SPLL is not used in this version of the software. 

 � ALT: To access additional display button options or alternate parameter controls on any 
channel control, use this modifier button. 
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Right side of panel, In-Line Channel display buttons from top to bottom: 
 � CTL: Use this button to select the secondary functions for the dual-function display 

buttons below. Also, holding the Control button while touching one of the knobs or 
faders will reset any of the touch-sensitive controls to their default values. This is one of 
three identical Control buttons on the channel control components set, and it works the 
same as pressing the Control modifier key on a computer keyboard. 

 � PAN/PATH: This button displays all the in-line surround panning controls including 
Left/Right, Front/Back, Down/Up, and Spread. Press the ALT display button to see the 
alternate Rotate, Tilt, Divergence, and LFE controls. Hold the Control button and press 
the PAN/PATH button to display the Path setting controls, including Record level, Trim, 
Insert, and Direct Out. Press ALT while the PATH controls are active to see the alternate 
Path controls: Mic Gain, Group, and the Direct Output Pre/Post fader switch. These 
Path settings are the same as the controls in the Path Settings window available via the 
Track Input drop-down menu on the Fairlight page Mixer. 

 � EQ/FILT: To control the In-Line channel parametric Equalizer (EQ), use this button 
without a modifier to display four frequency bands, including High Frequencies (HF), 
High-Middle Frequencies (HMF),Low-Middle Frequencies (LMF), and Low Frequencies 
(LF). Press the ALT button for Gain control of each of the four bands. Use the Control 
key for the secondary button function to display and modify the two channel filters for 
High-pass, Low-pass, High-shelf or Low-shelf filtering. While in EQ/FILT In-Line display 
mode, the Channel Control touch-sensitive knobs are used to sweep Frequencies 
or Gain, and the Channel Control buttons toggle between Bell, Notch, High Pass 
Filter (HPF), Low Pass Filter (LPF), High Shelf (Hi-Sh), and Low Shelf (Lo-Sh) filtering 
curves. The functionality of EQ/ FILT works the same as using the Channel EQ window 
available on the Fairlight page Mixer. 

 � AUX/AUX: This button displays in-line controls for Aux sends 1 to 16 in sequential 
groups of 4 Aux buses at a time. You can toggle between Aux 1-4 and 5-8 by pressing 
the Aux key again. Hold Control while this button is active to display controls for Aux 
sends 9 to 16. Pressing the Aux key while holding Control will toggle between Aux 9-12 
or 13-16. Press the ALT button for the alternate Pre/Post fader controls for the Aux send. 

 � COMP/U1: This is for In-Line Dynamics controls for the Compressor, including: 
Threshold, Attack, Hold, and Release. Use this button without a modifier. Press the 
ALT button for the alternate Ratio controls. Hold Control and press any of the dynamics 
display buttons: COMP, LIM, or EXP to access the Makeup gain controls. The secondary 
U1 function is not implemented in this version of the software. 

 � LIM/U2: To display the In-Line Limiter controls, use this button. Without a modifier, you’ll 
see the limiter controls, including Threshold, Attack, Hold, and Release. Hold Control 
and press LIM to access the Makeup gain controls. The secondary U2 function is not 
implemented in this version of the software. 

 � EXP/U3: This display button is for the in-line Expander/Gate controls. The unmodified 
Expander controls include Threshold, Attack, Hold, and Release. Press the ALT button 
to switch to the alternate Gate controls, including Ratio, Range, Hold, and Release. 
Hold Control and press EXP/U3 to access the Makeup gain controls. The secondary 
U3 feature is not implemented in this version of the software. 

 � ALT: This is the alternate option modifier button and functions the same as the 
ALT/Option key on the computer keyboard. To access additional display button options 
or an alternate control on any channel control, use this button. 
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The left-side Channel Display buttons without modifiers and with 
Control button pressed to show secondary functions 

NOTE: Non-functioning Channel Display buttons, such as PLUG and ENAB, 
remain unlit. These buttons will be operational in future software updates. 

Pan Settings window in the Fairlight page interface, available in the Mixer 
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The right-side In-Line Channel Display buttons with Pan/Path 
button pressed and corresponding Pan controls in the Channel 
Control LCD

The right-side In-Line Channel Display buttons with ALT + Pan/Path 
button pressed and corresponding ALT-Pan controls in the Channel 
Controls LCD
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Path Settings window in the Fairlight page interface, available in the Mixer, Input drop-down menu

The right-side In-Line Channel Display buttons with CTRL + Pan/Path button pressed and 
corresponding Path controls in the Channel Controls LCD

The right-side In-Line Channel Display buttons with ALT + CTRL + Pan/Path button 
pressed and corresponding ALT-Path controls in the Channel Controls LCD
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Channel Control Buttons and Channel Control Knobs 
Spanning the middle of the Channel Control panel, you’ll find 12 parallel groups of multi 
functional channel controls that align with the 12 faders on the Channel Fader panel. Within 
each of the 12 groups are four highly visible LED buttons and four touch-sensitive rotary knobs. 
If you touch knobs with Control held this will reset the value, and if you turn a knob with Shift 
held you will have fine control for the parameter. 

Since the functions of these buttons and knobs change based on the channel display mode 
and selected channel and active parameters, these “soft” controls remain unlabeled, and are 
identified by the corresponding controls on an adjacent LCD monitor. Additionally, each channel 
control button is illuminated with bi-colored LEDs to make it easy to identify active buttons, 
parameters, and groups of controls at a glance. 

In-line EQ display mode showing four red In/Out toggle 
switches and four dial controls on each channel.

Channel Control buttons appear red or green when they are matched to a parameter on the 
Channel LCD monitor, and can be used as either toggles, On/Off, or In/Out switches for the 
adjacent parameter on-screen. Similar parameters will all have the same colored buttons while 
the Channel Controls are set to In-Line mode. However, in Channel or Master display mode, 
you’ll see alternating rows or groups of red or green buttons to separate the different parameter 
groups as shown on the Channel display. 
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In-line Pan display mode showing one green In/Out toggle 
switch and four dial controls for each channel.

Additionally, Channel Control buttons brighten to show that they have been pressed, or remain 
unlit and therefore without color when there is no corresponding parameter with a switch in the 
current channel display mode. 

Channel display mode showing alternating colored 
buttons to separate parameter groups and unlit buttons 
where there are no matching on-screen parameters.
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In-Line Channel Extension Buttons 
Along the bottom of the Channel Control panel are 12 groups of six In-Line Channel Control 
Extension buttons that match the buttons at the bottom of the Channel LCD Monitor. These 
dedicated LED buttons are toggle switches for channel-specific controls like Select, Solo Safe, 
and Arm. In-Line Channel Control Extension buttons are always available, regardless of the 
channel control mode, and correspond with similar functions in the Mixer or Timeline track 
headers on the Fairlight page. 

In-Line Channel Extension buttons, clockwise from the top right: 
 � INS IN: Insert In enables routing of up to six VST plug-ins or one hardware effect 

per channel from Blackmagic Design’s Fairlight audio interface hardware to 
outboard effects boxes and back again. This button can be toggled to enable/disable 
insert routing. 

 � SAFE: This button toggles on Solo Safe mode the same as Command-Option-clicking a 
Solo button on the Fairlight page. Tracks set to Solo Safe will always play, even if Solo is 
enabled for other tracks, and are easily identified by the blue-highlighted Solo button. 

 � ARM: Arms the track for recording. This is the same as clicking the Arm button [R] 
on the corresponding Timeline track header or Mixer channel strip on the Fairlight 
page timeline. Tracks must be patched to a microphone or another source input prior to 
arming. 

 � SEL: This button selects a channel in the Fairlight Console Channel Control bay, 
and is the same as clicking a Timeline track header or channel strip in the Mixer on 
the Fairlight page. You can select multiple tracks by pressing additional Channel 
Select buttons. 

 � Middle-left button: This is not implemented in this version of the software. 

 � Upper-left button: This is not implemented in this version of the software. 

In-line Channel Extension buttons displayed at the bottom of the Channel LCD.

In-line Channel Extension buttons that represent the physical 
switches for the corresponding buttons on the LCD above.

NOTE: You can only have a Channel Control panel for a bay that also has the Channel 
Fader and Channel LCD monitor. 
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Fairlight Console Channel Fader 
In addition to 12 Channel strips complete with designated control buttons, touch-sensitive 
faders, and pan knobs, the Fairlight Console Channel Fader panel includes an LCD display of 
channel information and eight display buttons for bank selection and mapping of up to 
144 tracks and buses to the 12 faders. The Fairlight Console Channel Fader panel works in 
tandem with DaVinci Resolve and the Fairlight Channel Control module for completing 
professional audio post-production work flows using traditional mixing controls. 

SOLO

MUTE

CALL AUTO

10 •

5 •

0 •

5 •

10 •

15 •

20 •

30 •

40 •

50 •

70 •

100 •

• 10

• 5

• 0

• 5

• 10

• 15

• 20

• 30

• 40

• 50

• 70

• 100

SOLO

MUTE

CALL AUTO

10 •

5 •

0 •

5 •

10 •

15 •

20 •

30 •

40 •

50 •

70 •

100 •

• 10

• 5

• 0

• 5

• 10

• 15

• 20

• 30

• 40

• 50

• 70

• 100

SOLO

MUTE

CALL AUTO

10 •

5 •

0 •

5 •

10 •

15 •

20 •

30 •

40 •

50 •

70 •

100 •

• 10

• 5

• 0

• 5

• 10

• 15

• 20

• 30

• 40

• 50

• 70

• 100

SOLO

MUTE

CALL AUTO

10 •

5 •

0 •

5 •

10 •

15 •

20 •

30 •

40 •

50 •

70 •

100 •

• 10

• 5

• 0

• 5

• 10

• 15

• 20

• 30

• 40

• 50

• 70

• 100

SOLO

MUTE

CALL AUTO

10 •

5 •

0 •

5 •

10 •

15 •

20 •

30 •

40 •

50 •

70 •

100 •

• 10

• 5

• 0

• 5

• 10

• 15

• 20

• 30

• 40

• 50

• 70

• 100

SOLO

MUTE

CALL AUTO

10 •

5 •

0 •

5 •

10 •

15 •

20 •

30 •

40 •

50 •

70 •

100 •

• 10

• 5

• 0

• 5

• 10

• 15

• 20

• 30

• 40

• 50

• 70

• 100

SOLO

MUTE

CALL AUTO

10 •

5 •

0 •

5 •

10 •

15 •

20 •

30 •

40 •

50 •

70 •

100 •

• 10

• 5

• 0

• 5

• 10

• 15

• 20

• 30

• 40

• 50

• 70

• 100

SOLO

MUTE

CALL AUTO

10 •

5 •

0 •

5 •

10 •

15 •

20 •

30 •

40 •

50 •

70 •

100 •

• 10

• 5

• 0

• 5

• 10

• 15

• 20

• 30

• 40

• 50

• 70

• 100

SOLO

MUTE

CALL AUTO

10 •

5 •

0 •

5 •

10 •

15 •

20 •

30 •

40 •

50 •

70 •

100 •

• 10

• 5

• 0

• 5

• 10

• 15

• 20

• 30

• 40

• 50

• 70

• 100

SOLO

MUTE

CALL AUTO

10 •

5 •

0 •

5 •

10 •

15 •

20 •

30 •

40 •

50 •

70 •

100 •

• 10

• 5

• 0

• 5

• 10

• 15

• 20

• 30

• 40

• 50

• 70

• 100

SOLO

MUTE

CALL AUTO

10 •

5 •

0 •

5 •

10 •

15 •

20 •

30 •

40 •

50 •

70 •

100 •

• 10

• 5

• 0

• 5

• 10

• 15

• 20

• 30

• 40

• 50

• 70

• 100

SOLO

MUTE

CALL AUTO

10 •

5 •

0 •

5 •

10 •

15 •

20 •

30 •

40 •

50 •

70 •

100 •

• 10

• 5

• 0

• 5

• 10

• 15

• 20

• 30

• 40

• 50

• 70

• 100

BLUE

BANK

FLIP

1
POT

2
FDR

3
MAP

4
BUS

5
MSET

6
LOCK

LCD Fader Channel Displays 

Rotary Pan Knobs

Fader Channel Control Buttons

Faders
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Fairlight Channel Fader module.

LCD Fader Channel Display 
At the top of each channel strip you’ll find a high-resolution color display that shows the track 
name,track color, level, and pan status. If the channel is part of a VCA group, the VCA group 
number appears above the meters. The information displayed for each track directly correlates 
with the Fairlight page Mixer and track headers. 

LCD Fader Channel Displays showing track 
name, number, color, pan status, level meters, 
and VCA group number. 
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Rotary Knob 
Below the LCD display on each channel strip you’ll find the touch-sensitive rotary knob 
designated as the panoramic potentiometer, or pan pot for short. This versatile dial control is 
assigned to Left-Right track panning by default, but may also be assigned to other parameters. 
Press the Control button while you press and release the 2/FDR button to use the rotary knob 
to control the last-used alternate parameter. This is especially usefully during automation or 
complex mixing procedures when you need to keep alternative parameters, like the Ratio for 
your Compressor, within easy reach of the faders. Like all touch-sensitive controls on the 
Fairlight console components, holding the Control button and touching the knob resets the 
parameter to the default value, and if you turn the knob with Shift held you’ll have fine control. 

Fader Channel Control Buttons 
Each channel strip includes four dedicated control buttons for common channel-specific mixing 
functions. These brightly colored LED buttons are easy to read, logically placed above each 
fader, and can be used independently or in combination with other channels. 

LCD Fader Channel Display, Fader Pan knobs, 
and Fader Channel control buttons. 

 � SOLO: Use this button to select only this channel for playback. Multiple tracks can be 
soloed simultaneously to isolate selective tracks for playback while all non-soloed 
tracks will be muted. Pressing Solo while holding the Control button clears all soloed 
track buttons, and pressing Control again restores soloed tracks. Solo buttons on the 
Channel Fader panel correspond with the Solo buttons on the Fairlight page Mixer and 
track headers. 

 � MUTE: This button turns the channel off and on for playback. Mute buttons on the 
Channel Fader panel correspond with the Mute buttons on the Fairlight page Mixer and 
track headers. 

 � CALL: As the name suggests, the Channel Call button simply calls up a track’s 
parameters in the Channel Control panel and LCD monitor while in Channel display 
mode. Additionally, the Channel Call button loads the channel into the built-in Audio 
Editor display, regardless of the channel control mode. Using the Channel Call button 
is a fast way to work with a channel’s parameters, plus you can quickly press other 
Call buttons to change focus from track to track for detailed comparison and control. 
Channel Call on the Fader Panel is similar to the Select button at the bottom of the 
Channel Control panel; the difference is that the Select button also selects the track in 
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the Fairlight page Timeline and Mixer, which enables additional editing options. Using 
the Call button while tracks are selected does not change the state of the selected 
tracks. Call buttons are also used for manually mapping banks of channel faders and 
spilling the member tracks of a master bus to nearby faders.

Call buttons tally on or off when pressed and change color based on the current task 
as follows: 

 – Yellow Call buttons: The default color and indicate standard call functionality. When 
the Call buttons are yellow, only one Call button can be tallied on at at time.

 – Red Call buttons: Appear when fader mapping is engaged. Auto fader mapping, 
automatically maps faders to groups of 12 channels in sequential order. When in 
manual fader mapping mode, you can use the red Call buttons in the Fader panel, 
or the track selection keys showing in the picture keyboard to manually assign 
channels to the 12 faders for each fader bank. 

 – Green Call buttons: Indicate master buses and VCA groups in the current fade bank 
when using the Fader Spill function. Pressing a green Call button spills the member 
channels of a bus or VCA group to the neighboring faders according to the Fader 
Spill option keys in the Setup mode layout on the Audio Editor.

 � AUTO: When automation controls are active, the AUTO button arms this channel for 
automation, preview, write, and trim. Like the Solo and Mute buttons, the Auto button 
on the Fader Panel corresponds with the Auto buttons on the Fairlight page Mixer and 
track headers. Automation buttons turn amber when automation is active. 

Touch-Sensitive Faders 
The bottom-half of the Fader Panel comprises 12 touch-sensitive motorized faders that offer 
precision gain controls for 12 signal paths. These faders correspond with faders on the Fairlight 
page Mixer, and can be mapped to 12 different fader banks using the Bank Display buttons 
located on the left side of the Fader Panel. Additionally, each 100mm fader can be assigned to 
control other channel parameters like send levels, channel trim, or record levels. Holding the 
Control button while touching a fader resets it to the default position, which is 0 dB. 

Fader Bank Display Buttons 
On the left side of the Channel Fader module are seven multicolored LED Bank Display buttons 
that are used to display, map, bus, set, and lock banks of channels to the 12 faders on the panel. 
The top two buttons are CTL (control) and BANK, which are modifier buttons used to access 
secondary button functions or additional fader banks for the subsequent numbered Fader Bank 
Display buttons. Each of the six numbered Fader Bank Display buttons serve three functions, 
including load a primary fader bank, load an additional fader bank when pressed with the Bank 
modifier button, or perform a secondary function when the Control button is pressed. You can 
easily identify the blue Control button at the top of the Fader Bank Display buttons, while the 
other seven buttons are yellow in their normal state, and blue or purple when the secondary 
function is selected via the Control button. 

With the Fader Bank Display buttons, you can map each of the 12 fader banks with 12 different 
faders to control a total of 144 tracks and buses to the 12 faders. The more Fairlight Console 
Channel Fader panels you have in your console, the more faders and tracks you can control. 
For example, the Fairlight Console 5.bay, is designed for high-end mixing and mastering with 
four Fader Panels to control up to 576 channels and busses at a time. 
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Fader Bank Display Buttons from top to bottom: 
 � CTL: This button selects secondary functions for the seven display buttons below and 

works the same as the Control key on the computer keyboard or the two identical 
Control display buttons on the Channel Control panel. 

 � BANK/FLIP: You can use the Bank button to switch between the primary fader set for 
each of the numbered bank buttons labeled 1 to 6, or the additional fader set for the 
same numbered buttons to show banks 7 to 12. Without a modifier, the Bank button 
is yellow along with the numbered bank buttons below. When pressed, the yellow 
Bank button brightens to indicate that it is latched, and the active numbered bank 
button also brightens to indicate which additional fader set has been loaded. The 
secondary FLIP function, via the Control button, is used to spill the member tracks of a 
master bus or VCA group to the neighboring faders. 

 � 1/POT: The 1 button chooses Fader Set 1 without a modifier or Fader Set 7 when 
selected with the Bank button. The alternate POT function for this button involves 
the touch-sensitive Pan pot above the channel fader. Pressing and releasing the 
1/POT button while Control is pressed toggles the knob control between normal 
Left/Right Pan mode and the secondary mode where the knob controls the last-used 
alternative parameter. 

 � 2/FDR: The 2 button chooses Fader Set 2 without a modifier or Fader Set 8 when 
selected with the Bank button. Pressing and releasing the 2/FDR button while Control 
is pressed toggles between normal mode where the fader controls channel level, and 
secondary mode where the fader controls the last-used alternative parameter. 

 � 3/MAP: The 3 button chooses Fader Set 3 without a modifier or Fader Set 9 when 
selected with the Bank button. If Control is pressed, the 3/MAP button enters the 
secondary Fader Mapping tool for the current fader set on the Audio Editor. 

 � 4/BUS: The 4 button chooses Fader Set 4 without a modifier or Fader Set 10 when 
selected with the Bank button. Pressing Control along with the 4/BUS button toggles 
the secondary Bus mode on and off. When Bus mode is on, the system puts all used 
buses on as many faders as needed to accommodate all non-zero format buses. 
Pressing a Fader Bank display button from 1 to 6 returns control to the appropriate 
fader set. 

 � 5/MSET: The 5 button chooses Fader Set 5 without a modifier or Fader Set 11 when 
selected with the Bank button. If Control is pressed, the 5 button toggles the secondary 
Mixer Set function on and off. While Mixer set is on, any track that is enabled for Editing 
is automatically allocated to a fader. 

 � 6/LOCK: The 6 button chooses Fader Set 6 without a modifier or Fader Set 12 when 
selected with the Bank button. LOCK is not implemented in this version of the software. 

Fader Bank display buttons and touch-sensitive fader 
with Bank 1 selected, and with the secondary button 
functions available while the Control button is pressed.
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Manually mapping faders to banks:
1 In the Fader Bank Display buttons, press CTRL and the 3/Map key to enter fader 

mapping mode. You’ll know that you entered bank mapping mode because all of 
the Call buttons turn red. The bank mapping is set to Auto mode by default, which 
automatically maps channels to faders in sequential order in groups of 12 up to 144. 
When you enter channel mapping mode, the top four rows of picture keys in the Audio 
Editor change to track selection keys, while the bottom row of picture keys shows the 
following dedicated channel mapping function keys: 

 – Exit: Exits the channel mapping mode.

 – Delete: Deletes the channel assigned to the active channel indicated by the tallied 
red Call button. 

 – Blank: Leaves a blank fader bank beneath the active red Call button. This is useful 
for adding a space between groups of similar tracks such as dialogue, background 
sound effects, and music.

 – Insert: As the name suggests, this key inserts an unassigned fader in the position of 
the active red Call button. 

2 In the bottom row of the picture keyboard, press the first key 
(MODE: Auto/MODE:Manual) to toggle the fader mapping to Manual mode. 

3 Press the red Call button on the fader you would like to assign, then choose a channel 
from the track selection buttons on the adjacent picture keys in the Audio Editor. 
Once you assign a track or bus to a fader, the next fader to the right becomes active 
with a red tallied Call button so that you can continue assigning faders sequentially. 
This automatic call selection also applies to the Delete, Blank, and Insert manual 
mapping functions. 

4 Select up to 12 track selection keys to assign to the current fader bank. Use the Bank 
display buttons to manually assign additional banks as needed. 

5 When you are finished mapping tracks to faders, press the Exit button in the bottom 
row of picture keys. Once you exit manual mapping mode, the picture keyboard layout 
returns to the current mode.

Example of Fader Bank 1 in Auto Mapping Mode

Fader Bank 1 in Auto mapping mode showing sequential tracks 1-12 with red Call buttons to indicate 
bank mapping mode is engaged and the first fader channel’s Call button is active
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Picture keyboard in Auto Fader Bank mapping mode

Auto Fader Bank mapping action keys in the lower left corner of the picture keyboard

Example of Fader Bank 1 in Manual Mapping Mode

Fader Bank 1 in Manual mapping mode showing the custom mapping:  
A21, blank, A30, A40, and DIALOG to the first five tracks 
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Fader Bank 1 in Manual mapping mode showing custom mapping: A21, blank, A30, A40, 
and DIALOG mapped to the first five faders; red Call buttons indicate bank mapping is 
engaged, with the first fader’s Call button active

Manual Fader Bank mapping action keys in the bottom row of the picture keyboard

Spilling bus member tracks to nearby faders:
1 In the Fader Bank Display buttons, select a fader bank that contains at least one bus. 

Buses include main, submix, Aux buses, and VCA groups.

2 Momentarily press and hold the Bank/Flip key to change the yellow Call buttons to 
green Call buttons on the bus fader channels. 

3 Press the green Call button for the bus fader you wish to spill to the neighboring faders. 
Once spilled, the Bank/Flip button turns purple to indicate that the current fader bank is 
displaying spilled faders for the active bus. 

4 To modify the fader spill direction or type of fader that is temporarily remapped, use the 
Fader Spill options keys available in the Setup mode picture key toolset. 

Fader Spill option keys include: 
 � Fader Spill: Use this menu key to reveal two menu Spill option keys that determine the 

type of fader channel and direction in which member tracks are temporarily mapped to 
the adjoining faders on the Fairlight Channel Fader panel.

 � Spill Left/Spill Right: This menu options key toggles between Spill: Left and Spill: Right, 
which in turn dictates whether the member tracks of a bus are assigned to neighboring 
faders to the left or right of a bus when Spill is engaged in the Channel Fader panel.

Chapter – 163 Fairlight Consoles 3404



 � Spill Any/Spill Tracks: When in the default (unlatched) state the Spill: Any menu 
option allows member tracks of a bus to be spilled to the nearest faders to the left or 
right, including faders assigned to Master buses and VCA groups. When latched to 
the Spill: Tracks option, member tracks of a bus spill either left or right starting with 
the nearest track fader in the designated direction. This option is useful if you need 
to maintain fader control of your buses while you spill their constituent tracks to the 
nearest track faders.

Fader Spill and Fader Spill option keys available in 
Setup Mode toolset on the Audio Editor Picture keys

Fader Bank 5 with Main 1, Sub 1, and Sub 2 buses assigned to the last three faders; 
yellow Call buttons indicate standard channel bank display 

Bank/Flip Bank Display Button momentarily held to display the buses within the active track; 
these buses (in the right 3 channels) can be easily identified by the green Call buttons
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Channel LCD displays Sub 2 bus, including A8, A10, A11, and A12, 
spilled on the nearest tracks to the left of the Sub 2 bus 

Purple Bank/Flip button indicates there is a spilled bus in the current bank. In this case, 
Bank 5 is showing, with Sub 2 spilled to the left of the the other buses, and includes A8, 
A10, A11, and A12 as the member tracks that comprise Sub 2. 

NOTE: While a bus fader is spilled, you may still use the standard bank display buttons 
to display any of the other banks normally.

To un-spill a bus fader: (OR) To disengage fader spill: 
1 In the Fader Bank Display buttons, press the Bank button that contains the spilled bus. 

2 Momentarily hold the Bank/Flip button to reveal green Call buttons for the bus faders. 
The spilled fader’s green Call button will be tallied on. 

3 Press the active green Call button to un-spill the fader.
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Sub 2 bus with active (tallied) green Call button, which 
indicates it has been spilled to neighboring faders 

NOTE: You can only spill bus member tracks to faders within the same fader 
bank. Use the Fader Spill option keys in the Audio Editor Setup mode toolset 
to spill either left or right within the current bank of 12 faders. Additionally, if 
you press the Bank/Flip button on a bank without any bus faders, you will not 
see any green Call buttons or subsequent bus faders to spill.

Fairlight LCD Monitors 
Standard Fairlight consoles include one high-resolution 1920 x 1080 Fairlight LCD Monitor for 
each bay. These custom designed LCD monitors align perfectly along the top of the console, 
forming an embedded eye-level monitor bridge that spans the width of the console. 

Fairlight LCD Monitor
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Each Fairlight LCD Monitor is paired with either Channel Control modules as a dedicated 
channel control display, or the Audio Editing module as a dedicated DaVinci Resolve GUI edit 
screen. Additionally, the switchable HDMI and SDI inputs on the back of each screen allow 
flexible display of plug-ins and reference video. 

Fairlight Console 3-bay with three Fairlight LCD monitors forming a 
display bridge across the top of the console.

Fairlight Console Configurations 
The Fairlight console can be purchased with all the standard panels as a bundle, or customized 
to meet specialized production requirements. With the Fairlight console’s unique modular 
design, you always get the flexibility to place the Audio Editor, Infill module, and Channel 
Component sets, in whichever order works best for you. 

Each bundled console includes a console chassis ranging in size from 2-bay to 5-bay, an LCD 
Monitor component for each bay, one Fairlight Audio Editor, and a set of Fairlight Channel bay 
components for each additional bay. For custom configurations, you choose the chassis size, 
and then purchase the console components individually. 

Before purchasing a console, it is important to consider the size of your workspace as well as 
your current and future audio post-production needs. For example, if you have a mid-sized 
mixing stage and are primarily working on short-form projects like commercials and trailers, a 
standard Fairlight Console 3-bay may work well. However, if you have the room, a customized 
Fairlight Console 4-bay chassis may work better in the long run because you’ll also have room 
to grow in the future for larger feature-length productions. Plus, empty console bays can be 
filled with custom machined Fairlight Console Blanks that add valuable flat surface space for 
assistant audio editors and mixers. Additionally, you can add a Fairlight Console LCD Monitor in 
the 4th bay to display video playback or plug-ins, and even add a Fairlight Channel Rack Kit to 
the channel section to mount standard 19-inch equipment such as the Fairlight Audio Interface 
or Blackmagic Design Smart View duo to your bay. 
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Standard Fairlight Console 3-bay. 

NOTE: For more information about the Fairlight Console Chassis, bundles, and 
hardware options, go to the Fairlight Console page on the Blackmagic Design website. 
https://www.blackmagicdesign.com/products/davinciresolve/ 

Additional Fairlight Hardware 
To effectively connect to and operate a Fairlight console with DaVinci Resolve Studio, you’ll also 
need a supported audio interface and PCIe audio card. If you are using a Mac or PC without a 
PCIe slot, you’ll also need an expansion box to connect the PCIe card to your computer, and a 
supported audio interface. You can use 3rd-party devices or purchase the Fairlight products 
designed specifically for the Fairlight consoles, including, the Fairlight PCIe Audio Accelerator, 
Fairlight Audio Interface and the Fairlight PCIe MADI Upgrade. 
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Fairlight PCIe Audio Accelerator.

Fairlight PCIe MADI Upgrade.

Fairlight Audio Interface.

NOTE: For more information about the Fairlight PCIe Audio Accelerator, Fairlight Audio 
Interface and the Fairlight PCIe MADI Upgrade, go to the Fairlight Console page on the 
Blackmagic Design website. www.blackmagicdesign.com/products/davinciresolve/ 
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